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I Symbols Used in This Document

A Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important

Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

»>» Note

Instructions including notes for operation and additional explanations.
Instructions explaining basic operations of your product.

»» Note

* Icons may vary depending on your product.
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I Trademarks

Microsoft, Excel, Internet Explorer, Microsoft Edge, Microsoft Store, OneDrive, PowerPoint, Windows
and Windows Vista are trademarks of the Microsoft group of companies.

Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad
Air, iPad mini, iPadOS, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and
other countries.

The Mopria® word mark and the Mopria® Logo are registered and/or unregistered trademarks of Mopria
Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited.

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google LLC.

Google Play and Google Play Logo are trademarks of Google LLC.

Adobe, Acrobat, Flash, Photoshop, lllustrator, Adobe RGB and Adobe RGB (1998) are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

USB Type-C™ is a trademark of USB Implementers Forum.

Amazon, Echo and Alexa are trademarks of Amazon.com, Inc. or its affiliates.

Google, Google Home, and YouTube are trademarks of Google LLC.

LINE is a registered trademark or trademark of LY Corporation.

LINE Clova is a registered trademark of LY Corporation.

Google Docs, and Google Drive are trademarks of Google LLC.

App Store is a trademark of Apple Inc., registered in the U.S. and other countries.

AOSS™ s a trademark of BUFFALO INC.

Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and in other
countries.

HP-GL and HP-GL/2 are either registered trademarks or trademarks of HP Inc. in the United States
and/or other countries.

Mozilla Firefox is a trademark or registered trademark of Mozilla Foundation in the U.S. and/or other
countries.

Wi-Fi, WPA, WPA2 and WPAZ3 are either registered trademarks or trademarks of Wi-Fi Alliance.

All other company names and products mentioned in this guide may be registered trademarks or
trademarks of their respective companies.
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I Licenses

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.
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"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work

and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or

Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of,

the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except

as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;
and
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3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,

or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
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such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

--—-- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2012, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----
Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
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OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: SciencelLogic, LLC copyright notice (BSD) -----
Copyright (c) 2009, Sciencelogic, LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of SciencelLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 10: Lennart Poettering copyright notice (BSD-like) -----

Copyright 2010 Lennart Poettering

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated documentation files
(the "Software"), to deal in the Software without restriction,

including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:
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The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

---- Part 11: IETF copyright notice (BSD) -----

Copyright (c) 2013 IETF Trust and the persons identified as authors of
the code. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Internet Society, IETF or IETF Trust, nor the
names of specific contributors, may be used to endorse or promote
products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 12: Arista Networks copyright notice (BSD) ----

Copyright (c) 2013, Arista Networks, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Arista Networks, Inc. nor the names of its
contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR

A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

---- Part 13: VMware, Inc. copyright notice (BSD) -----

Copyright (c) 2016, VMware, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
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* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of VMware, Inc. nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 14: USC/Information Sciences Institute copyright notice (BSD) -----

Copyright (c) 2017-2018, Information Sciences Institute

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Information Sciences Institue nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
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PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University
Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES

OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.
COPYRIGHT (c) 1989-2000.
On-Line Applications Research Corporation (OAR).
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Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated
Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it

will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley
Copyright (c) 1981-2000 The Regents of the University of California.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

2006-Jan-27
Copyright 1996-2002, 2006 by
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David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
("as is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(‘royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. ('credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

Portions of this software are copyright © <year> The FreeType
Project (www.freetype.org). All rights reserved.
Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

Throughout this license, the terms “package’, "FreeType Project', and "FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
‘FreeType Project’, be they named as alpha, beta or final release.

“You' refers to the licensee, or person using the project, where “using' is a generic term including
compiling the project's source code as well as linking it to form a “program’ or “executable’.

This program is referred to as “a program using the FreeType engine'.
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This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED "AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: “FreeType Project', "FreeType Engine', "FreeType library',
or "FreeType Distribution’.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts
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There are two mailing lists related to FreeType:
o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.
Our home page can be found at

http://www.freetype.org

---end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties

of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++
Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.
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ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License
Copyright (c) 2013-2017
Frank Denis <j at pureftpd dot org>

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS 1S" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE

OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
"AS 1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
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PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* Neither name of Intel Corporation nor the names of its contributors

may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Lua
Copyright © 1994-2014 Lua.org, PUC-Rio.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated

documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the

rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to

permit persons to whom the Software is furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in all copies or substantial
portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN

ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH

THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LuaSocket

LuaSocket 2.0.2 license
Copyright © 2004-2007 Diego Nehab

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation

the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

LuneScript
Copyright (c) 2018 ifritdJP

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

37



THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Copyright (c) 2002-2019, Jouni Malinen <j@w1.fi> and contributors
All Rights Reserved.

This software may be distributed, used, and modified under the terms of
BSD license:

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name(s) of the above-listed copyright holder(s) nor the
names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2019, Broadcom Corporation. All Rights Reserved.

Permission to use, copy, modify, and/or distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

38



THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES

WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The certificate files "Amazon Root CA 1", "Amazon Root CA 2", "Amazon Root CA 4" are licensed under a
Creative Commons Attribution-NoDerivatives 4.0 International License.

This software is licensed under the MIT License.
Copyright Fedor Indutny, 2018.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit
persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS I1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS

OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE
USE OR OTHER DEALINGS IN THE SOFTWARE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2008, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above

copyright notice, this list of conditions and the following disclaimer

in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its

contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
AS IS AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 1998-2010, Brian Gladman, Worcester, UK. All rights reserved.

The redistribution and use of this software (with or without changes)
is allowed without the payment of fees or royalties provided that:
source code distributions include the above copyright notice, this
list of conditions and the following disclaimer;

binary distributions include the above copyright notice, this list

of conditions and the following disclaimer in their documentation.

This software is provided 'as is' with no explicit or implied warranties
in respect of its operation, including, but not limited to, correctness
and fitness for purpose.
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Disclaimer: IMPORTANT: This Apple software is supplied to you, by Apple Inc. ("Apple"), in your
capacity as a current, and in good standing, Licensee in the MFi Licensing Program. Use of this
Apple software is governed by and subject to the terms and conditions of your MFi License,
including, but not limited to, the restrictions specified in the provision entitled "Public

Software", and is further subject to your agreement to the following additional terms, and your
agreement that the use, installation, modification or redistribution of this Apple software
constitutes acceptance of these additional terms. If you do not agree with these additional terms,
please do not use, install, modify or redistribute this Apple software.

Subject to all of these terms and in consideration of your agreement to abide by them, Apple grants
you, for as long as you are a current and in good-standing MFi Licensee, a personal, non-exclusive
license, under Apple's copyrights in this original Apple software (the "Apple Software"), to use,
reproduce, and modify the Apple Software in source form, and to use, reproduce, modify, and
redistribute the Apple Software, with or without modifications, in binary form. While you may not
redistribute the Apple Software in source form, should you redistribute the Apple Software in binary
form, you must retain this notice and the following text and disclaimers in all such redistributions

of the Apple Software. Neither the name, trademarks, service marks, or logos of Apple Inc. may be
used to endorse or promote products derived from the Apple Software without specific prior written
permission from Apple. Except as expressly stated in this notice, no other rights or licenses,
express or implied, are granted by Apple herein, including but not limited to any patent rights that
may be infringed by your derivative works or by other works in which the Apple Software may be
incorporated.

Unless you explicitly state otherwise, if you provide any ideas, suggestions, recommendations, bug
fixes or enhancements to Apple in connection with this software ("Feedback"), you hereby grant to
Apple a non-exclusive, fully paid-up, perpetual, irrevocable, worldwide license to make, use,
reproduce, incorporate, modify, display, perform, sell, make or have made derivative works of,
distribute (directly or indirectly) and sublicense, such Feedback in connection with Apple products
and services. Providing this Feedback is voluntary, but if you do provide Feedback to Apple, you
acknowledge and agree that Apple may exercise the license granted above without the payment of
royalties or further consideration to Participant.

The Apple Software is provided by Apple on an "AS IS" basis. APPLE MAKES NO WARRANTIES,
EXPRESS OR

IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY

AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE OR ITS USE
AND OPERATION ALONE OR

IN COMBINATION WITH YOUR PRODUCTS.

IN NO EVENT SHALL APPLE BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR

PROFITS; OR BUSINESS INTERRUPTION) ARISING IN ANY WAY OUT OF THE USE,
REPRODUCTION, MODIFICATION

AND/OR DISTRIBUTION OF THE APPLE SOFTWARE, HOWEVER CAUSED AND WHETHER UNDER
THEORY OF CONTRACT, TORT

(INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, EVEN IF APPLE HAS BEEN
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ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2009 Apple Inc. All Rights Reserved.
Copyright (c) 2012-2013 Apple Inc. All rights reserved.
Copyright (C) 2013 Apple Inc. All Rights Reserved.

The following applies only to products supporting the cloud service (formerly known as PIXUS Cloud Link,
PIXMA Cloud Link, or MAXIFY Cloud Link).

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel

Email local part: ph10

Email domain: cam.ac.uk

University of Cambridge Computing Service, Cambridge, England.
Copyright (c) 1997-2012 University of Cambridge

All rights reserved.

PCRE JUST-IN-TIME COMPILATION SUPPORT

Written by: Zoltan Herczeg

Email local part: hzmester

Emain domain:  freemail.hu
Copyright(c) 2010-2012 Zoltan Herczeg
All rights reserved.

STACK-LESS JUST-IN-TIME COMPILER

Written by: Zoltan Herczeg

Email local part: hzmester

Emain domain: freemail.hu
Copyright(c) 2009-2012 Zoltan Herczeg
All rights reserved.

THE C++ WRAPPER FUNCTIONS

Contributed by: Google Inc.
Copyright (c) 2007-2012, Google Inc.
All rights reserved.

THE "BSD" LICENCE
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----------------- Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google
Inc. nor the names of their contributors may be used to endorse or
promote products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 1S"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This software is based in part on the work of the Independent JPEG Group.
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I Basic Operations

» Printer Parts
« Front
« Back/ Side
@« Top View
@ Inside
@« Operation Panel
@« Desktop Basket
@ Printer Stand
» Using the Printer

@ Turning the Printer On and Off

Loading Rolls in the Printer

Loading Sheets or Postcards into the Printer

Loading Envelopes or Medicine Envelopes into the Printer

Using the Desktop Basket

Using the Basket on the Printer Stand

Stopping Printing
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I Printer Parts

»>

»>

Front

Back / Side

Top View

Inside
Operation Panel
Desktop Basket

Printer Stand
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A: Access Cover

Open when performing printer maintenance or when removing jammed paper.
= |nside

B: Cut Sheet Feed Cover
Open when loading sheets, postcards, envelopes or medicine envelopes in the top feed.

= Top View

C: Roll Paper Feed Cover
Open when loading rolls. Operate with the cut sheet feed cover open.

= Top View (with roll loaded)

D: Access Cover
Open when performing printer maintenance or when removing jammed paper.

= |nside

E: Ink Tank Cover
Open to refill ink tanks.

= |nside of Ink Tank Cover, Inside of Maintenance Cover

F: Maintenance Cover
Open when replacing the maintenance cartridge.

= |nside of Ink Tank Cover, Inside of Maintenance Cover

G: Output Guide
Supports output paper.

H: Operation Panel
Use to change the settings of the printer or to operate it.

The tilt of the operation panel can be adjusted in three steps.

= Operation Panel
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I Inside of Ink Tank Cover, Inside of Maintenance Cover

A: Ink Tank Inner Cover
Open to refill ink tanks.

B: Tank Caps
Open to refill ink tanks.

C: Ink Tanks
Containers for ink inside the printer. Refill when the ink runs low.

= Refilling Ink Tanks

D: Maintenance Cartridge
= Maintenance Cartridge

I Maintenance Cartridge

Model number: MC-32

Absorbs ink used for cleaning.

= Replacing the Maintenance Cartridge
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3% Important

* When purchasing, check the Model number.
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I Back / Side

Cc

A: USB Port
Plug in the USB cable to connect the printer with a computer.

B: Wired LAN Connector
Plug in the LAN cable to connect the printer to a LAN.

C: Carrying Grips
When carrying the printer, have 2 people hold it by these handles under both sides. Furthermore, hold
the left and right of these parts when moving the printer with a stand.

D: Power Cord Connector
Plug in the supplied power cord.
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A: Top Feed
When loading sheets, postcards, envelopes or medicine envelopes, open the top feed and then pull it
upwards.

= | oading Sheets or Postcards into the Printer
= | oading Envelopes or Medicine Envelopes into the Printer

B: Paper Guides
Align with both sides of the paper stack.

50



| Top View (with roll loaded)

A: Roll Holder
When the roll is loaded into the printer, it is attached and secured on either side of the roll paper.

= [ oading Rolls in the Printer

B: Slide Guide
Slide the roll holder over this guide to load the roll into the printer.

C: Roll Holder Siot
The roll holder shafts mounted on either side of the roll are set in these slots.

D: Roll Holder Support
Move this left or right when changing the width of the roll to be set.

= Moving the Roll Holder Support

E: Feed Cover Rollers
When feeding roll paper, these rollers help carry the paper to the paper retainer.

51



A: Paper Retainer
This retainer holds paper as it is fed.

B: Platen
The print head moves across the platen to print.

C: Ink Valve Lever
Use when the printer is sent for repair.

= Repairing Your Printer

D: Carriage Rail
The Carriage slides along this rail.

E: Carriage
Moves the print head.

= Carriage
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I Carriage

A: Print Head Locking Cover
Secures the print head.

B: Print Head
= Print Head

C: Print Head Lock Lever
Lock print head locking cover.

I Print Head

Model number: PF-08

The print head is equipped with ink nozzles.

= Replacing the Print Head

32 Important

* When purchasing, check the Model number.
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I Operation Panel
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»» Note

* The tilt of the operation panel can be adjusted in three steps.

A: ON button
Turns the printer on or off.

= Turning the Printer On and Off

B: ON lamp
Remains lit after flashing when the printer is turned on.

C: Touch Screen
Displays messages, menu items, and operating status. Touch the screen lightly with your finger to
select a menu item or button.

= Home Screen Menu Composition

D: Stop button
Cancels printing.

E: Alarm lamp
Lights up or flashes in case of errors.

F: HOME button
Used to display the HOME screen.

= Home Screen Menu Composition

G: Back button
Returns to the previous screen.
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I Desktop Basket

The following basket is available for this printer.

* Desktop Basket BU-06

I Parts of Desktop Basket

A: Basket Adapters
Insert these into the printer body to attach the Desktop Basket.

B: Basket Arm
Move the arm to open or close the basket.

C: Basket Cloth
Catches the ejected printed documents.
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D: Support Stay
Attached in front of the output guide to support the basket cloth.

»» Note

 For instructions on how to use the Desktop Basket, see "Using the Desktop Basket".
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I Printer Stand

The following stand is available for this printer.

¢ Printer Stand SD-24

I Parts of Printer Stand

A: Stand
A stand that holds the printer. It is equipped with casters to facilitate movement.

B: Basket Cloth
Catches the ejected printed documents.
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C: Locking Caster
The casters can be locked securely. When moving the printer, be sure to unlock the 4 casters. If you
move it while the locking casters are locked, the floor may become scratched.

> Note

» For instructions on how to use the basket that comes with the printer stand, see "Using the Basket on
the Printer Stand".
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I Using the Printer

» Turning the Printer On and Off

» Loading Rolls in the Printer

» Loading Sheets or Postcards into the Printer

» Loading Envelopes or Medicine Envelopes into the Printer
» Using the Desktop Basket

» Using the Basket on the Printer Stand

¥

Stopping Printing
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I Turning the Printer On and Off

I Turning on the printer

Press the ON button to turn on the printer.

= Checking that Power Is On

»» Note

* It may take a while for the printer to start printing immediately after you turn on the printer.

* You can set the printer to automatically turn on when a print operation is performed from a computer
connected by USB cable or wireless network. This feature is set to off by default.

= ECO
I Turning off the printer

1. Press the ON button to turn off the printer.

When the ON lamp stops flashing, the printer is turned off.

2. Confirm that the ON lamp is off.

22 Important

* When you unplug the power cord, press the ON button, then confirm that the ON lamp is off.
Unplugging the power cord while the ON lamp is lit or flashing may cause drying or clogging of
the print head and print quality may be reduced.
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I Checking that Power Is On

The ON lamp is lit when the printer is turned on.

Even if the touch screen is off, if the ON lamp is lit, the printer is on.

»>» Note

» The touch screen display will turn off if the printer is not operated for about 5 minutes. To restore the
display, touch the touch screen. The display is also activated again when an original is printed from a
computer.
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I Using the Desktop Basket

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

(1)
3% Important

* When storing printed documents on the basket, always use it in position (1). If you do not, printed
documents may not be dropped into the basket, and the printed surface may become soiled.

« Lift the left and right sides of the basket arm (A) evenly so that the front of the basket is horizontal.

* The number of sheets that can be collected in the basket is one. If printing multiple pages, print after
removing each sheet.

* The basket can hold printed documents from paper up to 36.0 inches (914.4 mm) long.

When printing on paper longer than that, close the basket and hold the ejected paper by hand. If the
paper falls, the printed surface may become dirty or damaged. Also, do not pull the paper forcibly during
printing.

* When printing on paper smaller than A4, the printed documents may not fit in the basket.
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* Printed documents that are short in length relative to the roll paper width may not fall straight down and
miss the basket. For short printed documents, it is recommended to use Eject cut.

= Specifying the Cutting Method for Rolls

« If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.
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I Using the Basket on the Printer Stand

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

(1) (2)
3% Important

* When storing printed documents on the basket, always use it in position (1). If you do not, printed
documents may not be dropped into the basket, and the printed surface may become soiled.

* To store printed documents in the basket, first pull down the side rod (B) evenly so that the front rod (A)
is not askew, and then use the basket.

* The number of sheets that can be collected in the basket is one. If printing multiple pages, print after
removing each sheet.

* The basket can hold printed documents from paper up to 48 inches (1219.2 mm) long.
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When printing on paper longer than that, close the basket and hold the ejected paper by hand. If the
paper falls, the printed surface may become dirty or damaged. Also, do not pull the paper forcibly during
printing.

* When printing on paper smaller than A4, the printed documents may not fit in the basket.

» When moving the stand, make sure that the basket does not graze the floor and that all four of the
casters are unlocked before moving the stand. Not doing so may damage the basket, scratch the floor,
or cause injuries.

« If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.
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I Stopping Printing

To cancel printing or reception of print jobs, press the Stop button on the operation panel.

4 A

@ 's ~ |
8]
EI & J

&
N w /
When you press the Stop button during printing, the printer operation varies depending on the current
status.

* You press the Stop button before printing starts

The print job is canceled.
* You press the Stop button during printing
Printing stops immediately.

32 Important

« If you press the ON button while printing is in progress, the print data sent from the computer queues in
the printer and you may not be able to continue to print. Press the Stop button to cancel printing.
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I Printing

» Printing from Your Computer (Windows)

Printing with Easy Setup #Basics

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Printing Hanging and Horizontal Banners on Roll Paper (Large-Format Printing)
& See more...

» Printing from Computer (macOS)

Printing with Easy Setup #Basics

Setting Paper Dimensions (Custom Size)

Printing Hanging and Horizontal Banners on Roll Paper (Large-Format Printing)

Printing Using AirPrint
& See more...
» Printing from Chromebook

» Printing from Smartphone/Tablet

Print Easily from a Smartphone or Tablet with Canon PRINT

Printing from iOS Device (AirPrint)

About Mopria®

Printing with Canon Print Service

» Using Cloud Service
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I Printing from Your Computer (Windows)

» Printing with Easy Setup 7Basic

» Setting the Number of Copies and Printing Order

» Printing Photos and Business Documents

» Printing CAD Drawings

» Printing on Postcards

» Setting Up Envelope Printing

» Setting Up Medicine Envelope Printing

» Changing the Print Quality and Correcting Image Data
» Scaled Printing

» Printing to Oversized Paper Sizes

» Setting Paper Dimensions (Custom Size)

» Printing with Minimal Margins on the Scenarios

» Printing Hanging and Horizontal Banners on Roll Paper (Large-Format Printing)
» Printing by Dividing/Joining Documents

» Printing by Saving Roll Paper

» Switching the Paper Source to Match the Purpose

» Displaying the Print Results before Printing

» Other Convenient Settings
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I Printing with Easy Setup

This section describes the simple setting procedure so that you can carry out appropriate printing on this
printer.

I Printing with Easy Setup

1. Check that printer is turned on

2. Load paper on the printer

Set roll paper or cut sheet to a printer.

3. Open the printer driver setup window

4. Select the media type

The type of paper set in the printer is displayed.
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22 Important

« See "Paper Information List" for Canon authentic paper or Canon output check paper.

»» Note

» To prevent the printer from automatically applying the media type set on the printer, change the
settings in Custom Settings... in the Utility tab.

» Click Get Information... to display the Paper Information on Printer dialog box. The Paper
Information on Printer dialog box allows you to get the paper information from the printer and
to set the paper source and the media type on the printer driver.

« For instructions on changing the media type from the printer's operation panel, see "Changing
the Type of Paper."
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5. Select print target

From the pull-down menu, select Easy Settings, and then select the setting that matches your
purpose from the Print Target list.
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6. Select the print quality

For Print Quality, select High, Standard or Draft according to your purpose.
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22 Important

» The print quality settings that can be selected may differ depending on a printing profile.

7. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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8. Select the paper source

For Paper Source, select the setting that matches your purpose.
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9. Select roll paper width
If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper

loaded in the printer.
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10. Complete the setup

Click OK.
When you print, the document is printed with settings that match your purpose.
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13%» Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.

I Checking Printer Settings and Applying Settings to Printer Driver

1. Open printer driver setup window
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2. Click Get Information... on Main tab

The Paper Information on Printer dialog box appears.

3. Select the paper source

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in the paper type and paper size settings.

4. Apply settings
To apply the printer settings to the printer driver, click OK.

»» Note

« If the media type and the output paper size are not set on the printer, OK will be grayed out and

cannot be clicked.
« If communication with the printer is disabled, printer media information from the printer cannot

be obtained.
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I Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Layout tab, specify the number of copies to be printed.

= Cance Printing Preferences 3
Man  Fage Setp Lot Favoctes  Liity
i
- Cromms. | e
[ 5amo CONFIDENTIAL
Lstier (BL5™ 117
EShinziidhn
4+ Asctusl Gize
Letier (BL5"R1E7)
T G_1 [ Retate 180 degrees
Cogees [t ns
@j ] Pt freen Last Puagee
#.k FA Coae
Parge Cptions. Spedial Semrgn Defmits
Concel | [ ool bes

3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.

Check the Collate check box when you are printing two or more copies, and want to print them in
groups, and uncheck the check box when you want to print them as a group on the same page.

4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

32 Important

* When the application software that you used to create the document has the same function, specify
the settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.
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I Printing Photos and Business Documents

» Printing By Setting Print Purpose

» Edit in PosterArtist and Print
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I Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select print setting mode

From the pull-down menu, select Easy Settings.
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4. Select print purpose

For Print Target, select the setting that matches the document.

Default Settings
Select this when printing general documents such as business documents.

Photo (Color)
Select this when printing color illustrations or photos.

Poster
Select this when printing posters.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD (Monochrome Line Drawing)
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

»» Note

» To check the settings of the items that are set by Print Target, click View Settings.

. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

7. Set the other items

Set the other items as necessary.
8. Complete the setup

Click OK.
When you print, the document is printed with settings to match the specified print purpose.
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I Edit in PosterArtist and Print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print
from PosterAtrtist.

The following explains the procedure for editing original documents made in multiple application software in
PosterArtist and printing in a poster layout.

1. Open the printer driver setup window

2. Select edit in PosterArtist

Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.
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»» Note

» Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist

Click OK.
When printing is executed, PosterArtist starts up and PageCapture window opens.

4. Select page to get in PosterArtist

5. Edit page in PosterArtist

Image editing and sorting is implemented in PosterArtist.

By repeating steps 1 through 4 without closing the PosterArtist window, documents made in multiple
application software can be arranged on one page.

After editing is complete, please print from PosterArtist menu.
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»» Note

» For instructions on how to edit and rearrange images, refer to the PosterArtist manual.
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I Printing CAD Drawings

» Printing By Setting Print Purpose
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I Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select print setting mode

From the pull-down menu, select Easy Settings.
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4. Select print purpose

For Print Target, select the setting that matches the document.

Default Settings
Select this when printing general documents such as business documents.

Photo (Color)
Select this when printing color illustrations or photos.

Poster
Select this when printing posters.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD (Monochrome Line Drawing)
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

»» Note

» To check the settings of the items that are set by Print Target, click View Settings.

. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

7. Set the other items

Set the other items as necessary.
8. Complete the setup

Click OK.
When you print, the document is printed with settings to match the specified print purpose.
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I Printing on Postcards

The method for printing Hagaki is described below.
1. Load postcard on the printer

2. Open the printer driver setup window

3. Select the media type
Select Hagaki from Media Type on the Main tab, and then select the Hagaki type you want to use.

2% Important

+ This printer cannot print on postcards that have photos or stickers attached.
* You will get cleaner printing if you print the address side first, and then print the message side.
» The paper settings on the printer driver are different, depending on whether you are printing on
the address side or the message side.
For details about the paper information to be registered to the printer driver and on the printer, see
the following:
— Paper Information List

— Paper Sizes

4. Select the paper size
Go to Page Size in the Page Setup tab, and then select Hagaki 100x148mm or Hagaki 2 200x148mm.
2» Important

* Return postcards can be used only when you print them from the computer.

* When printing a return postcard, always set the paper size to Hagaki 2 200x148mm from your
application software or the printer driver.

» Do not fold the return postcard. If a crease is formed, the printer will not be able to feed the
postcard properly, and this condition will cause line shifts or a paper jam.

5. Click OK
When you perform printing, the data will be printed onto the postcard.

> Note

* When printing the address in landscape orientation, select Landscape under Orientation on the Page
Setup tab.

85



I Setting Up Envelope Printing

1. Load envelope on the printer

2. Open the printer driver setup window

3. Select the media type

Select Envelope from Media Type on the Main tab.

4. Select the paper size

In the Page Size section of the Page Setup tab, select the size of the envelope you are using from
Envelopes.

5. Set the orientation

To print the addressee horizontally, select Landscape for Orientation.

A

6. Click OK
When you perform print, the information is printed on the envelope.

32 Important

* When you perform envelope printing, guide messages are displayed.
To hide the guide messages, check the Do not show this message again check box.
To show the guide again, click the Status Monitor... button on the Main tab, and start the Canon IJ
Status Monitor.
Then click Envelope Printing from Display Guide Message of the Option menu to enable the setting.
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I Setting Up Medicine Envelope Printing

1. Load medicine envelope on the printer

2. Open the printer driver setup window

3. Select the media type

Go to Media Type in the Main tab, and then select Medicine Envelope or Medicine Envelope
(Instant-dry).

4. Set the following items as needed:
* When printing in landscape orientation with the open side of the envelope on the right:

Select Landscape under Orientation on the Page Setup tab, and uncheck Rotate 180 degrees
on the Layout tab.
* When printing in landscape orientation with the open side of the envelope on the left:

Select Landscape under Orientation on the Page Setup tab.

5. Click OK

When you print, the information is printed on the medicine envelope.

22 Important

« If you do not select the correct size and orientation, the printout may be upside down or rotated 90
degrees.

+ Depending on the app you're using, the document may not automatically rotate, resulting in it being
printed upside down. In such cases, check Rotate 180 degrees on the Layout tab.

* When printing, guide messages are displayed.
To hide the guide messages, check the Do not show this message again check box.
To show the guide again, click the Status Monitor... button on the Main tab, and start the Canon IJ
Status Monitor.
Then click Medicine Envelope Printing from Display Guide Message of the Option menu to enable
the setting.
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I Changing the Print Quality and Correcting Image Data

» Adjusting Color Balance

» Setting the Print Quality Level (Custom)

» Printing a Color Document in Monochrome
» Specifying Color Correction

» Adjusting Brightness

» Adjusting Contrast

¥

Printing Using Detailed Setting Mode
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I Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window

2. Select the advanced settings

Select Advanced Settings from the pull-down menu on the Main tab.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.
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4. Adjust color balance

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes
stronger when the corresponding slider is moved to the right, and becomes weaker when the
corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red
becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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I Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select the print quality

For Print Quality, select Custom.
The Custom dialog box opens.
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3% Important

« If Auto (Use Printer Settings) is selected for Media Type, Custom cannot be selected.

4. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.

91



2% Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

I Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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I Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Monochrome or Monochrome Bitmap.

»» Note

» The selectable Color Mode depends on the media type selected for Media Type on the Main tab.
* You can select Monochrome Bitmap for Color Mode only if Line Drawing/Text is selected in
Print Priority.

4. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.
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3% Important

* When Monochrome or Monochrome Bitmap are selected, the printer driver processes image data as
sRGB data. In this case, actual colors printed may differ from those in the original image data.

When using the grayscale printing function to print Adobe RGB data, convert the data to SRGB data
using an application software.

»» Note

* When Monochrome or Monochrome Bitmap is selected, inks other than black ink may also be used.
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I Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or, ICC Profile
Matching. When you want to use an application software to specify a printing ICC profile, select Off.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
Print with the optimal color using the printer driver's original color profile. Normally, you should
choose this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching
method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or
the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing
from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing a color chart using a profile
creation tool.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

32 Important

» When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.

« If Auto (Use Printer Settings) is selected for Print Priority in Advanced Settings, the Matching
sheet is not displayed, and color correction occurs according to printer settings.
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I Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
= Printing with ICC Profiles
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I Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

I Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

»>» Note

* Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a
format called RAW. RAW data refers to an image saving format that requires a computer to develop
the image. You can embed an input ICC profile tag into a RAW file by using special application
software.

I Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space of the image data or the application
software to be used.

There are two typical printing methods.
Check the color space of the image data and the application software to be used, and then select the
printing method suited to your purpose.

Adjusting Colors with the Printer Driver

This section describes the procedure for printing data by using the color correction function of the
printer driver.

Select this function when you want to print impressions that are close to those displayed on the
monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of the image data effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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I Adjusting Colors with the Printer Driver

To use printer driver matching when printing, turn on the printer driver's color correction function. Printer
driver matching accurately applies the characteristics of data displayed on the monitor and allows you to
obtain print results of impressions that are close to those displayed on the monitor.

22 Important

» When printing using printer driver matching, Canon recommends that you set the monitor and the
environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix £ 125 Ix

»>» Note

* When printing from an application software that can identify ICC profiles and allows you to specify them,
use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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5. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Perceptual (Photo)
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD)
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you print, the colors get adjusted by the printer driver when printing the data.
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I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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| Printing with IcC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data
effectively.

The printer driver setting procedure varies depending on the application software used to print.

I Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself, be sure to select color management
items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Off for Color Correction.
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5. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Specify an ICC Profile with the Printer Driver, and then Print

When you print from application software that cannot identity input ICC profiles or does not allow you to
specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select ICC Profile Matching for Color Correction.
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5. Select input profile

Select the Input Profile you want to use.

104



32 Important

» When the application software specifies an input profile, the input profile setting of the printer
driver becomes invalid.

6. Select the printer profile
Select Printer Profile as follows:

» To set the printer profile automatically:
Select Auto Settings.

» To set the printer profile manually:
Select a printer profile that matches the media type to be used.

7. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

32 Important

* When you select Perceptual to print images, Canon recommends that you set the monitor
and the environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix + 125 Ix

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.

Absolute Colorimetric
When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper
(background color). However, when Absolute Colorimetric is selected, how the white spots are
reproduced depends on the image data.

3% Important

» Depending on the media type, you may obtain the same print results even when you change
the Rendering Intent setting.

105



8. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

9. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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I Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing.
The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust brightness

On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors,
and moving the slider to the left darkens (intensifies) the colors.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the adjusted brightness.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Contrast
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I Adjusting Contrast

You can adjust the image contrast during printing.
To make the differences between the light and dark portions of images greater and more distinct, increase

the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust the contrast

On the Color Adjustment tab, moving the Contrast slider to the right increases the contrast, and
moving the slider to the left decreases the contrast.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness
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| Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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4. Set print conditions
Set the following items as necessary.

Print Priority
Select elements to prioritize for print results.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Color Mode
Selects color adjustment method.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was

created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed with the print conditions you set.
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I Related Topics

= Adjusting Color Balance

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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I Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Select the paper size of the document

Using Page Size on the Page Setup tab, select the page size that is set with your application software.

3. Select the paper source

For Paper Source, select the setting that matches your purpose.

4. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

5. Select scaled printing

Check the Enlarged/Reduced Printing check box.
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6. Set one of scaling methods described below

From the items listed below, select the setting that matches your purpose and select the corresponding

check box.
The current settings are displayed in the settings preview on the left side of the window.

* Fit Paper Size
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Scales the document to match the paper size.
* Fit Roll Paper Width

|
%, L

Scales the document to match the roll paper width.
* Scaling

80%

Allows you to specify the scaling by entering a number directly or by selecting the paper size you
want from the Printer Paper Size list.

The document is reduced when a size smaller than the Page Size setting is selected from the
Printer Paper Size list, and enlarged when a size larger is selected.

7. Complete the setup
Click OK.

When you execute print, the document will be printed with the specified scale.

32 Important

* When the application software which you used to create the original has the scaled printing function,
configure the settings on your application software. You do not need to configure the same setting in
the printer driver.

115



»» Note

+ Selecting Enlarged/Reduced Printing changes the printable area of the document.
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I Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the
Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so
that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after
printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window

2. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

3. Click Size Options...
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The Paper Size Options dialog box opens.

4. Select oversize

Select the Oversize check box, and click OK.

117



Paper Size Optaons *

_F“MS-:!LI'H ) I_T-..rﬂm Paper Sine Nama
HMame S =)
#150 B4 5382 1350 [
. 2028 2366 Cheren
*g3 14300 2028 Sy
sps 101251453 s
v L
SIPOMCANSID) 2200 MO0 LJMiimal Margin Frinting Sice
= TFull (ANSIC) 17090 2203 [ et Flatin of the Wik 1o Hisght
1315 e B) 1300s 1500 Wiickh: | 3.8 ki) 50 - 200
#1117 (Ladger) 11.00= 1700 T T = s,
* Letter (R 5117 BSUe 110D toicht TN inehi0- 157,65
[ Ragister wih the 05 Add
Dhaplary Series
1150 AT AL IS ARCHEA.BL.) ElErmetape
B2 150 B3 B4, ) & ANSI (A, E [l T
EF 3415 (B3 B4, ) [ Photo
Elsomgacs.) =L
Cren | [ b

The current settings are displayed in the settings preview on the left side of the Page Setup tab.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed using oversize.

2% Important

» When printing to oversized paper sizes, use paper that has the following necessary margins added to
the document size.
— Cut sheet: 10 mm or more added to width and 10 mm or more added to height of document size
— Roll paper: 10 mm or more added to width and 10 mm or more added to height of document size

»>» Note

* An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.

» To set an oversized paper size for a non-standard paper size, register the paper size in the Paper
Size Options dialog box. An oversized paper size cannot be set for paper sizes that were set in the
Custom Size Settings dialog box.
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I Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page
Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it
becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:

I Setting from Paper Size Options

1. Open the printer driver setup window

2. Click Size Options... on the Page Setup tab
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The Paper Size Options dialog box opens.

3. Set user-defined paper

Set Custom Paper Size Name, Units, and Paper Size, and then click Add.
For Paper Size, specify a size or select the paper size to be used from Paper Size List.
To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
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»» Note

» By selecting the Minimal Margin Printing Size check box for Paper Size, you can select a size

from the paper sizes that support Minimal Margin Printing. By selecting the Fix the Ratio of
the Width to Height check box, you can change the size while keeping the Width and Height

ratio.
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4. Set user-defined paper

Click OK, then it returns to Page Setup tab.

The paper size registered by using Custom Paper Size Name is registered to Custom Paper Size of

Page Size and can be selected at any time.

I Setting from Custom Size

1. Open the printer driver setup window

2. Select the paper size

For Page Size on the Page Setup tab, select Custom Size from the Custom Paper Size list.
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3. Set the custom paper size

Enter the Width and Height values of the paper to be used, specify the Units, and then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

22 Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver

to set the values.
 Printing may be disabled depending on the size of the specified user-defined media.
For information about printable sizes for user-defined media, see "Paper Sizes."
* Any paper size that was set by using Custom Size can no longer be used after the application software

is closed.
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3> Note
« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can still print but you may not be able

to obtain correct print results.
» The maximum configurable size with Custom Size is 3.2m.
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I Printing with Minimal Margins on the Scenarios

» Printing with Minimal Margins to Match Paper Size
» Printing with Minimal Margins to Match Roll Paper Width
» Printing Full-Size with Minimal Margins

» Print with Three-sided Minimal Margins on Roll Paper
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I Printing with Minimal Margins to Match Paper Size

The procedure for minimal margin printing by enlarging or reducing documents to match paper size is

described below.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select minimal margin printing

Place a checkmark next to the Minimal Margin Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.

. Select a method for printing with minimal margins

Select Fit Paper Size in Minimal Margin Printing Method.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

. Complete the setting process

Click OK.
If you print now, the document will be printed with minimal margins to fit the paper size.

22 Important

Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing with minimal margins on paper with low ink-fixing properties, depending on frequency of
use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to
be unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

If you select a paper type that doesn't support minimal margin printing, you won't be able to print with
minimal margins. To see which paper types support minimal margin printing, refer to "Paper Settings
List (Roll Paper)."

If you feel the left and right margins are different sizes, adjust the margin amount from Roll paper
minimal margin amount on the printer. Then, perform printing.

For instructions on how to adjust Roll paper minimal margin amount, refer to "Setting the Minimal
Margin Amount When Performing the Minimal Margin Printing."

When using Minimal Margin Printing, the print settings are automatically changed to the optimized
ones.This may result in having the same print result despite the change in the print settings.

»» Note

When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Printing with Minimal Margins to Match Roll Paper Width

Procedure for printing with minimal margins by enlarging/reducing documents to match roll paper width.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select minimal margin printing

Place a checkmark next to the Minimal Margin Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.
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5. Select a method for printing with minimal margins

Select Scale to fit Roll Paper Width in Minimal Margin Printing Method.

6. Complete the setting process

Click OK.
Job will print to the entire roll width with minimal margins.

32 Important

Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing with minimal margins on paper with low ink-fixing properties, depending on frequency of
use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to
be unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

If you select a paper type that doesn't support minimal margin printing, you won't be able to print with
minimal margins. To see which paper types support minimal margin printing, refer to "Paper Settings
List (Roll Paper)."

If you feel the left and right margins are different sizes, adjust the margin amount from Roll paper
minimal margin amount on the printer. Then, perform printing.

For instructions on how to adjust Roll paper minimal margin amount, refer to "Setting the Minimal
Margin Amount When Performing the Minimal Margin Printing."

When using Minimal Margin Printing, the print settings are automatically changed to the optimized
ones.This may result in having the same print result despite the change in the print settings.

»» Note

When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.

127



I Printing Full-Size with Minimal Margins

—

Procedure for printing images with minimal margins in the same size as the original document without
enlarging/reducing them.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select minimal margin printing

Place a checkmark next to the Minimal Margin Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.

5. Select a method for printing with minimal margins
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Select Print Image with Actual Size in Minimal Margin Printing Method.

6. Complete the setting process

Click OK.
If you print, the document is printed in the original size with minimal margins.

2% Important

+ If Amount of Enlargement in Minimal Margin Settings is set to the second from the right, create
the source document with a size 2mm larger on each of the top, bottom, left and right sides than
the size of the paper you wish to print.

32 Important

Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing with minimal margins on paper with low ink-fixing properties, depending on frequency of
use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to
be unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

If you select a paper type that doesn't support minimal margin printing, you won't be able to print with
minimal margins. To see which paper types support minimal margin printing, refer to "Paper Settings
List (Roll Paper)."

If you feel the left and right margins are different sizes, adjust the margin amount from Roll paper
minimal margin amount on the printer. Then, perform printing.

For instructions on how to adjust Roll paper minimal margin amount, refer to "Setting the Minimal
Margin Amount When Performing the Minimal Margin Printing."

When using Minimal Margin Printing, the print settings are automatically changed to the optimized
ones.This may result in having the same print result despite the change in the print settings.

> Note

When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Print with Three-sided Minimal Margins on Roll Paper

g

.f.

You can combine paper sizes that don't match the roll paper width and print with minimal margins aligned to
three sides. However, you need to cut the right side of the paper after printing.

I Printing to Match Paper Size

The procedure for minimal margin printing aligned to three sides by enlarging or reducing documents to
match paper size is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select minimal margin printing

Place a checkmark next to the Minimal Margin Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as
that of the paper roll loaded in the printer and click OK.

. Click Minimal Margin Settings

When the Minimal Margin Settings dialog box is displayed, place a checkmark next to Align to left
and print (minimal margin on left only), and then click OK.
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. Select a method for printing with minimal margins

In the Minimal Margin Printing Method, place a checkmark next to the Fit Paper Size option.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

. Complete the setting process

Click OK.
If you print now, the document will be printed to fit the paper size.

. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing. Cut slightly to the inside of the
margin as the document is enlarged.

To get the document to standard size, it is recommended to take measurements and cut in the correct
positions.
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I Printing Full-Size

The procedure for printing aligned to three sides in the same size as the original document without
enlarging or reducing the size is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select minimal margin printing

Place a checkmark next to the Minimal Margin Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as
that of the paper roll loaded in the printer and click OK.

5. Click Minimal Margin Settings

When the Minimal Margin Settings dialog box is displayed, place a checkmark next to Align to left
and print (minimal margin on left only), and then click OK.
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6. Select a method for printing with minimal margins

In the Minimal Margin Printing Method, place a checkmark next to the Print Image with Actual
Size option.

7. Complete the setting process

Click OK.
If you print now, the document will be printed aligned to three sides while retaining the same document
size.

8. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing.
To get the document to standard size, it is recommended to take measurements and cut in the correct

positions.
L ) ' o L
2 &
22 Important

» Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

* When printing with minimal margins on paper with low ink-fixing properties, depending on frequency of
use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to
be unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

* If you select a paper type that doesn't support minimal margin printing, you won't be able to print with
minimal margins. To see which paper types support minimal margin printing, refer to "Paper Settings
List (Roll Paper)."

+ If you want to change the margin on the left side of the document,adjust the margin amount from Roll
paper minimal margin amount on the printer. Then, perform printing.

For instructions on how to adjust Roll paper minimal margin amount, refer to "Setting the Minimal
Margin Amount When Performing the Minimal Margin Printing."

* When using Minimal Margin Printing, the print settings are automatically changed to the optimized

ones.This may result in having the same print result despite the change in the print settings.
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»» Note

* When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing Hanging and Horizontal Banners on Roll Paper (Large-
Format Printing)

A drapery or banner can be made by enlarging or reducing original documents made on application
software.

The procedure for printing hanging and horizontal banners is as follows:

| Print for width of roll

1. Create document by using application software

2. Open the printer driver setup window

3. Select the paper size

Select the same original paper size created in the application soft in the Page Size on the Page Setup
tab.

In the event an optional size is set in the application software, select Custom Size from Custom
Paper Size in Page Size and designate size in the dialog box that appears.

4. Select roll width

Select the equivalent to the paper width of the roll set in the printer under Roll Paper Width.

5. Set Enlarged/Reduced Printing

Check Enlarged/Reduced Printing and select Fit Roll Paper Width.
When the Information dialog box appears, select the equivalent to the paper width of the roll set in
the printer.
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6. Complete the setup

Click OK.
When printing is executed, a drapery or banner can be printed according to the roll.

I Enlarge and print

1. Register user-defined paper

Register both the actual desired print size (user-defined paper 1) and original document size created
in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

»» Note

» Please set user-defined paper 2 to the same aspect ratio as user-defined paper 1. If the aspect

ratio differs, the enlarged image may not turn out to be the expected size.
After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the
Ratio of the Width to Height, settings can be set to the same aspect ratio.
Also set user-defined paper 2 to a size that doesn't exceed the maximum size supported by the
application.

For example, when printing on paper 600mm wide and 3,000mm long, use the following
settings.

(when setting length to 1/6 the user-defined paper)

— User-defined paper 1: Width 600mm, Height 3,000mm

— User-defined paper 2: Width 100mm, Height 500mm

2. Create original document in application software

Use the registered user-defined paper 2 size to create original document using an application.
3. Open printer driver settings screen

4. Select Paper Size

Select registered user-defined paper 1 from Custom Paper Size in the Page Size on the Page Setup
tab.

5. Complete the setup

Click OK.
When you print, the hanging or horizontal banner is printed by using the user-defined size.

»>» Note

» Maximum printable length is 4.0m. In the event the enlarged length exceeds 4.0m, the part of the image
exceeding the length will not be printed.

« If printing cannot be performed correctly, you may be able to improve printing by using the Special
Settings dialog box on the Layout tab to change FineZoom Settings to Yes.
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I Printing by Dividing/Joining Documents

» Input Documents Created Using Multiple Application Software into Free Layout
plus

» Printing by Connecting Multiple Pages
» Printing Multiple Pages All on One Page

» Dividing and Printing Posters
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I Printing by Connecting Multiple Pages

Print documents with several pages as one continuous document. When you do this, the spaces between
the pages will be removed.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select Roll Paper.
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3. Set roll paper options

Click Roll Paper Options... to display the Roll Paper Options dialog box.
Select the Banner Printing check box, and then click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

Roll Paper Optazns .o

Carcel Defouts Hels

4. Complete the setup

Click OK on the Page Setup tab.
When you print, the document is printed with the print conditions you set.
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I Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of pages to be printed per sheet

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/
Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.
The current settings are displayed in the settings preview on the left side of the window.
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4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Set..., specify the following settings in the Page Layout Printing dialog box, and click
OK.

Page Layout Printing X

Caneel Defsuty Hein

Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, select something other than None from the list.

5. Complete the setup

Click OK on the Layout tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.

2» Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the
Page Setup tab, Page Layout is grayed out and cannot be set.

« If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW Spooling),
Page Layout is grayed out and cannot be set.
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| Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for dividing and printing posters is as follows:

I Setting for Dividing and Printing Posters

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of divisions

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select Poster (1
x 2) or Poster (2 x 2).
The current settings are displayed in the settings preview on the left side of the window.
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4. Complete the setup

Click OK on the Layout tab.
When you execute print, the document will be divided into several pages during printing.

3% Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on
the Page Setup tab, Page Layout is grayed out and cannot be set.

+ If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW
Spooling), Page Layout is grayed out and cannot be set.

I Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Display Pages to Print dialog box

For Page Layout, click Set... to display the Pages to Print dialog box.

2. Set print range

Clear the check boxes of the pages you do not want to print.

In the setting view, the pages that you cleared are deleted and only the pages to be printed are
displayed.

Check the pages to be printed, and then click OK.
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3> Note
* In the setting view on the left side of the Pages to Print dialog box, you can also clear the
display by clicking the pages you do not want to print.

To redisplay a cleared page, click that page again.
» To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup

Click OK on the Layout tab.
When you print, only the specified pages are printed.

22 Important
« If you partition and print as a poster, the source document will be printed in enlarged form, so the print

results may become rough.
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I Printing by Saving Roll Paper

» Saving Roll Paper by Rotating Document 90 Degrees
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I Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees
and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.
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3. Select the paper size
From the Page Size list on the Page Setup tab, select the same size as that of the document that was

created with the application software.

4. Select the paper source

In Paper Source, select Roll Paper.

5. Selecting Paper Saving

Select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select roll paper width
For Roll Paper Width, select the width of the roll paper loaded in the printer.

ﬂ.'f'.'l Cancn Printing Preferences x
Man | Page S Layout Favoctes  Lbiky
B pge e [Letter 5011 ~|
[ Mrimal Margin Frieng Minimal Margin Setings
[C] Erkarged Fedused Prirting
it Poper Sice
78 Fiod Paper Wickh
Cit i fube T
LLetier (ELEX11T) IJ":',J Breder B ot Eama a3 Page Size
& Astual Sise
o
BSHinx 1100m
" A @ A Ollantscace
£
j [ Rotate Fage %0 degrees
Faper Source: Fud Fager 2
[7at Pacer v |28 Bt 1509 e -]
Faoll Paper Optiors
s | [y [ e

7. Complete the setup

Click OK.
When you print, you can rotate a portrait document 90 degrees to save paper.

22 Important
* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the Page
Setup tab, Rotate Page 90 degrees is grayed out and cannot be set.
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* When selecting paper in portrait format as the Page Size from the Page Setup tab, if the length in the
vertical direction is longer than the width selected in Roll Paper Width, even if a checkmark is placed
next to Rotate Page 90 degrees, the page will not be rotated.

147



I Switching the Paper Source to Match the Purpose

This printer has two paper sources: Roll and Top Feed.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window

2. Select the media type

The type of paper set in the printer is displayed.

3. Select the paper source

From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.
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Feeds paper using roll paper.

Top Feed
Feeds paper using the cut sheet.

4. Complete the setup

Click OK.
When you execute print, the printer uses the specified paper source to print the data.

»» Note

« |If the paper settings in the printer driver differ from the paper information registered on the printer,
an error message may appear on the printer's operation panel. You can still print but you may not
be able to obtain correct print results.
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I Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.
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3. Complete the setup

Click OK.
When you execute print, the Canon imagePROGRAF Preview opens and displays the print results.

I Related Topic

= Canon imagePROGRAF Preview
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I Other Convenient Settings

» Stamp Printing
» Setting a Page Size and Orientation

» Registering a Frequently Used Printing Profile
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I Stamp Printing

The Stamp function allows you to print a stamp text over or behind document data.
"DRAFT," "CONFIDENTIAL," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and then select the stamp to use from the list.
The current settings are displayed in the settings preview on the left side of the Layout tab.
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3. Complete the setup
Click OK.

When you execute print, the data is printed with the specified stamp.

22 Important

» Depending on your usage environment, you may not be able to use the Stamp function. In this case,
set Spooling at Printer Driver in the Special Settings dialog box to Yes.
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I Registering a Stamp

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

I Registering a New Stamp

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
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The Define Stamp dialog box opens.
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3. Set stamp details

Click Add to add a new stamp (Untitled) to the list.

In Name, enter the name of the stamp to register, and in Text, enter the character string you want as
the stamp.

Change the Font, Style, Size, and Color settings as necessary.

4. Set the other items

Set the following items as necessary.

Outline

Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.

Select Transparent to print the stamp on the back of the document, and select Overlap to print it
on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to
the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the
setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
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5. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

I Changing and Registering Some of Stamp Settings

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed

From Stamps, select the title of the stamp you want to change the settings for.
3. Configure each setting while viewing the preview

4. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

»» Note

» The stamp registered as the default setting cannot be changed.

I Deleting an Unnecessary Stamp

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp to be deleted

Select the title that you wish to delete from the Stamps and click Delete.
Click Yes when the confirmation message appears.

3. Complete the setup
Click OK to return to the Layout tab.
3> Note

» The stamp registered as the default setting cannot be deleted.
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I Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size

and orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation
Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you

want to perform printing with the original being rotated 90 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.
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I Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be
deleted at any time.

The procedure for registering a printing profile is as follows:
I Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items
On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to
register.

3. Display Add dialog box

On the Favorites tab, click Add....
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4. Register favorite setting
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In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then
click OK.

The name and the icon appear in the Favorites list.

To check the settings of the registered favorite, click Settings Details.

»» Note

» To save the settings of the favorite to a file, click Export... on the Favorites tab.

I Printing Using Favorite Settings
1. Open the printer driver setup window

2. Apply favorite

From the Favorites list on the Favorites tab, select the favorite you want to use.
Click Apply Favorite to replace the registered print settings.

3. Complete the setup

Click OK.
When you print, the document is printed with the settings of the registered favorite.

I Deleting Unnecessary Printing Profile

1. Select favorite to be deleted

Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting

Click Delete. When the confirmation message appears, click OK.
The selected favorite is deleted from the Favorites list.

»>» Note

* Printing profiles that are registered in the initial settings cannot be deleted.

» The settings of the favorite being applied to the current print settings cannot be deleted. To delete
that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings
of that other favorite, and then delete the target favorite.
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I Printing from Smartphone/Tablet

For more on printing from a device, refer to the device's or application's instruction manual.

» Print Easily from a Smartphone or Tablet with Canon PRINT
» Printing from iOS Device (AirPrint)
» About Mopria®

» Printing with Canon Print Service
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I Windows Printer Driver

» Overview of the Printer Driver
» Printer Driver Description

» Updating the Printer Driver
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I Overview of the Printer Driver

>

>

Canon IJ Printer Driver

Changing the Print Options

Canon imagePROGRAF Preview

How to Open the Printer Driver Setup Window
Updating Media Information in Printer Driver
Deleting the Undesired Print Job

Canon |J Status Monitor

Instructions for Use (Printer Driver)

160



I Canon |J Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

I Installing the Printer Driver

To install the printer driver, install the driver from the Setup CD-ROM or our website.

I Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name).

I Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

I Related Topic

= How to Open the Printer Driver Setup Window
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I Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Special Settings... on the Layout tab
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3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Layout tab is displayed again.

162



I Canon imagePROGRAF Preview

The Canon imagePROGRAF Preview is an application software that displays what the print result will look
like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

I Related Topic

= Displaying the Print Results before Printing
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I How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

I Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

I Opening the Printer Driver Setup Window from the Printer Icon
Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

The following instructions are shown using screens displayed in Windows 11 as an example.
1. Select the Settings -> Bluetooth & devices -> Printers & scanners

2. Click your model name icon, and then select Printing preferences from the displayed
menu

The printer driver setup window appears.

»» Note

« If you're using Windows 10 or earlier, follow the steps below to display the printer driver settings
screen.
1. Select the Control Panel -> Hardware and Sound -> Devices and Printers

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

Opening the printer driver setup window through Printer properties displays such tabs
regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not appear
when opening through Printing preferences or application software. For tabs regarding
Windows functions, refer to the user's manual for the Windows.
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I Updating Media Information in Printer Driver

This function gets the latest media information from the printer and updates the media information in the
printer driver.

When the media information is updated, the media displayed for Media Type on the Main tab is updated to
the latest information.

The procedure for updating media information is described below.

1. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Update media information

Click Update Media Information the Device Settings tab.

When a confirmation message appears, click Start.

If the paper information on the driver cannot be updated, click Initial Check Items and check the
displayed information.

The printer driver media information will update.

32 Important

+ It may take some time to update the media information.

4. Finish updating media information

When a confirmation message appears, click OK.
The media information will be updated.

32 Important

* Restart the printer driver after updating media information.
» Do not change media information on the printer while you are updating media information on
the driver.

2% Important

» Ensure that a user with administrative privileges carries out the media information update.
Users other than administrators can check if a media information update is required, but cannot carry
out the update itself.

* When you have added, deleted, or edited media using administrative tools (the Media Configuration
Tool) but have not updated the media information, issues may arise such as the inability to print.
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I Deleting the Undesired Print Job

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Open the printer driver setup window

2. Display the Canon IJ Status Monitor

Click Status Monitor... on the Main tab.
The Canon |J Status Monitor appears.

3. Display the print jobs

Click Display Print Queue.
The print queue window opens.

4. Delete the print jobs

Select the print jobs you want to delete, and select Cancel from the Document menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

32 Important

» Users who have not been granted access permission for printer management cannot delete the print
job of another user.
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I Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

I Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon |J Status Monitor appears as a button on the task bar.

El -

Click the button of the status monitor displayed on the task bar. The Canon |J Status Monitor appears.
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»» Note

» To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup
window and click Status Monitor... on the Main tab.

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.

I When Errors Occur

If an error occurs (e.g., if the printer runs out of paper or if the ink is low), the Canon IJ Status Monitor
displays an error information dialog box.
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In such cases, take the appropriate action as described.
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I Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Main tab, click Status Monitor....
The Canon IJ Status Monitor opens.

3. Display Estimated ink levels

Ink status is displayed as an illustration.
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»» Note

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.
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I Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

I Restrictions on the Printer Driver

Before installing, log on to Windows as user with administrator rights.
Always check the following before installing the software.
1. Quit the application software while it is running.
2. If you are printing a document, abort printing or wait for it to finish.
3. Close all the printer driver's dialog boxes.

If you can set the number of copies with the application software, set them either with the printer
driver or the application software.

If you can configure enlarging/reducing settings with the application software, set the normal size
(100%) in the printer driver, and then configure the magnification factor with the application software.
Depending on the application software used, it may be possible to print collated copies; however,
please do not use this feature when configuring layout printing with the Page Layout option in the
Layout tab.

This may cause incorrect layout.

When printing enlarged/reduced documents, printed results may come out different due to a
discrepancy between the image data resolution and the enlarging/reducing ratio.

When printing reduced color images, 1-dot wide lines or points may disappear from the color images.
Depending on the application software, lines drawn at almost horizontal angles may not print
correctly.

If that should happen, re-draw the line horizontally and print one more time.

Immediately after installing (or updating) the printer driver, you might not be able to visualize new
features in some of the application software.

In all application software provided with printing features, choose Print from the File menu and, after
selecting the printer you are using, click the Properties.

After the Properties dialog box has opened, immediately close it by clicking OK.

If you update the model name of your printer through the General tab in the printer's Properties, the
Favorites settings registered in the printer driver will be disabled.

In such cases, save the Favorites settings as a file before changing the name of the printer and reload
the saved file after you have updated the printer's name.

Printing at high resolution requires a large amount of memory on your computer.

When your computer is low on memory or you are using a large number of application software, the
application software may not work correctly.

In such cases, re-start Windows and, before resuming printing, close all the applications you are not
using. Also, when the printer is not printing correctly, switch the Print Quality setting in the Main tab
to a lower resolution.

When using a local connection, if you do not see a check mark next to the Enable bidirectional
support option in the Ports tab in the printer's Properties, it will not be possible to acquire printer and
device information correctly.

If you are using your printer with a USB connection, refrain from using standby mode. To set standby
mode, select Control Panel -> System and Security -> Power Options.
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* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, in the Advanced tab in the printer's Properties, select Start printing after last page is
spooled in Spool print documents so program finishes printing faster.
* Fine lines and gradients may not print correctly.
In such cases, choose Print from the File menu of the application, and after opening from there the
property dialog box of the printer driver, follow the procedure below and then run printing.
1. In the Main tab, uncheck Preview before printing.
2. In the Layout tab, uncheck Page Layout.
3. If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.

* In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.

In such cases, you may be able to print by increasing the time set in Job timeout in the printer's
operation panel.

» Depending on the application used, if you print using features like enlarging/reducing, layout printing,
page borders and so on, some of the data in the resulting printed document, for example graphics,
may differ from the source document.

* If you print very large images from your computer when it's running low on memory, you may not be
able to print correctly; for example, it may take a very long time to print or parts of the image may end
up missing.

In such cases, try printing after following the procedure indicated below.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.
o Increase your computer memory.
o Increase the virtual memory of your operating system.

* Do not change the Print Processor... settings in the Advanced tab in the printer Properties.
If you change them, you will not be able to use some of the features correctly, such as the Page
Layout feature in the Layout tab.
* In the cases described below, you will not be able to use the Edit Using PosterArtist feature of Page
Layout in the Layout tab, as well as the Canon imagePROGRAF Preview feature.
o When right-clicking on the printer icon and choosing from See what's printing: Printer -> Pause
Printing, or when right-clicking on the printer icon and choosing Pause Printing
o When right-clicking on the printer icon and choosing from See what's printing: Printer -> Use
Printer Offline, or when right-clicking on the printer icon and choosing Use Printer Offline
o When printing during hours other than those set in Available from and To in the Advanced tab in
the printer's Properties
o When printing with the Enable advanced printing features turned off in the Advanced tab in the
printer's Properties
o When printing with Print directly to the printer enabled in the Advanced tab in printer's
Properties
o When printing after the printing port in the Ports tab in the printer's Properties has changed to
FILE:
o When printing after choosing Output to file in the Print dialog box in the application software

« If you perform a point-and-print installation, you will not be able to use the Edit Using PosterArtist
features of Page Layout in the Layout tab.
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* If you print after setting Edit Using PosterArtist, refrain from printing from other drivers.

« If you combine specific Print Quality with large paper sizes, you may not be able to correctly print
stamps and borders.

* In the Canon imagePROGRAF Preview, characters and fine lines visualized in the View screen may
look differ from printed results. In such cases, try choosing the Layout tab, opening the Special
Settings dialog and turning on Preview Switching.

I Points to Note About Applications with Restrictions

« If, in Microsoft Excel, you place a checkmark next to the Collate and then you print more than one
copy, or if you do Entire workbook after configuring different settings in each tab, you may not be
able to perform layout printing nor to get the intended printing results.

* If you try to print data on a very large-size paper through applications like Adobe lllustrator, you may
not be able to print.

In such cases, try printing after following the procedure indicated below.
o Open the Main tab and uncheck Preview before printing.
o If you are using a 32-bit driver, open the Layout tab and click Special Settings....
Turn off Fast Graphic Process.
o Increase the virtual memory of your operating system.
o If you are using Adobe lllustrator, turn off/on Bitmap printing in the Print dialog box.

* When printing from application software that does not allow EMF spooling, you will not be able to use
the Edit Using PosterArtist feature of Page Layout in the Layout tab.

» When printing from Adobe Photoshop, tone jumps may occur in the gradation of black and white
photographs.

* When printing data created with Microsoft Word using Enlarged/Reduced Printing or Minimal
Margin Printing, you may not be able to print correctly.
In such cases, try printing after following the procedure indicated below.

o Open the printer folder from the start menu, right click on the printer icon and select Printing
preferences. Launch the application after setting, in the Page Setup tab, Page Size, Enlarged/
Reduced Printing and Minimal Margin Printing.

o Open Microsoft Word's Page setup dialog box and close it by clicking OK.

o After configuring the printer driver, close momentarily the Print dialog box without printing. Then,
open the printer driver's set up screen once again, close it by clicking OK, and run printing.
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I Printer Driver Description

» Main Tab Description

» Page Setup Tab Description

» Layout Tab Description

» Favorites Tab Description

» Utility Tab Description

» Device Settings Tab Description

» Canon |J Status Monitor Description
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I Main Tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.
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Settings Preview

The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

The printer illustration shows how to load paper to match the printer driver settings.

Check whether the printer is set up correctly by looking at the illustration before you start printing.
Media Type

Selects a type of printing paper.

Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Get Information...

Opens the Paper Information on Printer dialog box.

You can check the settings on the printer and apply the checked settings to the printer driver.
Specify...

Open the Paper Detailed Settings dialog box, and specify detailed print settings that match the media
type loaded in the printer.

Pull-down menu

Switches the Easy Settings and Advanced Settings.
Easy Settings

This mode allows you to print by using pre-registered print settings.
Print Target

Print settings that are generally used frequently are pre-registered as print purposes. By using

a print purpose to print, you can print by using settings that match the document.
Default Settings

Select this when printing general documents such as business documents.
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Photo (Color)
Select this when printing a color illustration or a photograph.

Poster
Select this when printing posters.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD (Monochrome Line Drawing)
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

22 Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality. Resolution settings depend on media type.

Draft
Good for trial printing.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

View Settings
Opens the View Settings dialog box.

Advanced Settings
This mode allows you to print by specifying detailed settings that match your purpose.
Print Priority
Select elements to prioritize for print results.
Auto (Use Printer Settings)
Use printer settings when printing.

Image
Prioritize image results when printing.

Line Drawing/Text
Prioritize detailed lines and text when printing.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
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3% Important

» Depending on the Media Type settings, the same print results may be produced even if
the Print Quality is changed.

High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality. Resolution settings depend on media type.

Draft
Good for trial printing.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

Color Mode
Select the color to print.
Color
Prints with the number of colors in the document.

Monochrome
Select this setting to print a line drawing using black ink.

Monochrome Bitmap
Print all non-white parts in black.

Color Settings...
Opens the Color Settings dialog box.
You can adjust individual color settings such as Cyan, Magenta, Yellow, Brightness,
and Contrast on the Color Adjustment tab, and select the Color Correction method on
the Matching tab.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

Preview before printing
You can start up the Canon imagePROGRAF Preview, and check what the printing results will be
before executing the print.
Check this check box to display a preview before printing.

Status Monitor...
Displays the status monitor.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).

I Paper Detailed Settings dialog box

Drying Time
Wait time can be set to allow ink to dry. Between Pages settings are only enabled for roll paper.
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Between Pages
The wait time until outputting paper can be set after printing one page. Time is taken before
cutting roll paper to allow the ink to dry, so the page may be dropped into the basket with dried
ink.
Printer Default
Settings in printer unit operation panel are applied.

None
Page will be output immediately after printing

30 sec. /1 min./ 3 min.
Page will be output after set amount of time has passed after printing.

Between Scans

The wait time until printing next scan can be set after printing one scan in page. Set in the event
smudging occurs in the page, unevenness occurs in minimal margin printing, etc., and you would
like to avoid this smudging and unevenness.

Printer Default

Settings in printer unit operation panel are applied.

None
Next scan will be print immediately after first scan is print.

0.5 sec./1 sec.
Next scan will be print after the set amount of time has passed after printing one scan.
* If smudges and/or unevenness occur, please increase time.
Roll Paper Safety Margin

The margin length on the edge of the paper can be selected.
Top/Bottom Margins

Set how images are printed relative to the margin amount on the roll paper.
Printer Default

Settings in printer unit operation panel are applied.

Prioritize Image Size
This setting adds margins to the outside of the print data. Larger margins make the printed
material vertically longer, and more of the roll paper will be used.

Prioritize Paper Size

This setting adds margins to the inside of the print data. Larger margins increase the
unprinted area at the top and bottom of the printed material.

3% Important

* When using Prioritize Paper Size, the top and bottom of the image may be cut off
depending on the margin amount you set. It is recommended that you consider the
margins beforehand when creating the print data.

Leading Edge/Far End Margin
Set the margin length on each end of the roll paper.
Printer Default

Settings in printer unit operation panel are applied.

Auto
Automatically set the margin amount.
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Leading Edge 5 mm / Far End 5 mm / Leading Edge 15 mm / Far End 15 mm / Leading
Edge 30 mm / Far End 30 mm
Select a larger margin when rubbing of the print heads occurs, such as when heavily curling
paper is being used.

Cut Speed
Select auto-cut speed. This can be adjusted when paper cannot be cut precisely with auto-cut.
Printer Default
Settings in printer unit operation panel are applied.

Fast
Select when cut is not smooth with Standard settings.

Standard
Select when there are no particular problems with auto-cut.

Slow
If this is selected for paper with adhesive, the cutter will not stick to the adhesive easily and it will
slow deterioration of the cutter's capabilities.

Unidirectional Printing
Controls color unevenness and unaligned ruled lines.
Please check when printing in one direction.

Mirror
Select whether to print reflected image or not. When you select this check box, text and images will
be printed as if reflected in a mirror.

I Custom dialog box

Set the quality level, and select the desired print quality.
Quality

You can use the slider bar to adjust the print quality level.

32 Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.

»» Note

» The High, Standard, or Draft print quality modes are linked with the slider bar. Therefore when
the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding quality is selected for Print Quality on the Main tab.

I View Settings dialog box

Print Target
Select the print purpose. The settings of the selected print purpose are displayed in Details.

Name
Displays the name of the selected print purpose.
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Details
Displays the settings of the print purpose that was selected for Print Target.

I Color Settings dialog box

Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

32 Important

* When Monochrome is selected for Color Mode, the color balance (Cyan, Magenta, and
Yellow) can't be set.

Brightness
Adjusts the brightness of your print. You cannot change the levels of pure white and black.
However, the brightness of the colors between white and black can be changed. Colors become
brighter as you drag the slider toward the right and darker as you drag the slider toward the left.
You can also directly enter brightness values that are linked to the slider bar. Enter a value in the
range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Matching Tab

This is displayed when Color is selected for Color Mode.
Allows you to select the method for adjusting colors to match the type of document to be printed.
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Color Correction

Allows you to select Driver Matching, ICC Profile Matching, ICM, or Off to match the purpose of
the print operation.

Driver Matching

Print with the optimal color using the driver's original color profile. Normally, you should choose
this mode.

ICC Profile Matching

Carry out color matching using the ICC profile. Specify the input profile, printer profile and
matching method in detail, and select when printing. You can use the digital camera or
scanner ICC profile, or the ICC profile created using the profile creation tool.

ICM

Perform color matching on the host computer using the Windows ICM function. Select when
printing from an ICM function-compatible application.

Off

Print without performing color matching on the printer driver. Select this when performing color

matching using applications such as Adobe Photoshop, or printing using a profile creation tool
or color chart.

3% Important

* When setting not to use ICM in the application software, ICC Profile Matching and ICM
of Color Correction do not function. There are also times when it does not print correctly.

Input Profile
Specifies the input profile to be used when you select ICC Profile Matching for Color Correction.
Printer Profile

Specifies the printer profile to be used when ICC Profile Matching is selected for Color
Correction.

Normally Auto Settings is selected but you can also select a printer profile manually.
Rendering Intent

Specifies the matching method to be used when you select Driver Matching, ICC Profile
Matching, or ICM, for Color Correction.
Perceptual (Photo) / Perceptual

Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.
Saturation (Poster/CAD) / Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors
suitable for line drawing.
Relative Colorimetric

When image data is converted to the color space of the printer, this method converts the

image data so the color reproduction approximates the shared color regions. Select this

method to print image data with colors that are close to the original colors.

The white spots are reproduced as white spots (background color) on the paper.
Absolute Colorimetric

This method uses the white spot definitions in the input and output ICC profiles to convert the
image data.
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Although the color and color balance of the white spots change, you may not be able to get the
desired output results because of the profile combination.

22 Important
» Depending on the media type, you may obtain the same print results even when you change

the Rendering Intent setting.
« If Driver Matching is selected for Color Correction, then Relative Colorimetric and

Absolute Colorimetric are not displayed.
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I Page Setup Tab Description

The Page Setup tab allows you to specify the scaling for enlarging or reducing, set the paper feeding
method, and more.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
When you select Custom Size from Custom Paper Size, the Custom Size Settings dialog box
appears, and you can specify any vertical and horizontal dimensions for the paper.

Minimal Margin Printing
Choose whether to perform minimal margin printing with slight margins on the left and right sides or to
print with margins on the top, bottom, left, and right.
In minimal margin printing, originals are enlarged to extend slightly off the paper. If you feel the left and
right margins are different sizes, adjust the margin amount from Roll paper minimal margin amount
on the printer. Then, perform printing.
For instructions on how to adjust Roll paper minimal margin amount, refer to "Setting the Minimal
Margin Amount When Performing the Minimal Margin Printing."

32 Important

* When Top Feed is selected for Paper Source, Minimal Margin Printing is grayed out and cannot
be set.

Minimal Margin Settings
Select Minimal Margin Printing to enable it for clicking.
Open the Minimal Margin Settings dialog box, so that you can adjust Amount of Enlargement.
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Minimal Margin Printing Method
This appears when you select Minimal Margin Printing.
Set the minimal margin printing method.
Fit Paper Size
Enlarge or reduce the document to match the size of the paper to be printed, and then print the
document.

Scale to fit Roll Paper Width
You can enlarge or reduce the document to match the roll paper width and then print the
document.

When you select this radio button, the Information dialog box appears, and you can select Roll
Paper Width.

Print Image with Actual Size
Prints the document at its actual size.

Printer Paper Size
When you select Fit Paper Size, you can specify the setting.
Select the size of the paper to be printed.
The list displays the paper sizes that support minimal margin printing.

Enlarged/Reduced Printing
You can enlarge or reduce a document and then print it.
When you select Enlarged/Reduced Printing, you can then set Fit Paper Size, Fit Roll Paper Width,
or Scaling.
Fit Paper Size
Enlarge/reduce the document to match the size of the paper to be printed, and then print the
document.

Fit Roll Paper Width
You can enlarge/reduce the document to match the roll paper width and then print the document.

When you select this radio button, the Information dialog box appears, and you can select Roll
Paper Width.

Scaling
Enlarge or reduce the document to a specified scale before printing.

Printer Paper Size
When you select Fit Paper Size, or Scaling, you can specify the setting.
Select the size of the paper to be printed.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
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Rotate Page 90 degrees
Rotate the long edge of the document 90 degrees, match it to the width of the roll paper, and then print
the document.
When you print a portrait document onto roll paper, you can save paper by rotating the document 90
degrees and print the document horizontally relative to the paper.

Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Roll Paper
Feeds paper using roll paper.

Top Feed
Feeds paper using the cut sheet.

32 Important

» Depending on the media type and size, the Paper Source settings that can be selected may differ.

Roll Paper Width
Select the roll paper width.
Select the width that matches the width of the roll paper loaded in the printer.

Roll Paper Options...
Displays the Roll Paper Options dialog box.
You can specify banner printing, and other settings for printing on roll paper.

Size Options...
Displays the Paper Size Options dialog box.

The Paper Size Options dialog box allows you to create and register any user-defined paper.

I Custom Size Settings dialog box (Paper Size)
This dialog box allows you to specify the size (width and height) of the custom paper.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Units
Select the unit for entering a user-defined paper size.

I Minimal Margin Settings dialog box

Configure the minimal margin printing setting.

Amount of Enlargement
Adjust how much of the document is enlarged during minimal margin printing.
Moving the slider to the right increases the amount of enlargement.
Moving the slider to the left reduces the amount of enlargement and expands the range of the
document to print.
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Align to left and print (minimal margin on left only)
If you check this check box, and the width or the length of the output paper size is smaller than the
roll width, a margin will be created on the right of the document, and the left side will have minimal
margins when printing.

I Roll Paper Options dialog box

You can specify settings for printing on roll paper.

Banner Printing
Select this check box to print documents with several pages as one continuous document. When you
do this, the spaces between the pages will be removed.

I Paper Size Options dialog box

You can create and register any user-defined paper. You can then select the defined paper size from
Custom Paper Size of Page Size.

Paper Size List
The names and sizes of the paper sizes that the printer driver can use are displayed.

Delete
From Paper Size List, you can delete a user-defined paper that a user created.

»» Note

» Paper deletion is not possible in the following case:
— When a standard paper size of the printer driver is selected
— When an oversized paper size is selected
— When a paper size with a red circle is selected

Custom Paper Size Name
You can specify the name of a user-defined paper.
Units
You can specify the units for the height and width dimensions of the user-defined paper.
Page Size
You can specify the Width and Height settings of the paper.
Minimal Margin Printing Size
When you select this check box, you can select a size from the paper sizes that support Minimal
Margin Printing.

Fix the Ratio of the Width to Height
When you select this check box, you can change the size while keeping the Width and Height
ratio.

Width
Specify the paper width.

Height
Specify the paper height.
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3% Important

» Printing may be disabled depending on the size of the specified user-defined media.
For information about printable sizes for user-defined media, see "Paper Sizes."

Register with the OS
Register the set user-defined paper in the OS.
By registering in the OS, any user sharing the use of the printer or PC can use the set user -defined

paper.
Add

You can register a user-defined paper that was set and overwrite the existing user-defined paper.
Display Series

You can narrow down the paper sizes to be displayed in Paper Size List.
Oversize

When you select this check box, add appropriate margins so that the document contents will not get
cut off, and then print the document.

186



I Layout Tab Description

The Layout tab allows you to specify how to arrange the document onto the paper. You can also set the
number of copies to be printed and the print sequence. If the application software that you used to create
the document features the same functions, specify the settings from the application software.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Layout
Selects the size of the document you want to print and the type of printing.
Poster (1 x 2)/Poster (2 x 2)
Printing is performed with poster settings.
The value in parentheses represents the ratio of the vertical x horizontal lengths. As the number
of divisions increases, the number of sheets used for printing increases. If you are pasting pages
together to create a poster, increasing the number of divisions allows you to create a larger poster.
Set...
Opens the Pages to Print dialog box.
Specify this setting when you want to print only specific pages.

2 Pages/Sheet / 4 Pages/Sheet /| 6 Pages/Sheet / 8 Pages/Sheet / 9 Pages/Sheet / 16 Pages/Sheet
Multiple pages are assigned to one sheet of paper and printed. The number presents the number
of pages assigned to one sheet.

Set...
Opens the Page Layout Printing dialog box.
You can freely specify detailed settings for assigned printing.

Edit Using PosterArtist
Word processing and spreadsheet software documents and web browser screens, etc. can be
edited a print from PosterArtist.
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You must install PosterArtist to use this function. Go to the Canon website, download PosterArtist,
and then install it.

Stamp
The Stamp function prints a specific character string over the document pages. You can select the
characters to be printed from a list or use the Define Stamp dialog box to set any characters.
Define Stamp...
Opens the Define Stamp dialog box.

You can specify detailed stamp settings or register any stamp.

Rotate 180 degrees
Rotates document 180 degrees and prints it.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
32 Important

« If the application used to create your document has a similar function, specify the number of copies
with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not
need to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check the check box when you are printing two or more copies, and want to print them in groups.
Uncheck the check box when you want to print them as a group on the same page.

Page Options...
Opens the Page Options dialog box.
You specify settings for printing information such as date, user name, and page number.
32 Important

» Depending on your usage environment, you may not be able to use the Page Options function. In
this case, set Spooling at Printer Driver in the Special Settings dialog box to Yes.

Special Settings...
Opens the Special Settings dialog box.
If you are unable to obtained the desired print results, you can change the print processing method.

I Pages to Print dialog box

When printing a poster that has been divided into several pages, you can specify which pages to print and
just print those pages.
Simply clear the check boxes of the pages you do not want to print.
In the setting view, the pages that were unchecked are hidden, and only the pages to be printed are
displayed.
Invert

Switches the pages to be displayed or hidden.
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»» Note

» The Pages to Print dialog box appears only when Poster (1 x 2) or Poster (2 x 2) is selected
for Page Layout.

I Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Select something other than None from the list to print the page border line.

»» Note

» The Page Layout Printing dialog box appears only when 2 Pages/Sheet, 4 Pages/Sheet, 6
Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet is selected for Page Layout.

I Define Stamp dialog box

The Define Stamp dialog box allows you to specify settings for printing a stamp over the document
pages. In addition to the pre-registered ones, you can register and use your original stamp.

Stamps
This is a list of the pre-registered stamps.

Add
Creates an original stamp.
Click this item to set Name, Text, Font, Style, Size, and Color.
Name
Enter the stamp name to be registered.

Text
Enter the characters to be used in the stamp.

Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Color
Select the color of the stamp text string.
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Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps, and click this button.

Outline

Selects a frame that encloses the stamp text string.

Print Style
Select the stamp printing method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print the
stamp on the front.

Position
Specifies the stamp position on the page.
You can specify values in X and Y to set the coordinates, or you can drag the horizontal and vertical
slide bars to the left/right or up/down to change the coordinates.
Move to Center
Moves the stamp to the center of the paper.

Angle
Set the stamp positioning angle.
You can specify a value in Set Angle to set the angle, or you can drag the slide bar left/right to
change the angle.
When specifying an angle value, set a value in the range of -180 to 180.

Stamp first page only
Select this check box if you want to print a stamp only on the first page.

I Page Options dialog box

Specify the print settings, such as date, user name, and page number.

Print Date
Select the position for printing the date.

Print Time Also
Prints the time along with the date.

Print User Name
Select the position for printing the user name.

Print Page Number
Select the position for printing the page number.

»» Note

« It will be displayed if you select Yes in Spooling at Printer Driver in the Special Settings dialog
box.

Format Settings
The Format Settings dialog box opens, and you can set the format.

Format Settings dialog box

Set the format to be used when printing the contents set in the Page Options dialog box.
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Font
Select the font type.

Style
Select the font style.

Size
Select the font size.

Color
Select the font color.

I Special Settings dialog box

The Special Settings dialog box allows you to change the print processing method if you do not get the
print results you want.

Settings Summary
This is a list of items that you can set in the Special Settings dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.
Spooling at Printer Driver
Set whether print jobs are to be spooled in the print driver or whether PageComposer processing
is to be performed.
Setting No (Use RAW Spooling) or Yes may improve the print results or the printing speed.
Also, depending on the setting, you may not be able to use some of the driver functions.
FineZoom Settings
Use this function to print on long paper.
Yes
The print problem may be corrected.
Select this in usual cases.

No
Image distortions may be corrected (for example, small lines may be eliminated).

Preview Switching
If you check the Preview before printing check box on the Main tab and then print,
PageComposer starts.

Application Color Matching Priority
You can assign higher priority to color management by the application software.

Fast Graphic Process
If image colors or line thicknesses are printed incorrectly, you may be able to get the print results
you want by setting this function to off.
This is only displayed when using a 32-bit driver.

Disable the color profile setting of the application software
If the color profile information set in the application software is output to the printer driver, the
printing results may include an unexpected tint. You can resolve the problem in this case by
setting Disable the color profile setting of the application software to On.
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3» Important

» Even if this is set to On, it will only disable some of the color profile information, and it is still
possible to print using the color profile.
This should normally be set to Off when using.

Adjust Faint Lines
This function prevents thin lines from fading when printing by darkening light colored lines.

Specify Pattern Resolution
This function is for switching the rendering resolution for drawings using the hatch brush or
pattern brush.

Cleaner Lines/Text
Set to Off if the thickness and density of lines and text are not printed uniformly.
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I Favorites Tab Description

The Favorites tab allows you to register frequently used print settings as favorites.

= Canom Printing Pref erences e
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Favorites
A list of the registered favorite settings appears. The Default Settings are registered in the initial
settings.

Settings Details
The settings of the favorite that you selected from Favorites appear.

Comment
The comment registered to the favorite appears.

Apply Favorite
You can change the print settings to the settings of the favorite that you selected from the Favorites
list.

Delete
You can delete favorites that have become unnecessary.

Edit...
The Edit dialog box opens.
You can change the name and icon settings of the favorite that you selected from the Favorites list.

Add...
The Add dialog box opens.
You can register the current settings as a favorite.

Application Settings Priority
The setting in the application software will take priority over the favorites setting set on the printer driver.
The setting in the application software is only prioritized for Page Size, Orientation and Copies.
Place a checkmark to prioritize the settings for the application software.

Import...
You can read the settings of the favorite that was saved to a file (.cfg).
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Export...
You can save the settings of a favorite to a file (.cfg).

| Edit dialog box

You can change the name and icon of the favorite that you selected from the Favorites list.

Name
Changes name to be displayed in Favorites list.

Icon
Changes icon to be displayed in Favorites list.

Comment
Changes information to be displayed in Comment.

| Add dialog box

You can save the current print settings as the settings of a favorite.

Name
Set the name to be displayed in Favorites list.

Icon
Set the icon to be displayed in Favorites list.

Comment
Enter information to be displayed in Comment.
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| utility Tab Description

The Utility tab allows you to perform printer maintenance or check the settings of the printer.
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Print Nozzle Check Pattern

Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, use Print Head
Cleaning to clean the print head.
Paper Source

Displayed using the Media Type, Page Size and Roll Paper Width for each currently set paper

feed position.

»

Print Head Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

Paper Feed Amount Adjustment
This function adjusts the paper feed amount if the print result is faint or contains streaks.
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Custom Settings...
Acquire media information from the printer at startup
When the printer driver setup window is opened, the media type registered in the printer is
automatically applied to Media Type.

Apply the previous print settings according to the media type
If you change Media Type, the print purpose and quality of the previous print are applied.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Settings Summaries...
The Settings Summaries dialog box is displayed.
You can confirm the list of items set in the printer driver.
If you click the tab of each sheet, you can confirm the setting details of each item.

I Related Topics

= Cleaning the Print Heads
= Printing a Nozzle Check Pattern
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I Device Settings Tab Description

Many of the tabs in the Properties windows of the printer are controlled by Windows. However, the Device
Settings tab is for specifying printer configuration-related settings and is part of the printer driver.

The Device Settings tab allows you to specify settings related to the printer unit, as well as administrator
settings.

= Canom Properties X
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Update Media Information
Opens the Update Media Information dialog box.
Gets the latest media information from the printer and updates the media information in the printer
driver.

Preferences...
Configure administrator settings for the printer driver.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.
Settings for Data Sending
If you click Settings for Data Sending, the Settings for Data Sending dialog box will be
displayed.
If it includes data you do not agree to sending, uncheck this check box.

I Preferences dialog box

Use System Language
Set this to On to change the display language of the printer driver according to the OS language
settings.
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I Canon |J Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.
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I Canon |J Status Monitor Features

The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

I Canon |J Status Monitor Overview

Canon IJ Status Monitor allows you to check the status of the printer and ink with graphics and messages.

You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon |J Status Monitor shows an icon when a warning or error occurs to the printer.

! : A warning is being displayed.
@ : An operation error has occurred.
0 : You are being informed of remaining ink levels, etc.

0 : There has been an error which requires a service.
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Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print queue.

Cancel Printing
Cancels the current print job.

Estimated ink levels
Displays icons to report a remaining ink level warning and an ink depletion error.

Click \» (the disclosure triangle) to display a pictorial representation of the estimated ink level in the
ink tank.
Ink Model Number

You can look up the correct ink tank for your printer.

Estimated Maintenance Cartridge Usage
Displays icons to report that the available space in the maintenance cartridge is low or the cartridge is
full.

Click '» (the disclosure triangle) to display a pictorial representation of the estimated usage amount
in the maintenance cartridge.

Paper Feed
Displays the size and type of paper loaded in each feeder.

Click \.» (the disclosure triangle) to check the remaining amount of paper.
Purchase information is displayed in Purchase Paper....

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon 1J
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Guide Message
Displays guide messages for complicated paper setting operations.
Envelope Printing
Displays a guide message when envelope printing starts.
To hide this guide message, select the Do not show this message again check box.
To display the guide message again, open the Option menu, select Display Guide
Message, click Envelope Printing, and enable this setting.

Medicine Envelope Printing
Displays a guide message when medicine envelope printing starts.
To hide this guide message, select the Do not show this message again check box.
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To display the guide message again, open the Option menu, select Display Guide
Message, click Medicine Envelope Printing, and enable this setting.

Display Warning Automatically
When a Low Ink Warning Occurs
Starts the Canon IJ Status Monitor window automatically and displays it in front of the other
windows when a low ink warning occurs.

When a Maintenance Cartridge Warning Occurs
When a maintenance cartridge remaining space warning occurs, the Canon IJ status
monitor starts automatically and appears in front of all other windows.

Other Warnings
When any other warning occurs, the Canon IJ Status Monitor will open automatically and be
displayed in front of other windows.

Start when Windows is Started
Starts the Canon |J Status Monitor automatically when you start Windows.

Remote Ul menu
You are able to open the printer's Remote User Interface.
You are able to check the printer status and run maintenance functions on the printer when
connected to and using it through a network.

»» Note

* When the printer is being used via USB connection Remote Ul will not display.

Printer Information
Allows you check detailed information, such as the printer status, the print progress, and
remaining ink levels.

Maintenance
Allows you to run printer maintenance and change printer settings.

Job Log
Displays the Job history window.

Download Security Certificate
Displays the For secure communication window.
This window allows you to download the root certificate, register it to the browser, and disable
warning displays.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and you
can check the version and copyright information.
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I Updating the Printer Driver

» Obtaining the Latest Printer Driver
» Deleting the Unnecessary Printer Driver
» Before Installing the Printer Driver

» Installing the Printer Driver
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I Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Utility tab.

You can access our website and download the latest printer driver for your model.

32 Important

* You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

I Related Topics

= Before Installing the Printer Driver
= |nstalling the Printer Driver
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I Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

Select the Control Panel -> Programs -> Uninstall a program (Programs and Features).
From the program list, select "XXX Driver" (where "XXX" is your model name) and then click Uninstall.

The confirmation window for uninstalling the model appears.

2% Important

+ A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Start. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.
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I Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

I Checking the Printer Status

* Turn on the printer.

I Checking the Personal Computer Settings

» Terminate all running applications.
* Log on as a user who has the administrator account.

I Related Topics

= Obtaining the Latest Printer Driver
= |nstalling the Printer Driver
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I Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver for your model.

The procedure for installing the downloaded printer driver is as follows:
1. Turn on the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

2» Important

* A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver

Take the appropriate action as described on the screen.

4. Complete the installation
Click Exit.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

32 Important

* You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

I Related Topics

= QObtaining the Latest Printer Driver
= Deleting the Unnecessary Printer Driver
= Before Installing the Printer Driver
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I Handling Paper

» Handling rolls

Loading Rolls in the Printer

Moving the Roll Holder Support
Removing the Roll from the Printer
Cutting Roll Paper
Cutting Roll Paper after Printing
Remove Jammed Roll Paper

Remove a Jammed Sheet

» Loading Sheets or Postcards into the Printer

» Loading Envelopes or Medicine Envelopes into the Printer

» Paper Settings

Changing the Type of Paper

Specifying the Cutting Method for Rolls

Cutting the Leading Edge of Roll Paper Automatically
Reducing Dust from Cutting Rolls

Specifying the Ink Drying Time

Setting the Upper and Lower Margins on Roll Paper

Setting the Minimal Margin Amount When Performing the Minimal Margin Printing

» Information about Paper

Paper Sizes

Usable Paper

Paper Information List

Updating paper information

Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
Settings
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Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a
Media Type

@« Managing Paper Information on Printer Using Media Configuration Tool
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I Handling rolis

» Loading Rolls in the Printer

@« Moving the Roll Holder Support
» Removing the Roll from the Printer
» Cutting Roll Paper
» Cutting Roll Paper after Printing
» Remove Jammed Roll Paper

* Remove a Jammed Sheet
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I Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

/% Caution

 Set the roll on its side on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and
dropping a roll may cause injury.

32 Important

* This printer can use the roll paper with an outer diameter of 4.4 in. (110 mm) or less. For details on roll
paper sizes and types that can be used, see "Paper Sizes" or "Paper Information List".

» Before loading a roll, make sure that the inside of the printer and the output guide are clean. If these
areas are dirty, we recommend cleaning them in advance.

= Cleaning Inside the Printer

* When handling the roll, be careful not to soil the printing surface. This may affect the printing quality.
We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

» Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding
problems and affect the printing quality.

........

+ Align the edges of the paper on both ends of the roll. This may cause feeding problems.

* When loading paper or printing, the leading edge of the roll paper may be trimmed. The cut paper may
remain on the output guide, which may cause a paper jam. Therefore, remove any remaining paper.
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1. Select paper settings display area on the Home Screen.

D Plain Paper

D There is no paper,
Replace Set cut
-
g paper E‘ length

2 o O 0

2. Select the roll paper area.

Paper information

© Plain Paper
49ft. A3 Roll

1) There is no paper.

3. Select Load roll paper or Replace paper.

2» Important
« If paper that will not be used is fed, a message confirming paper replacement is displayed. Follow
the instructions on the screen, and then go to the next step.

= Removing the Roll from the Printer

* When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not
open the cover before these instructions are displayed.

4. Open the cut sheet feed cover.

3% Important
* You cannot load the roll paper when the top feed is open. Remove any paper loaded in the top

feed and close the top feed.
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5. Unlock with the lever and open the roll paper feed cover.

6. Check the contents of the message and select OK.

7. If necessary, move the roll holder support to match the width of the roll paper to be loaded.

= Moving the Roll Holder Support

8. Load rolls on the roll holder.

1. Make sure that the lock levers on the left and right roll holders are toward m and unlocked.

2. Align the roll paper winding direction as shown in the figure, insert the roll holder marked with [R]
from the right, and press it firmly until the side of the roll paper (A) sits flush against the roll holder
without any gap.

Insert the roll holder marked with [R] so that it is on the right side.
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/I Caution

* Do not touch the metal part inside the roll holder when setting the roll holder. The sharp
edges of the metal may cause injury.

3% Important

* When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage
the roll holder.

3. Turn the lock lever (B) of the inserted roll holder toward ﬁ to lock it.
B

4. Insert the roll holder marked with [L] from the left and press it firmly until the side of the paper roll
(C) sits flush against the roll holder with no gap.
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9. Before setting the roll holder, make sure that the roll holder support is firmly fixed in the
position that matches the width of the roll paper.
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2% Important

» Make sure that the knurled screw on the roll holder support is tightened until it does not turn.

10. Hold the left and right roll holders (E) and place the roll paper on the slide guide (H) so that
the roll holder shafts (F) are in front of the roll holder slots (G).
Place the paper roll so that the roll holder marked with [R] is on the right side and the roll holder marked
with [L] is on the left side.
G

2% Important

* Do not allow roll paper or other materials to come in strong contact with the feed cover rollers
located inside the roll paper feed cover. Doing so may result in problems with paper feeding.

214



11. Set the shafts (F) of the left and right roll holders in the roll holder slots (G) by sliding them
on the slide guides (H).

A\ Caution

» Do not force the roll holder into the printer with the right and left ends reversed. This may damage
the printer and roll holder.

* Do not release the roll holder until the holder is loaded in the roll holder slot.

 Be careful not to pinch your fingers between the roll holder shafts (F) and the roll holder slots (G)
when loading rolls.

2% Important

« |If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

Load the roll paper so that it is not loaded in the opposite direction.
« If the roll paper has become unwound, remove the slack before loading the roll paper.

« If the paper is wrinkled or warped, straighten it out before loading it.

Load the roll so that there is no gap between the sides of the roll and the roll holder.
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|«

12. Insert the leading edge of the roll into the feed slot (I) and feed it until you hear a sound or
the screen display changes.

2 Important

« |If the leading edge of the paper is stuck to the roll and difficult to insert into the feed slot, pull out
the roll slightly before inserting the edge into the feed slot.

» Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

13. Close the roll paper feed cover completely.

i ' ™

14. Select the type of paper to use.
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After selecting the paper type, paper feeding starts.

Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{|nstant-dry)

Coated Paper

2» Important

* Do not open the roll paper feed cover after the paper feeding has started. It may cause paper
feeding to fail.

« Cut the edge of the roll using the Set cut length function if the edge is creased or soiled.

= Cutting Roll Paper

» Depending on the type of paper, the paper width may not be detected automatically. Follow the
instructions on the screen to manually select the paper size.

3> Note
 For details on media types that you can select, see "Paper Information List."

* When selecting Enable in Keep roll paper type, there is no need to specify the type of the paper.
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I Moving the Roll Holder Support

To load roll paper of different widths, move the roll holder support as described below.

1. Loosen the knurled screw (A) securing the roll holder support by turning it
counterclockwise.

2 Important

* There is a hole for the knurling screw at the positions of each support roll paper size. Move the
holder to the required position and make sure that the screw is aligned with the hole.

3. Turn the knurled screw (A) clockwise to secure the roll holder support to the printer.
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3% Important

+ Tighten knurled screw finger-tight until it stops turning. Do not use a screwdriver or similar tool to
tighten the screw too tightly.

2% Note
« After moving the roll holder support, continue loading the roll paper.

= [ oading Rolls in the Printer
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I Removing the Roll from the Printer

Remove rolls from the printer as follows.

1. Select paper settings display area on the Home Screen.

D Plain Paper

D There is no paper,

E._:_. Replace Set cut
paper +1" length

T o &0

2. Select the roll paper area.

Paper information

© Plain Paper ]

4911. A3 Roll
1) There is no paper.

3. Select Remove paper.

4. Select Yes.
The roll is rewound.

3% Important

* When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not
open the cover before these instructions are displayed.

5. Open the cut sheet feed cover.
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2% Important

* You cannot remove the roll paper when the top feed is open. Remove any paper loaded in the top
feed and close the top feed.

6. Unlock with the lever and open the roll paper feed cover.

8. Hold the left and right roll holders (A) and remove the roll paper from the printer.
A

9. Remove the roll from the roll holder.

1. Turn the lock lever (B) on the left roll holder toward d-\ to unlock.
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2. Remove the unlocked roll holder from the roll paper.

/1 Caution

» Do not touch the metal part inside the roll holder when removing the roll holder. The sharp
edges of the metal may cause injury.
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3. Turn the lock lever (C) on the right roll holder toward m to unlock.

4. Remove the unlocked roll holder from the roll paper.

-

32 Important

« Store the roll in the original bag or box, away from high temperature, humidity, and direct
sunlight. If paper is not stored properly, the printing surface may become scratched, which
may affect the printing quality when you use it again.

10. Close the roll paper feed cover completely.
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12> Note

* To load new roll paper in the printer at this point, see "Loading Rolls in the Printer."
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I Cutting Roll Paper

After feeding of the roll paper, you can feed the roll paper by a specified length and cut it. (Set cut length)

1. Select paper settings display area on the Home Screen.

D Plain Paper

D There is no paper,
Replace Set cut
—
E-. paper Eﬁ length

2 o o e

2. Select the roll paper area.

Paper information

© Plain Paper
49ft. A3 Roll

1) There is no paper.

3. Select Set cut length.

4. Select the input field and enter the length by which you want to feed the roll paper.

Set cut length

[ 11.9 ] inch

{4.0-39.4)

Cut paper

5. Select Cut paper.

6. Select Yes.

The roll paper is cut after the specified length is fed.
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I Cutting Roll Paper after Printing

How rolls are cut after ejection varies depending on printer settings.

= Specifying the Cutting Method for Rolls

Eject cut (when the paper surface is being scratched / to wait for ink to
dry)
3% Important

» When cutting wide printed documents after ejection, have two people support the documents. If the
paper drops, printed documents may be damaged.

» Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect
the printing quality or cause rough cut edges.

« After printing is completed, Eject cut is possible after the set ink drying time has passed. If 5 minutes
have passed without Eject cut, the printed document will be cut automatically to protect the printer
mechanism.

1. Print the job.

When printing is finished, the printer will stop without cutting.

2. While holding the printed document from the bottom edge to prevent it from dropping,
select Cut paper to cut the roll paper.

Printing is complete.
Tap [Cut paper] to cut the
paper.

About 4 min,

Cut paper
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I Loading Sheets or Postcards into the Printer

Load sheets or postcards in the top feed.

When printing on postcards, check the contents of "Precautions when printing on postcards" before loading
postcards.

Also, load envelopes and medicine envelopes in the top feed.

= | oading Envelopes or Medicine Envelopes into the Printer

3% Important

* Do not load any sheet smaller than L(89x127mm) size. Doing so may cause a paper jam.

»» Note

» For the page size and paper weight you can use for this printer, see Paper Sizes or Usable Paper.

1. Prepare sheets.

Align the edges of paper. If paper is curled, flatten it.

2% Important

« If paper is curled, hold the curled corners and gently bend them in the opposite direction until the
paper becomes completely flat.

For details on how to flatten curled paper, see "Correct curl before loading paper." in Paper rubs
against the Print Head.

« Align the edges of paper neatly before loading. Loading paper without aligning the edges may
cause paper jams.

» For the paper smaller than A4 size, load one sheet at a time regardless of the paper type.

2. Open the cut sheet feed cover.
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3. Open the top feed and then pull it upwards.

12> Note

* When loading the long paper, depending on the weight of the paper, the leading edge may lift up,
causing printing to become misaligned. To prevent the leading edge of the paper from lifting up,
hold the portion of the paper protruding from the tray with your hands, and so on.

4. Slide the left and right paper guides (A) to open both paper guides.
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5. Load the sheets in portrait orientation with the print side facing up.

After loading the paper, the paper setting confirmation screen for the top feed appears on the touch

screen.
H @

32 Important

» Always load paper (except return postcard) in the portrait orientation. Loading paper in the
landscape orientation can cause paper jams.
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6. Slide the left and right paper guides to align with both sides of the sheets.

2% Important
» Do not slide the paper guides too hard against the paper. The paper may not be fed properly.

* Do not load sheets of paper higher than the load limit mark (B).

7. If the page size and type displayed on the touch screen match size and type of the sheets
loaded in the top feed, select Yes.

If not, select Change to change the settings in accordance with the size and type of the loaded paper.
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Current top feed setting.
Please confirm.

¥ A
Plain Paper

Change Yes

2% Important

» There are many types of paper available, each best suited to a particular printing use. Each media
type has specific preset settings (how ink is used and sprayed, distance from nozzles, etc.), that
allow you to print to that type with optimal image quality. The wrong paper settings may cause
poor printout color quality or scratches on the printed surface.

 For details on media types that you can select, see "Paper Information List".

* When printing on small size paper, the printed documents may remain on the output guide.
Remove the remaining printed documents before performing the next printing.

I Precautions when printing on postcards

22 Important

* When printing both sides of a postcard, one side at a time, we recommend printing the message side
first and then print the address side to ensure the clean printing.

 This printer cannot print on postcards affixed with photos or stickers.

» Do not fold the return postcard. If a crease is formed, the printer will not be able to feed the postcard
properly, causing misaligned printing or paper jams.

»>» Note

* When printing on postcards or return postcards, load them so that the postal code is placed in the
lower portion with the print side facing up.
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= Printing on Postcards (Windows)

= Printing on Postcards (macOS)

* When holding the postcard, hold it by the edges as much as possible, and avoid touching the printed
surface until the ink dries.
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I Loading Envelopes or Medicine Envelopes into the Printer

Load envelopes or medicine envelopes into the printer.

The address is automatically rotated and printed according to the envelope's direction by specifying with the
printer driver properly.

22 Important

» Before loading paper, check that the paper is compatible with the printer.

= Usable Paper
= Paper Information List

1. Prepare envelopes or medicine envelopes.

Align the edges of paper. If paper is curled, flatten it.

* Loosen the stiff portions of the corners. If paper is curled, hold the opposite corners and gently
twist them in the opposite direction.

* Press down on all four corners and edges of paper to flatten them.

« If the corner of the envelope flap is folded, flatten it.

* Use a pen to press the leading edge in the inserting direction flat and sharpen the crease.

< <S—
T s

zf‘“‘""‘; :;__._-. N {_._-..____“
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The figures above show a side view of the leading edge of the envelope.
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2% Important

* The envelopes may jam in the printer if they are not flat or the edges are not aligned. Make sure
that no curl or puff exceeds 0.12 in. (3 mm).

» For envelopes or medicine envelopes smaller than A4 size, load them one by one.

« If paper is not fed correctly into the printer despite these instructions, reduce the number of
sheets.

2. Open the cut sheet feed cover.

4. Slide the left and right paper guides (A) to open both paper guides.
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5. Load the paper in portrait orientation with the print side facing up.

After loading the paper, the paper setting confirmation screen for the top feed appears on the touch
screen.

* Envelopes with short side open

Load the envelope without folding its flap in portrait orientation with the address side facing up.

¥

* Envelopes

Fold flap of the envelope and load the envelope in portrait orientation with the address side facing
up.

* Medicine envelopes

Load medicine envelopes in portrait orientation with the side that opens facing up.
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3

6. Slide the left and right paper guides to align with both sides of the paper.

2% Important

» Do not slide the paper guides too hard against the paper. The paper may not be fed properly.

7. If the page size and type displayed on the touch screen match size and type of the paper
loaded in the top feed, select Yes.

If not, select Change to change the settings in accordance with the size and type of the loaded paper.

Current top feed setting.
Please confirm.

#1 Envelope Com 10
Plain Paper
Change Yes
3% Important

» There are many types of paper available, each best suited to a particular printing use. Each media
type has specific preset settings (how ink is used and sprayed, distance from nozzles, etc.), that
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allow you to print to that type with optimal image quality. The wrong paper settings may cause
poor printout color quality or scratches on the printed surface.

» For details on media types that you can select, see "Paper Information List".

* When printing on small size paper, the printed documents may remain on the output guide.
Remove the remaining printed documents before performing the next printing.
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I Paper Settings

» Changing the Type of Paper

» Specifying the Cutting Method for Rolls

» Cutting the Leading Edge of Roll Paper Automatically
» Reducing Dust from Cutting Rolls

» Specifying the Ink Drying Time

» Setting the Upper and Lower Margins on Roll Paper

» Setting the Minimal Margin Amount When Performing the Minimal Margin
Printing
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I Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

»>» Note

* If you want to continue using the same type of roll paper, set Keep roll paper type to Enable. The

previously selected paper type is automatically selected, saving you the trouble of selecting the paper
type when loading the roll paper.

= Keep roll paper type

22 Important

» For best printing results, the printer fine-tunes the print head height and the feed amount for each type
of paper. Be sure to select the type of paper to use correctly before printing.

» Because the printer fine-tunes the paper feed rate and print head height, the margins and the size of

printed images may vary depending on the type of paper used. If margins and the size of images are
not as you expected, adjust the image quality.

= Adjustments for Better Print Quality

I Changing the Type of Paper

1. Select paper settings display area on the Home Screen.

[r Plain Paper

D There is no paper,
Replace Set cut
-
E" paper Eﬁ length

’%“@'ﬁﬂ

2. Select the roll paper area or sheet area.

Paper information

© Plain Paper
49ft. A3 Roll

D There is no paper.

3. Select Paper settings.
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4. Select Type.

5. Select media type of roll paper loaded in printer.

Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{Instant-dry)

Coated Paper

32 Important

» Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.

> Note

 For details on media types, see "Paper Information List."
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I Specifying the Cutting Method for Rolls

22 important

Eject cut, printing does not resume after a series of jobs have been printed continuously until the roll is
cut.

Eject cut is the preset selection in Cutting mode for some types of paper. For this paper, we
recommend keeping the preset cutting mode.

If documents printed using Automatic cut or Eject cut are short, rolls are advanced a specific amount
before cutting to prevent problems with cutting and paper ejection. This may create a wider bottom
margin, in some cases.

. Select o (Setup) on the HOME screen.

of

. Select Printer settings.
. Select Paper-related settings.
. Select Advanced paper settings.

. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{Instant-dry)

Coated Paper

. Select Cutting mode.

. Select a setting from the menu.

Automatic cut
Select this to cut the roll paper automatically with the cutter blade.

Eject cut
Select this to move the cutter by operation panel operation and cut paper. With Automatic cut, the
paper drops and may rub against the basket, resulting in damage to the print surface, but you can
cut using this method and supporting the paper so that it does not drop to avoid damage to the
paper. Also, you can prevent paper that has not dried from dropping by visually checking the ink has
dried, and then cutting the paper.

241



After printing, select Cut paper and cut the roll paper on the cutter blade.

= Cutting Roll Paper after Printing
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I Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print
correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by
using Trim edge first in the operation panel menu.

* Auto

If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the
leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling the
printer.

* On(Preset Length)

The amount to cut from the leading edge of the paper varies depending on the media type and is cut to
a prescribed length. For the leading edge precut length, see "Paper Information List".

* On(Input Length)

The amount to cut from the leading edge of paper is specified in the operation panel. The amount to
cut from the leading edge can be specified in the range of lengths displayed in the operation panel. The
range of lengths differs according to the media type.

»» Note

» The amount to cut from the leading edge of paper cannot be set shorter than the length displayed in
the operation panel.

+ Off

The edge is not cut and scraps are not removed.

1. Select : (Setup) on the HOME screen.

of

2. Select Printer settings.
3. Select Paper-related settings.
4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.
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Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{|nstant-dry)

Coated Paper

6. Select Trim edge first.

7. Select a setting from the menu.

This setting takes effect the next time you load a roll.
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I Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting
Cut-dust reduction to ON from the operation panel menu, which will coat the leading and trailing edges

of the printed document with ink. As a result, you can reduce problems with the print head. You can set
Cut-dust reduction according to the media type.

>t

471 <

A: The ink is coated.
B: Cut Position
3% Important

* Do not set Cut-dust reduction to ON for paper that wrinkles easily, such as Plain Paper or lightweight
paper. If not cut properly, the paper may jam.

* When performing minimal margin printing, the function to reduce the cutting dust cannot be used. Even
if Cut-dust reduction is set to ON, the leading and trailing edges of the printed document will be
printed without ink being coated.

Follow these steps to set Cut-dust reduction to ON.

1. Select : (Setup) on the HOME screen.

%
2. Select Printer settings.

3. Select Paper-related settings.
4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.
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Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{|nstant-dry)

Coated Paper

6. Select Cut-dust reduction.

7. Select ON.
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I Specifying the Ink Drying Time

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface
during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait
for the ink to dry after printing.

22 Important

* Printer settings are applied when the ink drying time is not set in the printer driver. If the ink drying time
is set in the printer driver, that setting has priority.

»>» Note

« If the cutter touches the print surface on which the ink is not dry, the paper surface may become
scratched or soiled, or the paper surface may rub when the paper falls and the surface may become
soiled.

To wait for the ink to dry without dropping the printed documents into the basket immediately after
printing, set Cutting mode to Eject cut.

= Specifying the Cutting Method for Rolls

* When printing on envelopes, even if you set Pause between pages to OFF, a drying wait time will be
generated after printing.

I Set on the Printer

1. Select : (Setup) on the HOME screen.

&7

2. Select Printer settings.
3. Select Paper-related settings.
4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{Instant-dry)

Coated Paper
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6. Select Pause between scans or Pause between pages.
Advanced paper settings
Roll paper tension {printing)

Roll paper tension {feeding)

Pause between scans

Pause between pages

Pause between scans
Specify the waiting time between printing one scan and printing the next one. You can set the
drying waiting time and the target area where the waiting time occurs.

Pause between pages
Specify the waiting time between printing one page and ejecting the paper. If there is a next page,
it will be printed after the ink drying time has passed.

I Set on your Computer

Refer to the followings for how to set from your computer.

= Main Tab Description (Windows)

= Advanced Paper Settings (macOS)
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I Setting the Upper and Lower Margins on Roll Paper

Perform the setting of the upper and lower margins when printing on roll paper. Setting a large margin may
improve the image quality of the printed document.

32 Important

* In the printer driver, you can set the margins from Roll Paper Safety Margin in the Paper Detailed
Settings dialog box on the Main sheet. If you set from the printer driver, the setting from the printer
driver takes priority.

= Main Tab Description (Windows)

I Set the Margin Area of the Roll Paper

When printing on roll paper, set the size of margins to add to the top and bottom of the print data.

* Prioritize image size

This setting adds margins to the outside of the print data. Larger margins make the printout longer in
the vertical direction and use more paper.

5mm 30 mm

* Prioritize paper size

This setting adds margins to the inside of the print data. Larger margins may cause part of the print
data not to be printed.

5 mm
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3% Important

* When using Prioritize paper size, Roll paper lead edge/end margin may result in part of the image
being lost. Prepare your print data to match the printable area.

. Select : (Setup) on the HOME screen.

-_—

&Y

N

. Select Printer settings.

w

. Select Paper-related settings.

N

. Select Advanced paper settings.

a

. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{Instant-dry}

Coated Paper

6. Select Roll paper top/bottom margins.

7. Select Prioritize image size or Prioritize paper size.

I Set the Margins for the Leading Edge and Far End of the Roll Paper

When printing on roll paper, set the length of the vertical margin in the printing direction. When Auto is
selected, the margin amount is set according to the paper type and other factors.

32 Important

* Reducing the amount of space may result in the paper becoming dirty.

1. Select : (Setup) on the HOME screen.

&Y

2. Select Printer settings.

3. Select Paper-related settings.
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4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{Instant-dry)

Coated Paper

6. Select Roll paper lead edge/end margin.

7. Select the margin length you want to set or Auto.
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Setting the Minimal Margin Amount When Performing the
Minimal Margin Printing

When performing the minimal margin printing, the margin width may not be uniform on the left and right
sides of the paper. Widening the margins at the narrow ends may improve the problem.

22 Important

* The amount of minimal margin when performing the minimal margin printing can be set separately for
the left and right edges for each paper type.

» The set amount of minimal margin is enabled only when performing the minimal margin printing. If
the left and right margins are not uniform when printing with borders, perform Adjust horizontal print
position from Print settings.

= Print settings

To print with the set amount of minimal margin, the print head position is required to be adjusted
beforehand. Before performing the minimal margin printing, perform Print Head Alignment - Auto or
Print Head Alignment - Manual. If you perform the minimal margin printing without performing the print
head alignment, a message will be displayed and the print will be made with a certain amount of larger
margins.

= Automatic Adjustment to Straighten Lines and Align Colors

» To print with the set minimal margin amount, the print head height needs to be set low.
— Paper thickness (head height): Auto or Standard
— Prevent paper abrasion: OFF

Before performing minimal margin printing, change the settings as required. If you perform minimal
margin printing with the setting that increases the print head height, a message will be displayed and
the print will be made with a certain amount of larger margins.

= Advanced (Paper settings)
= Print settings

» The minimal margin printing cannot be performed when Detect paper width is set to Disable. Before
performing the minimal margin printing, set Detect paper width to Enable for the paper type to be
printed.

= Advanced (Paper settings)
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»» Note

» This product supports the minimal margin printing. Depending on the application you use to print, this
may be displayed as borderless printing.

| set the Amount of the Minimal Margin

1. Select : (Setup) on the HOME screen.

%
2. Select Printer settings.

3. Select Paper-related settings.
4. Select Advanced paper settings.

5. Select the paper type for which you want to change the setting.

Select the media type.

Plain Paper

PremPlainPpr 80
PlainP{Instant-dry)

Coated Paper

32 Important

* If you select a paper type that does not support the minimal margin printing, you cannot set the
amount of the minimal margin. For the paper types that support the minimal margin printing, see
"Minimal Margin Printing" item for each paper type in the Paper Settings List (Roll Paper).

6. Select Roll paper minimal margin amount.

7. Set the left and right adjustment values and select OK.

Left/right minimal margin settings

>+ Left

J r | 0.0 mm

| Right

D | 0.0 mm

OK
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»» Note

» The larger the set adjustment value, the wider the left and right margins. The adjustment value
can be set in the range of 0 mm to 0.7 mm in 0.1 mm increments.

* After setting, we recommend to perform the minimal margin printing to check the margin status.

= Printing with Minimal Margins on the Scenarios (Windows)
= Printing with Minimal Margins on the Scenarios (macOS)
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I Information about Paper

» Paper Sizes
» Usable Paper

» Paper Information List

¥

Updating paper information
» Using Paper Other Than Genuine Paper and feed confirmed Paper

@ Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

& Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding
a Media Type

» Managing Paper Information on Printer Using Media Configuration Tool
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I Paper Sizes

| Rolis

Rolls that meet the following conditions are supported.
 Outer diameter: within 4.4 in. (110 mm)
* Inner diameter of paper core: 2 inches

* Printing side out

Roll Paper Width (*1, *2) 24 in Roll : 24.00 in. (609.6 mm)
A1 Roll : 23.39 in. (594.0 mm)
B2 Roll : 20.28 in. (515.0 mm)
18 in Roll : 18.00 in. (457.2 mm)
17 in Roll : 17.00 in. (431.8 mm)
A2 Roll : 16.54 in. (420.0 mm)
B3 Roll : 14.33 in. (364.0 mm)
A3 Roll : 11.69 in. (297.0 mm)

Minimum Paper Length 8.00 in. (203.2 mm)
Maximum Printable Length 13 feet (4 m)
Thickness 3 mil (0.08 mm) to 11 mil (0.28 mm)

*1: For the paper types that support the minimal margin printing, see "Minimal Margin Printing" item for
each paper type in the Paper Settings List (Roll Paper).

*2: The minimal margin printing of this unit makes prints by setting the width of the original slightly smaller
than the paper, which results in minimal margins on the left and right.

= Print Area

I Sheets, Postcards, Envelopes, Medicine Envelopes

Paper of the following sizes are supported.

Paper Width (*3) 3.50in. (89.0 mm) to 11.69 in. (297.0 mm)
Minimum Paper Length (*3) 5.00 in. (127.0 mm)
Maximum Printable Length (*3) 47.24 in. (1200.0 mm)

If you set the length to a value more than 17.01 in. (432.0 mm), select
either Plain Paper, Coated Paper, or Photo Paper from Media Type.

Thickness 3 mil (0.08 mm) to 11 mil (0.28 mm)

*3: For the standard sizes that are compatible with this product, see Usable Paper.
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2> Note
* For details on non-standard sizes, see "Setting Paper Dimensions (Custom Size)" (Windows) or
"Setting Paper Dimensions (Custom Size)" (macOS).

» The minimal margin printing cannot be performed for the sheets, postcards, envelopes and medicine

envelopes.
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I Usable Paper

For information on the types of paper that can be used and detailed information on each paper type, see
"Paper Information List".

= Standard Sizes that can be used in Top Feed
= Paper Load Limits of Top Feed
= Unsupported Media Types

I Standard Sizes that can be used in Top Feed

You can use the following page sizes.

»>» Note

» Page sizes and media types the printer supports differ depending on the OS you are using.

Standard sizes:
* Letter
* Legal
* 11"x17"(28x43cm)
» Executive
* A6
* A5
« A4
* A3
+ ISO B4
+ B6
* B5
- B4
* 9"x12"(ARCH A)
» DIN C4
+ B-Oficio
+ M-Oficio
* Foolscap
* Legal(India)
* KG/4"x6"(10x15)
* 5"7"(13x18cm)
* 7"x10"(18x25cm)
+ 8"x10"(20x25cm)

258



+ 10"x12"(25x30cm)
* 10"x15"

* L(89x127mm)

* 2L(127x178mm)
» Hagaki

» Hagaki 2

* Envelope Com 10
* Envelope DL

* Nagagata 3

* Nagagata 4

* Yougata 4

* Yougata 6

* Envelope C5

* Envelope Monarch

I Paper Load Limits of Top Feed

This section shows the paper load limits of the top feed.

32 Important

» Postcards, envelopes, and paper smaller than A4 size should be loaded one at a time in the top feed

regardless of paper type.

»>» Note

» Page sizes and media types differ depending on the country or region where the paper is sold. For
details on page sizes and media types, access the Canon website.

Media Name

Top Feed

Plain Paper (including recycled paper) *1

A4, Letter: Approx. 100 sheets

Legal, 11"x17"(28x43cm), A3, ISO B4, B4,
10"x12"(25x30cm), 10"x15": Approx. 50 sheets

9"x12"(ARCH A), DIN C4, B-Oficio, M-Oficio, Foolscap,
Legal(India): 10 sheets

Executive, A6, A5, B6, B5, 7x10: 1 sheet

Coated Paper
Label Paper
Glossy Label

10 sheets

Photo Paper
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Letter, Legal, 11"x17"(28x43cm), A4, A3, ISO B4, B4,
10"x12"(25x30cm), 10"x15": 10 sheets




KG/4"x6"(10x15), 5"x7"(13x18cm), 8"x10"(20x25¢cm),
L(89x127mm), 2L(127x178mm): 1 sheet

Hagaki 1 sheet
Ink Jet Hagaki
Hagaki K
Hagaki.M
Hagaki.K
Hagaki.R
Envelopes

Window envelope

Medicine Envelopes A4: 10 sheets

A5, A6, B5, B6: 1 sheet

*1 Normal feeding at maximum capacity may not be possible with some types of paper, or under very high
or low temperature or humidity. In this case, load half the amount of paper or less.

I Unsupported Media Types

Do not use the following types of paper. Using such paper will cause not only unsatisfactory results, but
also the printer to jam or malfunction.

* Folded, curled, or wrinkled paper

* Damp paper

» Paper with unstraightened edges like manualy cut paper.

* Picture postcards

» Return postcard that has been folded once

 Postcards affixed with photos or stickers

» Envelopes with a double flap

» Envelopes with short side open having gummed flaps

» Envelopes with an embossed or treated surface

» Envelopes whose gummed flaps are already moistened and adhesive

* Any type of paper with holes

» Paper that is not rectangular

» Paper bound with staples or glue

» Paper with an adhesive surface on the back such as label seal

» Paper decorated with glitter, etc.
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I Updating paper information

You can update the printer's media information to the latest information by applying the latest version of the
Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.

= Media Configuration Tool Guide

22 Important

* If you are using the Media Configuration Tool, the new Media Information File is downloaded
automatically when released on the Canon website. A computer connected to the Internet is required to
download the Media Information File.

» Even if you are not using the printer driver, you should install the Media Configuration Tool in order to
register the media types for your region in the printer.
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Using Paper Other Than Genuine Paper and feed confirmed
Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use
paper that meets the following conditions.

» Paper where the size is described in "Paper Sizes"

» Paper where bleeding and ink overflow does not occur when printing

» Paper that does not warp severely when loading the paper or printing

32 Important

* For Canon genuine paper/feed confirmed paper, see "Paper Information List."

« If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides absolutely
no guarantees regarding print quality or paper feed properties.

After loading the paper in the printer, select the media type in the operation panel and printer driver and then
perform the printing. For the media type, you can select easily from existing settings or you can create and
use settings for the paper you are using.

First, check whether the existing settings provide the desired image quality. If you cannot obtain the desired
image quality with the existing settings, create new paper settings.

I Printing Using Existing Settings

You can print easily by selecting from existing settings provided in the operation panel and printer driver.

= Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings

I Create Settings and Print

You can use the function to add custom paper in the Media Configuration Tool to create settings suitable
for paper other than genuine paper/output confirmation paper you are using. You can add the created
settings to the printer operation panel and printer driver as a new paper type for printing.

= Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making
complicated settings by selecting the existing settings provided in the operation panel and printer driver
depending on the media type you are using.

The existing settings consist of the general-purpose paper settings provided for different media types and
the special paper settings that allow you to select various levels of ink usage.

First, select a paper with a similar type and basis weight from the general-purpose paper settings, and try
printing.

32 Important

» The Canon genuine paper settings provided in the operation panel and printer driver are optimized for
Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine
paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other
than Canon genuine paper and feed confirmed paper, we recommend that you select one of the
following general-purpose paper settings.

»» Note

* For the available paper types, see "Paper Information List."

» For instructions on selecting the media type with the operation panel, see "Changing the Type of
Paper". For instructions on selecting the media type with the printer driver, see "Main Tab Description"
(Windows) or "Quality & Media" (macOS).

I Choosing General-Purpose Paper Settings

These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed
paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For
details on the relationships between the conditions of paper other than Canon genuine paper and feed
confirmed paper and the media type to select, see "General-Purpose Paper Settings List (Roll Paper)" or
"General-Purpose Paper Settings List (Cut Sheet)."

I Selecting Special Paper Settings

These settings allow you to select the type of black ink and the amount of ink used. By selecting
the special settings for the amount of ink used that are appropriate for the paper, the lack of color
development and ink bleeding may be improved.

For details, see "Special Paper Settings List."

»>» Note

+ If you cannot obtain the desired results by selecting the general-purpose paper settings and the special
paper settings, use the add custom paper function in Media Configuration Tool to create settings
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suitable for the paper you are using. For details, see "Printing on Paper Other Than Genuine Paper and
feed confirmed Paper by Adding a Media Type."
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved
paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than
when printing with general-purpose settings. You can use this function to configure settings such as the
amount of ink used and the height of the print head according to the characteristics of the paper being used,
and thereby realize higher print quality. Also, you can add the settings created with this function as a new
media type to the operation panel and printer driver.

For details on Media Configuration Tool, refer as follows.

= Media Configuration Tool Guide

22 Important
* For details on how to select the added media type in the operation panel, see "Changing the Type of
Paper."

* You can select the media type to be used in printing in the Main sheet (Windows) or Quality & Media
(macOS) in the printer driver. For details, see "Main Tab Description" (Windows) or "Quality & Media"
(macOS).

* We recommend that you use an ICC profile created using commercially available profile creation
software to perform color management accurately on paper other than Canon genuine paper and feed
confirmed paper. You can register the ICC profile you created when creating a custom paper with
Media Configuration Tool. See "Adding Custom Paper" in Media Configuration Tool Guide.
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I Settings

» Changing Settings from Operation Panel
« Home Screen Menu Composition

Menu Structure

Setting Items on Operation Panel

Setting Administrator Password on Operation Panel

Checking the Total Number of Uses of Printer
» Changing Printer's Setting Using Web Browser
« Start up Remote Ul
« Changeable Setting Items Using Remote Ul
@ Setting Passwords Using Remote Ul
« Registering Printer's Root Certificate to Web Browser for SSL Communication
« Registering Printer's Root Certificate to Local Computer for SSL Communication
@« Generating Server Certificate
@ Setting Mail Server
@ Receiving Printer Status by E-mail
» Network Setting
@ Printer Connection Methods
@ Another Printer Found with Same Name
@ Printing Network Settings
@« Countermeasures against Unauthorized Access
@« Network Status and Troubleshooting
@« Checking Printer Connection Status Using Wi-Fi Connection Assistant
@ Sharing the Printer on a Network (Windows)
@« Sharing the Printer on a Network (macOS)

» Set Up/Manage Security

266



I Changing Settings from Operation Panel

» Home Screen Menu Composition

» Menu Structure

» Setting Items on Operation Panel

» Setting Administrator Password on Operation Panel

» Checking the Total Number of Uses of Printer
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I Home Screen Menu Composition

After the printer starts up, the HOME screen appears on the touch screen.

From the HOME screen, you can check the printer status and select the maintenance, paper operations,
settings, and other menus.

= Basic Touch Screen Operations

Er Plain Paper

D Plain Paper
E_ Replace '[_:';g Set cut LB
g paper +1" length
> [e]e]e
I

| |
D E F

O—{*)

A: Paper Setting Display Area
Displays information on loaded paper. Selecting this option displays the menu for making paper
settings.

B: Basic Menu
The frequently used Load paper / Replace paper and Set cut length are displayed here.

C: Network
Displays the current network status. Select to display the basic network information or to change the
network settings.

The icon differs depending on the network of use or the network status.
—
= Wi-Fi is enabled and the printer is connected to the wireless router.
»>» Note
» Depending on the signal state, the icon will change.
—
= (Signal strength: 81 % or more): You can use the printer over a Wi-Fi without any problems.
Fo
= (Signal strength: 51 % or more): The problem such as the printer cannot print may occur
according to the network status. We recommends placing the printer near the wireless router.

o)

(Signal strength: 50 % or less): The problem such as the printer cannot print may occur.
Place the printer near the wireless router.
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—_—
° X Wi-Fi is enabled but the printer is not connected to the wireless router.

Wired LAN is enabled.

Wireless Direct is enabled.
=]
o | .
Wi-Fi and Wired LAN are disabled.

D: Wireless connect
Select to connect the printer to a smartphone/tablet over Wi-Fi through Easy wireless connect.

Select this button to display a confirmation screen for starting a connection. Touch and hold this button
to switch to the standby mode for Easy wireless connect.

= Easy wireless connect

E: Setup

Displays the printer's setting menus or the maintenance menus.
F: Information

Displays quick guides about such procedures as loading paper and troubleshooting and such
information as estimated ink level and system information.

»» Note

» By default, menu settings apply to all print jobs. However, for settings that are also available in the
printer driver, the values specified in the printer driver take priority.

I Basic Touch Screen Operations

You can select various functions and settings by gently touching and swiping the touch screen with your
fingertip.

2% Important

» Take the following precautions when operating the touch screen. Otherwise, the touch screen may
malfunction or become damaged.

— Do not forcibly press the touch screen with your finger.

— Do not press the touch screen with an object other than your finger (such as a ballpoint pen,
pencil, fingernail, or other object with a sharp tip).

— Do not operate the touch screen with wet or dirty hands.

— Do not place objects on top of the touch screen.

» Do not place a protective film over the touch screen. Removing it can damage the touch screen.
Tap

Gently touch with your fingertip and then release.

Use this when selecting an item on the screen.

269



Touch
Gently touch with your fingertip.

To go (or return) to a menu or list, touch the directional mark.

Flick
Drag and release your finger up, down, left, or right.

Use this to quickly scroll through a menu or list.

Drag

Move your finger up, down, left, or right while gently keeping it in contact with the touch screen.

Use this to move a menu or list while viewing it.
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I Menu Structure

The * on the right side of an item indicates the default value.

Values may vary depending on your model and firmware version.

» Paper information

This menu is displayed by selecting paper information area.

Roll paper settings

Load roll paper / Replace paper

Set cut length

Remove paper

Paper settings

Type

Page size

Cut sheet settings

Paper settings

Type

Page size

» Load paper / Replace paper
» Set cut length

* LAN settings

This menu is displayed by selecting Network icon.

Wi-Fi

See settings

Enable/disable Wi-Fi

Enable / Disable

Wi-Fi setup

Easy wireless connect

Manual connect

WPS (Push button method)

Other connection types

WPS (PIN code method)

Wireless Direct

See settings

Connect to smartphone
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iPhonel/iPad

Android device

Others

Enable/disable Wireless Direct

ON / OFF

Change network name (SSID)

OK
Auto update
Yes / No
Change password
Change manually
Auto update
Yes / No

Connection request confirmation

ON / OFF
2.4GHz/5GHz Switch
2.4GHz / 5GHz
Wired LAN
See settings
Enable/disable Wired LAN
Enable / Disable
Advanced
Print details

* Wireless connect

* Setup

This menu is displayed by selecting Setup icon.

Printer settings

Security settings

Lockout settings

Enable/disable lockout

Enable / Disable*

Lockout threshold (times)

1 time /2 times / .../ 9 times / 10 times

Lockout period

273



1 minute / 2 minutes / ... / 59 minutes / 60 minutes

Use of Remote Ul

Restrict / Do not restrict®

Password policy settings

Minimum length settings

1 character / 2 characters / ... / 8 characters* / ... / 31 characters / 32 characters

Prohibit 3 repeated characters

Prohibit / Allow*

Require uppercase character

Enable / Disable*

Require lowercase character

Enable / Disable*

Require number

Enable / Disable*

Require symbol

Enable / Disable*

IPsec settings

Enable / Disable*

IEEE802.1X/EAP settings

Enable/disable

Enable / Disable*

Search for EAP router

Last authentication result

Authentication

TLS*/ TTLS / PEAP

Advanced setup

User-ID

Authentication server name

Verify auth. server name

Enable / Disable

Verify auth. server certificates

Enable / Disable

Print settings

Prevent paper abrasion

ON / OFF*

Adjust horizontal print position

274



Roll paper

+3.0/+2.9/.../+0.1/0.0/-0.1/.../-2.9/-3.0

Top feed

+3.0/+2.9/../+0.1/0.0*/-0.1/.../-2.9/-3.0

Cleaner Lines/Text

Enable* / Disable

IPP print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) / Mono-
chrome / Monochrome BMP

Print resolution

Standard* / Print priority

Print target

Photo / Line drawing*

Paper settings

Unidirectional printing

ON / OFF*

Default print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) / Mono-
chrome / Monochrome BMP

Print target

Photo / Line drawing*

Paper-related settings

Keep roll paper type

Enable / Disable*

Manage remaining roll amount

Auto estimate* / Disable

Roll amount warning settings

11m/36ft. / 9m/30ft. / 7Tm/23ft. / 5m/16ft. / 3m/10ft.* / 1m/3ft.

Detect top feed paper change

Enable* / Disable

Advanced paper settings

Power control
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Auto power off

Never / 240 min. / 120 min. / 60 min. / 30 min. / 15 min.

Auto power on

ON / OFF*

LAN settings

* The lower items of this menu are the same as the lower items of LAN settings displayed by selecting
Network icon.

Other printer settings

Date/time settings

Date display format

YYYY/MM/DD / MM/DD/YYYY / DD/IMM/YYYY

Daylight saving time setting

ON / OFF*

Sound control

Keypad volume

Loud / Standard* / OFF

Alarm volume

Loud / Standard* / OFF

Time zone

Keyboard settings

Standard* / Full keyboard

Ink level monitor

Timing for ink level notification

Standard* / Earlier notification

Length unit settings

Meters / Feet/inches

Language selection

Firmware update

Install update

Check current version

Update notification settings

ON*/ OFF

Auto update settings

ON / OFF

DNS server setup

Auto setup* / Manual setup
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Proxy server setup

Use / Do not use*

Administrator password settings

Change administrator password

Remove administrator password

Reset

settings

Web service setup only

LAN settings only

Settings only

Reset paper settings for all paper

Reset all

Security policy only

Maintenance

Nozzle Check

Roll paper

Top feed

Cleaning

All colors

Color

BK

Deep Cleaning

All colors

Color

BK

Print Head Alignment - Auto

Print Head Alignment - Manual

Roll paper

Top feed

Print the Head Alignment Value

Roll paper

Top feed

Paper feed adjustment

Set priority

(Paper type selection)

Auto

Prioritize print quality
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Prioritize length accuracy

Adjust print quality

Auto

Roll paper

Manual

Roll paper

Adjust feed length

Print alignment pattern

Roll paper

Change adjustment values

-0.70% / -0.68% / ... / 0.68% / 0.70%

Roller Cleaning

Bottom Plate Cleaning

Replace Ink in Print Head

All colors

Color

BK

Platen cleaning

Transport mode

Head Replacement

Web service setup

Settings for Data Sending

Web service connection setup

Cloud Printing Center setup

Check Web service setup

Issue registration code

DNS server setup

Auto setup* / Manual setup

Proxy server setup

Use / Do not use*

Web service inquiry

Print from Canon server

ECO

Auto power off

Never / 240 min. / 120 min. / 60 min. / 30 min. / 15 min.
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Auto power on

ON / OFF*

* Information

This menu is displayed by selecting Information icon.

Quick guide

Loading paper

Refilling ink tanks

Using from a smartphone

Using smartphone apps

Using Cloud applications

Learn more about your printer

Displaying the manual

Estimated ink levels

Current estimated ink levels

How to set

Ink model no.

Order ink now

Maintenance cart. info.

Maintenance cartridge usage

Replace

System information

Current version

Printer name

Serial number

Default password

MAC address (Wi-Fi)

MAC address (Wired LAN)

Root cert. thumbprint (SHA-1)

Root cert. thumbprint (SHA-256)

Troubleshooting

Print is smudged or patchy

Connecting with Wi-Fi

Paper is jammed

Printed surface is dirty
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Other problems

Job management

Display job history

Restrict job history access

Usage stats

Roll paper used area

Total sheets used on the device
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I Advanced (Paper settings)

This menu is displayed by selecting the Setup icon and then selecting Printer settings > Paper-related
settings > Advanced paper settings.

Advanced paper settings

Paper thickness (head height)

Auto / High / Standard

Skew detection accuracy

Standard / Loose / OFF

Cutting mode

Automatic cut / Eject cut

Cut speed

Fast / Standard / Slow

Trim edge first

Auto / On(Preset Length) / On(Input Length) / Off

Cut-dust reduction

ON / OFF

Roll paper tension (printing)

High / Standard / Low

Roll paper tension (feeding)

High / Standard / Low

Pause between scans

Ink drying wait time

OFF / 0.5 seconds / 1 second

Ink drying target area

Overall / Leading edge

Pause between pages

OFF / 30 seconds / 1 minute / 3 minutes

Roll paper lead edge/end margin

Auto/5mm /15 mm /30 mm

Roll paper top/bottom margins

Prioritize image size / Prioritize paper size

Roll paper minimal margin amount

Left

0.0/+0.1/../+0.6 / +0.7

Right

281



0.0/+0.1/

.../ +0.6/+0.7

Detect paper width

Enable / Disable

Paper core outer diameter

Paper thickness

Reset paper settings by paper
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I Advanced (LAN settings)

This is displayed when you select the network icon on the HOME screen and select Advanced.

The * on the right side of an item indicates the default value.

Advanced

Set printer name

TCP/IP settings

IPv4
IP address
Auto setup* / Manual setup
DNS server
Auto setup* / Manual setup
Proxy server
Use / Do not use*
IPv6
Enable/disable IPv6
Enable* / Disable
Manual address
Use / Do not use*

WSD settings

Enable/disable WSD

Enable / Disable*

Optimize inbound WSD

Enable* / Disable

Timeout settings

20 minutes / 15 minutes” / 10 minutes / 5 minutes / 1 minute

Bonjour settings

Enable/disable Bonjour

Enable* / Disable

Service name

LPD settings

Enable* / Disable

RAW settings

Enable* / Disable

LLMNR settings

Enable* / Disable
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IPP settings

Enable* / Disable

Wi-Fi DRX settings

Enable* / Disable

Wired LAN DRX settings

Enable* / Disable

Easy wireless connect

Auto start: ON / Auto start: OFF
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I Setting Items on Operation Panel

»» Note

* The administrator password is required to change some setting items if it is enabled for changing
settings using the operation panel.

= Setting Administrator Password on Operation Panel

D Plain Paper

D Plain Paper
Replace Set cut
—
E" paper Eg length

> @ o 0

o
)

(Network)

Lo

I (Setup)

* Printer settings

o Security settings

o Print settings

o Paper-related settings

o Power control

o LAN settings

o Other printer settings

o Language selection

o Firmware update

o Administrator password settings

= Setting Administrator Password on Operation Panel

o Reset settings

* Maintenance

* Web service setup

« ECO
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I e (Information)

e System information

« Job management

» Usage stats

= Checking the Total Number of Uses of Printer
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I Security settings

&

This item is displayed when you select Printer settings from (Setup) on the HOME screen.

22 Important

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

* Lockout settings
Set whether to lock password input for a period of time after multiple incorrect attempts.
o Enable/disable lockout
Enable or disable the lockout setting.
o Lockout threshold (times)
Set the number of attempts before input is locked.
o Lockout period

Set the length of time to lock input for.

* Use of Remote Ul

Set whether to lock use of the Remote UI.

» Password policy settings

Set whether to limit the characters that can be used when setting or inputting passwords.

* IPsec settings

Selecting Enable allows you to select the IPsec security protocol.
» IEEE802.1X/EAP settings

Setting item when you use IEEE802.1X/EAP (WPA/WPA2/WPAS3 Enterprise).
3> Note

» Refer to the Security Guide for details on Security settings.

= Set Up/Manage Security
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I Print settings

&

This item is displayed when you select Printer settings from (Setup) on the HOME screen.

* Prevent paper abrasion
Use this setting only if the print surface becomes smudged.

32 Important

* Be sure to set this back to OFF after printing since it may result in lower print quality.

* Adjust horizontal print position
Adjusts the print position when the left/right margins are not aligned.

You can adjust the left/right margins in increments of 0.004 in. (0.1 mm) between -0.12 in. (-3 mm) and
+0.12 in. (+3 mm) centered on the horizontal center of the paper.

32 Important

* When using 24 inch roll paper, the amount of adjustment that can be made is limited. You cannot
make adjustments greater than this limit.

+ This function is enabled only when printing with borders. To adjust the left and right margins when
printing with the minimal margins, it is required to change the setting value of the Roll paper
minimal margin amount.

= Setting the Minimal Margin Amount When Performing the Minimal Margin Printing

+ Cleaner Lines/Text

When enabled, lines and text are printed more sharply.

* IPP print settings
Sets the image quality and paper settings for IPP printing.

For example, when printing using AirPrint or Mopria Print Service, this setting value is applied.

+ Default print settings
Sets the default values for print settings.

If Media Type is set to Auto (Use Printer Settings) in the printer driver, this setting value is applied.
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I Power control

This item is displayed when you select Printer settings from : (Setup) on the HOME screen.

This setting allows you to turn on/off the printer automatically to save electricity.

32 Important

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

»>» Note

« If this setting is changed, power consumption may increase.

+ Auto power off

Specifies the length of time to turn off the printer automatically when no operation is made or no printing
data is sent to the printer.

+ Auto power on

Selecting ON enables the printer to turn on automatically when printing data is sent to the printer.
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I Paper-related settings

&

This item is displayed when you select Printer settings from (Setup) on the HOME screen.

* Keep roll paper type

Select Enable to continue using the same type of roll paper.

* Manage remaining roll amount

Selects the method to manage remaining roll amount and that to display warning when the roll is
running short.

o Auto estimate
Estimates and manages the remaining amount of roll paper.

To estimate the remaining roll amount, Paper thickness and Paper core outer diameter have to
be set correctly.

When using a paper that is not listed in the paper information list, set Thickness and Paper Tube
Size in Advanced paper settings or in Media Configuration Tool.

For paper thickness and paper tube outer diameter size, contact the paper manufacturer.

22 Important

* If you do not select the media type correctly, the remaining roll amount may not be estimated
correctly.

* There is an error in the estimated remaining roll amount, and paper may run out during printing.

o Disable

Select to disable managing remaining roll amount.

* Roll amount warning settings
Specifies when to warn the remaining roll paper amount.

»» Note

» This setting is enabled when Auto estimate is selected for Manage remaining roll amount.

» Detect top feed paper change
Detects paper insertion into the top feed when Enable is selected. When the paper registration screen is
displayed after replacing paper, register the paper size and the media type.

* Advanced paper settings
Performs advanced paper settings for each media types.

o Paper thickness (head height)
o Skew detection accuracy

o Cutting mode

o Cut speed

o Trim edge first
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Cut-dust reduction

Roll paper tension (printing)
Roll paper tension (feeding)
Pause between scans

Pause between pages

Roll paper lead edge/end margin
Roll paper top/bottom margins
Roll paper minimal margin amount
Detect paper width

Paper core outer diameter
Paper thickness

Reset paper settings by paper
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I LAN settings

This item is displayed by selecting Network icon.

22 Important

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

= Wi-Fi

= Wireless Direct
= Wired LAN

= Advanced

| wiFi

» See settings

The network settings information of the printer appears when it is connected by Wi-Fi. (Some setting
items are not displayed depending on the printer settings.)

Items Setting
Connection Enabled (connected)/Enabled (disconnected)/Disable
Network name (SSID) XXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXX
Frequency 2.4 GHz/5 GHz
Wi-Fi security Disable / WPA-PSK(AES) / WPA2-PSK(AES) / WPA/WPA2-PSK /

WPA3-SAE(AES) / WPA2/WPA3-PSK / WPA-EAP(AES) / WPA2-
EAP(AES) / WPA3-EAP(AES) / WPA/WPA2-EAP(AES) / WPA2/
WPA3-EAP(AES)

Signal strength (%)

XXX

IPv4 address

XXX, XXX, XXX, XXX

IPv4 subnet mask

XXX, XXX, XXX, XXX

IPv4 default gateway

XXX, XXX, XXX, XXX

IPv6 link-local address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 manual address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 manual prefix length

XXX

IPv6 stateless address 1

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 1

XXX

IPv6 stateless address 2

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 2

XXX
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IPv6 stateless address 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
IPv6 stateless prefix length 3 XXX
IPv6 stateless address 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
IPv6 stateless prefix length 4 XXX
IPv6 default gateway 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
IPv6 default gateway 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
IPv6 default gateway 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
IPv6 default gateway 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
MAC address (Wi-Fi) XXXXXXXX XX XX
Printer name XXXXXXXXXXXX XXX
Bonjour service name XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX

("XX" represents alphanumeric characters.)

< Enable/disable Wi-Fi
Enables/disables Wi-Fi.

* Wi-Fi setup

Selects the setup method for Wi-Fi connection.

o Easy wireless connect

Select if you specify the settings of the access point information to the printer directly from a
device (e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen

instructions of the connecting device for the setup procedure.

o Manual connect

Select when you perform settings for Wi-Fi manually using the operation panel of the printer.
o WPS (Push button method)

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi Protected
Setup (WPS) push button method. Follow the on-screen instructions during setup.

o Other connection types
= WPS (PIN code method)

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.
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I Wireless Direct

» See settings

The network settings information of the printer appears when it is connected by the wireless direct.
(Some setting items are not displayed depending on the printer settings.)

»» Note

» To show or hide the password, select Show password/Hide password in the Wireless Direct

setting list screen.

Items

Setting

Connection

Enable/Disable

Network name (SSID)

DIRECT-XXXX-TC-NNNNN

Password XXXXXXXXXX
Frequency 2.4 GHz/5 GHz
Wi-Fi security WPA2-PSK(AES)

No. of printers connected now

XXIXX

IPv4 address

XXX, XXX, XXX, XXX

IPv4 subnet mask

XXX, XXX, XXX, XXX

IPv4 default gateway

XXX, XXX, XXX, XXX

IPv6 link-local address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

MAC address (Wi-Fi) XX XX XXXX XX XX

Printer name XXXXXXXXXXXXXXX

Bonjour service name XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX

("XX" represents alphanumeric characters.)

» Connect to smartphone
Enables to connect the smartphone to the printer by reading the QR code displayed on the touch
screen with the smartphone, or also by manually obtaining the network name and password.

* Enable/disable Wireless Direct

Enables/disables Wireless Direct.

* Change network name (SSID)

Changes the identifier (SSID/the printer's name displayed on a Wi-Fi Direct compatible device) for
Wireless Direct.

* Change password

Changes the password for Wireless Direct.
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» Connection request confirmation

Selecting ON displays the confirmation screen when a Wi-Fi Direct compatible device is connecting

the printer.

¢ 2.4GHz/5GHz Switch

Sets the frequency to use.

| wired LAN

» See settings

The network settings information of the printer appears when it is connected by wired LAN. (Some

setting items are not displayed depending on the printer settings.)

Items

Setting

Connection

Enabled (connected)/Enabled (disconnected)/Disable

IPv4 address

XXX XXX, XXX, XXX

IPv4 subnet mask

XXX XXX, XXX, XXX

IPv4 default gateway

XXX XXX, XXX, XXX

IPv6 link-local address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 manual address

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 manual prefix length

XXX

IPv6 stateless address 1

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 1

XXX

IPv6 stateless address 2

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 2

XXX

IPv6 stateless address 3

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 3

XXX

IPv6 stateless address 4

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 stateless prefix length 4

XXX

IPv6 default gateway 1

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 default gateway 2

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX

IPv6 default gateway 3

XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
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IPv6 default gateway 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX
MAC address (Wired LAN) XXXXXX XX XX XX
Printer name XXXXXXXXXXXXXXX
Bonjour service name XXXXXXXXX XXX
XXXXXXXXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXX

("XX" represents alphanumeric characters.)

¢ Enable/disable Wired LAN
Enables/disables wired LAN.

I Advanced

» Set printer name
Specifies the printer name.
»» Note
* You cannot use the same printer name as that already used for other LAN connected devices.

* You cannot use a hyphen for the initial or last character of the printer name.

» TCP/IP settings

Performs IPv4 or IPv6 setting.

* WSD settings
Setting items when you use WSD (one of the network protocols supported in Windows).
o Enable/disable WSD
Selects whether WSD is enabled or disabled.
»» Note

* When this setting is enabled, the printer icon is displayed on the Network Explorer in
Windows.

o Optimize inbound WSD
Selecting Enable allows you to receive the WSD printing data faster.
o Timeout settings

Specifies the timeout length.

* Bonjour settings
Setting items when you use Bonjour.
o Enable/disable Bonjour

Selecting Enable allows you to use Bonjour to perform the network settings.
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o Service name
Specifies the Bonjour service name.

»>» Note

* You cannot use the same service name as that already used for other LAN connected
devices.

LPD settings
Enables/disables the LPD setting.

RAW settings
Enables/disables RAW printing.

LLMNR settings

Enables/disables LLMNR (Link-Local Multicast Name Resolution). Selecting Enable allows the printer
to detect printer's IP address from the printer name without a DNS server.

IPP settings

Selecting Enable allows you to print via the network with the IPP protocol.

Wi-Fi DRX settings

Selecting Enable allows you to activate discontinuous reception when using Wi-Fi (discontinuous
reception).

»>» Note

* Depending on the Wi-Fi router used, discontinuous reception may not be activated even though
Enable is selected.

« Discontinuous reception is enabled only while the printer is on standby. (The touch screen is in
the screen saver mode.)

Wired LAN DRX settings

Selecting Enable allows you to activate discontinuous reception when the printer is connected to a
device compatible with wired LAN.

Easy wireless connect

When set to Auto start: ON, the device will automatically put into the standby mode for easy wireless
connect.

To prevent the device from putting into the standby mode for easy wireless connect at unintended
times, set to Auto start: OFF.
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I Other printer settings

This item is displayed when you select Printer settings from

&

(Setup) on the HOME screen.

22 Important

The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

Date/time settings

Sets the current date and time.

Date display format

Sets the format of dates displayed on the touch screen and printed on photos.

Daylight saving time setting

Enables/disables the summer time setting. If you select ON, you can select additional sub-settings. This
setting may not be available depending on the country or region of purchase.

o Start date/time
Sets the date and time that summer time starts.
Month: Specify the month.
Week: Specify the week.
DOW: Specify the day of the week.

The screen to set the shift time to start summer time will be displayed after specifying the items
above and selecting OK.

After specifying the shift time and selecting OK, you can specify the end date/time.
o End date/time

Sets the date and time that summer time ends.

Month: Specify the month.

Week: Specify the week.

DOW: Specify the day of the week.

The screen to set the shift time to end summer time will be displayed after specifying the items
above and selecting OK.

Specify the shift time and select OK.

Sound control
Selects the volume.
o Keypad volume
Selects the beep volume when pressing the touch screen or the buttons on the operation panel.

o Alarm volume
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Selects the alarm volume.

» Time zone
Specifies the time zone according to a country or region you live in.
Specifying the time zone to the printer allows you to display the correct time an e-mail was sent from the
main unit on your mail software.
* Keyboard settings
Set the keyboard.
Select Full keyboard to select the keyboard layout from the following three types.
° QWERTY
> QWERTZ
o AZERTY

* Ink level monitor

Sets the timing of the remaining ink level notification.

* Length unit settings

Selects the length unit (meter or feet/inch).
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I Language selection

&

Changes the language for the messages and menus on the touch screen.

32 Important

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

This item is displayed when you select Printer settings from (Setup) on the HOME screen.
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I Firmware update

&

You can update the firmware of the printer, check the firmware version, or perform settings of a notification
screen, a DNS server and a proxy server.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

This item is displayed when you select Printer settings from (Setup) on the HOME screen.

»» Note

 If LAN is disabled, you cannot use Install update, DNS server setup, Proxy server setup.

* Install update
Updates the printer's firmware.

= Firmware update

* Check current version

You can check the current firmware version.

+ Update notification settings

Select ON to display a natification on the touch screen when a firmware update is available.

+ Auto update settings

Select ON to keep the firmware updated to the latest version.

* DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

* Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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I Reset settings

&

This item is displayed when you select Printer settings from (Setup) on the HOME screen.

You can set the settings back to the default.
3% Important
» The password of printer is set at the time of purchase.

= Default Administrator Password

* Web service setup only

Sets the Web service settings back to the default.

* LAN settings only
Sets the LAN settings back to the default.

+ Settings only
Returns the settings such as the paper size, media type, or other setting items back to the default. The
LAN settings is not returned back to the default.

* Reset paper settings for all paper
Selecting Yes initializes each setting specified in Advanced paper settings.

22 Important

* When you set the paper settings back to the factory default, added or updated paper information
using Media Configuration Tool is erased.

* Reset all

Sets all settings you made to the printer back to the default. The administrator password specified by
Remote Ul or Wi-Fi Connection Assistant reverts to the default setting.

After resetting, perform setup again as necessary.
»>» Note
* You cannot set the following setting items back to the default:

— Security policy

The language displayed on the touch screen

— The current position of the print head

The cumulative usage count of this product registered in Usage stats.

CSR (Certificate Signing Request) for encryption method (SSL/TLS) setting
 Security policy only

The Security administrator password and all Security policies will be reset. If a security administrator
password has been set, the security administrator password is required to perform the reset.
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= Set Up/Manage Security
3> Note

+ User mode settings restricted by the security policy will not be changed. (Feature settings will not
be returned to the settings prior to security restrictions under the security policy.)
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I Maintenance

e

This item is displayed when you select (Setup) on the HOME screen.

* Nozzle Check
Prints out the nozzle check pattern.

= Checking for Nozzle Clogging

» Cleaning
Select this to clean the print head.

= Cleaning the Print Head

* Deep Cleaning
Use this mode if no ink is ejected at all or if Cleaning does not solve the problem.

= Deep Print Head Cleaning

* Print Head Alignment - Auto
Adjusts the print head position automatically.

= Automatic Adjustment to Straighten Lines and Align Colors

* Print Head Alignment - Manual
Adjusts the print head position manually.

= Manual Adjustment to Straighten Lines and Align Colors

* Print the Head Alignment Value

Prints the print head position adjustment value.

» Paper feed adjustment

Adjusts the paper feed amount.

o Set priority
Sets how the paper feed rate is adjusted.
= Auto

Selects Prioritize print quality or Prioritize length accuracy automatically according to the
printer driver settings.

= Prioritize print quality

Adjust to make the horizontal streaks of the printed documents less noticeable. The settings in
Adjust print quality are applied.

= Prioritize length accuracy

Adjusts the length of the ruled lines on the printed documents to match. The values of Change
adjustment values under Adjust feed length are applied.

304



o Adjust print quality
Select this mode when the printed documents have horizontal streaks of different colors.

= Automatically Adjusting Different Colored Horizontal Streaks
= Manually Adjusting Different Colored Horizontal Streaks

o Adjust feed length
Select this mode when you want to print ruled lines in CAD drawings to their exact lengths.

= Adjusting Line Length

Roller Cleaning
Select this mode when cleaning the paper feed rollers.

= Cleaning Paper Feed Rollers

Bottom Plate Cleaning
Select this mode when cleaning the inside of the printer.

= Performing Bottom Plate Cleaning

Replace Ink in Print Head
Select this mode when Deep Cleaning does not improve the print quality.

= Replacing the Ink in the Print Head

Platen cleaning
Select this mode when cleaning the inside of the printer.

= Cleaning Inside the Printer

Transport mode
Select this to prepare for transporting the printer.

= Preparing to Transfer the Printer

Head Replacement
Select this mode when replacing the print head.

= Replacing the Print Head
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I Web service setup

e

This item is displayed when you select

22 Important

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

(Setup) on the HOME screen.

 Settings for Data Sending
Performs settings for the following data sending.
o Data necessary for services

o Data about your activities

* Web service connection setup
The following setting items are available.
o Cloud Printing Center setup
Registers/Deletes the printer to/from Canon Cloud Printing Center.
o Check Web service setup

Make sure whether the printer is registered to Canon Cloud Printing Center.

* Issue registration code

In order to link the web service and printer, obtain the registration code from the service origin.

* DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

* Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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| eco

e

This setting allows you to turn on/off the printer automatically to save electricity.

3% Important

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

This item is displayed when you select (Setup) on the HOME screen.

»>» Note

+ If this setting is changed, power consumption may increase.

+ Auto power off

Specifies the length of time to turn off the printer automatically when no operation is made or no printing
data is sent to the printer.

+ Auto power on

Selecting ON enables the printer to turn on automatically when printing data is sent to the printer.
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I System information

This item is displayed when you select

@

(Information) on the HOME screen.

Current version

Displays the current firmware version.

Printer name

Displays the printer name currently specified.

Serial number

Displays the printer serial number.

Default password
Displays the printer's initial password by selecting Show password.

If the password has been changed, it will not be displayed.

MAC address (Wi-Fi)
Displays the MAC address for Wi-Fi.

MAC address (Wired LAN)
Displays the MAC address for wired LAN.

Root cert. thumbprint (SHA-1)
Shows the root certification thumbprint (SHA-1) of the printer.

Root cert. thumbprint (SHA-256)
Shows the root certification thumbprint (SHA-256) of the printer.
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I Job management

@

This item is displayed when you select (Information) on the HOME screen.

22 Important

* In order to use this menu, the setting that uses the administrator password to change settings on the
operation panel needs to be enabled.

» The administrator password is required to change the settings if it is enabled to change the settings on
the operation panel using the administrator password.

* Display job history
Displays the job history.

* Restrict job history access

This is the menu for the developer.
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I Setting Administrator Password on Operation Panel

The administrator password can be set or canceled.

Specifying the administrator password requires you to enter the password to use the items or change the
settings below.

Security settings
LAN settings

Other printer settings
Language selection
Firmware update
Administrator password settings
Reset settings

Web service setup
ECO

Power control

Job management

Follow the procedure below to specify the administrator password.

32 Important

The password of printer is set at the time of purchase.

= Default Administrator Password

. Select : (Setup) on the HOME screen.
. Select Printer settings.

. Select Administrator password settings.

If you have set an administrator password, enter the password.

. Select Change administrator password.

. Select the effective range of the administrator password.

Remote Ul and other tools
To change the setting using the remote Ul or a certain software, the administrator password needs
to be entered.

LCD, Remote Ul, and other tools
To change the setting using the operation panel of this printer, remote Ul or a certain software, the
administrator password needs to be entered.

Enter new administrator password.
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2% Important
* When changing the password, the character is limited as follows.

— Single-byte alphanumeric characters, spaces, umlaut characters, and the following symbols
are available.

l@#S S N&T s, =+ (O) {3 < >
— Set the password according to the password policy.

= Security settings

7. Select Apply.
8. Enter the administrator password again.

9. Select Apply.

The administrator password is available.

I When You Want to Disable the Administrator Password:

After selecting : (Setup) on the HOME screen, select Printer settings > Administrator password
settings > Remove administrator password. Select either item and follow the on-screen instructions to
perform settings.
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I Checking the Total Number of Uses of Printer

You can get information on printer usage, such as the number of sheets printed.

1. Select o (Information) on the HOME screen.

2. Select ;“1’-

3 Usage stats.

3. Select item to check.

Roll paper used area
Displays the total area of roll paper used by this product.

Total sheets used on the device
Displays the total number of sheets printed.
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I Changing Printer's Setting Using Web Browser

» Start up Remote Ul

» Changeable Setting Items Using Remote Ul

» Setting Passwords Using Remote Ul

» Registering Printer's Root Certificate to Web Browser for SSL Communication

» Registering Printer's Root Certificate to Local Computer for SSL Communication
» Generating Server Certificate

» Setting Mail Server

» Receiving Printer Status by E-mail
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I Start up Remote Ul

You can check the printer status and change the printer settings using the web browser on your
smartphone, tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

»>» Note

* Remote Ul is a software that enables you to perform operations, which are usually performed on the
printer's operation panel, using a Web browser over a network.

LAN connection with the printer is required to use Remote UlI.
* You can use Remote Ul on the following OS and the web browser.

— iOS device

Web browser: iOS standard Web browser (Mobile Safari)
— iPadOS device

Web browser: iPadOS standard Web browser (Mobile Safari)
— Android device

Web browser: Android standard Web browser (Browser or Chrome)
— macOS device

Web browser: macOS standard Web browser (Safari)
— Windows device

Web browser: Microsoft Edge, Mozilla Firefox, Google Chrome

» Enable JavaScript and cookies in the web browser.

1. Check printer's IP address.

1. Select Network icon on the HOME screen.

Er Plain Paper

D Plain Paper
Replace Set cut
.‘-
D paper .[E-‘ length
o

T | | & | O

The icon displayed on the button varies depending on the current LAN status.

= Home Screen Menu Composition

2. Select the enabled LAN.

Diagonal lines are displayed for disabled LAN icons.
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3. Select See settings.

4. Check IPv4 address.

2. Open web browser on your smartphone, tablet, or computer and enter IP address.
Enter as following in the URL field of the web browser.
http://XXX. XX X. XXX
Enter the IP address of the printer in "XXX. XX. X XXX".
2> Note

* If you have set a DNS host name, you can also enter this.

When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or

computer.
Cetalls Ready o print
When a password is set, you will
b requested fo enfer your
passward. Estimated ink levels
m K | |

Manual [Online]

For secure cammunication ¥
Ink madel number | Order InkiConsumables Now
Roll papar "-D:I Flain Papar
=" 24inRoll
0 feat
Top feed Plain Paper

ToAd

¥ | Maintenance cartridge usage

»» Note

* If you display Remote Ul for the first time on your smartphone, tablet, or computer, download the
root certificate, and then register it.

= Regqistering Printer's Root Certificate to Web Browser for SSL Communication

« If the root certificate is not registered, a message to warn you that the secure connection is not
guaranteed may appear.

3. Select Log in.

The password authentication screen appears.

> Note

¢ When the standard user mode is enabled, choose either administrator mode or standard user
mode to log on.
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After choosing a mode and selecting Log in, the password authentication screen of each mode
appears.

4. Enter password.

When the password authentication is complete, the menus that can be utilized are displayed on the web
browser.

3% Important

» The password is set at the time of purchase. The password is the printer serial number. The

printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters.

For details on setting password, see Setting Passwords Using Remote UI.

5. Confirm that the main screen of Remote Ul is displayed.
For changeable setting items, see below.

= Changeable Setting Items Using Remote Ul

When you finish checking printer status and changing printer settings, select Log out.
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I Changeable Setting Items Using Remote Ul

»» Note

¢ The item which can be used is different in administrator mode or in standard user mode.

Frinter status

Ready 1o print
Utilities.
Frinter setfings Estimated ink levels

. K.
AirPrint settings .
I ———

Wieh service connection setup

Y

Jab higtery
Security Ink madel number | Order InkiConsumables Now
Records of use
Rall papar P j Flain Papar
System Info and LAN seftings = 24 n Raoll
0 feat

Firmiware i L]

pds Top feed Plain Paper

Language selection "o

Manual [Online]
[ Maintenance cartridge usage

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.

You can also connect to the ink purchase site or support page, and use Web Services.
Utilities
This function allows you to set and perform maintenance such as cleaning.

Printer settings
You can change various settings, such as print settings.

You can disable any operations using the operation panel from Operation panel lock on Custom
settings.

»>» Note

» Some of the menu is available only when you logged on in administrator mode.

AirPrint settings
This function allows you to specify the AirPrint settings when printing with AirPrint.

Web service connection setup
This function configures web services that use printer device information.

Job history
This function allows you to display the job history and set the public setting.

Security
Set passwords, make settings related to certificates for encrypted communication, and other security

settings.
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Records of use
Get information on printer usage.

System info and LAN settings
» Confirm system information
* LAN settings

Firmware update
You can update the firmware of the printer, check the firmware version, or perform settings of a DNS
server and a proxy server.

= Firmware update

Language selection
This function allows you to change the language on the display.

Manual (Online)
This function displays the Online Manual.

318



I Security

+ Administrator password setting

= Setting Passwords Using Remote Ul

» Standard user mode settings

Select Enable/Disable for the standard user mode.

» TLS server settings
Make settings related to certificates for encrypted communication.

Advanced TLS settings enables you to specify the range of TLS versions to be used, the algorithm to
be used, and so on.

+ IEEE802.1X/EAP settings
o Authentication
Select an authentication method for IEEE802.1X/EAP authentication.

»» Note

* In the case of using IEEE802.1X certificate, Security > IEEE802.1X/EAP settings > CA
certificate, and register the CA certificate.

» Supported authentication method
— EAP-TLS(Extensible Authentication Protocol-Transport Level Security)
— EAP-TTLS(EAP-Tunneled TLS)
— PEAP(Protected EAP)

- Key and certificate settings

Perform settings for key and client certificate.
o CA certificate

Perform settings for the CA certificate that verifies a server certificate.
> Enable/disable IEEE802.1X/EAP

Enable or disable IEEE802.1X/EAP authentication.

* IPsec settings

If enabled, you can set the IPsec security.

* Import printer settings

Imports the printer security settings.

* Export printer settings

Exports the printer security settings.

» Security policy

Allows you to set the security policy and check the setting values.
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= Set Up/Manage Security

* Encryption settings

Performs settings related to encryption.

» Password policy settings
Sets the minimum number of characters and combinations of characters that can be set for the printer
passwords such as the administrator password.

* Lockout settings
Performs settings for the function that locks operations that require entering the password if the incorrect
password is entered a specified number of times on the password entry screen.

* USB settings
Performs settings related to USB connection.

»>» Note

» Refer to the Security Guide for details on Security settings.

= Set Up/Manage Security
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| LAN settings

» Wi-Fi
Enables/Disables Wi-Fi.

* Wireless Direct

Enables/Disables Wireless Direct.

* Wired LAN
Enables/Disables Wired LAN.

» Confirm LAN settings
The LAN setting information is displayed.

* Advanced setup
o Set printer name
Specifies the printer name.
3> Note
* You cannot use the same printer name as that already used for other LAN connected devices.

* You cannot use a hyphen for the initial or last character of the printer name.

o TCP/IP settings

Performs IPv4 or IPv6 setting.
o WSD settings

Perform settings to use WSD.
o Bonjour settings

Perform settings to use Bonjour.
o LPD settings

Perform settings for printing with LPD.
o RAW settings

Enables/Disables the RAW printing.
o LLMNR settings

Enables/disables LLMNR (Link-Local Multicast Name Resolution). If you select Enable, you can
determine the printer's IP address from the printer name even in an environment without the DNS
server.

o SNMP settings

Perform settings for using SNMP to manage and control the printer.
o |PP Settings

Perform settings for printing with IPP.
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o CHMP settings

Perform settings for communication at the time when printer drivers or applications acquire the
information on status, paper, and job log, from the printer.

Selecting Enable HTTPS redirection redirects the communication using CHMP to encrypted
communication.

»» Note

» To use CHMP for encrypted communication, you need to register the printer's root certificate to
your computer.

= Registering Printer's Root Certificate to Local Computer for SSL Communication

* CHMP is a Canon proprietary protocol.

o DRX settings

When enabled, data is received intermittently during network connection.

[

IP filtering
Allows or denies access for specific IP addresses.

Settings for both IPv4 and IPv6 addresses can be specified.

32 Important

« If the device address for the administrator has been set to rejection by mistake, select :
(Setup) on the HOME screen of the operation panel, and then select Printer settings > Reset
settings > LAN settings only in this order, and initialize network information of the printer.

After resetting, perform setup again as necessary.

> MTU
Performs the MTU settings.

o

Easy wireless connect settings

When set to Auto start: ON, the device will automatically put into the standby mode for easy
wireless connect.

To prevent the device from putting into the standby mode for easy wireless connect at unintended
times, set to Auto start: OFF.
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I Setting Passwords Using Remote Ul

Each of passwords for administrator and standard user can be set.
When logging on with password for administrator, all settings can be changed.

When logging on with password for standard user, some of the settings can be changed.

= Setting Administrator Password
= Setting Standard User Password

»» Note

» Password can be set only when you are logged in administrator mode.
» The standard user password is disabled by default.

I Setting Administrator Password

Change the administrator password by following the steps below.
32 Important
» The password of printer is set at the time of purchase.

= Default Administrator Password

-_—

. Start up Remote UL.

= Start up Remote Ul

2. Select Security.
3. Select Administrator password setting.

4. Select Change administrator password.

If an administrator password is not specified, the confirmation message appears. Confirm the
message and select Yes. When message appears again, confirm it and select OK.

5. Select range where administrator password is valid and select OK.

Remote Ul and other tools

Entering the administrator password is required to change the setting items using the Remote Ul
or some software.

Operation panel/Remote Ul/other tools

Entering the administrator password is required to change the setting items using the operation
panel of the printer, the Remote Ul, or some software.

6. Enter password and select OK.

22 Important

» The following character restrictions apply to the password:
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— The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.

-l@#S P N&T = () {1 <>
— Set the password according to the password policy.

= Security settings

7. When completion message appears, select OK.

I Setting Standard User Password

For restricting the function for standard user, enable the standard user mode and set a standard user
password by following the steps below.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Security.
3. Select Standard user mode settings.
4. Confirm the message and select Yes.

5. Enter password and select OK.

32 Important
» The following character restrictions apply to the password:

— The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.

1@#S %N 5, = ({3 <>
— Set the password according to the password policy.

= Security settings

6. When completion message appears, select OK.
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Registering Printer's Root Certificate to Web Browser for SSL
Communication

If the printer's root certificate has not been registered to the web browser, a message to warn you that the
secure connection is not guaranteed may appear.

When you display Remote Ul for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message
will not appear. However, the message may appear depending on a web browser even after you have
registered the root certificate.

How to register the root certificate varies depending on the web browser.

Operating procedure may differ depending on the version of your web browser. For other web browser, refer
to each help.

32 Important

» Make sure that you have accessed to the printer IP address correctly by checking the URL field of the
web browser before registering the root certificate.

« If the printer is connected via IPv6 using Windows, you need to generate a server certificate using
Remote Ul.

For details, see Generating Server Certificate.

For Microsoft Edge
1. Select For secure communication on Remote Ul.

2. Select Download.

Downloading the root certificate is started.

3. If confirmation screen appears, select Open.
Certificate screen is displayed.

> Note

» To save the certificate file and register it, select Save. To register, select Control Panel >
Network and Internet > Internet Options, and register the root certificate from Certificates on
Content sheet.

4. Select Install Certificate.

Certificate Import Wizard screen is displayed.
5. Select Next.
6. Select Place all certificates in the following store.

7. Select Browse.
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Select Certificate Store screen is displayed.

8. Select Trusted Root Certification Authorities and OK.
9. Select Next on Certificate Import Wizard screen.

10. If Completing the Certificate Import Wizard appears, select Finish.
Security Warning screen is displayed.

11. Make sure that thumbprint on Security Warning screen matches printer's thumbprint.
To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.
thumbprint (SHA-256), select ﬂ (Information) on the HOME screen of the operation panel, and
then select System information.

12. If thumbprint on Security Warning screen matches printer's thumbprint, select Yes.

13. Select OK on Certificate Import Wizard screen.

The root certificate registration is completed.
For Safari
1. Select For secure communication on Remote Ul.
2. Select Download.

Downloading the root certificate is started.
3. Open the downloaded file.

Keychain access starts up and Add Certificates screen is displayed.
4. Select Add.

Information on the certificate is displayed.

2> Note
* You can also add the certificate by selecting Show Certificate, checking certificate name to add,
and then selecting the same certificate on Keychain access.

5. Make sure that fingerprint of certificate detail information matches printer's thumbprint.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select ﬂ (Information) on the HOME screen of the operation panel, and
then select System information.
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6. If fingerprint of certificate detail information matches printer's thumbprint, display information
on certificate from the menu or by double-clicking the certificate, and select Always Trust
on Trust.

The root certificate registration is completed.

»>» Note

« If a password is set on your device, entering a password may be required.
For Chrome on Android
1. Select For secure communication on Remote Ul.

2. Select Download.

Downloading the root certificate is started and then Name the certificate screen is displayed.

3. As entering the root certificate name is required, enter an arbitrary certificate name and
select OK.

The root certificate registration is completed.

»>» Note

« If PIN or password is not set as security type, the attention screen may appear. Select OK, and
then set the security type to PIN or password.

After Root Certificate Registration
We recommend that you make sure that the correct root certificate has been registered.

To make sure that the correct root certificate has been registered, make sure that thumbprint of certificate
information matches printer's thumbprint. Follow the steps below.

»» Note

+ Some Android devices cannot be checked the thumbprint of a registered route certificate.

1. From Settings menu on your device, select Security, Trust credentials, and USER.

The list of downloaded certificates appears.

2. Select downloaded certificate.

The certificate information appears.

3. Make sure that thumbprint of certificate information matches printer's thumbprint.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select ﬂ
then select System information.

(Information) on the HOME screen of the operation panel, and
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4. If thumbprint of certificate information screen matches printer's thumbprint, select OK.
The root certificate registration is completed.

If the message to warn you that the secure connection is not guaranteed appears when you select Log
in on Remote Ul after registering the root certificate, restart the web browser. The message will not
appear on the web browser.

»» Note

» Depending on the Android device, a warning may appear even after registering the proper root
certificate.

For Mobile Safari on iOS
1. Select For secure communication on Remote Ul.

2. Select Download.

Downloading the root certificate is started and then Install Profile screen is displayed.

3. Select Install.

Warning screen is displayed.

»>» Note

« If a password is set on your device, entering a password may be required.

4. Select Install.

5. Select Install on displayed dialog.

The root certificate registration is completed.
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Registering Printer's Root Certificate to Local Computer for
SSL Communication

To use Device Management Console or Accounting Manager, etc. when you connect the printer to a
computer using SSL encrypted communication, you need to register (import) the printer's root certificate to
your computer.

Procedure to register the certificate varies depending on your operation environment.

32 Important

« If the printer is connected via IPv6 using Windows, you need to generate a server certificate using
Remote Ul.

For details, see Generating Server Certificate.

Operation procedure may differ depending on your OS version.

For Windows 11/Windows 10/Windows 8.1

The procedure below describes how to import a root certificate in Windows 11/Windows 10/Windows 8.1.

1. Start up Remote UL.

= Start up Remote Ul

2. Select For secure communication.

»>» Note

* You can download a certificate from Status Monitor.

1. Open status monitor.

Open the Printing preferences, and select Status Monitor... on Main.
2. Download a certificate.
Select Download Security Certificate from the Remote Ul menu.
3. Select Download.

The root certificate will be downloaded.

4. When download confirmation screen is displayed, select Open.

The Certificate screen appears.

5. Select Install Certificate.

The Certificate Import Wizard screen appears.

6. Select Local Machine.
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1. Select Local Machine on the startup screen of Certificate Import Wizard.

Fe

¢ Centificate impont Wizard

Welcoma to the Certificate Import Wizard

This witard helos you copy cer tificabes, cortificate trust ists, and cerlificate revocation
kzte from your disk to & cerlificabs siore

A cerbificate; which is Bsued by a ceraficaton authonity, B a conSrmaton of your idertity
and contans informaton used to protect daka or to establish secure netmork
connectons. A certficate store is the system area where ceroficates are kept.

Share Location
& .i:__l.rrenr Lgar

Tia contirue, dds Next.

Cancel

2. Select Next.

3. Select Yes on the displayed screen.

The Certificate Store screen appears.
7. Select Place all certificates in the following store.

8. Select Trusted Root Certificate Authorities.

1. Select Browse to open the Select Certificate Store screen.
2. Select Trusted Root Certificate Authorities from the list and select OK.

3. Select Next on the Certificate Store screen.

9. Select Finish.

When the Completing the Certificate Import Wizard screen appears, check the settings and select
Finish.

For Windows 7

The procedure below describes how to import a root certificate in Windows 7.
3» Important
 Be sure to create a certificate snap-in before importing a root certificate.

The root certificate will be registered to the local user if you import it without creating a certificate
shap-in.
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Creating Certificate Snap-in

1. Start up Microsoft Management Console.

Enter MMC on Search programs and files in the Start menu and press the Enter key.
2. Select Yes on displayed screen.

3. Select Add/Remove Snap-in from File menu.

The Add or Remove Snap-ins screen appears.

4. Add Certificate snap-in.

1. Select Certificates from Available snap-ins list and select Add.

2. Select Computer account for This snap-in will always manage certificates for on the Certificates
snap-in screen and select Next.

3. Select Local computer on the Select computer screen and select Finish.

Salect Compuber ﬁ

Sedect fthe compuber you want this snap-n fo manage
This snap-n will alveays manage:

[lil lLooal compubsr: fthe computer this console i rI.ITIr\g_":I'I:I]

fnother comouter:

Alow the selsced compubs io be changsd whan sunching from the commend ina. The
orily spplies if you save tha consals.

< Bk Frush | Cance |

4. Select OK on the Add or Remove Snap-ins screen.

Downloading Certificate

1. Start up Remote UI.

= Start up Remote Ul

2. Select For secure communication.

»» Note

* You can download a certificate from Status Monitor.

1. Open status monitor.
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Open the Printing preferences, and select Status Monitor... on Main.
2. Download a certificate.

Select Download Security Certificate from the Remote Ul menu.

3. Select Download.

4. Select Save.

Importing Certificate
1. Open Certificate Import Wizard.
1. On the left window, open Trusted Root Certificate from Certificate on Console Root.
2. Right-click Certificates and select Import from All tasks.
2. Specify certificate file to import.
1. Select Next.
2. Specify the certificate file to import on File name and select Next.
3. Specify certificate store.
1. Select Place all certificates in the following store.
2. Select Trusted Root Certificate Authorities for Certificates Store.
4. Finish certificate import wizard.
1. Select Next and check the specified settings.

2. Select Finish to finish the wizard.

3. Select OK on the displayed screen.

Checking Imported Certificate

Make sure the imported certificate has been registered to your computer.

1. Display certificate list.

On the left window of Microsoft Management Console, select Console Root > Certificates (Local
Computer) > Trusted Root Certificate Authorities in this order, and Select Certificates to display
the certificate list.
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2. Check registered certificate.
Make sure the imported certificate name is displayed on the list.

»» Note

» Make sure you can see the registered certificate from Current user by creating the Current
user snap-in.

»» Note

* When you finish Microsoft Management Console, a message asking you whether to save the console
setting. If you continue to apply the same settings next, select Yes to save.

For macOS

The procedure below describes how to import a root certificate in macOS.

1. Start up Remote UL.

= Start up Remote Ul

2. Select For secure communication.

3. Select Download.

The root certificate will be downloaded.

4. Open downloaded certificate file.
When the download procedure is completed, a downloaded item pops up on the right of the screen.

Double-click the downloaded certificate on the list starts up Keychain Access and the Add Certificates
screen appears.

> Note

« If the downloaded item does not pop up, select the Show Downloads 0 button on the right.
+ Selecting the magnifying glass icon on the right of download list displays the folder containing the
certificate.

5. Select Add.
Select the destination for the certificate on Keychain.

Selecting Add displays information on the certificate.

2> Note
* You can add the certificate by selecting the same certificate on Keychain Access. Check the

name of certification to add after selecting View Certificates.

6. Check certificate.
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Make sure the fingerprint of certificate shown on Details corresponds with the root certificate thumbprint
of the printer.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), select ﬂ (Information) on the HOME screen of the operation panel, and
then select System information.

. Select Always Trust.

If the fingerprint of certificate detail information matches printer's thumbprint, display information on
certificate from the menu or by double-clicking the certificate, and select Always Trust on Trust.

The root certificate has been registered.

> Note

» Entering the password may be required if you specify it for your printer.
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I Generating Server Certificate

When you use SSL connection via IPv6 network, you need to generate an IPv6 server certificate using the
printer.

Generate the server certificate from Remote Ul.
Follow the procedure below.

1. Checking Printer's IP Address

2. Generating Server Certificate

3. Checking Generated Server Certificate

32 Important

+ If you generate an IPv6 server certificate, a warning message may appear if you are using Remote Ul.

To reset the IPv6 server certificate, select Security > TLS server settings > Delete key and
certificate in this order, and select OK on the displayed screen.

I Checking Printer's IP Address

1. Select Network icon on the HOME screen.

Er Plain Paper

D Plain Paper

E_ Replace Set cut
- paper +1" length
——

Tl & O

The icon displayed on the button varies depending on the current LAN status.

= Home Screen Menu Composition

2. Select the enabled LAN.

Diagonal lines are displayed for disabled LAN icons.
3. Select See settings.

4. Check the value on IPv6 link-local address.

Write down the value on IPv6 link-local address for your reference when you generate a server
certificate.
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I Generating Server Certificate

1. Start up Remote UL.

= Start up Remote Ul

2. Select Security.

3. Select TLS server settings.

4. Select Generate key and certificate.
5. Select Generate self-signed cert.

6. Specify each setting item.

» Key algorithm
Specify the signature algorithm and key information.

 Specify the expiration date.
Enter the date you generated the server certificate on Valid from.
Enter the date the server certificate expires on Valid to.

» Enter the common name.
On Common name, enter the IPv6 link-local address you checked in abbreviated form.

> Note

* When you enter the common name, add [ ] to each end of the abbreviation value of the
printer's IPv6 address.
* Do not use a comma or make a space for the common name.

7. Select Next.

Enter Country, State or province, Locality, Organization and Organizational unit as required.

Enter the same information in Subject Alternative Names as in Common name.

8. Select Generate.

The server certificate starts to be generated.

When the server certificate has been generated, Generated a self-signed certificate. appears.

9. Select Restart LAN.
LAN will be restarted.

When LAN has been restarted, Printer status on Remote Ul appears.

> Note

* If you cannot access to Remote Ul after you restart LAN, reload your web browser.
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I Checking Generated Server Certificate
1. Select Security on Remote Ul.
2. Select TLS server settings.

3. Select Check key and certificate.

Make sure the issuer of the root certificate is displayed on Issued by, and the value you entered is
displayed on Common name on Subject.
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I Setting Mail Server

To use mail function, specify the mail server settings.

»» Note

* If you did not specify the time zone setting using the printer's operation panel, a message to inform you
that the correct time may not be reflected on the sent e-mail appears. We recommend that you set the
time zone setting using the printer's operation panel.

= Other printer settings

» These functions can be set only when you are logged in administrator mode.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Printer settings.
3. Select Set mail server / test connect.
4. Select Set mail server.

5. Specify mail server settings.
Specify the following items.
* Sender address
Enter the e-mail address of the sender (this printer).
* Outgoing mail server (SMTP)
Enter the address of your SMTP server.
* Port number (SMTP)
Enter the port number of your SMTP server.
» Secure connection (SSL)
Select if you use the secure connection (SSL).
* Don't verify certificates
Select if you do not verify the certificate.
* Authentication
Select one of the following authentication methods.
o SMTP authentication
Select if you send e-mail with SMTP authentication.
Next, you can specify the following settings.
= Outgoing account

Enter the account name for sending to perform the authentication.
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= Outgoing password
Enter the password for sending to perform the authentication.
> POP before SMTP
Select if you send e-mail with POP before SMTP authentication.
Next, you can specify the following settings.
* Incoming mail server (POP3)
Enter the address of your POP server.
* Port number (POP3)
Enter the port number of your POP server.
* Incoming account
Enter the account name for receiving to perform the authentication.
* Incoming password
Enter the password for receiving to perform the authentication.
= Use APOP authentication
Select if you send the password by the encryption transmission.
= Clear mailbox
Select if you delete the e-mails that remain in the POP3 server.

32 Important

* When this setting is enabled, e-mail in the Inbox on the server will have all been
removed. If you specify the e-mail address of your everyday, be sure to disable this
setting as unread e-mail is not deleted. We recommend that you prepare this printer
dedicated e-mail account not to accidentally delete the unread e-mail.

o No authentication

Select if the authentication is not necessary.

6. Select OK.

The setting operation is completed.
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I Receiving Printer Status by E-mail

You receive the printer status information such as the remaining ink level and the error from the printer.
¥>» Note
* Specify the mail server settings in advance.

= Setting Mail Server

+ If you did not specify the date and time setting using the printer's operation panel, the date and time
may not be reflected on the sent e-mail. We recommend that you set the date and time setting using the
printer's operation panel.

For the date and time setting, see Other printer settings.

» These functions can be set only when you are logged in administrator mode.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Printer settings.
3. Select Status notification email.
4. Select Notification recipients.

5. Specify destination settings.

Up to 5 destinations can be registered by following the steps below.
1. Select number of destination.
2. Select Add.
3. Enter e-mail address, and then select printer status to send information.

4. Select OK.

The registration for destination is completed.
6. Select Printer settings.
7. Select Status notification email.
8. Select Retry settings.

9. Specify resending settings.

The number of resending can be specified by following the steps below.

1. Specify number of resending.
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2. Specify interval of resending.

3. Select OK.

The resending setting is completed.
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I Network Setting

>

Printer Connection Methods
@« Wi-Fi Connection

Wireless Direct Connection

Wired Connection

« USB Connection
Another Printer Found with Same Name
Printing Network Settings
Countermeasures against Unauthorized Access
Network Status and Troubleshooting
Checking Printer Connection Status Using Wi-Fi Connection Assistant
Sharing the Printer on a Network (Windows)

@« Setting Up a Shared Printer

@ Restrictions on Printer Sharing
Sharing the Printer on a Network (macOS)

@« Settings on Print Server

@« Settings on Client PC

@« Restrictions on Printer Sharing
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I Printer Connection Methods

4 connection methods are available on the printer.

« Wi-Fi Connection

L
(1]
e,
—

(¢

¢ USB Connection

The printer cannot use a wired LAN connection simultaneously with a Wi-Fi or wireless direct connection.

When connecting another device while the devices are already connected to the printer, connect using a
method other than the above.
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= Restrictions

32 Important

+ If you connect a device connected to the Internet via a wireless router to the printer that is in the
wireless direct, the connection between the device and wireless router will be disabled. In that case,
the connection of the device may switch to a mobile data connection automatically depending on your
device. Transmission fees for connecting to the Internet using a mobile data connection apply.
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| Wi-Fi Connection

Follow the procedure below to setup a printer.

»» Note

+ Refer to the following notes when connecting to Wi-Fi.
= Notes on Wi-Fi Connection

1. Make sure printer is turned on before starting wireless connection setup.

If the power is on, the ON lamp will be lit.

32 Important

« If printer is performing cleaning, print head alignment, or other processes, wait for the process
to finish, before starting setup.

2. Press the HOME button.

000

» Note

« If an error screen appears, select OK, and then press the HOME button.

3. On the HOME screen, select the Network icon.
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Depending on the current LAN status, the icon displayed on the button may differ.

= Home Screen Menu Composition

4. Select Wi-Fi.
LAN settings
5 OWi-Fi

™ Wireless Direct

= Wired LAN

Advanced Print details

5. Select Wi-Fi setup.

Wi-Fi

See settings

Enable/disable Wi-Fi

Wi-Fi setup

6. Select a connection method below.

Easy wireless connect

Set wireless router information to the printer directly from a device (such as a computer),
without operating the wireless router

Easy wireless connect may take some time. Internet connection may become temporarily
unavailable during setup.

Easy wireless connect is not available on Chrome OS or Windows 10 in S mode. Select Other

connection types.

346



347



I WPS Connection

1. Select WPS (Push button method).
Wi-Fi setup
Easy wireless connect

Manual connect

WPS {Push button method)

Other connection types

2. Select OK.

Connect to a wireless router
supporting the WPS push
button method.

ok |

3. Press and hold the WPS button on the wireless router.

»» Note

» For more on pressing the WPS button, see the wireless router manual.

4. Select OK on the printer within 2 minutes.

Press and hold the WPS button
on the wireless router,
then tap [OK] on the printer,

5. When the screen on the below appears, select OK.
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Connected to the wireless
router.

oK |

6. Press the HOME button.

The network connection setup is now complete.

—
)
Once connection is complete, appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Windows

Click @ (or ) on the 6 I - taskbar at the bottom of the screen, follow

the on-screen instructions to proceed with setup.

macOS

W

Click "™ onthe -m-m-;_m- 2% u= 8 Dock at the bottom of the screen, and follow the on-
screen instructions to proceed with setup.
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I WPS (PIN Code) Connection

1. Select Other connection types.
Wi-Fi setup
Easy wireless connect
Manual connect

WPS (Push button method)

[Gther connection types ]

2. Select WPS (PIN code method).

Other connection types

WPS (PIN code method)

3. Follow the on-screen instructions on a computer to set a PIN code on the wireless router.

PIN code method

Set the PIN below to the wireless
router within 2 minutes,

4. When the screen on the below appears, select OK.

Connected to the wireless
router.

oK |

350



5. Press the HOME button.

The network connection setup is now complete.

_—
)
Once connection is complete, appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Click @ (or @ ) on the I ... taskbar at the bottom of the screen, follow

the on-screen instructions to proceed with setup.

Windows

macOS

Click $ on the BEEECERCT8 Mgl ae 8 Dock at the bottom of the screen, and follow the on-
screen instructions to proceed with setup.
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I Manual connect

1. Select Manual connect.
Wi-Fi setup

Easy wireless connect

| Manual connect ]

WPS (Push button method)

Other connection types

2. Select your wireless router.

If you select a Wi-Fi router name, proceed to step 8 and continue with the settings.

If you select "Directly enter the wireless router name", proceed to step 3 and continue with the
settings.

If "Failed to connect to the wireless router." appears, see "Failed to connect to the wireless router."
Appears.

Select wireless router

Directly enter the wireless router
name

Search again

3. Select the input area.

Enter wireless router name

Up to 32 characters

~ Tap here to enter text.

4. Enter the wireless router name (SSID). Text entry is case-sensitive.
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abc def =]

ghi jkl mno
pars tuy WKyzZ B
1@ | 8- |
If you don't know your wireless router name, see the wireless router manual or contact its
manufacturer.
5. Select OK.

abc def x]
ghi jkl mno

pars tuy WXYZ
AZ1@ || o .@- ”"L\

6. Make sure the wireless router name (SSID) is correct.

7. Select OK.

Enter wireless router name

Up to 32 characters

T

8. The screen below will appear.

If "Connected to the wireless router." appears, the network does not require a password. Continue
from step 13.
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Enter password

characters

~ Tap here to enter text.

Show password OK

9. Select the input area.
10. Enter the password. Text entry is case-sensitive.
<>

abc def ]

ghi jkl mno
pars tuy WKYZ —
Asle| 4 e |
If you don't know the password for your wireless router, see the wireless router manual or contact its
manufacturer.
11. Select OK.

abc def =]

ghi jkl mno
pars tuv WXYZ
AZ1@ || o a- || K \
12. Select OK.

Enter password

© characters

kkkik

Show password OK
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13. When the screen on the below appears, select OK.

Connected to the wireless
router.

oK |

14. Press the HOME button.

The network connection setup is now complete.

_—
)
Once connection is complete, appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Windows

Click @ (or ) on the I . taskbar at the bottom of the screen, follow

the on-screen instructions to proceed with setup.

macOS

.ﬁz . L .
Click b on the BiEx ai & @a ¥ Dock at the bottom of the screen, and follow the on-

screen instructions to proceed with setup.
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I Easy wireless connect

1. Select Easy wireless connect.

Wi-Fi setup

[Easz.r wireless connect ]

Manual connect
WPS (Push button method)

Other connection types

2. Select Start.

Easy wireless connect is
available.

Do you want to connect to a
computer or smartphone now?

Start Cancel

3. When the printer preparation is complete, the screen below appears.

Follow the instructions on your
computer or smartphone.

@

4. Return to the application software and proceed with the setup.

Windows

Click @ (or @ ) on the

the on-screen instructions to proceed with setup.

.. taskbar at the bottom of the screen, follow
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macOS

Click ﬁ on the

screen instructions to proceed with setup.

~4= N Dock at the bottom of the screen, and follow the on-
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I Wireless Direct Connection

You can connect devices (e.g. computer, smartphone, or tablet) to the printer by two methods below.
* Wireless connection (connecting devices via a wireless router)
» Direct wireless connection (connecting devices directly without a wireless router)

This section describes Wireless Direct, which allows you to print by connecting the devices to the printer
directly.

32 Important
* You can connect up to 5 devices to the printer at the same time with Wireless Direct.
» Check the usage restrictions and connect the printer to the Wireless Direct.

= Restrictions

I Connecting a smartphone/tablet/computer to the printer

=

20 .

1. Enable Wi-Fi function on smartphone/tablet/computer.

Enable Wi-Fi in the Settings menu on your smartphone/tablet/computer.

For instructions on enabling the Wi-Fi function, refer to the instruction manual for your smartphone/
tablet/computer.

2. On the HOME screen, select the Network icon.

[r Plain Paper

D Plain Paper
E_ Replace Set cut
g paper *1" length

T @ & O

The icon displayed on the button varies depending on the current LAN status.

= Home Screen Menu Composition

3. Select Wireless Direct.

4. Select Connect to smartphone.
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5. Select iPhone/iPad to connect with an iPhone/iPad, Android device to connect with an
Android device, and Others to connect with other device.

« iPhonel/iPad
1. Select QR Code.

2. Scan the displayed QR code with the iPhone/iPad standard camera app or smartphone/

tablet app ©amen
The iPhone/iPad is connected to the printer.

»» Note

+ If the QR code cannot be read, press the Back button in the screen displayed QR code and
connect the printer from Connect to smartphone > Others.

» Android device
1. Select QR Code.
2. Scan the displayed QR code with the Android device in one of the following ways.

o Select network and Wi-Fi on the setting of Android device. Select QR code icon to the
right of the Add network at the bottom of the list of Wi-Fi connections and scan the QR
code.

o Scan the displayed QR code with the Android standard camera app or smartphone/

tablet app Camen
o Scan the displayed QR code with a QR code reading app.
The Android device is connected to the printer.
»>» Note

» Wireless Direct using QR code can be used with Android 5.0 or later.

* |t is available in Android 10 or later to scan QR code from setting and read QR code
with the Android standard camera.

» Depending on the smartphone/tablet, QR code may not be readable.

« If the QR code cannot be read, press the Back button in the screen displayed QR code
and connect the printer from Connect to smartphone > Others.

» Others
1. Select Next.

Network name (SSID) and Password are displayed.

»» Note

» To show the password, select Show password. To hide the password, select Hide
password.

» The password is required when connecting smartphone/tablet/computer to the printer.

2. Select "DIRECT-XXXX- ModelName" ("X" represents alphanumeric characters) on your
smartphone/tablet/computer.
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3. Enter Password on smartphone/tablet/computer.

The smartphone/tablet/computer is connected to the printer.

»» Note

« |f the printer is set to display a confirmation screen in Connection request
confirmation of Changing Wireless Direct Setting, when the wireless direct compatible
device connects to the printer, a confirmation screen asking for permission to connect
is displayed on the printer operation panel.

Make sure the name on the operation panel is the same as that of your wireless
communication device and select Yes.

You can print from your smartphone or tablet by installing the App. Download it from App Store and
Google Play.

= For iOS device
= For Android device

I Changing Wireless Direct Setting

=]

20 .

Change the settings for the Wireless Direct following the procedure below.

1. On the HOME screen, select the Network icon.

[r Plain Paper

D Plain Paper
Replace Set cut
-
D paper .[::Jk length

T |l O O

The icon displayed on the button varies depending on the current LAN status.

= Home Screen Menu Composition

2. Select Wireless Direct.

»» Note

» To change the Wireless Direct settings, you need to enable Wireless Direct in advance.

Select Enable/disable Wireless Direct on the menu screen displayed when selecting
Wireless Direct and enable Wireless Direct.
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3. Select a setting item.
Scroll down if necessary.
+ See settings
The setting values for using the printer with Wireless Direct are displayed.
» Change network name (SSID)
Change the identifier (SSID) for Wireless Direct.

The identifier (SSID) is the printer's name (device name) displayed on a Wi-Fi Direct compatible
device.

Follow the procedure below to change the identifier (SSID).
o To set manually
1. Select the displayed identifier (SSID).
2. Change using the keyboard that appears.
3. When you have finished making changes, select OK.
o To set automatically
1. Select Auto update.
2. Select Yes.
You can check the updated setting.

»» Note

» To show the password, select Show password. To hide the password, select Hide
password.

+ Change password
Change the password for Wireless Direct.
o To set manually
1. Select Change manually.
2. Select the displayed password.
3. Enter the new password (10 characters).
Change using the keyboard that appears.
4. When you have finished making changes, select OK.
o To set automatically
1. Select Auto update.
2. Select Yes.
You can check the updated setting.

»» Note

» To show the password, select Show password. To hide the password, select Hide
password.

» Connection request confirmation
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Change the confirmation screen setting when a Wi-Fi Direct compatible device is connecting to
the printer.

If you want the printer to display the screen to inform you a Wi-Fi Direct compatible device is
connecting to the printer, select ON.

22 Important

» To prevent an unauthorized access, we recommend you should select the setting to display
the confirmation screen.

* 2.4GHz/5GHz Switch
Change the frequency used for Wireless Direct.

While using Wireless Direct (2.4 GHz), the connection of nearby Bluetooth speakers may be
interrupted from time to time. In such a case, switching to 5 GHz will reduce the trouble.

»» Note

* If you change the Wireless Direct setting of the printer, also change the wireless router setting of the
device.

362



I Wired Connection

Follow the procedure below to setup a printer.

»» Note

» Refer to the following for notes when connecting to a wired LAN.

= Notes on Wired Connection

1. Make sure printer is turned on before starting wired connection setup.

If the power is on, the ON lamp will be lit.

32 Important
« If printer is performing cleaning, print head alignment, or other processes, wait for the process

to finish, before starting setup.

2. Press the HOME button.

. (@ S :
3 D
@ 0,

3. You will need an Ethernet cable (sold separately).

4. Connect the printer and a network device (router, etc.) with an Ethernet cable.

Do not connect to any other port.
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5. On the HOME screen, select the Network icon.
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Depending on the current LAN status, the icon displayed on the button may differ.

= Home Screen Menu Composition

6. Select Wired LAN.

LAN settings

EBOWi-Fi

Tl Wireless Direct

= Wired LAN

Advanced Print details

7. Select Enable/disable Wired LAN.
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Wired LAN

See settings

Enable/disable Wired LAN

8. Select Enable.

T Enable

Disable

9. Press the HOME button.

The network connection setup is now complete.

Once connection is complete, appears on the screen.

If performing setup with software, return to the software and proceed with the installation.

Windows

Click @ (or ) on the ﬁ I - taskbar at the bottom of the screen, follow

the on-screen instructions to proceed with setup.

macOS

Click "™ on the
screen instructions to proceed with setup.

2% u= W Dock at the bottom of the screen, and follow the on-
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I USB Connection

Connect the printer to a computer using a USB cable.

= \What Is USB Cable?
In USB connection, the printer is connected one-on-one to the computer.

If your computer is connected to LAN, you can use the printer with other devices by enabling the sharing
setting on your computer.

»» Note

* You can connect the printer to a computer via USB even when the printer is already connected to
another one via wired LAN.
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I Another Printer Found with Same Name

When the printer is found during setup, other printers with the same name may appear on the results
screen.

Select a printer with checking the printer settings against those on detection result screen.
Check the printer's MAC address or serial to select the correct printer from the results.

»» Note

+ Serial number may not appear on result screen.

@

Check the printer's MAC address and serial number by selecting
information.

(Information) > System

= System information
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I Printing Network Settings

Use the operation panel to print the printer's current network settings.

22 Important

» The network settings printout contains important information about your network. Handle it with care.

Items to Prepare
At least 10 sheets of unused A4 size plain paper

1. Load paper.

= | oading Sheets or Postcards into the Printer

2. On the HOME screen, select the Network icon.
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D Plain Paper
Replace Set cut
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The icon displayed on the button varies depending on the current LAN status.

= Home Screen Menu Composition

3. Select Print details.
4. Select Yes on displayed screen.

5. Select ON or OFF on displayed screen.

The printer starts printing network settings information.
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I Countermeasures against Unauthorized Access

This section describes countermeasures against an unauthorized access to the printer from outside. When
you use the printer via a network or you are an administrator, we recommend you read this section before
using the printer.

Four countermeasures below can be helpful against an unauthorized access.

= Specify a Private IP Address

= Restrict Communication Using Firewall or Wi-Fi Router
= Specify a Password for the Printer

= Apply higher security level for Wi-Fi connection

For some printers, operation logs are recorded on the printer itself.
= Downloading logs recorded on the printer

»>» Note

* As the setting procedure described below is an example, it may be different from that of your printer.
For details, refer to your printer's manual.

| Specity a Private IP Address

An IP address is a numeric label assigned to each device on the network. There are two types of IP
address. One is used for internet connection ("global IP address"), and the other is used for a local area
network such as an inhouse LAN ("private IP address").

If a global IP address is specified for the printer, many and unspecified users on internet can access to
the printer. As a result, you will face an increased risk of information leakage caused by an unauthorized
access from outside. On the other hand, if a private IP address is specified for the printer, users who can
access to the printer are confined to those on a local area network such as an inhouse LAN. Therefore,
we recommend you specify a private IP address for the printer.

The range of addresses used as a private IP address is shown below. Make sure whether a private IP
address is specified for your printer.
Range of private IP address

* 10.0.0.0 to 10.255.255.255
» 172.16.0.0 to 172.31.255.255
* 192.168.0.0 to 192.168.255.255

Procedure to check the IP address

Select Setup > Device settings > LAN settings on your printer to select a network connection method
and check the IP address. For the procedure to check and specify the IP address, refer to your printer's
manual.

»>» Note

 Establishing an environment to protect an access from outside using a firewall can reduce a risk of an
unauthorized access even though a global IP address is specified for your printer.
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I Restrict Communication Using Firewall or Wi-Fi Router

Firewall is a system which prevents an unauthorized access from an external network user to protect an
inhouse network against attack or intrusion.

Firewall enables your network to be protected against an unauthorized access by restricting a
communication from the specific external IP address which seems to have a risk.

A home use Wi-Fi router has a similar function. Be careful when you change the settings.

I Specify a Password for the Printer

Even if a malicious third party accesses to your printer by any chance, you can reduce a risk of
information leakage drastically by specifying a password to protect various information on your printer.

In addition, though the printer can be protected by specifying a password, it is important to manage the
specified password for security. Manage your password referring to the four points below. For details,
refer to your printer's manual.

» Be sure to change the default password.

» Change the password periodically.

* Do not use a password easy to guess for a third party.

» Do not tell a third party about the specified password casually.

»>» Note

» A password is not specified for some printers at the time of purchase. In this case, specify the
password for the printer.
» A password cannot be specified for some printers.

Password management using Remote Ul (User Interface)

Remote Ul is a software to access to the printer via a network by using a web browser. You can check the
printer status or settings on Remote Ul, which allows you to perform operations almost the same as those
you can on the operation panel of the printer.

Entering the printer's IP address or host name on the web browser displays the portal page of Remote Ul.
For the procedure to start up or operations of Remote Ul, refer to your printer's manual.

32 Important

» Do not access to a website while you are using Remote Ul on the web browser.

In addition, be sure to close the web browser when you leave your seat before you finish performing
settings, or when you have finished performing settings.

I Apply higher security level for Wi-Fi connection

When you use the printer via Wi-Fi, we recommend you apply a security method with higher security level
(e.g. WPA/WPA2).

For more on operations, refer to your printer's manual.
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I Downloading logs recorded on the printer

»>» Note

» This function may not be available depending on your region or printer model.
For some printers, logs are recorded on the printer when the following operations are performed. The
content of the logs varies depending on the printer being used.

* When authentication is performed using an administrator password
* When an administrator password is registered, changed, or deleted
* When time-related settings are changed

» When printer settings are imported/exported

* When all settings are reset (initialized)

You can download the logs in text file format by following the procedure below.
1. Open Remote UlI.
2. Select Printer settings.
3. Select Admin. Auth. Log Download.

4. Select Yes.

»>» Note

» To delete the logs, reset (initialize) all printer settings.

»» Note

» This web page contains information about several models. Depending on the specifications of the
printer you are using, some of the features described (device functions, connection method, operating
procedure and etc.) may not apply.
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I Network Status and Troubleshooting

Check the network status referring to LAN setting information on the touch screen.

= Printing Network Settings

Network Status

What to Do

Connected normally.

If you are unable to
print, see 1 on What
to Do.

1. If you are unable to print, check the items below:

» whether the computer is connected to Wi-Fi

» whether the firewall of your security software is enabled

» whether a privacy separator, SSID separator, or Network separation function is enabled
on your wireless router

If one of the above is enabled, disable it before setup.
» whether the network name (SSID) of the printer matches that of the router to connect

2. To change the network connection method (wired/wireless), change it on the printer's
network setting screen.

2 Note

» Turning off the band steering feature (determines the appropriate frequency band to con-
nect to when the number of devices connected increases and the 2.4 GHz and 5 GHz
frequency bands are congested) in your wireless router's settings may help.

* If the same SSID is set for both 2.4 GHz and 5 GHz, changing them to different SSIDs may
enable you to connect.

« If you can't connect to the network, use a USB connection.

Wi-Fi is disabled on
the printer.

Perform printer setup following the instructions of the manual.

Wired LAN connec-
tion is disabled.

Make sure the printer is connected to the router with the LAN cable.
If the LAN cable is loose, connect the cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN
side of the router.

Make sure the network devices (e.g. hub or router) are turned on.

IP address is not as-
signed.

If you specify the printer's IP address automatically, enable DHCP on the router.

If you specify the printer's IP address manually, the address is disabled because it is out of
the valid range. You specified (0.0.0.0) as the IP address, for example.

Specify the valid IP address.

The default gateway
is not specified.

Check the items below to communicate by hopping routers (e.g. using a cloud application).
» Make sure the device specified as the default gateway is turned on.

» Specify the default gateway address correctly.

Cannot connect to
the specified net-
work.

Check the status of the printer, network devices (e.g. wireless router), or smartphone/tablet.

« If they are turned off, turn them on.
* Make sure wireless signal is strong.

Monitor signal status and move the printer and wireless router as necessary.
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The security key specified for the wireless router may not match that you entered.
The security key is case-sensitive.

Enter the correct security key.

Make sure wireless
signal is strong.

Make sure the printer is not placed too far away from the wireless router.

Monitor signal status and move the printer and wireless router as necessary.

The number of con-
nected clients rea-
ches the upper limit.

Wireless Direct does not allow more than 5 devices to be connected.

If you add a device to connect, disconnect a device you do not use before adding the
device.

The signal to noise
ratio (S/N ratio) is
low.

There is a lot of noise from other devices.

Move the printer apart from other devices.

A link local address
is assigned.

* Perform printer setup again.

The security key specified for the wireless router may not match that you entered.
The security key is case-sensitive.

Enter the correct security key.

The specified net-
work name (SSID) is
left default value.

The network name (SSID) is not specified.

Enter the network name (SSID) specified for the destination.
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I Sharing the Printer on a Network (Windows)

When computers are used in a network environment, documents can be printed from multiple computers
that share a single printer.

Prind Servar
"'q.*
Metwork
L) o 2
£ i £ LY £ kY
Chent PC Client PC Client PC

» Setting Up a Shared Printer

This section describes how to set up the print server and the client.

»» Note

» The Windows versions of the computers connected to the network do not necessarily have to be the
same.

I Related Topic

= Restrictions on Printer Sharing

374



I Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the
print server.

1. Install the printer driver on the print server system

2. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

3. Click the icon for the model name of printer to be shared
Press the Alt key, and from the displayed File menu, select Printer properties -> Sharing tab.

3% Important

» When starting up the software and performing install or uninstall, a confirmation or warning dialog
box may appear.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

4. Set sharing

On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then
click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an
additional driver

-—

. Display the Devices and Printers, Printers, or Printers and Faxes window.

2. Select the printer icon, click Print server properties, and select the Drivers tab.
3. Click Add....

4. When the Add Printer Driver Wizard window is displayed, click Next.

5. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit
architecture, select x86. Then click Next.

6. Click Have Disk....

7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver,
specify the "inf" file, and click OK.
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¥ Note

« If the printer server is 32-bit, specify it as "xxxxxxx3.INF". If it is 64-bit, specify it as "xxxxxxx6.INF".

8. Select the printer to be used, and click Next.

¥ Note

« If an error message is displayed, select the other printer.

9. Click Finish

The setup on the print server system is complete. Next, set up the client systems.
6. On the client, open Explorer, and double-click the icon of the printer to be shared

7. Follow the window instructions, and install the printer driver

The setup on the client system is complete.
Even when you perform the setup on a different client, follow the same steps 6 and 7.
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I Restrictions on Printer Sharing

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

I Restriction on setting up printer sharing

If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:

1. Start Explorer on the print server and on the client with the different architecture, paste the
following path in the address bar, and press Enter on the keyboard:
Y%windir%\system32\driverstore\

2. Right-click the FileRepository folder, and click Properties.

3. On the Sharing tab, click Share.

4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder
that was shared in step 3, and click OK.

If there are multiples copies, select the file with the latest update date and time.

I Restrictions on sharing and using a printer

A print completion message may be displayed. To disable the message display, follow the procedure
below.
1. In the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers window of
the client system, select the printer, and click Print server properties on the command bar.
2. Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box cleared on the Ports tab, the bidirectional communication function of the print
server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.
When you print from a client system, the following functions cannot be used.

o The Edit Using PosterArtist feature of Page Layout in the Layout tab

When the functions on the Device Settings tab cannot be set properly from a client system, they may
be grayed out. In this case, change the settings from the print server.

When you change the settings of the print server, you should delete the icon of the shared printer
from the client system, and then specify the shared settings again in the client system.

If the same driver installed on the print server is also installed on the client, the network printer icon
may be created automatically.

If an error occurs when you print a document on a shared printer from a client, the error message

of the Canon |J status monitor is displayed on both the client and the print server. If a document is
printed out normally, the Canon IJ status monitor is displayed only on the client.
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I Maintenance

» Adjustments for Better Print Quality

Maintenance Procedure

@ Checking for Nozzle Clogging
@ Cleaning the Print Head
@« Deep Print Head Cleaning
« Adjustment to Straighten Lines and Align Colors
« Adjusting Different Colored Horizontal Streaks
@ Adjusting Line Length

» Replacing Consumables

« Refilling Ink Tanks

Checking Ink Level

Replacing the Print Head

Replacing the Maintenance Cartridge

Checking the Remaining Maintenance Cartridge Capacity

» Cleaning the Printer

Cleaning the Printer Exterior

Cleaning Inside the Printer

Cleaning Paper Feed Rollers

Performing Bottom Plate Cleaning
» Performing Maintenance Functions from Your Computer (Windows)
@ Cleaning the Print Heads
@ Printing a Nozzle Check Pattern
» Performing Maintenance Functions from Your Computer (macOS)
@« Opening Remote Ul for Maintenance
@ Cleaning the Print Heads

@ Printing a Nozzle Check Pattern
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» Other Maintenance
@ Preparing to Transfer the Printer
@« Reinstalling the Printer

« Firmware update
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I Adjustments for Better Print Quality

» Maintenance Procedure

» Checking for Nozzle Clogging

» Cleaning the Print Head

» Deep Print Head Cleaning

» Adjustment to Straighten Lines and Align Colors
« Automatic Adjustment to Straighten Lines and Align Colors
@ Manual Adjustment to Straighten Lines and Align Colors

» Adjusting Different Colored Horizontal Streaks
« Automatically Adjusting Different Colored Horizontal Streaks
« Manually Adjusting Different Colored Horizontal Streaks

» Adjusting Line Length
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I Maintenance Procedure

If print results are blurred, colors are not printed correctly, or print results are unsatisfactory (e.g. misaligned
printed ruled lines), perform the maintenance procedure below.

3% Important

* Do not rinse or wipe the print head. This can cause trouble with the print head.

»>» Note
» Check if ink remains in the ink tanks.

= Checking Ink Level

* Increasing the print quality in the printer driver settings may improve the print result.

= Changing the Print Quality and Correcting Image Data (Windows)
= Changing the Print Quality and Correcting Image Data (macOS)

I When the Print Results Are Blurred or Uneven:

Print the nozzle check pattern.

From the printer

= Checking for Nozzle Clogging

From the computer

= Printing a Nozzle Check Pattern (Windows)
= Printing a Nozzle Check Pattern (macOS)

Examine the nozzle check pattern.

If there are missing lines or horizontal white streaks in the pattern:
[ Step3 | Clean the print head.

From the printer

= Cleaning the Print Head

From the computer

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (macOS)

After cleaning the print head, print and examine the nozzle check pattern: =+ Step1

If the problem is not resolved after performing from step 1 to step 3 twice:

“v""
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Clean the print head deeply.

From the printer

= Deep Print Head Cleaning

From the computer

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (macOS)

After deep print head cleaning, print and examine the nozzle check pattern: = Step 1

When you have performed the procedure until step 4 and the problem has not been resolved, turn off the
power and clean the print head deeply again after 24 hours. Do not unplug the power cord when turning off the
power.

If the problem is still not resolved, replace ink in print head.

32 Important

* Replace ink in print head consumes a great amount of ink. Frequent replace ink in print head can rapidly
consume ink, so replace ink in print head only when necessary.

» Be sure to check the remaining ink level before replacing ink in print head.

= Replacing the Ink in the Print Head

If the symptom still persists, the print head may be defective. Replace the print head.

= Replacing the Print Head

When the Print Results Are Not Even such as the Ruled Lines Are
Misaligned:

Align the print head.

= Automatic Adjustment to Straighten Lines and Align Colors
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I Checking for Nozzle Clogging

If the print is blurred or has different color threading, print a nozzle check pattern to see if each nozzle of the
print head is not clogged.

»» Note

« If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Refill the ink tanks
whose ink is low.

= Refilling Ink Tanks

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
One unused sheet of A4 or larger size paper

1. Load paper.

= | oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

2. Select : (Setup) on the HOME screen.

3. Select i(a, Maintenance.
4. Select Nozzle Check.
5. Check message and select Yes.

6. Select Roll paper or Top feed.

The nozzle check pattern will be printed and two pattern confirmation screens will appear on the touch
screen.

7. Check the print result.

Check if there are missing lines in the pattern C or horizontal streaks in the pattern D.
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A B

A: No missing lines/No horizontal streaks
B: Lines are missing/Horizontal streaks are present

. Select the pattern that is closer to the printed nozzle check pattern on the confirmation
screen.

Which pattern is closest to your Which pattern is closest to your
printed pattern? printed pattern?
[ e e — |
All A All A
Also B Also B

For A (no missing lines or no horizontal streaks) in both the pattern C and pattern D:

The cleaning is not required. Select All A, confirm the message, then select OK.

The screen will return to the Maintenance screen.

For B (lines are missing or horizontal streaks are present) in the pattern C or pattern D, or in both
patterns:

The cleaning is required. Select Also B, then go to next step.
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10.

1.

12.

If the pattern D or any color in the pattern C is not printed:

I I (Example: Magenta pattern is not printed)

The cleaning is required. Select Also B, then go to next step.

c
L]

. Select Yes on the cleaning confirmation screen.

The printer starts cleaning the print head.

3% Important

» Do not perform any other operations until the printer completes the cleaning of the print head.

Check message and select Yes.

Select Roll paper or Top feed.

A nozzle check pattern is printed and two pattern confirmation screens appear on the touch screen.

Repeat steps 7 through 11.

22 Important

« If there is no improvement after repeating the cleaning process twice, perform Deep Cleaning.

= Deep Print Head Cleaning
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I Cleaning the Print Head

Clean the print head if lines are missing or if horizontal streaks are present in the printed nozzle check
pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the print head
consumes ink, so clean the print head only when necessary.

22 Important

» When performing the print head cleaning, check the free space in the maintenance cartridge. If there
is not enough free space, replace with the new maintenance cartridge. In the case of shortage of free
space in the maintenance cartridge, a message is displayed and the cleaning cannot be performed.

= Replacing the Maintenance Cartridge

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
One unused sheet of A4 or larger size paper

1. Load paper.

= | oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

2. Select : (Setup) on the HOME screen.

3. Select i(a, Maintenance.
4. Select Cleaning.
5. Check message and select Yes.

6. Select All colors, Color or BK.
The printer starts cleaning the print head.

Do not perform any other operations until the printer completes the cleaning of the print head.
7. Check message and select Yes.

8. Select Roll paper or Top feed.

The nozzle check pattern will be printed.

9. Check the print result.
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10.

Check if there are missing lines in the pattern C or horizontal streaks in the pattern D.

A B

BEE | EH

BK

- N S N e S S
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A B

A: No missing lines/No horizontal streaks
B: Lines are missing/Horizontal streaks are present

Select the pattern that is closer to the printed nozzle check pattern on the confirmation
screen.

Which pattern is closest to your Which pattern is closest to your
printed pattern? printed pattern?
[ e e — |
All A All A
Also B Also B

For A (no missing lines or no horizontal streaks) in both the pattern C and pattern D:

The cleaning is not required. Select All A, confirm the message, then select OK.

The screen will return to the Maintenance screen.

For B (lines are missing or horizontal streaks are present) in the pattern C or pattern D, or in both
patterns:

The cleaning is required. Select Also B, then go to next step.
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If the pattern D or any color in the pattern C is not printed:

I I (Example: Magenta pattern is not printed)

The cleaning is required. Select Also B, then go to next step.

c
L]

11. Select Yes on the cleaning confirmation screen.
The printer starts cleaning the print head.

2% Important

* Do not perform any other operations until the printer completes the cleaning of the print head.

12. Check message and select Yes.

13. Select Roll paper or Top feed.

A nozzle check pattern is printed and two pattern confirmation screens appear on the touch screen.

14. Repeat steps 9 through 13.
22 Important
« If there is no improvement after repeating the cleaning process twice, perform Deep Cleaning.

= Deep Print Head Cleaning
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I Deep Print Head Cleaning

If print quality does not improve by the standard cleaning of the print head, clean the print head deeply.
Cleaning the print head deeply consumes more ink than the standard cleaning of the print head, so clean
the print head deeply only when necessary.

22 Important

» When performing the print head deep cleaning, check the free space in the maintenance cartridge. If
there is not enough free space, replace with the new maintenance cartridge. In the case of shortage of
free space in the maintenance cartridge, a message is displayed and the cleaning cannot be performed.

= Replacing the Maintenance Cartridge

Items to Prepare

When Using Rolls
Unused roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
One unused sheet of A4 or larger size paper

1. Load paper.

= | oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

2. Select : (Setup) on the HOME screen.

3. Select i(a, Maintenance.
4. Select Deep Cleaning.
5. Check message and select Yes.

6. Select All colors, Color or BK.
The printer starts cleaning the print head deeply.
32 Important

» Do not perform any other operations until the printer completes the deep cleaning of the print
head.

7. Check message and select Yes.

8. Select Roll paper or Top feed.

The nozzle check pattern will be printed.
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9. When the completion message appears, select OK.

10. Check the print result.

Check if there are missing lines in the pattern C or horizontal streaks in the pattern D.
b B

BEEE | EE

BK

) S e S S S
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A B

A: No missing lines/No horizontal streaks
B: Lines are missing/Horizontal streaks are present

22 Important

« If the problem is not resolved, turn off the power and clean the print head deeply again after 24 hours.
Do not unplug the power cord when turning off the power.

+ If there is no improvement after repeating Deep Cleaning twice, perform Replace Ink in Print Head.

= Replacing the Ink in the Print Head
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I Replacing the Ink in the Print Head

Performing Replace Ink in Print Head consumes a lot of ink.The more frequently it is performed, the faster
ink is consumed.Perform only if one of the following applies.

1. Error 5200 occurs repeatedly.

2. Repeated deep cleaning does not improve poor printing.

22 Important

 Before performing Replace Ink in Print Head, check the remaining ink level of all colors.

= Checking Ink Level

* When performing an Replace Ink in Print Head, check the free space of the maintenance cartridge.
Replace Ink in Print Head consumes a lot of ink, and the consumed ink is discharged to the
maintenance cartridge. If the free space is low, replace it with a new maintenance cartridge. If the
available capacity of the maintenance cartridge is low, a message is displayed and Replace Ink in Print
Head cannot be performed.

= Replacing the Maintenance Cartridge

* Replace Ink in Print Head cannot be performed consecutively. It can be performed after the following
time has passed.

Second: after 1 hour

Third: after 24 hours

1. Select o (

Setup) on HOME screen.

2. Select i(ﬁ, (Maintenance).

3. Select Replace Ink in Print Head.

4. Check displayed message and select OK.
5. Check displayed message and select Yes.
6. Select All colors, Color or BK.

7. Check displayed message and select Yes.
The printer starts replacing the ink in the print head.

3% Important

* Do not perform any operations while replacing the ink in the print head is in progress.
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»» Note

« If print results do not improve after performing Replace Ink in Print Head, the print head may be at the
end of its service life. Replace the print head.

= Replacing the Print Head
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| Adjustment to Straighten Lines and Align Colors

» Automatic Adjustment to Straighten Lines and Align Colors

» Manual Adjustment to Straighten Lines and Align Colors
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I Automatic Adjustment to Straighten Lines and Align Colors

If vertical lines on the printed document are misaligned or a color shift occurs, adjust the print head position.

When Print Head Alignment - Auto is performed, the adjustment pattern will be printed and the print head
position is automatically adjusted based on the print result.

.

22> Important

 Since the adjustment result depends on the type of paper, adjust with the paper used for printing.

» Paper with high transparency, and photo paper with a glossy finish cannot be used.

¢ Cut sheets cannot be used.

»>» Note

+ If the remaining ink level is low, the print head alignment sheet will not be printed correctly. Refill the ink
tanks whose ink is low.

= Refilling Ink Tanks

Items to Prepare
Roll at least 11.69 in. (297.0 mm) wide

1. Load paper.

= | oading Rolls in the Printer

3% Important

» Make sure to match the paper loaded in the printer with the paper type setting in the printer. If the

loaded paper is different from the paper type setting in the printer is different, the print head will
not be adjusted correctly.

2. Select : (Setup) on the HOME screen.

3. Select i‘% Maintenance.

4. Select Print Head Alignment - Auto.

5. Check message and select Yes.

An adjustment pattern is printed and the print head position is automatically adjusted.
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6. When the completion message appears, select OK.

»» Note

« If the print results are still not satisfactory after adjusting the print head position as described above,
adjust the print head position manually.

= Manual Adjustment to Straighten Lines and Align Colors

+ If adjusting the print head with special paper does not produce the expected results, try again with
different paper, or manually adjust the print head.

= Manual Adjustment to Straighten Lines and Align Colors

» To print and check the current head position adjustment values, select Print the Head Alignment
Value on the Maintenance screen.
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I Manual Adjustment to Straighten Lines and Align Colors

If vertical lines on the printed document are misaligned or a color shift occurs, adjust the print head position.

When Print Head Alignment - Manual is performed, the adjustment pattern will be printed. Check the print
result and enter the setting value.

5

22 Important

» Since the adjustment result depends on the type of paper, adjust with the paper used for printing.

3> Note
» Using automatic print head adjustment is recommended.

= Automatic Adjustment to Straighten Lines and Align Colors

Items to Prepare

When Using Rolls
Roll at least 11.69 in. (297.0 mm) wide

When Using Sheets
Two sheets of A4 / Letter / A3 size paper

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

2. Select : (Setup) on the HOME screen.

3. Select i‘% Maintenance.
4. Select Print Head Alignment - Manual.
5. Check message and select Yes.

6. Select Roll paper or Top feed.

The print head alignment pattern will be printed.

7. When Did the patterns print correctly? appears, make sure pattern was printed correctly,
and if so, select Yes.
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8. Check message and select Next.

9. Examine first patterns and select A. In column A, find pattern in which stripes are least
noticeable, and then select the number of that pattern.

Print Head Alignment - Manual
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22 Note
- If all patterns look different, choose the pattern in which vertical stripes are least noticeable.

Subtle vertical stripes

Noticeable vertical stripes

T

« If all patterns look different, choose the pattern in which horizontal stripes are least noticeable.
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Subtle horizontal stripes

Noticeable horizontal stripes

10. Repeat these steps until you have finished entering pattern numbers for columns B to L,
and then select OK.

11. Check message and select OK.

The second set of patterns is printed.

12. Examine second patterns and select M. In column M, find pattern in which stripes are least
noticeable, and then select the number of that pattern.

T TR

. =
B R o= O = R oG A

= e o=

W
TR

13. Repeat these steps until you have finished entering pattern numbers for columns N to S,
and then select OK.

14. When confirmation message appears, select OK.
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I Adjusting Different Colored Horizontal Streaks

» Automatically Adjusting Different Colored Horizontal Streaks

» Manually Adjusting Different Colored Horizontal Streaks
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I Automatically Adjusting Different Colored Horizontal Streaks

If printed images are affected by banding in different colors across the sheet, execute Adjust print quality
for automatic adjustment of the paper feed amount.

The printer prints and reads a test pattern for automatic adjustment of the feed amount.
22 Important
* When using highly transparent media, use manual adjustment.

= Manually Adjusting Different Colored Horizontal Streaks

¢ Cut sheets cannot be used.

»>» Note

* We recommend executing the adjustment if you have changed the paper type or paper size.
» Always check the Set priority values.

= Paper feed adjustment

+ Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.
= Adjusting Line Length

» This may take some time, depending on the type of paper.

Items to Prepare
Roll at least 11.69 in. (297.0 mm) wide

Follow the procedure below to adjust.

1. Load paper.

= Loading Rolls in the Printer

2. Select : (Setup) on the HOME screen.

3. Select i(% Maintenance.

4. Select Paper feed adjustment.
5. Select Adjust print quality.

6. Check message and select OK.
7. Select Auto.

8. Select Roll paper to adjust.

A test pattern is printed for adjustment and adjustment is finished.
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»» Note

* Depending on the type of paper, horizontal streaks may not improve. If the horizontal streaks are not
improved, adjust it manually.

= Manually Adjusting Different Colored Horizontal Streaks
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I Manually Adjusting Different Colored Horizontal Streaks

If printed images are affected by banding in different colors, execute Adjust print quality for adjustment of
the paper feed amount.

Use manual adjustment with highly transparent media.
Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

> Note

* We recommend executing the adjustment if you have changed the paper type or paper size.
» Always check the Set priority values.

= Paper feed adjustment

* Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.
= Adjusting Line Length

Items to Prepare
Roll at least 11.69 in. (297.0 mm) wide

Follow the procedure below to adjust.

1. Load paper.

= Loading Rolls in the Printer

2» Important

» Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

¢ Cut sheets cannot be used.

2. Select : (Setup) on the HOME screen.

3. Select i(% Maintenance.

4. Select Paper feed adjustment.
5. Select Adjust print quality.

6. Check message and select OK.
7. Select Manual.

8. Select Roll paper to adjust.

Test pattern A is printed for manual adjustment.
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9. Examine test pattern A for adjustment. Determine pattern in which banding is least
noticeable.

»» Note

+ If banding seems least noticeable in two patterns but you cannot decide which one is better,
choose an intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or
12 is better.

10. Select number you decided.

Test pattern B is printed for manual adjustment.

11. Examine test pattern B for adjustment. Determine pattern in which banding is least
noticeable.

12. Select number you decided.

The adjustment value is now registered, and adjustment is complete.
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I Adjusting Line Length

To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust feed length to
adjust the amount that paper is advanced.

There are two options in Adjust feed length : Print alignment pattern and Change adjustment values.

»>» Note

* We recommend executing the adjustment if you have changed the paper type or paper size.
* Always check the Set priority values before adjustment.

= Paper feed adjustment

Items to Prepare
* Roll at least 11.69 in. (297.0 mm) wide
» High-precision ruler

Follow the procedure below to adjust.

1. Load paper.

= | oading Rolls in the Printer

2% Important

» Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

¢ Cut sheets cannot be used.

2. Select : (Setup) on the HOME screen.

3. Select i(a, Maintenance.
4. Select Paper feed adjustment.
5. Select Adjust feed length.

6. Select Print alignment pattern or Change adjustment values.
* If you select Print alignment pattern:
The test pattern is printed for you to measure the scale and calculate the discrepancy.

The scale bar prints "Millimeter" in 50 mm increments and "Inch" in 1-inch increments.

Billimeter Inch
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* If you select Change adjustment values:

No test pattern is printed. Instead, you will measure a document already printed to determine the
discrepancy.

7. Select amount of discrepancy.

If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative
value. The feed amount can be adjusted in 0.02% increments.

405



I Replacing Consumables

» Refilling Ink Tanks

» Checking Ink Level

» Replacing the Print Head

» Replacing the Maintenance Cartridge

» Checking the Remaining Maintenance Cartridge Capacity

406



| Refilling Ink Tanks

When remaining ink cautions or errors occur, the message will appear on the touch screen to inform you of
the error. Check the remaining amount of ink and refill the ink if necessary.

»» Note

 For information on how to check the remaining ink level, see "Checking Ink Level".

= Checking Ink Level

» For precautionary notes on handling ink bottles, see "Notes on ink bottles".

= Notes on ink bottles

I Refilling Procedure
When you refill ink tanks, follow the steps below.

32 Important

* Please ensure the printer remains flat after initial setup and is NOT turned upside down or on its side,
as ink in the printer may leak.

1. Check that printer is turned on.

= Checking that Power Is On

2. Open the ink tank cover (A).

3. Open the ink tank inner cover (B) of the ink tank to be refilled.

407



32 Important

+ Carefully open the tank cap of the ink tank. Ink on the inside of the tank cap may spatter when
opening it.

5. Hold the ink bottle upright and gently twist the bottle cap (D) to remove.

22 Important

» Do not shake the ink bottle. Ink may spatter when opening the cap.

6. Refill the ink tank.

Aligning the ink bottle's tip with the ink tank's inlet (E), slowly stand the bottle upside down, and push
the bottle into the inlet.
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The ink tank is refilled. Support the bottle with your hand so that it does not fall.

32 Important

» Make sure that each color of ink tanks is filled with corresponding color of ink bottles.
« If ink does not pour into the ink tank, slowly remove and insert the ink bottle.
* Pouring stops automatically when the ink tank is full.

»» Note

* You can check the ink status from the touch screen.

7. When ink refilling is complete,remove the ink bottle from the inlet.
Hold up the ink bottle slightly and remove the bottle from the inlet while slowly tilting it.

3% Important

» Do not leave ink bottles in ink tanks.

+ Close the bottle cap of the ink bottle completely and store the ink bottle upright.

» Discard empty ink bottles in compliance with local laws and regulations regarding disposal of
consumables.

8. Close the tank cap of the ink tank.

Make sure the tank cap is completely inserted.
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10. Close the ink tank cover.

23%» Note

« If the error message appears on the touch screen after the ink tank cover is closed, take appropriate
action.
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I Notes on ink bottles

32 Important

» Keep out of reach of children.

* Do not drink ink.

« If ink is accidentally licked or swallowed, rinse out your mouth or drink one or two glasses of water
and obtain medical advice immediately. If ink gets into your eyes, flush them with water right away,
and obtain medical advice immediately.

* If ink gets on your skin, wash the area with soap and water immediately. If irritation to your skin
persists, obtain medical advice immediately.

* When you store ink bottles, close bottle caps completely and place bottles in standing position. If the
ink bottles are laid down, ink may leak.

* When refilling ink tanks, take sufficient care to prevent ink from spattering onto surroundings.

 Ink may stain clothes or other belongings permanently. Washing may not remove ink stains.

» Do not use ink bottles and ink contained therein except to refill tanks of printers specified by Canon.

» Do not leave ink bottles in areas exposed to high temperature, such as near fire or a heater or in a
car. Bottles may warp and cause ink leakage or ink may become poor quality.

» Do not subject ink bottles to impacts. Ink bottles may be damaged or bottle caps may come off by
such impact, and ink may leak.

» Do not transfer ink to other containers. This may result in accidental ingestion, inappropriate use, or
poor ink quality.

» Do not mix ink with water or other ink. This may damage the printer.

» Once an ink bottle has been opened, do not leave it with bottle cap off. Ink will dry out, possibly
preventing proper operation of the printer when an ink tank is refilled using this bottle.

» To obtain the optimum print quality, it is recommended to refill the ink about once a year until the ink
level display on the operation panel shows that the ink level is full.

» Handling of malfunctions caused by using ink other than genuine Canon ink is not covered by the
warranty.

» The use of ink other than genuine Canon ink may cause degradation in printing quality or damage to
the print head.

»>» Note

 Color ink may be consumed even when printing a black-and-white document or when black-and-
white printing is specified. Every ink is also consumed in the standard cleaning and deep cleaning of
the print head, which may be necessary to maintain the performance of the printer.

When ink runs low, promptly refill it.

= |nk Tips
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I Checking Ink Level

You can check the remaining amount of ink on the touch screen.

1. Select o (

(1]

2. Select 4 Estimated ink levels.

Information) on the HOME screen.

The Current estimated ink levels screen is displayed.

Current estimated ink levels

EK C M Y

How to set Ink model no.

When the ink level is low, ® is displayed above the ink level on the touch screen, and @ is displayed
when ink runs out.

3% Important

» Before performing large-format printing that consumes a large amount of ink, it is recommended to
refill the ink until the ink level display shows that the ink level is full.

= Refilling Ink Tanks

»» Note

* When a message appears instructing you to check the remaining ink level, or when performing
head cleaning that consumes a large amount of ink, check the remaining ink level and refill ink as
necessary.

= Refilling Ink Tanks

* To ensure you receive premium print quality and to help protect your print head, a certain amount
of ink remains in the ink tank when the printer indicates to refill the ink tank. The estimated page
yields of the ink bottle do not include this amount.

* Ink flows from the ink tanks to the inside of the printer. Ink may seem to run out fast due to this
procedure when you start using the printer or after transporting it.

» Select Ink model no. > Order ink now for information on where to purchase ink.
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I Replacing the Print Head

If the touch screen indicates to replace the print head or if instructed to do so by your Canon dealer, replace
the print head.

I Compatible Print Head

For details on compatible print head, see Print Head.

I Precautions When Handling Print Head

Take the following precautions when handling the print head.

A\ Caution

» For safety, keep print head out of the reach of children.

« Ifink is accidentally ingested, contact a physician immediately.

» Do not touch the print head immediately after printing. The print head becomes extremely hot, and
there is a risk of burns.

3% Important

» There may be ink around the nozzles of the print head you remove. Handle the print head carefully
during replacement. The ink may stain clothing.

» Do not open the print head pouch until immediately before installation. After removing the print head
from the pouch, install it right away. If the print head is left as is after the pouch is opened, the
nozzles may dry out, which may affect printing quality.

I How to Replace Print Head

A\ Caution

* When replacing the print head immediately after printing, wait a few minutes before replacing it. The
metal parts of the print head become hot during printing, and there is a risk of burns from touching
these parts.

32 Important

* Your hands may become dirty during print head replacement. Use the gloves provided in the box with
the new print head for replacement.

»>» Note

« Refill the ink tanks when ink levels are low.

= Refilling Ink Tanks

* Prepare a new maintenance cartridge when the remaining capacity of the maintenance cartridge is
low.

= Replacing the Maintenance Cartridge

413



. Select : (Setup) on the HOME screen.

. Select i‘.' Maintenance.
. Select Head Replacement.

. Check message and select Start.
Draining ink from the print head starts.

22 Important

» When the cover is ready to be opened, instructions will be displayed on the touch screen. Do
not open the cover before these instructions are displayed.

. Open the access cover on the left side of the printer.

. If the print head locking cover and print head lock lever are dirty, use a damp cloth that
you have wrung out completely to wipe them clean.
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32 Important

» Do not touch the linear scale (A) and carriage rail (B). Touching these may cause malfunction.

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so
as not to scratch the surface.

7. Open print head lock lever firmly toward the front while holding its center (C) with your
fingertip.

8. Grab grip (D) and open print head locking cover.
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32 Important

» Never touch the metal contacts of the carriage. Furthermore, do not allow any dirt or debris to
become adhered to the metal contacts of the carriage. These may damage the printer.

23> Note

+ Dispose of the used print head in accordance with local regulations.

10. Remove print head that was in case from pouch.
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11. Remove tape used to secure print head.

12. Hold the left and right grips, and remove the print head from the case.

32 Important

» Always carry the print head by holding its right and left grips. Never touch nozzle (F) or metal
contacts (G). This may damage the print head and affect printing quality.
» Never touch the ink holes (H). This may affect printing quality.

» The print head contains ink to protect the nozzle. If ink accidentally spills, wipe off the ink with a
dry cloth.

* If you need to put a print head somewhere temporarily before installation, do not set it down
with the nozzles and metal contacts facing down. If the nozzles or metal contacts are damaged,
it may affect the printing quality.
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13. Turn ink holes (H) toward the front and insert print head into carriage.

Insert the print head all the way into the carriage, while taking care to keep the ink supply unit from
touching the carriage.

When inserting the print head into the carriage, make sure that the print head lock lever is firmly
opened toward the front of the printer.

3% Important

» Do not force the print head. The carriage may be damaged.

14. Grasp tab (D) of print head locking cover and lower it to front to lock print head.
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16. Close the access cover on the left side of the printer.

Ink now fills the print head.

3% Important

* While ink is being filled, definitely do not remove the maintenance cartridge. Ink may leak out.
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I Replacing the Maintenance Cartridge

I Compatible Maintenance Cartridges

For details on compatible maintenance cartridge, see Maintenance Cartridge.

I Precautions When Handling Maintenance Cartridge
Take the following precautions when handling the maintenance cartridge.

A\ Caution

» For safety, keep maintenance cartridge out of the reach of children.
« Ifink is accidentally ingested, contact a physician immediately.

3% Important

« If the displayed message indicates that the maintenance cartridge is nearly full, promptly obtain a
new one. If the maintenance cartridge becomes full, an error message is displayed and the printer
cannot be printed until it is replaced with a new one.

» Do not remove the maintenance cartridge except to replace it. Ink may leak out.

» Do not remove a maintenance cartridge during initialization immediately after turning on the printer,
during print head cleaning, while ink is being drawn out, or during initialization immediately after
replacing the maintenance cartridge.

The maintenance cartridge may become damaged or ink may leak out.

» To prevent ink from leaking from a used maintenance cartridge, avoid dropping the cartridge or
storing it at an angle. Otherwise, ink may leak and cause stains.
» Handle the maintenance cartridge carefully during replacement. The ink may stain clothing.

I How to Replace a Maintenance Cartridge

If a message indicates you should replace a maintenance cartridge, check the message details and go to
step 6.

1. Select o

&
2. Select ¥ Maintenance cart. info..

(Information) on the HOME screen.

3. Select Replace.
4. Select Yes.

5. Check message and select OK.

Instructions for the maintenance cartridge replacement procedure appear on the touch screen.
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6. Open box, and remove plastic bag and maintenance cartridge.

22 Important

» Do not touch the terminal (A) or opening (B) of the maintenance cartridge.

8. Pull out the maintenance cartridge.

Hold the upper portion of the maintenance cartridge with your hands so that its bottom does not touch
the floor or desk.
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32 Important

» A used maintenance cartridge is heavy. Always grasp the cartridge firmly and keep the
cartridge level during removal. If you drop a used maintenance cartridge or store it at an angle,
ink may leak and cause stains.

9. Put used maintenance cartridge in supplied plastic bag and store on flat surface.

22 Important

» Be careful not to drop or place the removed maintenance cartridge on a desk or something. Dirt
on the bottom may adhere to it or the ink inside may be scattered.

* Do not turn the removed maintenance cartridge upside down to prevent leakage of ink.

» Put the used one immediately into the plastic bag attached to the new maintenance cartridge
and seal the bag by tying the opening tightly to prevent the ink from leaking.
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» Do not put your hands inside the printer, as ink may adhere to your hands.

10. Wipe away any soiling on the maintenance cover.

¢/
N

22 Important

» When wiping the maintenance cover, support the left side of the cover.

11. Keeping the new maintenance cartridge level, insert it all the way in.

The maintenance cartridge is initialized.
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32 Important

» Do not remove the maintenance cartridge during initialization immediately after replacing the
maintenance cartridge. The maintenance cartridge may become damaged.

12. Close the maintenance cover.
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I Checking the Remaining Maintenance Cartridge Capacity

1. Select o (

&
2. Select ¥ Maintenance cart. info..

Information) on the HOME screen.

The Maintenance cartridge usage screen appears.

Maintenance cartridge usage

®

Replace

When @ appears on the touch screen, the maintenance cartridge is nearly full. Prepare a new one.
2> Note
» To replace the maintenance cartridge, select Replace.

= Replacing the Maintenance Cartridge
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I Cleaning the Printer

» Cleaning the Printer Exterior
» Cleaning Inside the Printer
» Cleaning Paper Feed Rollers

» Performing Bottom Plate Cleaning
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I Cleaning the Printer Exterior

Clean the printer regularly to maintain better printing quality and help prevent problems.

To ensure a comfortable working environment, clean the printer exterior about once a month.

1. Turn printer off.

= Turning off the printer

2. Unplug power cord from outlet.

A Caution

« Always turn off the printer and unplug the power cord before cleaning or maintenance.
Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the
printer.

3. Wring out soft cloth with water or watered-down neutral detergent, and use it to wipe off dirt.

Clean the printer exterior and the power cord plug.

A Warning

¢ Never use flammable solvents such as alcohol, benzine, or thinner. If these substances come into
contact with electrical components inside the printer, there is a risk of fire or electrical shock.

2% Important

« |If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the output guide even if it does not appear dirty, because it may actually be covered with
paper dust.

= Cleaning Inside the Printer

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as
not to scratch the surface.
* When neutral detergent is used, be sure to wipe off the detergent with soft cloth with water.

4. After cleaning, dry with a soft dry cloth.

5. Plug power cord into outlet.
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I Cleaning Inside the Printer

Clean inside the printer about once a month to maintain better printing quality and help prevent problems.
Also clean inside the printer in the following situations to ensure optimal operation.

« If the printed surface or the underside of paper is dirty after printing
* When a roll paper runs out

« After printing on small paper

« After printing on paper that generates a lot of cutting debris

« After changing the roll paper

+ After printing on paper that generates a lot of paper dust

32 Important

« If the platen inside the printer becomes dirty, it may soil the underside of paper. We recommend
cleaning the platen after printing on small paper.

« If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the output guide even if it does not appear dirty, because it may actually be covered with
paper dust.

» Cleaning may not be performed if there is paper in the cleaning area. Remove the paper.

1. Select o (

Setup) on the Home Screen.

2. Select i‘% Maintenance.
3. Select Platen cleaning.

4. Select Yes.
2 Important

* When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not
open the cover before these instructions are displayed.

5. Open the access cover on the right side of the printer.
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2% Important

* Do not touch the linear scale (A) or carriage rail (B). Touching these may cause malfunction.

6. Clean the inside of the right side of the printer with a well wrung-out damp cloth.

Wipe off ink stains and paper dust (such as cutting scraps) on the platen (C), paper retainer (D), and
output guide (E).

/A Warning

¢ Never use flammable solvents such as alcohol, benzine, or thinner. If these substances come into
contact with electrical components inside the printer, there is a risk of fire or electrical shock.
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2% Important
* Do not use a dry cloth to wipe the inside of the printer. This may create a static charge, which may
attract dust and affect the printing quality.
* Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as

not to scratch the surface.

« |If the protruding part of the platen is badly dirty, gently wipe off the ink stain on the protruding part
with a cotton swab.

7. After wiping off the inside of the right side of the printer, select OK.

8. Close the access cover on the right side of the printer.

3% Important

* When the cover is ready to be opened, instructions will be displayed on the touch screen. Do not
open the cover before these instructions are displayed.

9. Open the access cover on the left side of the printer.
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10. Clean the inside of the left side of the printer with a well wrung-out damp cloth.

Follow the same procedure for cleaning the inside of the left side of the printer as for cleaning the right
side.

11. After wiping off the inside of the left side of the printer, select OK.

12. Close the access cover on the left side of the printer.

If the printed document is still dirty after performing these operations, the part that cannot be wiped off may
be dirty. The dirt may be removed by passing a blank sheet of paper, so perform the following operations.

« If the roll paper is dirty, perform Set cut length several times.

= Cutting Roll Paper

« If the sheet is dirty, perform Bottom Plate Cleaning.

= Performing Bottom Plate Cleaning
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I Cleaning Paper Feed Rollers

If the paper feed roller is dirty or paper powder is attached to it, paper may not be fed properly. In this
case, clean the paper feed roller. Cleaning will wear out the paper feed roller, so perform this only when
necessary.

You need to prepare: three sheets of A4 or Letter-sized plain paper

1.

9.

Select 0 (

Setup) on the Home Screen.

. Select i(% Maintenance.
. Select Roller Cleaning.

. Select Yes.

Follow the instructions to remove any paper from the top feed.

. Select OK.

The paper feed roller will rotate as it is cleaned without paper.

Make sure that the paper feed roller has stopped rotating, then follow the instructions to
load the prepared plain paper in the top feed.

= | oading Sheets or Postcards into the Printer

. Select OK.

The printer starts cleaning. The cleaning will be complete when the paper is ejected.

When the completion message appears, select OK.

If the problem is still not resolved with the operation described above, follow the operation below.

1.
2.

Turn off the power and then unplug the power cord.

While rotating the paper feed rollers (A) located inside the top feed more than two laps, wipe them with
a cloth tightly squeezed after moistening.
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32 Important

» Do not touch the paper feed rollers with your fingers. Paper feeding performance may be
degraded.

3. Turn on the power, then clean the paper feed rollers again.

If the problem is not resolved after cleaning the paper feed roller, contact your nearest Canon service center
to request a repair.
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I Performing Bottom Plate Cleaning

Remove stains from the inside of the printer. If the inside of the printer becomes dirty, printed paper may get
dirty, so we recommend performing cleaning regularly.

You need to prepare: a sheet of A4 or letter size plain paper *

* Be sure to use a new piece of paper.

1. Select 0 (

Setup) on the Home Screen.

2. Select i‘% Maintenance.

3. Select Bottom Plate Cleaning.

4. Select Yes.

5. Follow the message to remove any paper from the top feed, then select OK.

6. Fold the prepared plain paper in half lengthwise, unfold the paper, then select OK.

7. Load the plain paper horizontally in the top feed with the open side up.

= | oading Sheets or Postcards into the Printer

8. Select OK.
Bottom Plate Cleaning is performed, and paper is fed.

Check the folded parts of the ejected paper. If they are smudged with ink, perform Bottom Plate
Cleaning again.

9. When the completion message appears, select OK.

> Note

* When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.

434



If printed pages are still dirty even after cleaning again, the inside of the printer may be dirty. Clean the
inside of the printer.

= Cleaning Inside the Printer
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Performing Maintenance Functions from Your Computer
(Windows)

» Cleaning the Print Heads

» Printing a Nozzle Check Pattern
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I Cleaning the Print Heads

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for print head cleaning is as follows:

‘ J Print Head Cleaning

1. Open the printer driver setup window

2. Click Print Head Cleaning on the Utility tab

When the Print Head Cleaning dialog box opens, make sure that the printer is on, and then click OK.

Print head cleaning starts.

»» Note

+ After Cleaning is complete, perform Print Nozzle Check Pattern and check the cleaning results.

I Related Topic

= Printing a Nozzle Check Pattern
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I Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

‘ J Print Nozzle Check Pattern

1. Open the printer driver setup window

2. Load paper in the printer

3. Click Print Nozzle Check Pattern on the Utility tab

The Print Nozzle Check Pattern dialog box opens.

4. Select the paper source

Select the paper source from the displayed dialog box.

5. Print a nozzle check pattern

Make sure that the printer is on and click OK.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.

6. Check the print result

Check the print results.

(B)

(A) As long as the horizontal lines are in line, and not missing, the nozzle is working normally.
(B) Where the horizontal lines are not in line or are missing, the color nozzle is blocked.

»» Note

» From the nozzle check pattern printing results, if it becomes patchy or there are areas that
cannot be printed, use Print Head Cleaning to clean the print heads.
Once cleaning is complete, print the nozzle check pattern again and check the results.
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I Related Topic

= Cleaning the Print Heads
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I Other Maintenance

» Preparing to Transfer the Printer
» Reinstalling the Printer

» Firmware update
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I Preparing to Transfer the Printer

To protect the internal parts in transit, always follow these steps before transferring the printer to a new
location.

For details on installing printer after transfer, see Reinstalling the Printer.

22 Important

* You cannot take ink out of ink tanks.

* Prepare for transporting the printer with the print head attached. This allows the printer to automatically
cap the print head, thus preventing it from drying.

* Do not remove the print head. Ink may leak.
« If ink stains the inside of the printer, wipe them using a soft cloth dampened with water.

= Cleaning Inside the Printer

» Transport the printer in a plastic bag to prevent ink leakage. Prepare the plastic bag before transporting
the printer.

»>» Note

* If you can move the printer in a level state using casters or something similar, you do not need to
execute Transport mode.

I Switch to Transport mode using the Operation Panel

To switch to Transport mode using the operation panel, follow the steps below. If you cannot switch to
Transport mode using the operation panel due to a malfunction, see "Repairing Your Printer".

1. Remove all paper.

= Removing the Roll from the Printer

2. Select :

(Setup) on the Home Screen.

3. Select i‘n, Maintenance.
4. Select Transport mode.

5. Confirm the message, then select Yes.

The mode is shifted to the Transport mode.

When it is completed, the power is turned off automatically.
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I Packing Printer

1. Check that ON lamp is off and unplug power cord.

= Checking that Power Is On

32 Important

» Do not unplug the printer while the ON lamp is lit or flashing. This may cause malfunction or
damage to the printer, making the printer unable to print, or it may not be ready for transport,
leading to ink leakage during transportation.

2. Unplug the printer cable from the computer and from the printer, then unplug the power
cord from the printer.

3. Open the ink tank cover (A).

5. Make sure tank caps are closed securely.

442



32 Important

» Check if the tank cap is completely inserted. If the ink tank inner cover is not completely closed,
insert the tank cap properly.

6. Close all the ink tank inner covers.

7. Close the ink tank cover.

8. Open the cut sheet feed cover.
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10. Loosen the knurled screw (C) securing the roll holder support by turning it
counterclockwise.

11. Remove the roll holder support.
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14. Close the cut sheet feed cover.
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16. Remove the desktop basket or printer stand by following the installation instructions in
reverse.

22 Important

* When removing the desktop basket, hold down the buttons on the basket adapters and pull it
out from the printer.

»» Note

» Refer to the Desktop Basket Setup Guide for the desktop basket installation procedure and the
Printer Stand Setup Guide for the printer stand installation procedure.

/1 Caution

» Moving the printer requires two people. Be careful to avoid back strain and other injuries.

» When moving the printer, firmly grasp the carrying grips. The printer may be unsteady if you
hold it at other positions, which poses a risk of injury from dropping the printer.
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17. Pack printer in plastic bag.
Seal the mouth of the plastic bag with the tape or tie it tightly so that ink does not leak.

18. Pack printer in box.

Attach the protective material to the printer to pack it securely in the box.
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22 Important

» Pack the printer in a sturdy box so that it is placed with its bottom facing down, using sufficient
protective material to ensure safe transport.

* Do not tilt the printer. Ink may leak.

* When a shipping agent is handling transport of the printer, have its box marked "THIS SIDE
UP" to keep the printer with its bottom facing down. Mark also with "FRAGILE" or "HANDLE
WITH CARE".

» Please handle with care and ensure the box remains flat and NOT turned upside down or on its
side, as the printer may be damaged and ink in the printer may leak.

» Pack the removed roll holder and roll holder support separately from the printer.

19. Disassemble and pack the removed desktop basket or printer stand by following the
installation instructions in reverse.

22 Important

» Pack the removed desktop basket or printer stand separately from the printer.
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I Reinstalling the Printer

The basic workflow for reinstalling the printer is as follows.

I Assemble the stand (Option)

1. If you want to use the printer stand, assemble the printer stand.

»» Note

* For instructions on assembling and installing the printer stand, see the Printer Stand Setup
Guide.

I Install the printer

1. Remove the packed printer from the box and bag.

/1 Caution

» Moving the printer requires two people. Be careful to avoid back strain and other injuries.

» When moving the printer, firmly grasp the carrying grips. The printer may be unsteady if you
hold it at other positions, which poses a risk of injury from dropping the printer.
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2. When using the printer stand, attach the printer to the assembled stand.

3. When using a desktop basket, attach the desktop basket to the printer.

3% Important

» The printer stand and desktop basket cannot be installed at the same time.

22> Note

* For instructions on installing the desktop basket, see the Desktop Basket Setup Guide.

4. Install the roll holder support.
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6. Plug the power plug into an outlet.

7. Press ON button to turn on printer.

= Turning on the printer

8. Install the software.
Note that the driver installation procedure varies depending on the type of connection.

= |nstalling the Printer Driver (Windows)
= [nstalling the Printer Driver (macOS)

32 Important

* When the printer is connected to a network (via TCP/IP), the printer's IP address may be
changed if you reinstall the printer.
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In this case, be sure to reconfigure the printer's IP address.
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I Firmware update

22 Important
* When you use this function, make sure the printer is connected to the Internet.

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

I Using Operation Panel

1. Select : (Setup) on the HOME screen.
2. Select Printer settings.

3. Select Firmware update.

If an administrator password is set, enter the password.
4. Select Install update.

5. Select Yes.

6. Check message and select Start update.

I Using Remote Ul

1. Start up Remote UL.

= Start up Remote Ul

2. Select Firmware update.
3. Select Install update.

4. Check message and select Update.

2> Note
« If the firmware update is not complete, check the following and take an appropriate action.

— Check the network settings such as a wireless router.

— If Cannot connect to the server. is displayed on the touch screen, select OK and try again after a
while.
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I Frequently Asked Questions

I Problems with the Printing Quality

Unevenness, Banding, Faint

Printing is faint

Banding in different colors occurs

Colors in printed images are uneven

Image edges are blurred or white banding occurs

L R 2R 2R

dirt

Paper rubs against the Print Head

The edges of the paper are dirty

The surface of the paper is dirty

The back side of the paper is dirty

Trail Edge Margin Becomes Dirty When Making Prints with Margins Immediately
after the Minimal Margin Printing/Borderless Printing

L3R 2R 2E AN 2
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colors are inaccurate

= Printed colors are inaccurate
= Documents are printed in monochrome

Line
= Line thickness is not uniform
= | ines or colors are misaligned
Others

The length of the printed image in the paper ejection direction is not accurate
Images are printed crooked

Margins are wide

Borders Appear in the Minimal Margin Printing/Borderless Printing

Left and Right Margins Do Not Match in the Bordered Printing

When printing on roll paper, the printed surface becomes scratched

LR 2R 2% 2B A 4

I General FAQ

Ink Does Not Come Out

Software does not work on macOS 15 or later
Printer Does Not Print

Printing stops and an error message is displayed
Failed to Printer Driver Installation (Windows)
Repairing Your Printer

LR 2R 2B B A 4

Search by Category

Cannot Configure Network Settings

= Message Appears on Computer During Setup
= Cannot Proceed Beyond Printer Connection Screen (Cannot Find Printer Connected via USB)
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= "Failed to connect to the wireless router." Appears
= Printer Cannot Be Used After Replacing Wireless Router or Changed Router Settings
= Privacy Separator/SSID Separator/Network Separation Function

Cannot Find Printer on Network

= Cannot Find Printer on Network
= Searching Printer by IP Address or Host Name During Setup

Cannot Print over Network

= Cannot Print over TCP/IP Network
= Cannot Print over Bonjour networks
= Cannot Print Using AirPrint

Network Connection Problems

= Network Settings and Common Problems
= Cannot Connect to the Printer

= Network Key (Password) Unknown

= Checking Network Information

= Restoring Printer's LAN Settings to Defaults

Printer Problems

Printer Does Not Turn On

=Y
= USB Connection Problems
= | CD Is Off
-
=Y

Messages advising to check the maintenance cartridge are not cleared
If the Printer Makes a Strange Sound

Printing Problems

= Printer Does Not Print

= Printing Stops
= Printing stops and an error message is displayed

Paper is not Fed or Ejected Properly

Remove Jammed Roll Paper

Remove a Jammed Sheet

Remove Jammed Paper (Paper Feed Slot)

What to Do When Small Paper Sizes Are Jammed

Roll paper cannot be inserted into the Paper Feed Slot
Printer Does Not Pick up or Feed the Paper/"No Paper" Error
Roll Paper Remains/Lacks under Quantity Management

The printer ejects blank, unprinted paper

L 2R 2 2B B IR 2R 3

Paper Cutting Problems

= Paper is not cut straight

= Cutter Blade Does Not Work While Cutting Is in Progress

= | want to know how to configure roll cutting

= | want to configure so that the roll is cut automatically after waiting for the ink to dry
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Paper Setting Problems

= Paper widths with high transparency cannot be detected
= Paper types that can be used with this printer / What paper type to select
= The paper type that | want to print is not displayed on the Touch Screen

Ink-related Problems

= |nk Does Not Come Out
= Printer consumes a lot of ink
= |nk Level Detection

About Print Settings

= How do | print without borders

= | want to easily create vertical or horizontal banners
= Can | perform duplex printing

= | want to perform enlargement printing
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Q

Failed to Printer Driver Installation (Windows)

A

If the printer driver were not installed correctly, make sure that all Windows Update have been applied. If
all Windows Update have not been applied, apply all Windows Update.

After confirming Windows Update, perform the following operations to install the printer driver.

1. Open screen to uninstall printer Driver.

For Windows 11:
Select Settings > Apps.
Select Apps & features.

For Windows 10:

Select Settings > Apps.

2. Check if there is "Canon XXX Driver" or "Canon XXX Printer Driver" you want to install
in list.

"XXX" is the model name.

3. If you find printer driver for printer you want to install, uninstall it.

If not found, proceed to the next step.

4. Restart computer.
After restarting, install the latest printer driver.

22 Important
¢ For Windows:

To restart your computer, choose Restart instead of Shut down.
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I Repairing Your Printer

If the power does not turn on or you cannot run the transport mode from the operation panel, perform the
following steps.

2% Important
¢ You cannot take ink out of ink tanks.

» Make sure the tank caps of ink tanks are closed securely. If the tank caps are open, close the tank caps
properly.

* Press the ON button to turn off the printer with the print heads installed. The printer protects the print
heads by covering them automatically to prevent them from being dried.

* Do not remove the print heads. Ink may leak.

« If the inside of the printer becomes dirty, clean with a soft cloth that gets wet with water and squeezed
firmly.

* When transporting the printer, pack the printer in a plastic bag so that ink does not leak.

» Pack the printer in a sturdy box so that it is placed with its bottom facing down, using sufficient
protective material to ensure safe transport.

* Do not tilt the printer; otherwise, ink may leak.

* When a shipping agent is handling transport of the printer, have its box marked "THIS SIDE UP" to
keep the printer with its bottom facing down. Mark also with "FRAGILE" or "HANDLE WITH CARE".

» Please handle with care and ensure the box remains flat and NOT turned upside down or on its side, as
the printer may be damaged and ink in the printer may leak.

1. If the power is on, press the ON button to turn off the printer.

= Turning off the printer
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2. Remove all paper.

3. Open the access cover on the right side of the printer.

4. Close ink valve.

Close the ink valve by tilting the ink valve lever tightly to the left.

2% Important

+ If you pack the printer without closing the ink valve, ink may leak out. Be sure to close the ink
valve before packing the printer.

« If the ink valve lever is dirty, wipe the lever clean before closing the valve.

12> Note

« If the ink valve lever is already tilted to the left and the ink valve is closed, leave it in place.

5. Close the access cover on the right side of the printer.
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6. Pack the printer.

= Packing Printer

22 Important

* Remove the roll holder, roll holder support, desktop basket, and printer stand from the printer.
Contact the customer service center in your country or region for information on how to handle these
parts when sending the printer unit for repair.
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| Problems with the Printing Quality

>

>

Printing is faint

Banding in different colors occurs

Colors in printed images are uneven

Image edges are blurred or white banding occurs
Paper rubs against the Print Head

The edges of the paper are dirty

The surface of the paper is dirty

The back side of the paper is dirty

Trail Edge Margin Becomes Dirty When Making Prints with Margins Immediately
after the Minimal Margin Printing/Borderless Printing

Printed colors are inaccurate

Documents are printed in monochrome

Line thickness is not uniform

Lines or colors are misaligned

The length of the printed image in the paper ejection direction is not accurate
Images are printed crooked

Margins are wide

Borders Appear in the Minimal Margin Printing/Borderless Printing

Left and Right Margins Do Not Match in the Bordered Printing

When printing on roll paper, the printed surface becomes scratched
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Q

Printing is faint

AN

Is the reverse side of the paper being used for printing?

Print on the printing surface.

Is the Print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.

= Checking for Nozzle Clogging
= Maintenance Procedure

Are paper scraps stuck in the printer?

Remove paper scraps left inside the printer.

= Remove Jammed Roll Paper
= Remove a Jammed Sheet

Was the paper cut before the ink dried?

In the touch screen menu, select Paper-related settings > Advanced paper settings, and increase time in
Pause between scans or Pause between pages.

= Specifying the Ink Drying Time

RN \When printing photos and posters, are the Print target settings set correctly?
Do one of the following.
* In the printer driver, change the setting to Photo (Color) or Poster in Print Target.

= Printing By Setting Print Purpose
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* In the touch screen menu, select (Setup) > Printer settings > Print settings > Default print
settings > Print quality settings > Print target, and change the setting to Photo. (This is only available
when the printer driver's Media Type is set to Auto (Use Printer Settings)).

= Print settings

Is the printer driver Print Quality set to a low quality setting?

Follow the steps below to set Print Quality to higher quality settings, and then print.
* Windows
Change the Print Quality settings in the printer driver Advanced Settings.
= Changing the Print Quality and Correcting Image Data (Windows)
* macOS

Change the Print Quality in the printer driver Quality & Media settings.
= Changing the Print Quality and Correcting Image Data (macOS)
3> Note

* When the minimal margin printing or borderless printing, the optimal settings are automatically changed, so
changing the settings may not change the print results.

Does the paper used for printing create a lot of cutting dust?

In the touch screen menu, set Cut-dust reduction in Advanced paper settings to ON.

= Reducing Dust from Cutting Rolls

When using paper with one printable surface, check the correct printable side
of the paper.

Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.

= [ oading Sheets or Postcards into the Printer

Refer to the instruction manual supplied with the paper for detailed information on the printable side.
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Q

Banding in different colors occurs

Make sure that the Print head nozzle is not blocked

Print a test pattern to check the nozzles and see if they are clogged.

= Checking for Nozzle Clogging
= Maintenance Procedure

Does the paper loaded on the printer match the media type selected in the
printer driver?

When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.

= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)

> Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

Does the paper loaded on the printer match the media type selected on the
touch screen?

Set the correct media type on the touch screen.

= Changing the Type of Paper

Has the paper feed rate been calibrated properly?
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Adjust the feed amount.

= Automatically Adjusting Different Colored Horizontal Streaks
= Adjusting Line Length

When printing photos and posters, are the Print target settings set correctly?
Do one of the following.

* In the printer driver, change the setting to Photo (Color) or Poster in Print Target.

= Printing By Setting Print Purpose

* In the touch screen menu, select (Setup) > Printer settings > Print settings > Default print
settings > Print quality settings > Print target, and change the setting to Photo. (This is only available
when the printer driver's Media Type is set to Auto (Use Printer Settings)).

= Print settings

Low Print Quality setting causing lines in the printing

Follow the steps below to set Print Quality to the highest quality setting, and then print.
* Windows
Change the Print Quality settings in the printer driver Advanced Settings.
= Changing the Print Quality and Correcting Image Data (Windows)
* macOS

Change the Print Quality in the printer driver Quality & Media settings.
= Changing the Print Quality and Correcting Image Data (macOS)

»» Note

* When the minimal margin printing or borderless printing, the optimal settings are automatically changed, so
changing the settings may not change the print results.

Is Set priority in the touch screen menu set to Prioritize length accuracy?

Setting Set priority to Prioritize print quality in Paper feed adjustment may improve the print quality.

= Maintenance

Check if the Print head is in the right position

Adjust the Print head position.

= Automatic Adjustment to Straighten Lines and Align Colors

Print job may have been interrupted while receiving, and therefore not printed
at a fast frame rate

Exit other applications and cancel other print jobs.
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Q

Colors in printed images are uneven

LWL SN Does the paper loaded on the printer match the media type selected in the
printer driver?
When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.

= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)

> Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media

type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Set the correct media type on the touch screen.

= Changing the Type of Paper

Is the Print head position adjusted correctly?

Adjust the Print head position.

= Automatic Adjustment to Straighten Lines and Align Colors

Is the feed amount adjusted correctly?
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Adjust feed amount.

= Automatically Adjusting Different Colored Horizontal Streaks
= Adjusting Line Length

OLE RN \When printing photos and posters, are the Print target settings set correctly?
Do one of the following.
* In the printer driver, change the setting to Photo (Color) or Poster in Print Target.

= Printing By Setting Print Purpose

* In the touch screen menu, select (Setup) > Printer settings > Print settings > Default print
settings > Print quality settings > Print target, and change the setting to Photo. (This is only available
when the printer driver's Media Type is set to Auto (Use Printer Settings)).

= Print settings

Colors in printed images may be uneven if the Print Quality setting is too low

If using Windows, select Advanced Settings from the Main tab of the printer driver, and then select a higher
Print Quality setting.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.

= Changing the Print Quality and Correcting Image Data (Windows)
= Changing the Print Quality and Correcting Image Data (macOS)

»» Note

* When the minimal margin printing or borderless printing, the optimal settings are automatically changed, so
changing the settings may not change the print results.

Are the Print Head nozzles clogged?

Check for nozzle clogging.

= Checking for Nozzle Clogging
= Maintenance Procedure

Colors in printed images may be uneven on the boundary between shades if
there are dark and light areas in an image

Prints on the same page while switching between Bidirectional printing and Unidirectional printing. Therefore,
color unevenness may occur when switching. Using the unidirectional printing function may reduce color
unevenness in this situation.

Follow the steps below for unidirectional printing.
* Windows

Open Paper Detailed Settings from the Main tab of the printer driver, and then select Unidirectional
Printing.

= Main Tab Description

* macOS
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Open Advanced Paper Settings in the printer driver, and then select Unidirectional Printing.

= Advanced Paper Settings
22 Important

« If any of the following conditions are met in the printer driver settings, the unidirectional printing function
setting will be disabled.

— The Banner Printing check box is checked.
— The paper length exceeds 78.7 inches (2000.0 mm).

OLWC SN |f printing with minimal margins or borderless, colors in printed images may be
a little uneven at the leading edge of the paper because printing is interrupted to cut the
paper

»» Note

+ Selecting a higher Print Quality in the printer driver Advanced Settings may resolve the problem.

= Changing the Print Quality and Correcting Image Data (Windows)
= Changing the Print Quality and Correcting Image Data (macOS)

OLWEC [ Does this paper curl easily?

Colors in printed images may be uneven at the leading edge of paper that curls easily. Set a margin of at least
0.8 inches (20 mm) at the front edge of the paper.

= Setting the Upper and Lower Margins on Roll Paper

Color may be uneven if printing materials were stacked while drying

To avoid uneven colors, we recommend drying each sheet separately.

Is Ink drying target area for Pause between scans in the touch screen
menu set to Leading edge?

If the Ink drying target area for Pause between scans is set to Leading edge, color may be uneven
approximately 4.3 to 6.3 inches (70 to 100 mm) from the front edge of the paper. (The position depends on
the Print Quality settings)

On the HOME screen of the touch screen, select (Setup) > Printer settings > Paper-related settings >
Advanced paper settings > Pause between scans > Ink drying target area and set to Overall.

However, note that printing will now take longer.

= Specifying the Ink Drying Time
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Q

Image edges are blurred or white banding occurs

Check if the Print head is in the right position.

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper etc., adjust the position of the
Print head.

= Automatic Adjustment to Straighten Lines and Align Colors

LA Does the paper loaded on the printer match the media type selected in the
printer driver?
When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.
= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)
»» Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Set the correct media type on the touch screen.

= Changing the Type of Paper

Are the Print Head nozzles clogged?
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Perform print head cleaning.

= Cleaning the Print Head
= Maintenance Procedure
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Q

Paper rubs against the Print Head

A

LWL SN Does the paper loaded on the printer match the media type selected in the
printer driver?
When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.
= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)
»» Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Set the correct media type on the touch screen.

= Changing the Type of Paper

Correct curl before loading paper.

We recommend putting unused paper back into the package and storing it flat.
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* Plain Paper:

Turn the paper over and reload it to print on the other side.

* Such as Envelopes and Medicine Envelopes:

For details, see Loading Envelopes or Medicine Envelopes into the Printer.

* Other Paper such as Postcards:

If the paper corners curl more than 0.1 in. / 3 mm (A) in height, the paper may smudge or may not feed
properly. Follow the instructions below to correct the paper curl.

1. Roll up paper in opposite direction to paper curl as shown below.

HO

2. Check that paper is now flat.

We recommend printing curl-corrected paper one sheet at a time.

»» Note

» Depending on paper type, the paper may smudge or may not feed properly even if it is not curled inward.
Follow the instructions below to curl the paper outward up to 0.1 in. / 3 mm (C) in height before printing.
This may improve the print result.

(B) Print side

We recommend feeding paper that has been curled outward one sheet at a time.

Is the paper loaded properly?

If not loaded properly, paper can buckle and rub against the Print head.
Reload the paper.

= | oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer
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O Are the margins of the rolls narrow?

Narrow margins can cause the leading edge of the paper to curl easily, and the raised paper may rub against the
head after the ink has landed on it. Make the margins wide.

= Setting the Upper and Lower Margins on Roll Paper

If you are using plain paper, changing the settings from the printer driver may
improve the print results.
* For the Easy Settings
Set Print Target to Photo (Color) or Poster.

= Printing By Setting Print Purpose

* For the Advanced Settings
Select Image in Print Priority.

= Printing Using Detailed Setting Mode

O LA |f you are using rolls, are you using the recommended paper and
recommended environment?

Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

= Paper Settings List (Roll Paper)

Set the setting to prevent paper rubbing.

Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the paper.
If you notice abrasion even with the media type set correctly to match the paper, set the printer to prevent paper
abrasion using the operation panel or the computer.

This may reduce the print speed.

* Once you have finished printing, undo this setting. Otherwise, it will apply to subsequent print jobs.
* From operation panel

Select : (Setup) on HOME screen > Printer settings > Print settings in this order, and then set
Prevent paper abrasion to ON.

= Changing Settings from Operation Panel

Is the leading edge or the trailing edge of the paper rubbing?

If the leading edge of the paper is rubbing, set a margin at the leading edge and print. If the trailing edge of the
paper is rubbing, set a margin at the trailing edge and print.

474



Q

The edges of the paper are dirty

W IN Are you printing with minimal margins, borderless, or on small size paper?
When printing with minimal margins, borderless, or on small size paper, the platen may become dirty.
Clean the platen.

= Cleaning Inside the Printer

Does the paper loaded on the printer match the media type selected in the
printer driver?

The platen may become dirty if the loaded paper does not match the settings. We recommend that you clean the
platen before printing again.

= Cleaning Inside the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.
= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)
3> Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

* Click Get Information to reflect the paper information set in the printer to the printer driver.

When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?
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The platen may become dirty if the loaded paper does not match the settings. We recommend that you clean the
platen before printing again.

= Cleaning Inside the Printer

Set the correct media type on the touch screen.

= Changing the Type of Paper

OLWEO B Correct curl before loading paper.

We recommend putting unused paper back into the package and storing it flat.

* Plain Paper:

Turn the paper over and reload it to print on the other side.

* Such as Envelopes and Medicine Envelopes:

For details, see Loading Envelopes or Medicine Envelopes into the Printer.

* Other Paper such as Postcards:

If the paper corners curl more than 0.1 in. / 3 mm (A) in height, the paper may smudge or may not feed
properly. Follow the instructions below to correct the paper curl.

1. Roll up paper in opposite direction to paper curl as shown below.

HO

2. Check that paper is now flat.

We recommend printing curl-corrected paper one sheet at a time.

»» Note

» Depending on paper type, the paper may smudge or may not feed properly even if it is not curled inward.
Follow the instructions below to curl the paper outward up to 0.1 in. / 3 mm (C) in height before printing.
This may improve the print result.
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(B) Print side

We recommend feeding paper that has been curled outward one sheet at a time.

oL |s the paper creased or curled?

Straighten out the wrinkles or curls and reload the paper.

= | oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

In the touch screen menu, is Cut-dust reduction in Advanced paper settings
set to ON?

A cut dust reduction line is printed at the paper cut position when Cut-dust reduction is set to ON.

If cutting dust reduction is not required, set Cut-dust reduction to OFF.

= Reducing Dust from Cutting Rolls

Is the ejection guide dirty?

Clean the ejection guide.

= Cleaning Inside the Printer

O LI Are the margins of the rolls narrow?

Narrow margins can cause the leading edge of the paper to curl easily, and the raised paper may rub against the
head after the ink has landed on it. Make the margins wide.

= Setting the Upper and Lower Margins on Roll Paper

If you are using plain paper, changing the settings from the printer driver may
improve the print results.
* For the Easy Settings
Set Print Target to Photo (Color) or Poster.

= Printing By Setting Print Purpose

* For the Advanced Settings
Select Image in Print Priority.

= Printing Using Detailed Setting Mode

R[N |f you are using rolls, are you using the recommended paper and
recommended environment?

Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

= Paper Settings List (Roll Paper)

Set the setting to prevent paper rubbing.
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Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the paper.
If you notice abrasion even with the media type set correctly to match the paper, set the printer to prevent paper
abrasion using the operation panel or the computer.

This may reduce the print speed.

* Once you have finished printing, undo this setting. Otherwise, it will apply to subsequent print jobs.

* From operation panel

Select : (Setup) on HOME screen > Printer settings > Print settings in this order, and then set
Prevent paper abrasion to ON.

= Changing Settings from Operation Panel

s the inside of the printer dirty?

During printing, ink may stain the inside of the printer, smudging the printout.
Perform bottom plate cleaning to clean inside of printer.

= Performing Bottom Plate Cleaning

»» Note

» To prevent staining inside the printer, be sure to set the correct paper size.
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Q

The surface of the paper is dirty
TP
;?. \!

I

A

IR |s the paper retainer clean?

Clean the paper retainer.

= Cleaning Inside the Printer

If using plain paper, is the media type set to Plain Paper?

Set the media type to PlainP(Instant-dry) for improved quick-drying.

= Changing the Type of Paper

Does this paper take longer to dry?

Increase the length of the Pause between pages and Pause between scans settings from the touch screen
menu.

= Specifying the Ink Drying Time

»» Note

* When printing on paper that takes longer to dry, the paper may curl during printing and come in contact
with the output tray.

In such situations, set an Ink drying wait time and an Ink drying target area for Pause between scans
in the touch screen menu.

However, note that printing will now take longer.

Does the paper loaded on the printer match the media type selected in the
printer driver?

The platen may become dirty if the loaded paper does not match the settings. We recommend that you clean the
platen before printing again.

= Cleaning Inside the Printer
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When printing with the media type loaded in the printer, specify the same media type in the printer driver.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.

= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)

> Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

Does the paper type selected in the printer driver or on the touch screen match
the actual paper type loaded?

The platen may become dirty if the loaded paper does not match the settings. We recommend that you clean the
platen before printing again.

= Cleaning Inside the Printer

Set the correct paper type on the touch screen.

= Changing the Type of Paper

OLWE IO Correct curl before loading paper.

We recommend putting unused paper back into the package and storing it flat.

* Plain Paper:

Turn the paper over and reload it to print on the other side.

* Such as Envelopes and Medicine Envelopes:

For details, see Loading Envelopes or Medicine Envelopes into the Printer.

* Other Paper such as Postcards:

If the paper corners curl more than 0.1 in. / 3 mm (A) in height, the paper may smudge or may not feed
properly. Follow the instructions below to correct the paper curl.

1. Roll up paper in opposite direction to paper curl as shown below.
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2. Check that paper is now flat.
We recommend printing curl-corrected paper one sheet at a time.

»» Note

» Depending on paper type, the paper may smudge or may not feed properly even if it is not curled inward.
Follow the instructions below to curl the paper outward up to 0.1 in. / 3 mm (C) in height before printing.
This may improve the print result.

(B) Print side

We recommend feeding paper that has been curled outward one sheet at a time.

Dirt may be removed by letting a blank sheet of paper pass through.

If the roll paper is dirty, perform Set cut length several times.

= Cutting Roll Paper

If the sheet is dirty, perform Bottom Plate Cleaning.

= Performing Bottom Plate Cleaning

If you are using plain paper, changing the settings from the printer driver may
improve the print results.
* For the Easy Settings
Set Print Target to Photo (Color) or Poster.

= Printing By Setting Print Purpose

* For the Advanced Settings
Select Image in Print Priority.

= Printing Using Detailed Setting Mode

O |f you are using rolls, are you using the recommended paper and
recommended environment?

Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

= Paper Settings List (Roll Paper)

Set the setting to prevent paper rubbing.

Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the paper.
If you notice abrasion even with the media type set correctly to match the paper, set the printer to prevent paper
abrasion using the operation panel or the computer.
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This may reduce the print speed.

* Once you have finished printing, undo this setting. Otherwise, it will apply to subsequent print jobs.

* From operation panel

: (Setup) on HOME screen > Printer settings > Print settings in this order, and then set
Prevent paper abrasion to ON.

Select

= Changing Settings from Operation Panel

S EEMN Are you using medicine envelopes or label paper?

Set the paper type to Label (Instant-dry), Glossy Label (Instant-dry) or MedicineEnv.(Instant-dry) whose
quick-drying performance is increased.

= Changing the Type of Paper

s the inside of the printer dirty?

During duplex printing, ink may stain the inside of the printer, smudging the printout.
Perform bottom plate cleaning to clean inside of printer.

= Performing Bottom Plate Cleaning

»» Note

» To prevent staining inside the printer, be sure to set the correct paper size.

Did you print the communication side first?

When printing the postcards, it is recommended to print the address side first, then print the communication side
to ensure clear printing.
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Q

The back side of the paper is dirty

OLE RN \Was the previous print job borderless, or printed on small paper?
The platen may become dirtied by borderless printing or on small paper sizes.
Clean the platen.

= Cleaning Inside the Printer

Is Detect paper width in the touch screen menu set to Disable?

Printing with Detect paper width set to Disable may cause the platen to be dirtied.
Set Detect paper width in the touch screen menu to Enable, and then clean the platen.

= Cleaning Inside the Printer

Does this paper take longer to dry?

Increase the length of the Pause between pages and Pause between scans settings from the touch screen
menu.

= Specifying the Ink Drying Time

If the platen is dirty, open the top cover and clean the platen.

= Cleaning Inside the Printer

»» Note

* When printing on paper that takes longer to dry, the paper may curl during printing and come in contact
with the output tray.

In such situations, set an Ink drying wait time and an Ink drying target area for Pause between scans
in the touch screen menu.

However, note that printing will now take longer.
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Does the paper loaded on the printer match the media type selected in the
printer driver?

The platen may become dirty if the loaded paper does not match the settings. We recommend that you clean the
platen before printing again.

= Cleaning Inside the Printer

When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [ oading Rolls in the Printer
= [ oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.
= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)
»» Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

Does the paper type selected in the printer driver or on the touch screen match
the actual paper type loaded?

The platen may become dirty if the loaded paper does not match the settings. We recommend that you clean the
platen before printing again.

= Cleaning Inside the Printer

Set the correct paper type on the touch screen.

= Changing the Type of Paper

Dirt may be removed by letting a blank sheet of paper pass through.

If the roll paper is dirty, perform Set cut length several times.

= Cutting Roll Paper

If the sheet is dirty, perform Bottom Plate Cleaning.

= Performing Bottom Plate Cleaning
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Q

Trail Edge Margin Becomes Dirty When Making Prints with Margins
Immediately after the Minimal Margin Printing/Borderless Printing

Depending on the usage environment, if printing with minimal margins or borderless is performed with the
setting of automatic cutting of the leading and trailing edges on roll paper, the ink on the cutter blade may be
transferred on the next printed document.

Use Pause between pages on the touch screen to change the ink drying time to between 30 seconds and 3
minutes before performing borderless printing.

= Specifying the Ink Drying Time
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Q

Printed colors are inaccurate

Is the Print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.

= Checking for Nozzle Clogging

= Maintenance Procedure

When printing photos and posters, are the Print target settings set correctly?

Do one of the following.
+ In the printer driver, change the setting to Photo (Color) or Poster in Print Target.

= Printing By Setting Print Purpose

* In the touch screen menu, select : (Setup) > Printer settings > Print settings > Default print
settings > Print quality settings > Print target, and change the setting to Photo. (This is only available
when the printer driver's Media Type is set to Auto (Use Printer Settings)).

= Print settings

Has color been adjusted in the printer driver?

Follow the steps below to adjust color settings.
* Windows
Adjust the color settings with Color Mode > Color Settings in Advanced Settings in the printer driver.

= Main Tab Description (Windows)

* macOS
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Adjust the color settings in the printer driver Color Options.

= Color Options (macOS)

Is Application Color Matching Priority set to Off in a Windows printer driver?

In the printer driver Layout sheet, click Special Settings, and then set Application Color Matching Priority to
On in the dialog box that appears.

= | ayout Tab Description (Windows)

OLWC SN Has the computer or monitor color been adjusted?

Take the actions below.
* Refer to the computer and monitor documentation to adjust the colors.

* Adjust the settings of the color management software, referring to the software documentation as needed.

LN Color varies even between printers of the same model due to differences in
firmware and printer driver versions, settings, or environment.

Follow these steps to prepare the printing environment.
1. Use the same version of firmware or printer driver.

2. Specify the same value for all settings items.
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Q

Documents are printed in monochrome

A

Is Color Mode set to Monochrome, or Print Target set to CAD
(Monochrome Line Drawing) in a Windows printer driver?

In the Advanced Settings of the printer driver, specify Color in Color Mode and try printing again.

= Main Tab Description (Windows)

VAN |[s Color Mode set to Monochrome selected in the macOS printer driver?

Set Color Mode to Color in the printer driver Quality & Media settings, and then print again.

= Quality & Media (macOS)

The print head nozzle may be blocked

Print a test pattern to check the color ink nozzles and see if they are clogged.

= Checking for Nozzle Clogging
= Maintenance Procedure
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Q

Line thickness is not uniform

(111U

A

OV Does the paper loaded on the printer match the media type selected in the
printer driver?
When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.
= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)
3> Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

* Click Get Information to reflect the paper information set in the printer to the printer driver.

When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Set the correct media type on the touch screen.

= Changing the Type of Paper

Adjust the position of the Print head

If the printed result does not look uniform, such as when the lines are misaligned, adjust the position of Print
Head.

= Automatic Adjustment to Straighten Lines and Align Colors
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Disabling the line and text cleanup process may improve the situation.

If the printed result does not look uniform, such as when the lines are misaligned, adjust the position of Print
Head.

+ For Windows
Turn off Cleaner Lines/Text in the printer driver settings.

= [ ayout Tab Description

* For macOS

In the touchscreen menu, select (Setup) > Printer settings > Print settings > Cleaner Lines/Text,
and set to Disable.

Is Fast Graphic Process set to On in the 32-bit Windows printer driver
Special Settings dialog box?

Access the printer driver Properties dialog box from Print in the File menu of the source application, and follow
these steps to print.

1. Deselect Preview before printing in the Main sheet.
2. Deselect Page Layout in the Layout sheet.

3. Click the Special Settings button in the Layout sheet, and then set Fast Graphic
Process to Off in the Special Settings dialog box that opens.
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Q

Lines or colors are misaligned

5

A

Adjust the position of the Print head

If borders are misaligned or the print results are not uniform, adjust the position of the Print head.

= Automatic Adjustment to Straighten Lines and Align Colors

LA Does the paper loaded on the printer match the media type selected in the
printer driver?
When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.

= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)

»» Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Set the correct media type on the touch screen.

= Changing the Type of Paper

Is the Roll Paper loaded at an angle?

If there is a gap between the roll paper and the roll holder, reload the roll paper.

= [ oading Rolls in the Printer

Is Detect paper width set to Disable?

Set Detect paper width in the touch screen menu to Enable to load the paper.
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= Advanced (Paper settings)

Is Skew detection accuracy in the touch screen menu set to Loose or OFF?

Set Skew detection accuracy to Standard, and then reload the paper.

= Advanced (Paper settings)

O AN |f you are using rolls, are you using the recommended paper and
recommended environment?

Using rolls or environments other than those recommended, may result in increased curl and rubbing of the print
head. Use the recommended paper and recommended environment.

= Paper Settings List (Roll Paper)

Colors in printed images may be uneven if the Print Quality setting is too low

If using Windows, select Advanced Settings from the Main tab of the printer driver, and then select a higher
Print Quality setting.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.

= Changing the Print Quality and Correcting Image Data (Windows)
= Changing the Print Quality and Correcting Image Data (macOS)

> Note

* When the minimal margin printing or borderless printing, the optimal settings are automatically changed, so
changing the settings may not change the print results.

Is Unidirectional printing set to Disable?

Using the Unidirectional printing function may reduce the shift of ruled lines. Follow the steps below for
unidirectional printing.

* Windows

Open Paper Detailed Settings from the Main tab of the printer driver, and then select Unidirectional
Printing.

= Main Tab Description

* macOS
Open Advanced Paper Settings in the printer driver, and then select Unidirectional Printing.
= Advanced Paper Settings
22 Important

« If any of the following conditions are met in the printer driver settings, the unidirectional printing function
setting will be disabled.

— The Banner Printing check box is checked.
— The paper length exceeds 78.7 inches (2000.0 mm).
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Q

The length of the printed image in the paper ejection direction is
not accurate

WS Does the paper loaded on the printer match the media type selected in the
printer driver?
When printing with the media type specified in the printer driver, load the specified media type in the printer.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When printing with the media type loaded in the printer, specify the media type in the printer driver.

= Printing with Easy Setup (Windows)
= Printing with Easy Setup (macOS)

> Note

* When Auto (Use Printer Settings) is selected for the media type, printing is performed with the media
type loaded in the printer.

+ Click Get Information to reflect the paper information set in the printer to the printer driver.

When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Set the correct media type on the touch screen.

= Changing the Type of Paper

Perform print quality adjustment to automatically adjust the feed amount.

The paper feed amount is automatically adjusted by performing Adjust print quality from Paper feed
adjustment, and printing the adjustment pattern.

= Automatically Adjusting Different Colored Horizontal Streaks
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LM |s Set priority for Paper feed adjustment in the touch screen menu set to
Prioritize print quality?
Set priority for Paper feed adjustment to Prioritize length accuracy, and then carry out Adjust feed length.

= Maintenance
= Adjusting Line Length
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Q

Images are printed crooked

Has the roll paper been loaded at an angle?

If there is a gap between the roll paper and roll holder, reload the roll on the roll holder.

= [ oading Rolls in the Printer

Is Detect paper width set to Disable?

Set Detect paper width in the touch screen menu to Enable to load the paper.

= Advanced (Paper settings)

Is Skew detection accuracy in the touch screen menu set to Loose or OFF?

Set Skew detection accuracy to Standard, and then reload the paper.

= Advanced (Paper settings)

Check if the roll holder support is correctly installed.

Check that the roll holder support is installed at the proper width.
= Moving the Roll Holder Support

Also, check that the knurled screws on the roll holder supports are tightened securely.

22 Important

» Make sure the knurled screws are tightened until they no longer turn.
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Q

Margins are wide

A

Does the printed document have a wide margin on the trailing edge only?

Rolls are advanced a specific amount before cutting to prevent problems with cutting and paper ejection.
This operation is normal.

The specified length varies depending on the media type and the usage environment (humidity). Please refer to
the minimum printing length of the paper from paper information list.

If the length of the printed document is shorter than the minimum cut length, an extra edge margin will be added
to increase the length of the printed document to the minimum cut length.

= Paper Settings List (Roll Paper)

Adjust the margins.

= Setting the Upper and Lower Margins on Roll Paper
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Q

Borders Appear in the Minimal Margin Printing/Borderless Printing

This product is capable of the minimal margin printing. Some software displays this as borderless printing.

In the minimal margin printing, small margins will appear on the left and right sides of the paper. If you are
not getting the expected results with minimal margin printing, check the following.

Is the position of the Print head adjusted?

Adjusting the position of the Print head will improve the printing accuracy.

= Automatic Adjustment to Straighten Lines and Align Colors

To print with the specified amount of minimal margin, the print head height must be lowered.
* Paper thickness (head height): Auto or Standard

= Paper-related settings

* Prevent paper abrasion: OFF

= Print settings

LW Did you perform Roll paper minimal margin amount?

Adjust the left and right margins in Roll paper minimal margin amount in the touch screen menu.

= Setting the Minimal Margin Amount When Performing the Minimal Margin Printing

When printing at full-scale with minimal margins or borderless, is the selected
paper wider than the original size?

For the printing at full-scale with minimal margins or borderless, use roll paper that has the same width as the
original size.

= Printing Full-Size with Minimal Margins (Windows)
= Printing Full-Size with Minimal Margins (macOS)

OB Does the source file have margins?
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Check that the printing image data does not have any objects like crop marks and transparent objects.

LN [s a margin set in application software?

Check that no margins are configured in the application software you are using.
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Q

Left and Right Margins Do Not Match in the Bordered Printing

Is the position of the Print head adjusted?

Adjusting the position of the Print head will improve the printing accuracy.

= Automatic Adjustment to Straighten Lines and Align Colors

PN |s the Adjust horizontal print position performed?
Adjusts the print position if the left and right margins are not uniform.

= Print settings

LW Does the source file have margins?

Check that the printing image data does not have any objects like crop marks and transparent objects.

WM [s a margin set in application software?

Check that no margins are configured in the application software you are using.
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Q

When printing on roll paper, the printed surface becomes
scratched

A

Make sure the roll paper has not lost tension during printing.

If the roll paper loses tension, the paper surface could be damaged and the paper could wrinkle or fold.
Set Roll paper tension (printing) to High in the touch screen menu.

= Advanced (Paper settings)

»» Note

» Carrying out Adjust print quality is recommended when changing Roll paper tension (printing)
settings.

= Automatically Adjusting Different Colored Horizontal Streaks
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I Cannot Configure Network Settings

>

>

Message Appears on Computer During Setup

Cannot Proceed Beyond Printer Connection Screen (Cannot Find Printer
Connected via USB)

"Failed to connect to the wireless router." Appears

Printer Cannot Be Used After Replacing Wireless Router or Changed Router
Settings

Privacy Separator/SSID Separator/Network Separation Function
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I Message Appears on Computer During Setup

= Screen to Enter Password Appears During Setup (Windows)
= Encryption Settings Screen Appears When Wireless Router Selected (Windows)
= "You have connected the printer to the non encrypted wireless network" Appears

Q Screen to Enter Password Appears During Setup (Windows)

A

If the printer is set up for use with a network and an administrator password has been set, a screen asking
you to enter the password appears.

Enter the same password as that specified for the printer.
»» Note
» An administrator password is already set for the printer at the start of use.
For details:
= Default Administrator Password
For improved security, we recommend that you change the administrator password.

= Setting Administrator Password on Operation Panel

Q Encryption Settings Screen Appears When Wireless Router Selected
(Windows)

A

This screen appears automatically if the selected wireless router is encrypted. Set the same encryption
settings as those set for the wireless router.

For more on encryption settings, see Performing/Changing Wi-Fi Settings.

Q "You have connected the printer to the non encrypted wireless
network™ Appears

A

Security is not configured on the wireless router. The printer can still be used, so continue the setup
procedure and complete it.
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3% Important

« If you connect to a network that is not protected with security measures, there is a risk of disclosing
data such as your personal information to a third party.
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Q

Cannot Proceed Beyond Printer Connection Screen (Cannot Find
Printer Connected via USB)

A

If you cannot proceed beyond the Printer Connection screen, check the following.

Make sure USB cable is securely plugged in to printer and computer.

Connect the printer and the computer using a USB cable as the illustration below. The USB port is located at the
back of the printer.

22 Important

» Check the orientation of the "Type-B" connector and connect to the printer. For details, refer to the
instruction manual supplied with the USB cable.

Follow procedure below to connect printer and computer again.
1. Unplug USB cable from printer and computer and connect it again.
2. Make sure no printer operation is in progress and turn off.

3. Turn on printer.

Follow the steps below to install printer driver again.
1. Download the latest printer driver.

2. Turn off printer.
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3. Restart computer.
After restarting, install the latest printer driver downloaded in step 1.
32 Important
* When installing the printer driver, make sure you select the correct printer name.
* For Windows:

To restart your computer, choose Restart instead of Shut down.
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Q

"Failed to connect to the wireless router." Appears

A

Each time you perform each check, select OK on the error screen to clear the error and set up the printer
again.

Error

Failed to connect to the wireless
router.

Follow the steps below.

1. Check that the selected

wireless router is correct,
7 Cherl that the entered

oK

= When Security Type is WPA/WPA2/WPA3
= \When Security Type is set to Disable

I When Security Type is WPA/WPA2/WPA3

Check the password entered for the wireless router is correct.

If the password you entered is incorrect, enter the correct password.

Check the wireless router's settings.

If the wireless router's DHCP function is off, turn it on and redo the wireless connection settings.

Check the MAC address filtering's settings.

If MAC address filtering is enabled on the wireless router, change the settings to accept the printer's MAC

address.

The MAC address of the printer can be viewed from (Information) > System information.

= System information

Check the wireless router's security protocol (encryption method) settings.

For details on changing the wireless router settings, see the wireless router manual or contact its
manufacturer.
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I When Security Type is set to Disable

Is the wireless router turned on?

If it is already turned on, turn it off, and then turn it back on.

Do not proceed to the next screen of this guide until the power is turned on. The connection to the wireless
router will be temporarily disabled.
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Printer Cannot Be Used After Replacing Wireless Router or
Changed Router Settings

When wireless router is replaced or router settings are changed, the network settings of your computer,
smartphone/tablet or printer must be reconfigured according to the new wireless router.

L ’ |.““.|

| S —

Check if your computer or smartphone/tablet can be connected to Internet
through the new wireless router.

If your computer or smartphone/tablet cannot be connected to Internet, check if the wireless router setup is
completed and configure the settings on the computer or smartphone/tablet to connect to the wireless router.

Resetup printer network.
Refer to Setup Guide to setup.
»>» Note
» Wi-Fi Connection Assistant allows you to diagnose and repair the network status.
Select the link below to download Wi-Fi Connection Assistant and install it.
= Checking Printer Connection Status Using Wi-Fi Connection Assistant
Refer to below in regard to starting up Wi-Fi Connection Assistant.
— For Windows:
= Starting Up Wi-Fi Connection Assistant
— For macOS:

= Starting Up Wi-Fi Connection Assistant

If this does not solve the problem, see below.

= Cannot Communicate with Printer After Enabling MAC/IP Address Filtering or Encryption Key on
Wireless Router

= With Encryption On, Cannot Communicate with Printer After Changing Encryption Type at Wireless
Router

= Privacy Separator/SSID Separator/Network Separation Function

Q Cannot Communicate with Printer After Enabling MAC/IP Address
Filtering or Encryption Key on Wireless Router

A

W& Check wireless router setting.
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For more on setting up a wireless router, see the instruction manual provided with the wireless router or
contact its manufacturer. Make sure the computer and the wireless router can communicate with each other
under this setting.

If filtering MAC addresses or IP addresses at wireless router, check
that MAC addresses or IP addresses for computer, network device, and printer are
registered.

If using WPA/WPA2/WPA3 key or a password, make sure encryption key for
computer, network device, and printer matches key set for wireless router.

The length or format of the Wi-Fi password and authentication method must be identical among the wireless
router, the printer, and your computer.

For details, see Setting an Encryption Key.

»» Note

» To configure IEEE802.1X/EAP (WPA/WPA2/WPA3 Enterprise), you also need to configure the
authentication (Radius) server.

Contact the network administrator for more information.

Q With Encryption On, Cannot Communicate with Printer After
Changing Encryption Type at Wireless Router

A

If the printer cannot communicate with the computer after you change the encryption type for the wireless
router, make sure the encryption type and passkey or password for the computer matches that of the
wireless router.

= Cannot Communicate with Printer After Enabling MAC/IP _Address Filtering or Encryption Key on

Wireless Router

509



Q

Privacy Separator/SSID Separator/Network Separation Function

A

If a privacy separator, SSID separator, or Network separation function is enabled on the wireless (mobile)
router, you cannot perform setup. Before performing setup, disable these functions. For the procedure, refer
to your wireless (mobile) router's instruction manual or visit the manufacturer's website.
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I Cannot Find Printer on Network

»» Note

« If you are using macOS 15 or later, you must configure each application to allow device discovery on
the local network. Failing to enable device discovery may restrict software functionality or prevent it
from starting properly.

For detailed instructions, refer to "Setting Up Local Network Device Discovery."

» Cannot Find Printer on Network

» Searching Printer by IP Address or Host Name During Setup
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Q

Cannot Find Printer on Network

A

In the following cases, set up the printer again.

* When you buy a new computer or wireless router

* When you change the settings on your wireless router

* When the connection method (Wi-Fi / USB) of the printer is changed
For more on the setup procedure:

= Set Up

I In Other Cases Than Above:

If the printer suddenly stops working, even though you have not changed the settings of the device or
network to which it is connected, or if you cannot find the printer during the setup process, check and
solve the problem, using Wi-Fi Connection Assistant. After the condition improves, redo the setup of the
printer.

Wi-Fi Connection Assistant is a powerful solution tool for network problems.

Check Basic Items for Network.

Solve Problems, Using Wi-Fi Connection Assistant.

If the Solution Tool Does Not Solve the Problem.

Step 1 : Check Basic Items for Network.

Check power status.

Check your printer and the network device (wireless router, etc.) are turned on.

If you are in the process of setting up, interrupt it and check if the wireless router (modem) is turned on and then
check if the printer is turned on.

1. Check if network device such as router is turned on.

If network devices are not turned on, turn on the power. If the network devices are on, turn them off
and on again.

It may take a while for the network device to become ready for use once they are turned on.

Proceed once the network device such as router is ready for use.

2. Check if printer is turned on.
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If printer is not turned on, turn on the power. If the printer is on, turn it off and on again.

Proceed once you complete checking the power status above.

Check PC network connection.

If your computer and network devices (wireless router, etc.) are fully configured, your computer is ready to
connect to the network.

1. Check the settings of the network device (wireless router, etc.).

Connect to the Internet and see if you can browse any web page. If you cannot view web pages on
your computer, check wireless router network connection settings, such as IP address filtering, MAC
address filtering, and DHCP function.

To check the network name (SSID) of the wireless router the printer is connected to, print the network
settings.

= Printing Network Settings

»» Note

» Depending on the wireless router, note that different network name (SSID) is assigned for a
bandwidth (2.4 GHz or 5 GHz) or its usage (for PC or game machine), using alphanumeric
characters at the end of network name (SSID).

» For more on checking the settings of the wireless router, refer to the instruction manual
supplied with the wireless router or contact the manufacturer.

If you use an encryption key, specify it for the network name (SSID) you are using. For details, see
Setting an Encryption Key.

2. Check PC network connection.

For the procedures, refer to the instruction manual supplied with the computer, or contact the
manufacturer.

Once you complete setting up the wireless router and your computer, configure the settings on your computer in
order to view web pages, using the information of the wireless router.

Proceed once you complete checking the network connection above.

Check printer's network settings.
= For Wi-Fi
= For Wired LAN
For Wi-Fi
=
L]

Make sure the is displayed on the touch screen.

513



—_—
i X
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X

is displayed.

indicates that the wireless router and the printer are not connected. Check the setting of printer.

Reconsider the location of the wireless router and the printer in the next check.

E

or is displayed

The printer is not set to use Wi-Fi.

Select the network icon on the HOME screen, and select Wi-Fi > Enable/disable Wi-Fi > Enable.

For Wired LAN

1. Check the power and LAN cable.

When the printer cannot be found on the setup screen, using LAN connection setup, make sure that
all the network devices are connected to the router and the hub via LAN cables and that all the
devices are turned on.

+ If LAN cable is not connected:
Connect the router, hub, computer and printer via LAN cables.
Make sure the printer is turned on.

= Turning the Printer On and Off

Make sure the printer, the router and the hub are turned on.

 If LAN cable is connected, and printer and network device are off:

Turn on printer and network device.

* If LAN cable is connected, and printer and network device are on:
Turn them off and on again.

»» Note

» Some devices require a couple of minutes after being turned on to become ready for use.
Wait until all devices are ready before proceeding.

2. Check printer's Wired LAN settings.

Make sure that the is displayed on the printer's touch screen.

* If icon is not displayed:
The printer is not set to use wired communication. Enable Wired LAN from the printer settings.

Select the network icon on the HOME screen, and select Wired LAN > Enable/disable Wired
LAN > Enable.
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(o) @8 Check location of wireless router.

Make sure the printer is not placed too far away from the wireless router.

The printer can be up 50 m (164 ft.) from the wireless router indoors if unobstructed. Make sure the printer is
close enough to the wireless router to be used.

Place the printer and wireless router where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due
to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

Step 2 : Solve Problems, Using Wi-Fi Connection Assistant.
Diagnose and repair the network connections using Wi-Fi Connection Assistant.
Download Wi-Fi Connection Assistant from the below page, and install it on your computer.
= Checking Printer Connection Status Using Wi-Fi Connection Assistant

Refer to below in regard to starting up Wi-Fi Connection Assistant.

¢ For Windows:

= Starting Up Wi-Fi Connection Assistant

* For macOS:
= Starting Up Wi-Fi Connection Assistant

Step 3 : If the Solution Tool Does Not Solve the Problem.

LWL Make sure security software's firewall is off.

If your security software's firewall is on, a message may appear warning you that Canon software is attempting to
access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings.

If printer is connected to AirPort Base Station via Wi-Fi, make sure you use
alphanumeric characters for network name (SSID). (macOS)

If your network name (SSID) contains characters other than single-byte alphanumeric characters, the connection
is not established properly. Change the network (SSID) to use only single-byte alphanumeric characters.

Solve network troubles with the printer's diagnostic functions.

See below.

= Cannot Connect to the Printer
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I Searching Printer by IP Address or Host Name During Setup

»» Note

« If you are using macOS 15 or later, you must configure each application to allow device discovery on
the local network. Failing to enable device discovery may restrict software functionality or prevent it
from starting properly.

For detailed instructions, refer to "Setting Up Local Network Device Discovery."

If the printer cannot be found on the Select Printer screen, search for the printer by an IP address or
host name. Click Search By IP Address on the screen which appears by clicking Printer Not Found. The
screen to select searching criteria appears.

1. Check printer's IP address or host name.
You can check the IP address or host name set for the printer by displaying it on the touch screen.
= LAN settings
2> Note

« If you use the printer in an office, ask the network administrator.

2. Specify searching method.

Select one of the methods below.

Specify Printer Search Method

@® Search by IPv4 address A
Search by IPv6 address B
Search by host name c

In order to search for your printer by IP address, you must first assign an IP address to the printer. For more details, click
[Instructions].

Instructions [4

Back Next

A: Search by IPv4 address
Select to search for printers by IPv4 address.
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B: Search by IPv6 address
Select to search for printers by IPv6 address.

C: Search by host name
Select to search for printers by host name. A host name is referred to as LLMNR host name or
Bonjour name.

3. Enter IP address or host name and click Next.

Printer search starts.

I If an error screen appears:

Resolve the error according to the instruction on the screen.

If the IP address you entered is already used for another device, follow the procedure below to specify
printer's IP address.

1. On the HOME screen, select the Network icon.

[r Plain Paper

D Plain Paper

E_ Replace Set cut
g paper *1" length
o

Tl & O

The icon displayed on the button varies depending on the current LAN status.

= Home Screen Menu Composition

If you specify the administrator password, enter the password.
2. Select Advanced.
3. Select Yes on displayed screen.

4. Select TCP/IP settings.

* If you specify IPv4 address:

1. Select IPv4.
2. Select IP address.

3. Select Manual setup.

Selecting Auto setup specifies the IP address automatically.
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4. Select Yes on displayed screen.
5. Enter IP address.

6. Select OK.

7. Enter subnet mask.

8. Select OK.

9. Enter default gateway.

10. Select OK.

The IPv4 address has been specified.

* If you specify IPv6 address:
1. Select IPv6.
2. Select Enable/disable IPv6.

3. Select Enable.
The IPv6 address has been specified.

32 Important

« If firewall is enabled on the computer, printers on a different subnet may not be detected.
Disable firewall.

I If firewall interferes with printer search:

The operating system installed on your computer and the firewall function of the security software may
unintentionally prevent communication for setup. Check if a firewall message appears.
« If a firewall message appears:

If a firewall message appears warning that Canon software is attempting to access the network, set
the security software to allow access.

After allowing the software to access, return to setup and follow the instructions on the screen.

« If no firewall message appears:
Temporarily disable the firewall and return to setup and follow the instructions on the screen.

After the setup is complete, re-enable the firewall.
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> Note

» For more on firewall settings of your operating system or security software, see instruction manual or
contact its manufacturer.
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I Cannot Print over Network

» Cannot Print over TCP/IP Network
» Cannot Print over Bonjour networks

» Cannot Print Using AirPrint
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Q

Cannot Print over TCP/IP Network

A

O VSN IS the printer's IP address configured correctly?
Make sure the printer's IP address is configured correctly.

»» Note
+ For Windows, you can configure the printer's IP address using Wi-Fi Connection Assistant.

For details, refer to "Performing/Changing Network Settings" > "Performing Network Settings" in Wi-Fi
Connection Assistant Guide.

= \Wi-Fi Connection Assistant Guide

Are the printer's TCP/IP network settings configured correctly?

Make sure the printer's TCP/IP network settings are configured correctly.

Is the computer you are trying to print from configured correctly?

Make sure the computer's TCP/IP network settings are configured correctly.
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Q

Cannot Print over Bonjour networks

A

Is the computer you are trying to print from configured correctly?

Make sure the computer is configured correctly.

Are the computer and printer on the same network?

Due to the nature of Bonjour, printing may not be possible if the printer is on another network behind a router.
Make sure the computer and printer are on the same network. For information about network settings, ask your
network administrator.

Are the printer's Bonjour settings configured correctly?

Make sure the Bonjour settings are configured correctly.
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Q

Cannot Print Using AirPrint

A

L &N Make sure printer is turned on.

If the printer is turned on, turn it off and back on, and then check whether the issue is resolved.
(VAN Make sure printer is registered to your computer.

Make sure printer is connected by LAN to same network subnet as AirPrint
compliant device when printing over LAN.

Make sure printer has enough paper and ink.

OLE SN Make sure no error message is displayed on printer's touch screen.
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I Network Connection Problems

» Network Settings and Common Problems
» Cannot Connect to the Printer

» Network Key (Password) Unknown

» Checking Network Information

» Restoring Printer's LAN Settings to Defaults
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I Network Settings and Common Problems

Here are frequently asked questions on network.

Cannot Find Printer

= Cannot Find Printer on Network
= Cannot Proceed Beyond Printer Connection Screen (Cannot Find Printer Connected via USB)
= Searching Printer by IP Address or Host Name During Setup

Cannot Print or Connect

= Cannot Print Using AirPrint
= Cannot Connect to the Printer

LAN Setting Tips/Changing LAN Settings

= Printer Connection Methods

= L AN settings

= Another Printer Found with Same Name
= Printing Network Settings

= Network Status and Troubleshooting

525



I Cannot Connect to the Printer

= Cannot Connect to a Printer after Network Configuration Changes
= Cannot Connect to a Printer via Wi-Fi

= Cannot Connect to a Printer through Wireless Direct

= Cannot Connect to a Printer via Wired LAN

= Cannot Print through Network

Q Cannot Connect to a Printer after Network Configuration Changes

A

It may take a while for the computer to obtain an IP address, or you may need to restart your computer.

Make sure the computer has obtained a valid IP address, and try again to find the printer.

Q Cannot Connect to a Printer via Wi-Fi

A

Check the power status of printer and devices (e.g. wireless router or
computer) connected to the network.

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

It may be necessary to resolve wireless router problems (e.g. update interval of a key, problems of DHCP
update interval, energy saving mode, etc.) or to update the wireless router firmware.

For details, contact the manufacturer of your wireless router.

oW Can you view any web pages on your computer?

Make sure your computer is connected to the wireless router properly.

For more on checking computer settings or connection status, see the instruction manual supplied with the
computer or contact the manufacturer.

o L& |s the printer connected to the wireless router?

Use the icon on the touch screen to check the connection status between the printer and wireless router. If the
—
)

icon is not displayed, Wi-Fi is disabled. Turn on wireless communication on the printer.

Make sure the printer and wireless router network settings match.

Make sure the network settings of the printer (e.g. wireless router name, SSID, network key, etc.) are identical
with those of the wireless router.
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To check the settings of the wireless router, refer to the instruction manual provided with it or contact its
manufacturer.

You can check the current network settings for the printer by displaying them on the touch screen.
= | AN settings
2> Note
» Wi-Fi Connection Assistant allows you to diagnose and repair the network status.
Select the link below to download Wi-Fi Connection Assistant and install it.

= Checking Printer Connection Status Using Wi-Fi Connection Assistant

Make sure the printer is not placed too far away from the wireless router.

If the distance between the printer and wireless router is too far, wireless communication becomes poor. Place
the printer and wireless router close to each other.

2> Note

» Though an antenna is attached to most wireless routers, note that some of them have it inside.

O Make sure wireless signal is strong. Monitor signal status and move printer
and wireless router as necessary.

Place the printer and wireless router where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due
to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

2> Note
» Wi-Fi Connection Assistant allows you to diagnose and repair the network status.
Select the link below to download Wi-Fi Connection Assistant and install it.

= Checking Printer Connection Status Using Wi-Fi Connection Assistant

Make sure of the Wi-Fi channel numbers used for your computer.

You need to have the same Wi-Fi channel number that you are using for the wireless router as your computer.
It is normally set in the way that you can use all the Wi-Fi channels. However, when the channels that you are
using are restricted, the Wi-Fi channels do not match.

See the instruction manual provided with your computer and check the Wi-Fi channel number available for
your computer.

o)l &M \Make sure channel set on wireless router is a usable channel as confirmed in
Check 7.

If it is not, change the channel set on the wireless router.
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O Make sure security software's firewall is off.

If your security software's firewall is on, a message may appear warning you that Canon software is attempting
to access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings.

If printer is connected to an AirPort Base Station via LAN, make sure you
use alphanumeric characters for network identifier (SSID). (macOS)

If the problem is not resolved, redo setup.
* For Windows:
Perform setup using the Setup CD-ROM or from Setup Guide.
* For macOS:

Perform setup from Setup Guide.

Q Cannot Connect to a Printer through Wireless Direct

A

Check the power status of printer and other devices (smartphone or tablet).

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

s the D icon displayed on the touch screen?

If not, Wireless Direct is disabled. Turn on Wireless Direct.

Check the settings of your device (smartphone/tablet).

Make sure Wi-Fi is enabled on your device.

For details, refer to your device's instruction manual.

Make sure printer is selected as connection for device (e.g. smartphone or
tablet).

Select the identifier for Wireless Direct (SSID) specified for the printer as the connection destination for
devices.

Check the destination on your device.
For details, refer to your device's instruction manual or visit the manufacturer's website.

When using wireless direct, you can check the network name (SSID) set for the printer by displaying it on the
touch screen.

= LAN settings
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o)L Have you entered the proper password specified for the Wireless Direct?
You can check the password set for the printer by displaying it on the touch screen.

= | AN settings

Make sure the printer is not placed too far away from the device.

If the distance between the printer and device is too far, wireless communication becomes poor. Place the
printer and device close to each other.

O\ LA Make sure 5 devices are already connected.

Wireless Direct does not allow more than 5 devices to be connected.

Q Cannot Connect to a Printer via Wired LAN

A

oL Make sure the printer is turned on.

Make sure the LAN cable is connected properly.

Make sure the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the
cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.

If the problem is not resolved, redo setup.
» For Windows:
Perform setup using the Setup CD-ROM or from Setup Guide.
* For macOS:

Perform setup from Setup Guide.

Q Cannot Print through Network

A

O SN Make sure the computer is connected to the wireless router.

For more on how to check the computer settings or connection status, see your computer instruction manual
or contact its manufacturer.

If the printer driver is not installed, install it. (Windows)

Install the printer driver using the Setup CD-ROM or install it from Setup Guide.
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LWL \When using Wi-Fi, make sure wireless router does not restrict which
computers can access it.

For more on connecting to and setting up your wireless router, see the wireless router instruction manual or
contact its manufacturer.
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I Network Key (Password) Unknown

Diagnose and repair the network connections using Wi-Fi Connection Assistant.
Download Wi-Fi Connection Assistant from the below page, and install it on your computer.
= Checking Printer Connection Status Using Wi-Fi Connection Assistant

Refer to below in regard to starting up Wi-Fi Connection Assistant.

* For Windows:

= Starting Up Wi-Fi Connection Assistant

* For macOS:

= Starting Up Wi-Fi Connection Assistant

If the problem persists after diagnosis and repair with Wi-Fi Connection Assistant, check the following items.

= WPA/WPA2/WPA3 Key Set for Wireless Router Unknown, Cannot Connect
= Setting an Encryption Key

Q WPA/WPA2/WPA3 Key Set for Wireless router Unknown, Cannot
Connect

A

Check the wireless router settings. For more on setting up a wireless router, see the instruction manual
provided with the wireless router or contact its manufacturer. Make sure your computer can communicate
with the wireless router.

Q Setting an Encryption Key

A

Select the encryption containing WPA2.

2> Note
» The factory default of wireless router supporting WPA3 may be set to WPAS3.

Make sure your computer can communicate with the wireless router using the settings you have selected.
For more on setting up a wireless router, see the instruction manual provided with the wireless router or
contact its manufacturer.

» Using WPA2/WPA3 (Windows)

The authentication method, Wi-Fi password, and dynamic encryption type must be identical among
the wireless router, the printer, and your computer.
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Enter the Wi-Fi password configured on the wireless router.
AES (secure encryption) is selected automatically as the dynamic encryption method.
For details, see If WPA/WPA2/WPAS3 Details Screen Appears.

»>» Note

» For the secure encryption supported by this printer, see "Network Specifications".

= Network Specifications

» To configure IEEE802.1X/EAP (WPA/WPA2/WPA3 Enterprise), you also need to configure the
authentication (Radius) server.

Contact the network administrator for more information.
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I Checking Network Information

= Checking Printer IP Address or MAC Address

= Checking Computer IP Address or MAC Address

= Checking Communication Between the Computer, the Printer, and the Wireless Router
= Checking Network Setting Information

Q Checking Printer IP Address or MAC Address

A

To check the printer's IP Address or MAC Address, print out the network settings information or use the
operation panel to display it.

 Display on the operation panel.
= | AN settings
* Print the network settings.

= Printing Network Settings

For Windows, you can check the network setting information on the computer screen.

= Canon Wi-Fi Connection Assistant Screen

Q Checking Computer IP Address or MAC Address

A

To check the IP Address or MAC Address of your computer, follow the instructions below.

* For Windows:
1. Select Command Prompt from Start.

2. Enter "ipconfig/all* and press Enter.

The IP Address and MAC Address of your computer appear. If your computer is not connected to
a network, the IP Address does not appear.

* For macOS:
1. Select System Settings from Apple menu, and then click Network.

2. Make sure network interface used by computer is selected.

Make sure Wi-Fi is Connected when connecting via Wi-Fi or Ethernet is Connected for Wired
LAN connection and click.
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3. Click Details to check the IP Address.

The IP Address of your computer appears. To check the MAC Address, click Hardware.

Q Checking Communication Between the Computer, the Printer, and the
Wireless Router

A

Perform a ping test to check if communication is taking place.

* For Windows:
1. Select Command Prompt from Start.

2. Type "ping XXX XXX.XXX.XXX" and press Enter.
XXX XXX XXX XXX" is the IP Address of the target device.
If communication is taking place, a message like the one shown below appears.
Reply from XXX XXX.XXX.XXX: bytes=32 time=10ms TTL=255

If Request timed out appears, communication is not taking place.

¢ For macOS:

1. Start Terminal as shown below.

Select Computer from Go menu of Finder, double-click Macintosh HD > Applications > Utilities
> Terminal.

2. Type "ping -c3 XXX XXX.XXX.XXX" and press Enter.
XXX XXX XXX XXX" is the IP Address of the target device.
If communication is taking place, a message like the one shown below appears.
64 bytes from XXX XXX.XXX.XXX: icmp_seq=0 ttl=64 time=3.394 ms
64 bytes from XXX XXX XXX.XXX: icmp_seq=1 ttI=64 time=1.786 ms
64 bytes from XXX XXX XXX.XXX: icmp_seq=2 ttI=64 time=1.739 ms
- XXX XXX XXX XXX ping statistics ---
3 packets transmitted, 3 packets received, 0% packet loss
If the following message is displayed, communication is not working properly.
PING XXX XXX XXX XXX (XXX XXX XXX.XXX) : 56 data bytes
=== XXX XXX XXX XXX ping statistics ---

3 packets transmitted, 0 packets received, 100% packet loss
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Q Checking Network Setting Information

A

To check the printer's network settings information, display it using the operation panel of the printer or
print it out.

 Display on the operation panel.
= | AN settings
* Print the network settings.

= Printing Network Settings
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Q

Restoring Printer's LAN Settings to Defaults

A

22 Important

* Initialization erases all network settings on the printer, making printing operation from a computer over
a network impossible. To use the printer over a network again after restoring it to the factory defaults,
refer to "Setup Guide" and redo setup.

Initialize the network setting using the printer's operation panel.

= Reset settings
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I Printer Problems

» Printer Does Not Turn On

» USB Connection Problems

» LCD Is Off

» Messages advising to check the maintenance cartridge are not cleared

» If the Printer Makes a Strange Sound
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Q

Printer Does Not Turn On

Press ON button.

Make sure power plug is securely connected to printer, and then turn on again.

W Unplug printer, leave it for at least 2 minutes, and then plug it back in and turn
on again.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

= Repairing Your Printer
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Q

USB Connection Problems

A

If the printer connected to the computer via USB is not recognized, check the following items.

= USB Connection Not Recognized

The following problems may occur even though the USB connection is recognized.

* Printing speed is slow.
* Hi-Speed USB connection does not work.
* A message such as "This device can perform faster" appears (Windows).

If the above is the case, check the following.
= USB Connection Does Not Work Properly
»>» Note

« If your system environment does not support Hi-Speed USB, the computer is connected to the printer
at Full-Speed or Low-Speed. In this case, the printer works properly but printing speed may slow down
due to the difference in the communication speed.

I USB Connection Not Recognized

OV &N Make sure printer is turned on.

Unplug the USB cable from the printer and the computer, and then connect it
again.

The USB cable port is located on the rear of the printer as shown in the illustration below.
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32 Important

» Check the orientation of the "Type-B" connector and connect to the printer. For details, refer to the
instruction manual supplied with the USB cable.

Check that Enable bidirectional support is selected in Ports sheet of
Printer properties dialog box (Windows).

If not, select it to enable bidirectional support.

= How to Open the Printer Driver Setup Window

Initialize the printer settings.

e

= Reset settings

Select (Setup) on HOME screen > Printer settings > Reset settings > Reset all.
After initializing the printer settings, redo setup.

Refer to Setup Guide and redo setup.

I USB Connection Does Not Work Properly

Check following to make sure your system environment supports Hi-Speed
USB connection.

» The types of USB cables that can be used differ depending on your printer. Check the shape of the USB
cable connection of the printer.

= What Is USB cable?
* Does the USB port on your computer support Hi-Speed USB connection?
* Does the USB cable or the USB hub support Hi-Speed USB connection?

Be sure to use a certified Hi-Speed USB cable. We recommend that the USB cable be no longer than 10
feet / 3 meters or so.

* Is the Hi-Speed USB driver working properly on your computer?

Make sure the latest Hi-Speed USB driver is working properly and install the latest version of the
Hi-Speed USB driver for your computer, if necessary.

32 Important

» For more information, contact the manufacturer of your computer, USB cable, or USB hub.
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Q

LCD Is Off

A

+ If ON lamp is off:
The printer is not powered on. Check that the power cord is connected and press the OK button.

= Turning the Printer On and Off

* If ON lamp is lit:

The touch screen may be in screen-saver mode. Press any button on the operation panel.
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Q

Messages advising to check the maintenance cartridge are not
cleared

A

The newly replaced maintenance cartridge is not recognized.
Remove the newly replaced maintenance cartridge, and then reinsert it again firmly.

= Replacing the Maintenance Cartridge
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Q

If the Printer Makes a Strange Sound

A

Has an unusual noise been produced from the vicinity of the roll holder?

If dust accumulates on the gear (A) at the end of the roll holder, a noise may be produced from that area.

(T 1T TWooooonp

—L 1

When the noise starts, clean the gear with the following procedure.
1. Remove the roll holder from the printer.
2. Wipe the dust off the gear with a damp, tightly wrung cloth, and then dry with a dry cloth.

3. Insert the roll holder in the printer.

Operating noise may be heard from the printer even when not printing.
The following sounds do not indicate a problem with the printer.
* Roll paper makes a fluttering sound during printing.
There may be a fluttering sound when large paper is advanced.
* You suddenly hear the sound of cleaning operations.
Cleaning is automatically performed at specified intervals in order to keep the printer maintained.
* You suddenly hear the sound of ink agitation.

In other cases, contact your Canon dealer.
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I Printing Problems

» Printer Does Not Print
» Printing Stops

» Printing stops and an error message is displayed
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Q

Printer Does Not Print

A

LW &N Make sure printer is turned on.
If not, make sure the printer is securely plugged in and press ON button to turn on.
The ON lamp flashes while the printer is initializing. Wait until the ON lamp stops flashing and remains lit.

»» Note

+ If you are printing large data such as photos or other graphics, printing may take longer to start. The ON
lamp flashes while the computer is processing data and sending it to the printer. Wait until printing starts.

Make sure printer is properly connected to computer.

If you are using a USB cable, make sure it is securely connected to both the printer and the computer. When the
USB cable is securely plugged in, check the following:

« If you are using a relay device such as a USB hub, disconnect it, connect the printer directly to the
computer, and retry the printing. If printing starts normally, there is a problem with the relay device. Contact
the vendor of the relay device.

» There could also be a problem with the USB cable. Replace the USB cable and retry the printing.
If you use the printer with a network connection, make sure the printer is correctly set up for network use.

= Cannot Find Printer on Network (Windows/macOS)

»» Note

* Wi-Fi Connection Assistant allows you to diagnose and repair the network status.

Select the link below to download Wi-Fi Connection Assistant and install it.
= Checking Printer Connection Status Using Wi-Fi Connection Assistant

Refer to below in regard to starting up Wi-Fi Connection Assistant.

— For Windows:

= Starting Up Wi-Fi Connection Assistant

— For macOS:

= Starting Up Wi-Fi Connection Assistant

Make sure paper settings match information set for the printer.

If the paper settings do not match the information set for the printer, an error message appears on the touch
screen. Follow the instructions on the operation panel to solve the problem.

If printing from a computer, delete unnecessary print jobs.
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* For Windows:

= Deleting the Undesired Print Job

* For macOS:

= Deleting the Undesired Print Job

Are your printer's Printer Driver selected when printing?

The printer will not print properly if you are using a printer driver for a different printer.

* For Windows:

Make sure "Canon XXX" (where "XXX" is your printer's name) is selected in the Print dialog box.

»» Note

« If multiple printers are registered to your computer, set your printer as default printer to make the one
selected by default.

* For macOS:

Make sure your printer's name is selected in Printer in the Print dialog.

»» Note

« If multiple printers are registered to your computer, select Set as Default Printer from System
Settings > Printers & Scanners for a printer to make the one selected by default.

If printing from your computer, restart the computer.

Restart the computer and try printing again.
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Q

Printing Stops

Is paper loaded?

Make sure paper is loaded.

If necessary, load paper.

Do documents to be printed have many photographs or illustrations?

It takes time for the printer and the computer to process large data such as photos or other graphics, so it may
seem that the printer is not working.

Also, if you are printing data that requires a lot of ink on successive sheets of plain paper, the printer may pause
temporarily. In either case, wait until the process is complete.

»» Note

+ If you are printing a document with a large printing area or printing several copies, printing may pause to
allow the ink to dry.

Has printer been printing continuously for a long period?

If the printer has been printing continuously for a long time, the print head or other parts around it may overheat.
The printer may stop printing at a line break for a period of time and then resume printing.

In this case, wait a while without doing anything. If the printing does not resume, turn the printer off. After waiting
for a while, turn on the printer, and check whether printing is possible.

/1 Caution

+ Print head and surrounding area in the printer can become extremely hot. Never touch print head or nearby
components.
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Q

Printing stops and an error message is displayed

A

If the action indicated in the error message does not solve the problem, the roll paper may be stuck and not
able to be advanced.

Is the loaded roll paper touching printer parts, etc.?

If the loaded roll paper is touching printer parts, load the roll paper again.

= Removing the Roll from the Printer

O |s the roll paper proper to use?

Check the outer diameter and paper thickness of the roll paper that can be used with your printer.

= Paper Sizes
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I Paper is not Fed or Ejected Properly

>

>

Remove Jammed Roll Paper

Remove a Jammed Sheet

Remove Jammed Paper (Paper Feed Slot)

What to Do When Small Paper Sizes Are Jammed

Roll paper cannot be inserted into the Paper Feed Slot
Printer Does Not Pick up or Feed the Paper/"No Paper" Error
Roll Paper Remains/Lacks under Quantity Management

The printer ejects blank, unprinted paper

549



Q

Remove Jammed Roll Paper

A

If roll paper jams, follow the steps below to remove jams.

1. Positioning your hands as shown, open the cut sheet feed cover.

figure.

3. Cut loaded roll paper with regular scissors or the like.

Before cutting, loose the roll paper and lift it up.

A Caution

» When cutting paper, be careful to avoid injury or damage to the printer.
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4. Open the left and right access covers, and the access cover and move the carriage to the
left or right side manually, away from the jam.

32 Important

» Do not move the carriage over jammed paper. This may damage the print head.
» Do not touch the linear scale (A) or carriage rail (B). This may stain your hands and damage the
printer.

5. Remove the jammed paper from the output tray.
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7. After rolling up all the paper, remove it from the platen.

After removing the paper from the platen, check for any remaining pieces of paper.
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Q

Remove a Jammed Sheet

A

If a sheet jams, follow the steps below to remove it.
« If the paper is jammed by the paper feed slot
Remove the jammed paper from the paper feed slot.

After removing the paper, make sure there are no other scraps of paper in the printer.

« If the paper is jammed by the ejection guide
Remove the jammed paper from the output tray.

After removing the paper, make sure there are no other scraps of paper in the printer.

« |If the paper cannot be pulled through by any of the solutions above, try the following.

1. Open the left and right access covers, and the access cover and move the carriage to
the left or right side manually, away from the jam.
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2» Important

» Do not move the carriage over jammed paper. This may damage the print head.
* Do not touch the linear scale (A) or carriage rail (B). This may stain your hands and damage
the printer.

2. Remove the jammed paper from the paper feed slot and output tray again.

After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close the left and right access covers.
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Q

Remove Jammed Paper (Paper Feed Siot)

A

Follow these steps to remove any scraps left in the paper feed slot after you clear jammed sheets or roll
paper.

1. Positioning your hands as shown, open the cut sheet feed cover.

figure.

3. Fold an A4 sheet lengthwise four times, insert it through the gap of the paper feed slot, and
scrape the jammed paper to the paper feed slot side.

=y

4. Remove scrap when it is pushed out onto the paper feed slot.
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5. If any scraps remain inside paper feed slot, repeat steps 3 and 4.

6. Holding it at the positions indicated, close the roll paper feed cover and cut sheet feed
cover.
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I What to Do When Small Paper Sizes Are Jammed

If the paper jams when you try to print on a small paper size such as 4"x6" 10x15cm size, follow the steps
below.

1. Press printer's Stop button.

2. Load one sheet of A4 or Letter plain paper in portrait orientation into the printer.

= | oading Sheets or Postcards into the Printer

3. Turn off printer.

4. Turn on printer.
When the loaded paper is fed, the jammed paper will be pushed out.

> Note

« If the jammed paper is not ejected, try cleaning the paper feed rollers before step 5. The jammed
paper may be ejected along with the paper used for cleaning the paper feed rollers.

= Cleaning Paper Feed Rollers

5. Load paper into the printer.

= | oading Sheets or Postcards into the Printer
= Loading Envelopes or Medicine Envelopes into the Printer

2» Important

* Do not load paper in landscape orientation. It may cause a paper jam.

* You cannot print on paper smaller than the minimum size.

= Paper Sizes

»» Note

» Make sure you are using suitable paper and loading it correctly.

6. Redo printing.
All jobs in the print queue are canceled. Redo the printing.
If the measures above do not solve the problem, contact your Canon dealer.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
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* When transporting the printer for repairing it, see Repairing Your Printer.
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Q

Roll paper cannot be inserted into the Paper Feed Slot

Is the roll paper curled?

Straighten out curls and reload the roll.

Is paper jammed in the feed slot?

Remove the jammed paper.

= Remove Jammed Roll Paper
= Remove a Jammed Sheet

Check the paper information on the HOME screen.

Select the paper setting display area on the HOME screen of the touch screen, and if "Roll" is not displayed,
select Replace paper or Load roll paper from the Roll paper settings screen, and then load the roll paper.
Select the paper setting display area on the HOME screen, and select the area of the roll paper from the Paper
information screen. Select Replace paper or Load roll paper from the Roll paper settings screen, and then
load the roll paper.

[r Plain Paper

D There is no paper,
Replace Set cut
-
E" paper Eg length

> @ o 0

The leading edge of the roll paper may not be cut properly.

If the leading edge of the roll paper is crooked or folded, the paper may not be fed correctly. Cut the leading
edge with scissors to straighten it.
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Q

Printer Does Not Pick up or Feed the Paper/”"No Paper" Error

A

Make sure paper is loaded in the printer.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

When loading sheets, be sure to load the paper with the following precautions.

* When loading two or more sheets of paper, align the edges of the sheets before loading the paper.

* When loading two or more sheets of paper, make sure the paper stack does not exceed the paper load
limit.
However, paper may not feed correctly at the maximum capacity, depending on the type of paper or

environmental conditions (very high or low temperature and humidity). In such cases, reduce the amount of
paper you load at a time to less than half of the paper load limit.

* For envelopes or medicine envelopes smaller than A4 size, load them one by one.
+ Always load the paper in portrait orientation, regardless of the printing orientation.

* When you load the paper on the top feed, place the print side facing UP and align the right and left paper
guides with the paper stack.

= | oading Sheets or Postcards into the Printer

Is paper too thick or curled?

When loading envelopes, consider the following.

* When printing on envelopes, see Loading Envelopes or Medicine Envelopes into the Printer, and prepare
the envelopes before printing.

Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed in
landscape orientation, they will not feed properly.

= | oading Envelopes or Medicine Envelopes into the Printer

Make sure media type and paper size settings match with loaded paper.

Make sure that there are not any foreign objects in the top feed.

Remove any foreign objects from the top feed.

If a foreign object is inside the top feed, remove it according to the following procedure.

1. Turn off the power of the printer and disconnect the power plug from the outlet.
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2. Fold one A4 sheet in half and insert it horizontally into the top feed.

Insert the paper so that your hand does not directly touch the part in the center of the top feed when
removing the foreign object.

3. Remove foreign object by hand with paper inserted.

Put your hand between the paper you inserted and the top feed to remove the foreign object.

4. Remove the folded paper inserted in step 2.

32 Important

* Do not tilt the printer or do not it upside down. Doing so may cause the ink to leak.

Clean Paper Feed Roller.

= Cleaning Paper Feed Rollers
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> Note

+ Cleaning the paper feed roller abrades it, so do this only when necessary.
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Q

Roll Paper Remains/Lacks under Quantity Management

A

Check the setting of Manage remaining roll amount.

« If Auto estimate is selected for Manage remaining roll amount:
Make sure the media type is configured correctly.

Make sure Paper core outer diameter and Paper thickness are configured correctly for Advanced paper
settings.

= Paper-related settings

»» Note

» Paper core outer diameter and Paper thickness must be set correctly for auto estimation to be
accurate.

» Contact the media manufacturer for paper core outer diameter and paper thickness.

» For pre-registered paper, the paper core outer diameter and paper thickness are set, but they may be
changed at the convenience of the media manufacturer.

« If you want to use paper that is not displayed in the paper information list, set the paper thickness and
paper core outer diameter in the Media Configuration Tool.
= Media Configuration Tool Guide
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Q

The printer ejects blank, unprinted paper

A

The leading edge of the roll paper may have been trimmed.

The leading edge of the roll paper may be trimmed if Trim edge first is not set to Off in the touch screen menu.

When you perform the minimal margin printing or borderless printing, the leading edge of the roll paper is
trimmed.

= Cutting the Leading Edge of Roll Paper Automatically

Is the Print head nozzle blocked?

Print a nozzle check pattern to check the Print head status.

= Checking for Nozzle Clogging
= Maintenance Procedure

O &M |s the correct printer driver selected?

Print again using the correct printer driver for your printer.

If none of the above apply, there may be a printer malfunction.

Contact your Canon dealer for assistance.
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I Paper Cutting Problems

» Paper is not cut straight
» Cutter Blade Does Not Work While Cutting Is in Progress
» | want to know how to configure roll cutting

» | want to configure so that the roll is cut automatically after waiting for the ink to
dry
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Q

Paper is not cut straight

A

Is the edge of the paper cutting position creased?

Straighten out any curling by the edges of the paper.

Is the edge of the paper cutting position lifting up when cutting?

Reload the paper correctly.

Check that the Cut speed setting is correct.

If the paper edge cannot be cut straight at the cut starting position, it may be improved by selecting slower cut
speed than that selected currently.

If the paper edge cannot be cut straight at the cut ending position, it may be improved by selecting faster cut
speed than that selected currently.

Select : (Setup) > Printer settings > Paper-related settings on Advanced paper settings in the touch
screen menu, and change the Cut speed setting.

= Advanced (Paper settings)

O CH®AN Did the printing material slip diagonally while being cut?
Set the Cutting mode in the touch screen menu to Eject cut, and then hold and cut the material after it has
printed.

= Specifying the Cutting Method for Rolls
= Cutting Roll Paper after Printing
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Q

Cutter Blade Does Not Work While Cutting Is in Progress

A

SN Does a message appear on the touch screen?
If the cutter blade failed to cut the paper, it stops moving and a message appears on the touch screen.
Remove the paper and try printing again.

= Remove Jammed Roll Paper

Check the setting value for Cut speed.

Selecting slower value may enable the cutter blade to cut paper.

Select : (Setup) > Printer settings > Paper-related settings > Advanced paper settings on the HOME
screen of the touch screen, and change the Cut speed setting.

= Advanced (Paper settings)
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Q

| want to know how to configure roll cutting

A

Cutting methods can be selected in the printer settings.
To automatically cut roll paper after printing, open the Cutting mode settings on the printer.

When using paper that is easily scratched, or paper where the ink requires extra time to fix, we recommend
setting Cutting mode on the printer to Eject cut.

= Specifying the Cutting Method for Rolls
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Q

| want to configure so that the roll is cut automatically after waiting
for the ink to dry

A

You can set an ink drying time in the printer driver.
You can also configure the same settings on the printer itself.

= Specifying the Ink Drying Time
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I Paper Setting Problems

» Paper widths with high transparency cannot be detected
» Paper types that can be used with this printer / What paper type to select

» The paper type that | want to print is not displayed on the Touch Screen
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Q

Paper widths with high transparency cannot be detected

A

If the paper is semi-transparent paper, the size cannot be detected. Detect paper width setting is disabled.
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Q

Paper types that can be used with this printer / What paper type to
select

A

For information about paper that can be used with this printer, refer to the paper information list.
= Paper Information List

Select the media type according to the following.

I If using Canon genuine paper/feed confirmed paper

See "Paper Settings List (Roll Paper)" or "Paper Settings List (Cut Sheet)".
»>» Note

 For instructions on selecting the media type with the operation panel, see "Changing the Type
of Paper". For instructions on selecting the media type with the printer driver, see "Main Tab
Description” (Windows) or "Quality & Media" (macOS).

paper

See "Using Paper Other Than Genuine Paper and feed confirmed Paper".

I If using the paper other than Canon genuine paper/feed confirmed
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Q

The paper type that | want to print is not displayed on the Touch
Screen

A

If using a new paper type, start the Media Configuration Tool to get the latest media information.

= Updating paper information
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I Ink-related Problems

* Ink Does Not Come Out
» Printer consumes a lot of ink

» Ink Level Detection

577



Q

Ink Does Not Come Out

A

Check the remaining ink level.

= Checking Ink Level

Print the nozzle check pattern and make sure that the ink is coming out
normally.

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

2. Select : (Setup) on the HOME screen.

3. Select i‘% Maintenance.
4. Select Nozzle Check.
5. Check message and select Yes.

6. Select Roll paper or Top feed.

The nozzle check pattern will be printed and two pattern confirmation screens will appear on the touch
screen.

7. Check the print result.
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If the nozzle check pattern more closely resembles B1:

= Cleaning the Print Head

If the nozzle check pattern more closely resembles B2:
= Deep Print Head Cleaning

»» Note

* To avoid image degradation, we recommend printing at least once a week.

»» Note

+ Slowly over time, air naturally enters the ink tube (C) that connects the print head (A) to the ink tank (B). If
this air accumulates in the print head, ink (D) is not easily ejected.
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]
*

The cross-section of the ink tube (E) shows a small amount of air (F) inside it. These small air bubbles

will be carried with the ink and expelled when printing without impacting the print results. However, if no
printing is performed for an extended period, the bubbles will accumulate into larger air pockets (G). When
these air pockets reach the print head (A), the amount of air inside the print head may increase to the point
where ink is not easily ejected, potentially resulting in faint images or blank pages.

O LM |s the correct printer driver selected?

Print again using the correct printer driver for your printer.

If none of the above apply, there may be a printer malfunction.

Contact your Canon dealer for assistance.
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Q

Printer consumes a lot of ink

A

Are lots of full-color materials being printed?

In print jobs such as photos, images are filled with color. This consumes a lot of ink. This does not indicate a
problem with the printer.

Is Replace Ink in Print Head being carried out frequently?

Replace Ink in Print Head uses a lot of ink. This is normal. We recommend that you only carry out Replace
Ink in Print Head after the printer has been transported, if it has not been used for a long time, or if there is a
problem with the Print head.

You have just finished initial installation, when more ink is consumed to fill the
system.

If using the printer for the first time, or using it after transport, the ink tank will supply an initial fill of ink to the
Print head.

Although the amount of remaining ink may drop as a result, it does not indicate a problem.

Is the Print head nozzle blocked?

Check for nozzle clogging.

= Checking for Nozzle Clogging
= Maintenance Procedure
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Q

Ink Level Detection

A

This printer has a function that detects the remaining ink level to prevent running out of ink while printing and
to avoid printer failure.

= Checking Ink Level
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| About Print Settings

» How do | print without borders
» | want to easily create vertical or horizontal banners
» Can | perform duplex printing

» | want to perform enlargement printing
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Q

How do | print without borders

A

If printing on roll paper, you can perform the minimal margin printing by the printer driver settings. Some
software displays this as borderless printing. (If printing on sheets, minimal margin printing is not possible.)

In the minimal margin printing, slight margins will appear on the left and right sides of the paper.
= Printing with Minimal Margins on the Scenarios (Windows)
= Printing with Minimal Margins on the Scenarios (macOS)

»>» Note

* When perform the minimal margins printing, if the left and right margins do not match, adjust the left
and right margin amounts in Roll paper minimal margin amount in the touch screen menu.

= Setting the Minimal Margin Amount When Performing the Minimal Margin Printing

* For the roll paper types compatible with the minimal margin printing, see "Paper Settings List (Roll
Paper)".

= Paper Settings List (Roll Paper)

* When performing the minimal margin printing, the leading edge of the roll paper is cut and the scraps
are ejected.
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Q

| want to easily create vertical or horizontal banners

A

You can print originals that are in landscape (or portrait) orientation automatically enlarged to fit the roll
width. This is an easy way to create vertical or horizontal banners.

= Printing Hanging and Horizontal Banners on Roll Paper (Large-Format Printing) (Windows)
= Printing Hanging and Horizontal Banners on Roll Paper (Large-Format Printing) (macOS)
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Q

Can | perform duplex printing

A

This printer cannot print double-sided.
An alternative to double-sided printing is to use the Folded Duplex function of the Windows software Free

Layout plus, which prints two pages on one side, folds the sheet back from the center, and hangs it.

= Laying Out Documents Freely Using Free Layout plus
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Q

| want to perform enlargement printing

A

Use the printer driver to adjust the original to the paper size and width, or print enlarged or reduced by
specifying a magnification factor.

= Scaled Printing (Windows)
= Scaled Printing (macOS)
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I List of Support Code for Error

Support code appears on the printer's touch screen and your computer screen when errors occur.

A "support code" is an error number, and appears along with an error message.

When an error occurs, check the support code and take the appropriate action in response.

I Support Code Appears on Printer's Touch Screen and Computer Screen

+ 1000 to 122Z

1000 100A 1021 1024 1026 1058 1070 1200 1201 120A 120B 120C
1215 1220 1221 1300 1313 1317 1338 1339 133A 1369 136A 136B
1401 1403 1405 140B 1434 147D 1496 1563 15A1 15A2 15A3 15B0
1641 1723 1724 1725 1726 1727

* 2000 to 2227
2114 2117 2123 2200 2500

» 3000 to 3Z2ZZ
3000 3252 3306 3310 3311 3312 3313 3314 3315 3316 3317 3318
3319 3413 3440 3441 3442 3443 3444 3445 3446 3447 3454 3455

* 4000 to 4Z2ZZ
4103 4104 410F 4111 4129 412A 4920 4931 495A

» 5000 to 52Z2Z
5100 5200 5207 5400 5700 5C02 5C30

* 6000 to 62Z2Z
6000 6001 6004 6011 6012 6013 6014 6015 6016 6017 6018 6019
6030 6500 6503 6700 6701 6800 6801 6830 6831 6832 6833 6900
6901 6902 6910 6920 6921 6930 6931 6932 6933 6940 6941 6942
6943 6944 6945 6946 G6A80 6A81 6DO1

» 7000 to 7Z2ZZ
7500 7600 7700 7800
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» A000 to ZZ2ZZ

B506 B508 B509 BS0A C000 C100 C101 D103 D107 D108 D109
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| 1000

I Cause

Possible causes include the following.

» There is no paper in the top feed.
» Paper is not loaded in the top feed properly.

I What to Do

Take the corresponding actions below.
» Load paper in the top feed.

= |[oading Sheets or Postcards into the Printer

+ Align the paper guides of the top feed with both edges of the paper.

After carrying out the above measures, select OK on the printer's touch screen to cancel the error.

> Note

» To cancel printing, press the printer's Stop button.
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| 100a

I Cause

You have attempted to print on a roll, but no roll is loaded.

| what to Do

Select Load roll paper on the touch screen, and then load the paper roll and print.
= [oading Rolls in the Printer

»>» Note

» To cancel printing, press the printer's Stop button.
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| 1021

I Cause

The printer has received a print job longer than the amount of roll paper left.

| what to Do

Select Replace paper on the printer's touch screen, replace the paper roll with a paper roll that is long
enough to print the print job and continue printing.

= Removing the Roll from the Printer
= [ oading Rolls in the Printer

»>» Note

» To cancel printing, press the printer's Stop button.
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| 1024

I Cause

Possible causes include the following.

* Roll paper is empty.
» There is remaining roll paper, but because it could not be advanced, it could not be detected.

I What to Do

* The roll paper has run out
Follow the steps below to replace the used roll with a new roll of the same type and size.
1. Remove the roll paper.

= Removing the Roll from the Printer

2. Load the new roll.

= [ oading Rolls in the Printer

» Feed stopped because the end of the paper roll is attached to the core with tape
Remove the used roll paper and insert a new roll paper.

= Removing the Roll from the Printer
= [ oading Rolls in the Printer

* Feed stopped because the remaining paper roll is too heavy
It may be helpful to change the printing mode, which will change the paper feed timing.
If using Windows, select a higher Print Quality setting under Advanced Settings in the printer driver.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality
setting.

= Setting the Print Quality Level (Custom) (Windows)
= Setting the Print Quality Level (Custom) (macOS)

»>» Note

» To cancel printing, press the printer's Stop button.
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| 1026

I Cause

Roll paper is empty.

| what to Do

* The roll paper has run out
Follow the steps below to replace the used roll with a new roll of the same type and size.
1. Remove the roll paper.

= Removing the Roll from the Printer

2. Load the new roll.

= [ oading Rolls in the Printer

* Feed stopped because the end of the paper roll is attached to the core with tape
Remove the used roll paper and insert a new roll paper.

= Removing the Roll from the Printer
= | oading Rolls in the Printer

> Note

» To cancel printing, press the printer's Stop button.
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| 1058

I Cause

Roll paper has almost run out.

| what to Do

Printing will continue. Replace the roll paper in the printer with one that has enough paper for printing as
soon as possible.

= Removing the Roll from the Printer
= [ oading Rolls in the Printer

»>» Note

» To cancel printing, press the printer's Stop button.
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| 1070

I Cause

Paper cannot be fed because the paper feed rollers are dirty.

| what to Do

Press the printer's Stop button to cancel printing.
Then perform the paper feed roller cleaning of top feed.
» From the printer's operation panel:

= Cleaning Paper Feed Rollers
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| 1200

I Cause

Access cover is open.

| what to Do

Close the access cover and wait for a while.
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| 1201

I Cause

The ink tank cover is open.

| what to Do

Close the ink tank cover.
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| 120n

I Cause

The access cover on the left side of the printer is opened.

| what to Do

Close the access cover on the left side, and wait for a while.
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| 1208

I Cause

The roll paper feed cover is open.

| what to Do

Close the roll paper feed cover.
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| 120c

I Cause

The print job was interrupted because the cover was opened while it was being prepared.

| what to Do

After closing the access cover, select OK.

If the maintenance work requires you to open the access cover, the instructions are displayed on the
screen of the printer.

Do not open it at any other timing.
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| 1215

I Cause

Printer maintenance in progress.

| what to Do

Complete printer maintenance.
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| 1220

I Cause

Roll paper feed cover is open.

| what to Do

Close the roll paper feed cover, select OK on the printer's touch screen to cancel the error.

= Front
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| 1221

I Cause

Roll paper feed cover is open.

| what to Do

Close the roll paper feed cover, select OK on the printer's touch screen to cancel the error.

= Front
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| 1300

I Cause

The paper is jammed inside the printer.

| what to Do

1. Remove jammed paper.

= Remove Jammed Roll Paper
= Remove a Jammed Sheet

»» Note

* If you cannot pull out the paper, turn the printer back on without pulling forcibly. The paper may

be ejected automatically.
* |If paper becomes jammed during printing and you need to turn off the printer to remove it, press

the printer's Stop button to stop the printing before you turn off the printer.
* If the paper tears and you cannot remove the jammed paper from the paper output slot or the
top feed, remove the paper from inside the printer.

= Remove Jammed Paper (Paper Feed Slot)

2. Lock the lock lever of the roll holder.

When roll paper is loaded, remove the roll paper from the printer, and check if the lock lever of the roll

holder is locked.

= Removing the Roll from the Printer

3. Reload paper and select OK on printer's touch screen.
The printer resumes printing. Reprint the page you were printing if it was not printed properly due to
the paper jam.

If you turned off the printer in step 1, all jobs in the print queue are canceled. Redo the printing.

> Note

* When reloading the paper, make sure you are using suitable paper and loading it correctly.
» We recommend using paper sizes other than A5 to print documents with photos or graphics. A5
paper may curl and jam as it leaves the printer.

If the measures above do not solve the problem, contact your nearest Canon service center to request a
repair.
2% Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 1313

I Cause

Paper is jammed as printer pulled in printed paper.

| what to Do

Depending on where the paper is jammed, decide on the countermeasure.
« If the paper is jammed at the paper output slot:

= Remove Jammed Roll Paper
= Remove a Jammed Sheet

« If the paper is jammed inside the printer:

= Remove Jammed Paper (Paper Feed Slot)
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| 1317

I Cause

Paper loaded crooked was detected when the paper was advanced.

| what to Do

Reload the paper.

= [ oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

If this error appears again even after reloading the paper roll, reinsert the roll holder so that there is no
gap between it and the paper roll.

= | oading Rolls in the Printer

32 Important

« If this message continues to appear even after taking the steps above, or if you do not want this
message to appear, set Skew detection accuracy in the printer menu to OFF or Loose. However,
note that the paper will be printed skewed, which could cause paper jams and abnormal print results,
or dirty the platen and the reverse of the next printed sheet.
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| 1338

I Cause

The lock levers of the roll holders are not locked.

| what to Do

Remove the roll paper from the printer and check if the lock levers of the roll holders are locked.

= Removing the Roll from the Printer

If there is a gap between the roll paper and the roll holders, push them firmly so that there is no gap, lock
the lock levers, and then reload the roll paper into the printer.

= | oading Rolls in the Printer
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| 1330

I Cause

The roll paper is not set correctly in the roll holders.

| what to Do

Remove the roll paper from the printer and set the roll holders again. At that time, make sure that roll
holders are pushed firmly into the roll until they make contact with the sides of the roll without any gaps.

= Removing the Roll from the Printer

Check that the lock levers are locked and reload the roll paper in the printer.

= | oading Rolls in the Printer
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| 133a

I Cause

Minimal Margin Printing cannot be performed because the roll paper is not set correctly in the roll holders.

| what to Do

Press the printer's Stop button to cancel printing. Then, remove the roll paper from the printer and set the
roll holders again.

= Removing the Roll from the Printer

Check that the lock levers are locked and that the roll holders are set correctly, then reload the roll paper
into the printer.

= | oading Rolls in the Printer

> Note

» Depending on the paper you are using, you may not be able to perform Minimal Margin Printing.
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| 1360

I Cause

There is insufficient ink to perform cleaning.

| what to Do

Select OK on the printer's touch screen to cancel the error.
Before performing cleaning, check the remaining ink level of all colors, and refill the ink as necessary.

= Checking Ink Level
= Refilling Ink Tanks

»>» Note

» Since replace ink in print head consumes a lot of ink, perform it only when necessary.
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| 136a

I Cause

Cleaning cannot be performed because the maintenance cartridge is almost full.

| what to Do

To perform Cleaning, replace the maintenance cartridge.

= Replacing the Maintenance Cartridge

Tap the printer's OK button.
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| 1368

I Cause

Print head cleaning was executed continuously.

| what to Do

Select OK on the printer's touch screen.

If cleaning is to be performed continuously, allow a certain amount of time after the previous cleaning.

613



| 1401

I Cause

Print head may be damaged or not installed.

| what to Do

If print head is not installed, install the print head.
Refer to Replacing the Print Head for instructions on installing the print head.
If print head is installed, you should turn off the printer, and turn it back on again.
If this doesn't solve the problem, the printer needs repair.
32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

»>» Note

» Refer to Replacing the Print Head for details on installing the print head.
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| 1403

I Cause

Print head may be damaged.

| what to Do

Turn off the printer and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 1405

I Cause

Print head may be damaged.

| what to Do

Turn off the printer and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 1408

I Cause

Print head may be damaged.

| what to Do

Turn off the printer and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 1434

I Cause

Print head may be damaged.

| what to Do

Turn off the printer and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 1470

I Cause

Print head may be damaged.

| what to Do

Turn off the printer and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 1406

I Cause

The maintenance cartridge cannot be recognized.

The maintenance cartridge may not be installed properly or may not be compatible with this printer.

| what to Do

Remove the maintenance cartridge, and then reinstall it correctly.

Refer to Replacing the Maintenance Cartridge for details on removing and installing the maintenance
cartridge.
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| 1563

I Cause

There may not be enough ink left.

| what to Do

Check the remaining ink level and refill with the ink of the color that is running low.

= Checking Ink Level
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| 15a1

I Cause

Printer operation is not completed.

| what to Do

Proceed with printer setup according to the message displayed on the printer's touch screen.

If this error occurs while operating the printer from a smartphone / tablet, complete the printer setup and
then operate again.
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| 15A2

I Cause

There is no ink in the ink tanks.

| what to Do

Fill the ink tanks with all the ink contained in the bottles included with the printer.

= Refilling Ink Tanks

After filling the ink, close the tank caps and ink tank inner covers firmly and close the ink tank cover.
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| 15A3

I Cause

Shipping tape or protective material may still be attached to carriage.

| What to Do

Open the access cover and make sure that shipping tape and protective material have been removed
from the carriage.

If the shipping tape or protective material is still there, remove it and close the access cover.

In the case of the first printer setup, select your printer name on the below page, and follow the
instructions.

= Set Up
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| 1580

I Cause

There may not be enough ink left.

| what to Do
Check the remaining ink level and refill the ink of the color that is running low, and then reset the
remaining ink count.

= Checking Ink Level
= Other printer settings
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| 1641

I Cause

Ink may have run out.

| what to Do

If you intend to PRINT, you should take one of the following steps:
- Tap OK on the printer's screen.

o If there is some residual amount of ink in the tank(s), you will be able to PRINT until the remaining
ink is depleted, although image quality may diminish as the remaining ink in the tank(s) becomes
depleted. Please note that if you continue to PRINT in this state, the printer may consume excess ink
as it attempts to return to normal image quality after it is refilled with ink.

- Refill the ink tank with ink until the 0 (icon) on the operation panel disappears, then close the ink tank
cover.

»>» Note

» Refer to Refilling Ink Tanks for details on refilling ink tanks.
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| 1723

I Cause

The maintenance cartridge is not installed.

| what to Do

You should install the maintenance cartridge.
Refer to Replacing the Maintenance Cartridge for instructions on installing the maintenance cartridge.

> Note

» Refer to Replacing the Maintenance Cartridge for details on replacing the maintenance cartridge.
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| 1724

I Cause

The currently installed maintenance cartridge cannot be used.

This printer cannot use maintenance cartridges that have been installed in other printers.

| what to Do

Replace with a new maintenance cartridge.

= Replacing the Maintenance Cartridge
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| 1725

I Cause

The maintenance cartridge cannot be recognized.

The maintenance cartridge may not be installed properly or may not be compatible with this printer.

| what to Do

Remove the maintenance cartridge, and then reinstall it correctly.

Refer to Replacing the Maintenance Cartridge for details on removing and installing the maintenance
cartridge.
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| 1726

I Cause

The maintenance cartridge is full.

| what to Do

You should replace the maintenance cartridge.
Refer to Replacing the Maintenance Cartridge for instructions on replacing the maintenance cartridge.

»>» Note

» The condition of the maintenance cartridge when this error is displayed will depend on where and
how the printer is used.

When this message is displayed, you must replace the maintenance cartridge.

+ Refer to Replacing the Maintenance Cartridge for details on replacing the maintenance cartridge.
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| 1727

I Cause

The maintenance cartridge is almost full.

| what to Do

The printer will not be able to print with a full maintenance cartridge.
Tap the printer's OK button to cancel the error and then prepare a new maintenance cartridge.

For details on the maintenance cartridge, see Replacing the Maintenance Cartridge.
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| 2114

I Cause

Paper settings specified when printing do not match the paper information for the top feed registered on
the printer.

> Note

* For the appropriate combination of the paper settings specified on the printer driver and the paper
information registered on the printer, refer to the paper information list.

= Paper Information List
» For how to register paper information on the printer, refer to the following.

= | oading Sheets or Postcards into the Printer
= Changing the Type of Paper

If the paper settings specified when printing differ from the paper information for the top feed registered on
the printer, the following message appears on the printer's touch screen.

» Paper settings specified on the printer driver when printing:
Paper size: A4
Media type: Plain paper

» Paper information for the top feed registered on the printer:
Paper size: A3
Media type: Plain paper

@ Support Code 2114

The following paper is not loaded
in the top feed.

Page size A4
Type Plain Paper

| More details Wext

I What to Do

Select Next on the printer's touch screen to display the screen below.
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Select what to do from the
following.

Print with the loaded paper.

Replace the paper and print

Cancel print

Select the appropriate action.

»>» Note

» Depending on the settings, some of the options below may not be displayed.

Print with the loaded paper.
Select this option to print on the loaded paper with the paper settings specified when printing.

For example, when the paper size specified when printing is A4 and the paper information for the top
feed is registered as A3, select this option to print on an A3 paper loaded in the top feed with the A4
setting.

Replace the paper and print
Select this option to print after changing the paper in the top feed.

For example, when the paper size specified when printing is A4 and the paper information for the top
feed is registered as A3, select this option to print after changing the paper in the top feed with an A4
paper.

After changing the paper, the paper information registration screen for the top feed appears. Register
the paper information on the printer according to the loaded paper.

»» Note

« If you do not know the paper size and media type to be loaded in the top feed, press the printer's
Back button. The paper size and media type are displayed.

» For the appropriate combination of the paper settings specified on the printer driver and the
paper information registered on the printer, refer to the paper information list.

= Paper Information List

Cancel print
Cancels printing.

Select this option when you want to change the paper settings specified when printing. Change the
paper settings and try printing again.
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| 2117

I Cause

Paper settings specified when printing do not match the paper information for the paper roll registered on
the printer.

> Note

* For the appropriate combination of the paper settings specified on the printer driver and the paper
information registered on the printer, refer to the paper information list.

= Paper Information List
» For how to register paper information on the printer, refer to the following.

= | oading Sheets or Postcards into the Printer
= Changing the Type of Paper

If the paper settings specified when printing differs from the paper information for the paper roll registered
on the printer, the following message appears on the printer's touch screen.

» Paper settings specified on the printer driver when printing:
Paper size: 24 in
Media type: Plain paper

» Paper information for the paper roll registered on the printer:
Paper size: A2 Roll
Media type: Plain paper

@ Support Code 2117

The following roll paper is not
loaded.

Page size 24 in Roll
Type Plain Paper

| More details Wext

I What to Do

Select Next on the printer's touch screen to display the screen below.
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Select what to do from the
following.

Replace the paper and print

Cancel print

Select the appropriate action.

»>» Note

» Depending on the settings, some of the options below may not be displayed.

Replace the paper and print
Select this option to print after replacing the paper roll.

For example, when the paper size specified when printing is 24 in Roll and the paper information for
the paper roll is registered as A2 Roll, select this option to print after replacing the paper roll with an
24 in Roll.

After replacing the paper roll, the paper information registration screen for the paper roll appears.
Register the paper information on the printer according to the loaded paper.

»>» Note

+ If you do not know the paper size and media type of the paper roll to be loaded, press the
printer's Back button. The paper size and media type are displayed.

* For the appropriate combination of the paper settings specified on the printer driver and the
paper information registered on the printer, refer to the paper information list.

= Paper Information List

Cancel print
Cancels printing.

Select this option when you want to change the paper settings specified when printing. Change the
paper settings and try printing again.
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| 2123

I Cause

Top feed paper information registration is incomplete. Or, the paper may have been exchanged while the
printer is turned off.

| what to Do

If the screen similar to the following is displayed on the printer's touch screen, the top feed paper
information registration is incomplete.

Current top feed setting.
Please confirm.

¥1 Any size
Others

Change Yes

If the paper loaded in the top feed matches the paper information displayed on the printer's touch screen,
select Yes.

If they do not match, select Change and then register the correct paper information.
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| 2200

I Cause

An internal part will need replacing soon.

| what to Do

Select OK on the printer's touch screen to cancel the error.
Contact your nearest Canon service center to request a repair as soon as possible.
You cannot replace the internal parts of the printer yourself.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repair, see Repairing Your Printer.
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| 2500

I Cause

Cause of following may have occurred failure of automatic adjustment to straighten lines and colors.

 Print head nozzles are clogged.
» Paper roll other than paper roll of 10.00 in. (254.0 mm) width or wider is loaded.
» Paper output slot is exposed to strong light.

| what to Do

Select OK on the printer's touch screen to cancel the error and take the corresponding actions below.

» Check the print head condition by printing the nozzle check pattern.

» Load a paper roll at least 10.00 in. (254.0 mm) wide.

» Adjust your operating environment and/or the position of the printer so that the paper output slot is not
exposed directly to strong light.

After carrying out the above actions, perform automatic adjustment to straighten lines and colors again.

If the error is still not resolved, select OK on the printer's touch screen to cancel the error and perform
manual adjustment to straighten lines and colors.

= Manual Adjustment to Straighten Lines and Align Colors
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| 3000

I Cause

The print head has not been calibrated.

| what to Do

Print Head Alignment - Auto is recommended.
= Automatic Adjustment to Straighten Lines and Align Colors
»>» Note

* This message will appear until Print Head Alignment - Auto is carried out.

* If you perform Minimal Margin Printing without adjusting the print head position, the margin of the
print results will be larger than the setting value of the margin amount set in Minimal Margin Printing.
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I 3252

I Cause

The maintenance cartridge is almost full.

| what to Do

The printer will not be able to print with a full maintenance cartridge.

Tap the printer's OK button to clear the error message.
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| 3306

I Cause

Media information cannot be recognized because the printer media information is corrupt.

| what to Do

Start the Media Configuration Tool, and then recover the media information.
= Media Configuration Tool Guide

To set the Media Configuration Tool to recovery mode, open the Media Configuration Tool, select this
device and then click OK.

Select and load the media information backup file.

If you do not have a media information backup file, contact a Canon customer service center.

641



| 3310

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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I 3311

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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I 3312

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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| 3313

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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| 3314

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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| 3315

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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| 3316

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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I 3317

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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| 3318

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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| 3310

I Cause

Incorrect print data.

lllegal number of parameters.

| what to Do

Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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| 3413

I Cause

Prevent paper abrasion has been set.

| what to Do

If you continue printing in the current setting, select Yes on the printer's touch screen.

Prevent paper abrasion may reduce print speed.

If you disable this setting, select No. Select : (Setup) on the HOME screen, select Printer settings,
Print settings, and then set Prevent paper abrasion to OFF.
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| 3440

I Cause

Easy wireless connect has failed.

| what to Do

Select OK on the printer's touch screen to cancel the error and retry Easy wireless connect.

If the error is not resolved, use another method to set up Wi-Fi.
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I 3441

I Cause

Easy wireless connect has failed.

| what to Do

Select OK on the printer's touch screen to cancel the error and retry Easy wireless connect.

If the error is not resolved, use another method to set up Wi-Fi.
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I 3442

I Cause

Printing of the first side is complete when doing manual duplex printing.

| what to Do

Prepare to print the other side.
Load the paper with the printed side facing down in the top feed without changing its orientation.
Select How to set on the printer's touch screen to see how to load the paper.
After loading the paper, select Start print on the printer's touch screen.
»>» Note

» To cancel printing, press the printer's Stop button.
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| 3443

I Cause

Printing of the first side is complete when doing manual duplex printing.

| what to Do

Prepare to print the other side.
Rotate the printed paper 180 degrees and load it with the printed side facing down in the top feed.
Select How to set on the printer's touch screen to see how to load the paper.
After loading the paper, select Start print on the printer's touch screen.
»>» Note

» To cancel printing, press the printer's Stop button.
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I 3444

I Cause

Printing of the first side is complete when doing manual duplex printing.

| what to Do

Prepare to print the other side.
Rotate the printed paper 180 degrees and load it with the printed side facing down in the top feed.
Select How to set on the printer's touch screen to see how to load the paper.
After loading the paper, select Start print on the printer's touch screen.
»>» Note

» To cancel printing, press the printer's Stop button.
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| 3445

I Cause

Printing of the first side is complete when doing manual duplex printing.

| what to Do

Prepare to print the other side.
Load the paper with the printed side facing down in the top feed without changing its orientation.
Select How to set on the printer's touch screen to see how to load the paper.
After loading the paper, select Start print on the printer's touch screen.
»>» Note

» To cancel printing, press the printer's Stop button.
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| 3446

I Cause

IP address and subnet mask are conflicting.

| what to Do

Select OK on the printer's touch screen to cancel the error.

Disable the wireless direct or change the Wi-Fi network configuration. When changing the network

configuration, specify a unique subnet range for each of the wireless direct and the Wi-Fi to prevent a
conflict.

For details on changing the network configuration, refer to the documentation for your wireless router.
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| 3447

I Cause

An error occurred while communicating via wireless direct or while in standby.

| what to Do

Select OK on the printer's touch screen to cancel the error.
Turn off the printer and turn it back on.

Wireless direct becomes enabled.
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| 3454

I Cause

Printer error has occurred.

| what to Do

Printer needs repair. Please contact customer support.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.
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| 3455

I Cause

Printer error has occurred.

| what to Do

A matter has been identified that requires immediate attention. Please contact customer support.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.
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| 4103

I Cause

Cannot perform printing with current print settings.

| what to Do

Press the printer's Stop button to cancel printing.

Change the print settings specified when printing and retry printing.
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| 4104

I Cause

The paper settings (paper size/paper type) or paper feed method specified when printing are incorrect.

| what to Do

Press the Stop button on the printer to stop printing, and then check the paper roll or the paper that can
be loaded in the top feed.

= |[oading Rolls in the Printer
= | oading Sheets or Postcards into the Printer

Do one of the following, and then try printing again.

» Change the paper settings (paper size/ paper type) specified when printing.
» Change the paper feeding method.
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| 410

I Cause

Minimal Margin Printing cannot be performed because Detect paper width is set to Disable.

| what to Do

Press the printer's Stop button to stop printing.

Set Detect paper width in the printer menu to Enable, and then try again.
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| 4111

I Cause

The media type specified is incompatible with this device.

| what to Do

Press the printer's Stop button to stop printing.

Check the media type settings, and then try again.
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| 4120

I Cause

The media type is not supported by Minimal Margin Printing.

| what to Do

Press the printer's Stop button to cancel printing.
Change the type of paper to be used for printing and try printing again.
» Changing the type of paper
o Windows

Open Media Type from Main in the printer driver and select the type of paper to be used for
printing.

= Main Tab Description

o macOS

Open Quality & Media in the printer driver and select the type of paper to be used for printing
from Media Type.

= Quality & Media

For information about the types of paper that can be used in Minimal Margin Printing, see "Paper Settings
List (Roll Paper)".
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| 4124

I Cause

This print setting does not allow Minimal Margin Printing.

| what to Do

Press the printer's Stop button to cancel printing.
Take the following steps, then try printing again.
» Set Unidirectional Printing to disable.
o Windows

Open Paper Detailed Settings from Main in the printer driver and uncheck the Unidirectional
Printing checkbox.

= Main Tab Description

° macOS
Uncheck the Unidirectional Printing checkbox in Advanced Paper Settings in the printer driver.
= Advanced Paper Settings
+ Change the setting of Print Quality.
o Windows
Change the setting of Print Quality in Advanced Settings in the printer driver.

= Changing the Print Quality and Correcting Image Data (Windows)

o macOS
Change the setting of Quality & Media in Print Quality in the printer driver.
= Changing the Print Quality and Correcting Image Data (macOS)
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| 4020

I Cause

Cannot cut paper for one of the following reasons.

» Paper that has been cut remains on the output guide.

» There is a foreign object near the output slot that is obstructing the cutter blade.
» The paper is not being used under the recommended usage conditions.

» The paper in use cannot be used with Automatic cut.

I What to Do

Remove jammed paper.

= Remove Jammed Roll Paper
= Remove a Jammed Sheet

After removing the jammed paper, select OK on the printer's touch screen to cancel the error.
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| 4031

I Cause

Paper feed adjustment may have failed for the following reasons.

» The paper for printing a test pattern is soiled. Otherwise, you have loaded colored paper.

* The printer may be exposed to strong light, such as direct sunlight, which can cause the sensors to
malfunction.

» The test pattern was printed too faintly.

I What to Do

Select OK on the touch screen to dismiss the error, and then take the following actions.

* Load unused paper.
» Make adjustments to ensure that the printer is not exposed to strong light.
* Print a nozzle check pattern to check the print head status.

If the pattern has gaps or horizontal white lines, the print head nozzle is blocked. Clean the print head.

= Checking for Nozzle Clogging
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| 405A

I Cause

An error occurred while communicating via Wi-Fi or while in standby.

| what to Do

Turn off the printer and turn it back on.
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| 5100

I Cause

Printer error has occurred.

| what to Do

If you are printing, press the printer's Stop button to cancel printing, then turn off the printer.

Check the following:

» Make sure carriage motion is not impeded by protective material and tape for securing the carriage,
jammed paper, etc.

Remove any impediment.

22 Important

» Do not touch the linear scale (A) or carriage rail (B). This may stain your hands and damage the
printer.

Turn the printer back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 5200

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Wait about 10 minutes and then plug in the printer again and turn it back on.
Make sure there is enough ink remaining, and perform replace ink in print head.

= Checking Ink Level

¢ From Windows:

= Cleaning the Print Heads

* From macOS:
= Cleaning the Print Heads
» From the operation panel of the printer:

= Replacing the Ink in the Print Head

If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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I 5207

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.
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| 5400

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.
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| 5700

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.
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| scoz

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

677



| sc30

I Cause

An error requiring a repair has occurred.

| what to Do

Turn off the printer and unplug it.
Contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.

678



| 6000

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

679



I 6001

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

680



| 6004

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

681



I 6011

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

682



I 6012

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

683



| 6013

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

684



| 6014

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

685



| 6015

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

686



| 016

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

687



I 6017

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

688



| 018

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

689



| 6010

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

690



| 6030

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

691



| 6500

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

692



| 6503

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

693



| 6700

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

694



I 6701

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

695



| 6300

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

696



I 6801

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

697



| 6830

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

698



I 6831

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

699



I 6832

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

700



| 6833

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

701



| 6000

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

702



I 6901

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

703



I 6902

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

704



| 6010

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

705



| 6020

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

706



I 6921

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

707



| 6030

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

708



I 6931

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

709



I 6932

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

710



| 6033

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

711



| 6040

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

712



| 6041

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

713



| 6042

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

714



| 6043

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

715



| 6944

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

716



| 6945

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

717



| 6046

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

3% Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

718



| 6ns0

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.
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| 6ns

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

720



| spot

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

721



| 7500

I Cause

An error requiring a repair has occurred.

| what to Do

Turn off the printer and unplug it.
Contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.

722



| 7600

I Cause

An error requiring a repair has occurred.

| what to Do

Turn off the printer and unplug it.
Contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 7700

I Cause

An error requiring a repair has occurred.

| what to Do

Turn off the printer and unplug it.
Contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.
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| 7800

I Cause

An error requiring a repair has occurred.

| what to Do

Turn off the printer and unplug it.
Contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
» When transporting the printer for repairing it, see Repairing Your Printer.

725



| B506

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

726



| Bsos

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

727



| Bs09

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

728



I B50A

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

729



| cooo

I Cause

Printer error has occurred.

| what to Do

Turn off the printer and unplug it.
Plug in the printer again and turn it back on.
If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the printer when moving it since the ink may leak out.
* When transporting the printer for repairing it, see Repairing Your Printer.

730



| c1o0

I Cause

Printer error has occurred.

| what to Do

Please stop using this printer immediately, then contact customer support.
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| cro1

I Cause

Printer error has occurred.

| what to Do

Please stop using this printer and unplug power cord immediately, then contact customer support.
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| p1o3

I Cause

The printer is in the reset process and cannot be operated.

| what to Do

Wait for a while until the process is completed.
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| p107

I Cause

The printer is in operation process and cannot be operated.

| what to Do

Wait for a while until the process is completed.
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| p1os

I Cause

The printer is in the process of moving the carriage and cannot be operated.

| what to Do

Wait for a while until the process is completed.
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| p1oo

I Cause

Firmware updates are available.

| what to Do

When update notifications are configured, a notification will appear when there is an available update.
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I Printer Information

» Safety
» Handling Precautions

» Specifications
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I Safety

» Safety Precautions
» Regulatory Information

» WEEE

738



I Safety Precautions

Follow the items below to use the printer safely. This may cause unexpected accidents such as fire or
electrical shock.

A\ Warning

* For people who are using a cardiac pacemaker

This product generates a low-level magnetic field. If you experience discomfort while working around
this product, leave the area and consult a doctor.

» Turn off the power immediately in the following circumstances.

If you continue to use the printer in the following cases, it may cause fires or electrical shock.
Immediately press the power button to turn off the printer, disconnect the power plug from the outlet,
and make a request for repairs.

— If any foreign matter (metal fragments, liquids, etc.) gets inside the printer
— If the printer emits smoke, abnormal odors, or abnormal noises
— If the power cord or any of the cables become hot, corroded, bent, frayed, or damaged

« Follow the items below as there is a risk of fire and electrical shock.

— Do not set up the product in any location exposed to alcohol, thinner, or other flammable liquids.

— Do not disassemble or modify the product.

— Use the cables that are included with the printer. Do not use the cables included with the printer
with other devices.

— Do not use outside of the designated power supply voltage and frequency.

— Insert the power plug securely and completely into the power outlet.

— Never handle the power plug with wet hands.

— Do not damage, modify, pull, bundle, join, or forcefully bend the power cord or any cables.

— Never place a heavy object on the power cord or any cables.

— Do not insert multiple power plugs into the same outlet.

— Do not connect multiple extension cords.

— If there is lightning nearby, disconnect the power plug from the outlet and do not use the product.

— When cleaning, always disconnect the cables and power plug, and do not use highly flammable
sprays or liquids such as alcohol or thinner.

— Once per month, disconnect the power plug and power cord from the outlet, and check that dust
has not accumulated, and that there are no abnormalities such as heat generation, rust, bending,
chafing, or cracking.

/A Caution

* Never insert your hand into the printer while it is printing.

» Never touch the electrical contacts of the print head by hand immediately after printing.

» The following symbol is displayed around the movable parts of the printer. Take care to avoid
touching them with your hand or inserting your finger. Note that this symbol may not appear on your
model.
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Moving Parts
A Keep body parts away from moving parts.
Keep body parts out of the motion path.

¢ About Ink Bottles

— Always store consumables out of the reach of small children.

— Do not drink ink.
If a child licks or ingests ink accidentally, wash out their mouth or make them drink 1 or 2 cups of
water, and immediately seek medical attention. If ink accidentally gets in your eyes, immediately
rinse with water, and immediately seek medical attention.

— If ink gets on your skin, immediately clean it off with soap and water. If irritation persists,
immediately seek medical attention.

— When storing ink bottles, securely close the bottle cap of the ink bottle and store in an always
upright state. If it falls over, there is a risk of the ink spilling.

— Take great care to avoid ink spraying around when refilling the ink tanks with ink.

— If ink becomes adhered to your clothes or anything you are carrying, you might not be able to
wash it out.

— Do not leave in a location that gets hot, such as near a fire, near a heater, or in a vehicle. The
container may deform, causing the ink to spill, or the ink quality may become degraded.

— Do not expose ink bottles to impacts. The ink bottle may break or the bottle cap may come off,
causing ink to spill.

— Do not pour into a different container. This may cause accidental ingestion or misuse of the ink,
or the ink quality may become degraded.

— Do not use for any purpose other than refilling the ink in the printer specified by our company.

— Do not dilute with water, mix with other inks, etc. This may damage the printer.

* Moving the Printer

— Have the following number of people carry the printer. The weight may cause pain such as back
pain.

TC-21 : 2 people

I Choosing a location

» Never install the printer on an unstable or vibrating surface.
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Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close
to a heating source.

To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in
the Specifications.

Do not place the printer on a thick rug or carpet.

Do not place the printer with its back attached to the wall.

We recommend ensuring ample space for installation.

Do not install the printer near sources of strong electromagnetic fields, whether equipment that
generates such fields or places where such fields occur.

I Power Supply

Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

Do not use an extension lead/cord.

I Working Around the Printer

Never put your hands or fingers in the printer while it is printing.

Firmly grasp the carrying grips on each side in the base. Holding the printer at other positions is
dangerous and cause injury and damage if the printer is dropped.

When using and transferring the printer, do not tilt it, stand it on its side, or turn it upside down. There
is a risk of the ink spilling.

When transferring the printer tilted, always perform the steps in "Preparing to Transfer the Printer" in
order to protect the internal structure.

Do not place any object on the printer. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the printer.

I Print Heads/Ink Bottle/Maintenance Cartridges

Keep ink bottle out of the reach of children. In case ink is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

Never touch the electrical contacts on a print head after printing.

The metal parts may be very hot and could cause burns.

Do not throw ink bottle and maintenance cartridges into fire.

Do not attempt to disassemble or modify the print head, ink bottle, and maintenance cartridges.
Avoid dropping or shaking print head, ink bottle, and maintenance cartridges.
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I Regulatory Information

I Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10629 (Contains FCC Approved WLAN Module K30387)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment and
meets the FCC radio frequency (RF) Exposure Guidelines as this equipment has very low levels of RF
energy.

But it is desirable that it should be installed and operated keeping the radiator at least 20cm or more away
from person's body.

Canon U.S.A,, Inc.

One Canon Park
Melville, New York 11747
1-800-652-2666
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I Users in Europe

Product Information for the requirement of COMMISSION REGULATION (EU)

The power consumption in Off Mode or network standby and the transition time to Off or network
standby are as follows:
https://www.canon-europe.com/consumer/lot26/

I Interference

Do not use the printer around medical equipment or other electronic devices. Signals from the printer may
interfere with the correct operation of these devices.
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I Only for the United Kingdom

i9:¢

_ EURDPE ONLY

These symbols indicate that this product is not to be disposed of with your household waste, according

to the UK Waste Electrical and Electronic Equipment Regulations and the UK Batteries and Accumulators
Regulations. If a chemical symbol is printed beneath the symbol shown above, in accordance with the

UK Batteries and Accumulators Regulations, this indicates that a heavy metal (Hg = Mercury, Cd =
Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above an applicable
threshold specified in the UK Batteries and Accumulators Regulations. This product should be handed
over to a designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar
product or to an authorized collection site for recycling waste electrical and electronic equipment (EEE)
and batteries and accumulators. Improper handling of this type of waste could have a possible impact on
the environment and human health due to potentially hazardous substances that are generally associated
with EEE. Your cooperation in the correct disposal of this product will contribute to the effective usage of
natural resources. For more information about the recycling of this product, please contact your local city
office, waste authority, approved scheme or your household waste disposal service or visit www.canon-
europe.com/sustainability/approach/.

I Only for European Union and EEA (Norway, Iceland and Liechtenstein)

B

These symbols indicate that this product is not to be disposed of with your household waste, according
to the WEEE Directive (2012/19/EU), the Battery Regulation ((EU) 2023/1542) and/or national legislations
implementing those Directive and Regulation.

If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery
Regulation, this indicates that a heavy metal (Pb = Lead) is present in this battery at a concentration
above an applicable threshold specified in the Battery Regulation.

This product should be handed over to a designated collection point, e.g., on an authorized one-for-one
basis when you buy a new similar product or to an authorized collection site for recycling waste electrical
and electronic equipment (EEE) and batteries. Improper handling of this type of waste could have a
possible impact on the environment and human health due to potentially hazardous substances that are
generally associated with EEE. Your cooperation in the correct disposal of this product will contribute to
the effective usage of natural resources.

For more information about the recycling of this product, please contact your local city office, waste
authority, approved scheme or your household waste disposal service or visit www.canon-europe.com/
sustainability/approach/.
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Nur fur die Europaische Union und EWR (Norwegen, Island und
Liechtenstein)

B

Diese Symbole weisen darauf hin, dass dieses Produkt gemafls WEEE-Richtlinie (2012/19/EU) (Richtlinie
Uber Elektro- und Elektronik-Altgerate), Batterienverordnung (EU) 2023/1542 und nationalen Gesetzen
zur Umsetzung dieser Richtlinie und Verordnung nicht Gber den Hausmiill entsorgt werden darf.

Falls sich unter dem oben abgebildeten Symbol ein chemisches Symbol befindet, bedeutet dies gemafn
der Batterieverordnung, dass in dieser Batterie ein Schwermetall (Pb = Blei) in einer Konzentration
vorhanden ist, die Uber einem in der Verordnung angegebenen Grenzwert liegt.

Dieses Produkt muss bei einer dafiir vorgesehenen Sammelstelle abgegeben werden. Dies kann

z. B. durch Rickgabe beim Kauf eines neuen dhnlichen Produkts oder durch Abgabe bei einer
autorisierten Sammelstelle fiir die Wiederaufbereitung von Elektro- und Elektronik-Altgeraten sowie
Batterien geschehen. Der unsachgemafRe Umgang mit Altgeraten kann aufgrund potenziell gefahrlicher
Stoffe, die generell mit Elektro- und Elektronik-Altgeraten in Verbindung stehen, negative Auswirkungen
auf die Umwelt und die menschliche Gesundheit haben.

Durch lhre Mitarbeit bei der umweltgerechten Entsorgung dieses Produkts tragen Sie zu einer effektiven
Nutzung natlrlicher Ressourcen bei.

Um weitere Informationen Uber die Wiederverwertung dieses Produkts zu erhalten, wenden Sie sich

an lhre Stadtverwaltung, den 6ffentlich-rechtlichen Entsorgungstrager, eine autorisierte Stelle fir die
Entsorgung von Elektro- und Elektronik-Altgeraten oder lhr 6rtliches Entsorgungsunternehmen oder
besuchen Sie

Www.canon-europe.com/sustainability/approach/.

Zusatzinformationen fiir Deutschland:

Dieses Produkt kann durch Rickgabe an den Handler, unter den in der Verordnung des Elektro- und
Elektronikgerategesetzes beschriebenen Bedingungen abgegeben werden.
Als Endbenutzer und Besitzer von Elektro- oder Elektronikgeraten sind Sie verpflichtet:

« diese einer vom unsortierten Siedlungsabfall getrennten Erfassung zuzufihren,

+ Altbatterien und Altakkumulatoren, die nicht von Aligerat umschlossen sind, sowie Lampen,
die zerstorungsfrei aus dem Altgerat enthommen werden kdnnen, vor der Abgabe an einer
Erfassungsstelle vom Altgerat zerstérungsfrei zu trennen,

» personenbezogene Daten auf den Altgeraten vor der Entsorgung zu I6schen.

Die Bedeutung des Symbols der durchgestrichenen Abfalltonne auf Radern finden Sie oben in dieser
Beschreibung.

Die Vertreiber von Elektro- oder Elektronikgeraten haben die Pflicht zur unentgeltlichen Ricknahme
von Altgeraten. Die Vertreiber haben die Endnutzer Uber die von ihnen geschaffenen Moglichkeiten der
Ruckgabe von Altgeraten zu informieren.
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I Union Européenne, Norvége, Islande et Liechtenstein uniquement.

B

Ces symboles indiquent que ce produit ne doit pas étre mis au rebut avec les ordures ménagéres, comme
le spécifient la Directive européenne DEEE (2012/19/UE), la Iégislation européenne relative a I'élimination
des piles usagés ((EU) 2023/1542) et les lois en vigueur dans votre pays appliquant ces directives et
Iégislations.

Si un symbole de toxicité chimique est imprimé sous le symbole illustré ci-dessus conformément a la
Iégislation relative aux piles, il indique la présence d'un métal lourd (Pb = plomb) dans la pile a une
concentration supérieure au seuil applicable spécifié par la législation.

Ce produit doit étre confié au distributeur a chaque fois que vous achetez un produit neuf similaire,

ou a un point de collecte mis en place par les collectivités locales pour le recyclage des Déchets des
Equipements Electriques et Electroniques (DEEE) et piles. Le traitement inapproprié de ce type de
déchet risque d'avoir des répercussions sur I'environnement et la santé humaine, du fait de la présence
de substances potentiellement dangereuses généralement associées aux équipements électriques et
électroniques.

Votre entiére coopération dans le cadre de la mise au rebut correcte de ce produit favorisera une
meilleure utilisation des ressources naturelles.

Pour plus d'informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-
organisme ou les autorités locales compétentes, ou consultez le site
www.canon-europe.com/sustainability/approach/.

Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen,
IJsland en Liechtenstein)

B

Met deze symbolen wordt aangegeven dat dit product in overeenstemming met de AEEA-richtlijn
(2012/19/EU), de wetgeving ((EU) 2023/1542) betreffende batterijen en/of de plaatselijk geldende
wetgevingen waarin deze richtlijnen en wetgevingen zijn geimplementeerd, niet bij het normale huisvuil
mag worden weggegooid.

Indien onder het hierboven getoonde symbool een chemisch symbool gedrukt staat, geeft dit in
overeenstemming met de wetgeving betreffende batterijen aan dat deze batterij een zwaar metaal
bevat (Pb = lood) waarvan de concentratie de toepasselijke drempelwaarde in overeenstemming met
de genoemde richtlijn overschrijdt.

Dit product dient te worden ingeleverd bij een hiervoor aangewezen inzamelpunt, bijv. door dit in te
leveren bij een hiertoe erkend verkooppunt bij aankoop van een gelijksoortig product, of bij een officiéle
inzameldienst voor de recycling van elektrische en elektronische apparatuur (EEA) en batterijen. Door
de potentieel gevaarlijke stoffen die gewoonlijk gepaard gaan met EEA, kan onjuiste verwerking van
dit type afval mogelijk nadelige gevolgen hebben voor het milieu en de menselijke gezondheid. Uw
medewerking bij het op juiste wijze weggooien van dit product draagt bij tot effectief gebruik van
natuurlijke hulpbronnen.

Voor verdere informatie over recycling van dit product kunt u contact opnemen met uw plaatselijke
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gemeente, afvaldienst, officiéle dienst voor klein chemisch afval of afvalstortplaats, of kunt u terecht op
www.canon-europe.com/sustainability/approach/

Sélo para la Unién Europea y el Area Econémica Europea (Noruega,
Islandia y Liechtenstein)

B

Estos iconos indican que este producto no debe desecharse con los residuos domésticos de acuerdo con
la Directiva sobre RAEE (2012/19/UE) y el Reglamento (UE) 2023/1542 relativo a las pilas y baterias y
sus residuos y/o la legislacion nacional que transponen e implementan dicha.

Si aparece un simbolo quimico bajo este icono, de acuerdo con el Reglamento sobre Pilas y baterias,
significa que la pila contiene metales pesados (Pb = Plomo) en una concentracion superior al limite
especificado en dicho Reglamento.

Este producto debera entregarse en un punto de recogida designado, por ejemplo, entregandolo en

el lugar de venta al adquirir un producto nuevo similar o en un centro autorizado para la recogida de
residuos de aparatos eléctricos y electrénicos (RAEE) y baterias. La gestion incorrecta de este tipo de
residuos puede afectar al medio ambiente y a la salud humana debido a las sustancias potencialmente
nocivas que suelen contener estos aparatos.

Su cooperacion en la correcta eliminacion de este producto contribuira al correcto aprovechamiento de
los recursos naturales.

Los usuarios tienen derecho a devolver pilas o baterias usadas sin coste alguno. El precio de venta de
pilas y baterias incluye el coste de la gestién medioambiental de su desecho, no reflejandose la cuantia
de dicho coste en la factura suministradas a los usuarios finales.

Si desea mas informacién sobre el reciclado de este producto, pdngase en contacto con su municipio, el
servicio o el organismo encargado de la gestion de residuos domésticos o visite
www.canon-europe.com/sustainability/approach/.

I Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)

B

Questi simboli indicano che il prodotto non pud essere smaltito con i rifiuti domestici, ai sensi della
Direttiva RAEE (2012/19/UE), del Regolamentola sulle Batterie ((UE) 2023/1542) e/o delle leggi nazionali
che attuano tale Direttiva e Regolamento.

Se sotto il simbolo indicato sopra € riportato un simbolo chimico, in osservanza del Regolamento sulle
Batterie, tale simbolo indica la presenza di un metallo pesante (Pb = Piombo) nella batteria con un livello
di concentrazione superiore a una soglia applicabile specificata nel Regolamento sulle Batterie.

Il prodotto deve essere conferito a un punto di raccolta designato, ad esempio il rivenditore in caso di
acquisto di un nuovo prodotto simile oppure un centro di raccolta autorizzato per il riciclaggio di rifiuti di
apparecchiature elettriche ed elettroniche (RAEE) nonché di batterie. Un trattamento improprio di questo
tipo di rifiuti puo avere conseguenze negative sull'ambiente e sulla salute umana a causa delle sostanze
potenzialmente nocive solitamente contenute in tali rifiuti.

La collaborazione dell'utente per il corretto smaltimento di questo prodotto contribuira a un utilizzo efficace
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delle risorse naturali.

Per ulteriori informazioni sul riciclaggio di questo prodotto, vogliate contattare il vostro ufficio comunale,
le autorita competenti, un sistema di raccolta rifiuti autorizzato, o il vostro servizio di raccolta dei rifiuti
domestici, oppure visitare il sito

www.canon-europe.com/sustainability/approach/.

Apenas para a Unidao Europeia e Espago Econémico Europeu (Noruega,
Islandia e Liechtenstein)

=4

Estes simbolos indicam que este produto nao deve ser descartado juntamente com os residuos urbanos,
segundo a Diretiva REEE - Diretiva 2012/19/UE, segundo o Regulamento Baterias - Regulamento (UE)
2023/1542 e/ou a legislagdo nacional que transpde esta Diretiva e Regulamento.

Caso esteja marcado um simbolo quimico abaixo do simbolo mostrado acima, de acordo com o
Regulamento Baterias, isso significa que esta presente nesta bateria um metal pesado (Pb = Chumbo)
numa concentragdo acima do respetivo limite especificado no Regulamento.

Este produto deve ser entregue num ponto de recolha designado, por exemplo num local de recegao
autorizado quando compra um equipamento novo idéntico, ou num local de recolha autorizado para
reciclar residuos de equipamento elétrico e eletrénico (EEE) e de baterias. O tratamento inadequado
deste tipo de residuos pode ter um impacto negativo no ambiente e na saude humana, devido a
substancias potencialmente perigosas que estdo geralmente associadas aos EEE.

A sua cooperacao no descarte adequado deste produto ira contribuir para a utilizacdo mais eficaz dos
recursos naturais.

Para saber mais sobre como reciclar este produto, por favor contacte a divisdo de residuos dos
servigos municipais ou entidades gestoras autorizadas para a gestao destes fluxos de residuos ou visite
www.canon-europe.com/sustainability/approach/.

Gzlder kun i Europziske Union og EQS (Norge, Island og
Liechtenstein)

B

Disse symboler betyder, at produktet ikke ma bortskaffes sammen med dagrenovation i henhold til
WEEE-direktivet (2012/19/EU), batteriforordningen ((EU) 2023/1542) og/eller de lokale lovgivninger, som
disse direktiver og forordninger er gennemfart i.

Hvis der i overensstemmelse med batteriforordningen er trykt et kemisk symbol under det symbol, der er
vist ovenfor, betyder det, at batteriet indeholder tungmetal (Pb = bly) i en koncentration, som ligger over
de graenseveerdier, der er beskrevet i batteriforordningen.

Produktet skal afleveres pa et godkendt indsamlingssted, f.eks. i overensstemmelse med en godkendt
én-til-én-procedure, nar du indkgber et nyt tilsvarende produkt, eller pa et godkendt indsamlingssted for
elektronikaffald og batterier. Forkert handtering af denne type affald kan medfgre negative konsekvenser
for miljget og menneskers helbred pa grund af de potentielt sundhedsskadelige stoffer, der generelt kan
forefindes i elektrisk og elektronisk udstyr.
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Nar du foretager korrekt bortskaffelse af produktet, bidrager du til effektiv brug af naturressourcerne.
Kontakt din kommune, den lokale affaldsmyndighed, det lokale affaldsanleeg, eller besgg
www.canon-europe.com/sustainability/approach/ for at fa flere oplysninger om genbrug af dette produkt.

Mévo yia Tnv Eupwraikn ‘Evwon kai Tov EOX (NopBnyia, loAavdia kai
AixtevoTdiv)

=4

AuTd Ta GUPBOAC UTTOBEIKVUOUV OTI QUTO TO TTPOIOV eV TTPETTEI VA ATTOPPITITETAI JAdi JE TA OIKIGKA
arroppiypara, cupewva pe Tnv Odnyia yia Ta ATTéRANTa HAekTpIKOU Kal HAekTpovikoU EEoTTAIoOoU
(AHHE) (2012/19/EE), Tnv Tov Kavoviauo yia 1i¢ Mtmratapieg ((EE) 2023/1542) f/kai Tig €BVIKEG vouoBeaieg
TTou £pappdlel TIG ev Adyw Odnyieg kai Kavoviopoug.

Edv kd&toio xnuikd oUpBoAo gival TUTTWPEVO KATW aTTé TO GUNPBOAO TTOU QaiveTal TTApATTAVW, CUUPWVA UE
Tov Kavoviouo yia 1ig¢ Mtrarapieg, utrodnAwvel o1 k&toio Bapu péTalro (Pb = MOAuBd0G) uttdpyel otnv
MTTATAPIO O OUYKEVTPWAN PEYOAUTEPN aTTd TO IoYUOV ETTITTESO TTOU KaBopileTal aTov Kavoviouo yia Tig
Mrrartapieg.

AuTS TO TTPOIGV TTPETTEI VA TTAPOdIOETAI 0€ KABOPIOUEVO ONPEI0 GUAAOYAG, TT.X. O€ JIa €E0UCIODOTNUEVN
Baon avraAiayrig étav ayopdleTe £va VEO TTAPOWOIO TTPOIGV ) 0€ pia egoualodoTnuévn B€on guAAOYRG yia
TNV avakUKAWGN Twv atToBAATWY NAEKTPIKOU Kal NAEKTPOVIKOU e€o0TTAIcuoU (HHE) kai Twv ptratapiwy. O
aKaTAAANAOG XEIPIOPOS auToU Tou TUTTOU aTTOBAATWY UTTOPE va £XEI ApVNTIKO avTIKTUTTO OTO TTEPIBAAAOV
Kal TNV uyeia Tou avBpwtrou, Adyw duvnTIKA ETTIKIVOUVWYVY OUCIWV TToU YeVIKG ouvdéovTal e Tov HHE.

H ouvepyaoia oag yia Tn owaoTr amméppiyn autol Tou TTPoidvTog Ba cuuBAAEl GTNV ATTOTEAECUATIK XPAON
TWV QUOIKWY TTOpwV. lNa TTEPICTOTEPES TTANPOPOPIEG OXETIKA € AVOKUKAWGOT auToU TOU TTPOIGVTOG,
ETTIKOIVWVIOTE PE TO TOTTIKG ypageio TNG TTOANG 0OG, TNV UTTNPECIA ATTOPPINPATWY, TO EYKEKPIPNEVO OXAMA
] TNV UTTNPETIa aTTOPPIYNG OIKIAKWY atToBAATWY 1 €TIOKEPBEiTE TN dieUBuvaon
https://www.canon-europe.com/sustainability/approach/ .

Gjelder kun den europeiske union og EGS (Norge, Island og
Liechtenstein)

B

Disse symbolene indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i
henhold til WEEE-direktivet (2012/19/EU), batteri-forordning EU 2023/1542 og/eller nasjonal lov som har
implementert disse direktivene og forordninger.

Hvis et kjemisk symbol vises under symbolet vist ovenfor, i samsvar med batteri-forordning EU
2023/1542, indikerer dette at et tungmetall (Pb = bly) finnes i batteriet i en konsentrasjon over en
gjeldende gvre grense som er spesifisert i batteri-forordning EU 2023/1542.

Produktet ma leveres til et dertil egnet innsamlingspunkt, det vil si pa en autorisert en-til-en-basis nar en
kjgper et nytt lignende produkt, eller til et autorisert innsamlingssted for resirkulering av avfall fra elektrisk
og elektronisk utstyr (EE-utstyr) og batterier. Feil handtering av denne typen avfall kan veere miljg- og
helseskadelig pa grunn av potensielt skadelige stoffer som ofte brukes i EE-utstyr.

Din innsats for korrekt avhending av produktet vil bidra til effektiv bruk av naturressurser.
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Du kan fa mer informasjon om resirkulering av dette produktet ved & kontakte lokale myndigheter,
avfallsadministrasjonen, et godkjent program eller husholdningens renovasjonsselskap, eller ga til
www.canon-europe.com/sustainability/approach/ .

Vain Euroopan unionin seka ETA:n (Norja, Islanti ja Liechtenstein)
alueelle.

=4

Nama tunnukset osoittavat, ettéd sahko- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi,
2012/19/EUV), paristoasetus ((EU) 2023/1542) seka kansallinen lainsaadanto kieltavat tuotteen
havittamisen talousjatteen mukana. Jos ylla olevan symbolin alapuolelle on paristoasetuksen mukaisesti
painettu kemiallisen aineen tunnus, kyseinen paristo siséltéda raskasmetalleja (Pb = lyijy) enemman kuin
paristoasetuksen salliman maaran.

Tuote on vietdva asianmukaiseen kerdyspisteeseen, esimerkiksi kodinkoneliikkeeseen uutta vastaavaa
tuotetta ostettaessa tai viralliseen sahko- ja elektroniikkalaiteromun tai paristojen kerayspisteeseen.
Sahko- ja elektroniikkalaiteromun virheellinen kasittely voi vahingoittaa ympéaristda ja ihmisten terveytta,
koska laitteet saattavat sisaltaa ymparistolle ja terveydelle haitallisia aineita. Tuotteen asianmukainen
havittdminen saastda myds luonnonvaroja.

Jos haluat lisatietoja taman tuotteen kierratyksesta, ota yhteys kunnan jatehuoltoviranomaisiin tai
kayttamaasi jatehuoltoyhtioon tai kay osoitteessa

www.canon-europe.com/sustainability/approach/.

Endast for Europeiska unionen och EES (Norge, Island och
Liechtenstein)

=4

De har symbolerna visar att produkten inte far sorteras och slangas som hushallsavfall enligt
WEEE-direktivet (2012/19/EU), batteriférordningen ((EU) 2023/1542) och/eller nationell lagstiftning som
implementerar dessa direktiv och férordningar.

Om en kemisk symbol forekommer under ovanstdende symbol innebér detta enligt batteriférordningen att
en tungmetall (Pb = Bly) forekommer i batteriet med en koncentration som éverstiger tillamplig grans som
anges i batteriférordningen.

Produkten ska lamnas in pa en avsedd insamlingsplats, t.ex. pa en atervinningsstation auktoriserad

att hantera elektrisk och elektronisk utrustning (EE-utrustning) samt batterier eller hos handlare som ar
auktoriserade att byta in varor da nya, motsvarande kdps (en mot en). Olamplig hantering av avfall av
den har typen kan ha negativ inverkan pa miljén och méanniskors hélsa pa grund av de potentiellt farliga
amnen som kan aterfinnas i elektrisk och elektronisk utrustning.

Din medverkan till en korrekt avfallshantering av produkten bidrar till effektiv anvéndning av
naturresurserna.

Om du vill ha mer information om var du kan ldamna in den har produkten, kontakta ditt lokala
kommunkontor, berérd myndighet eller foretag for avfallshantering eller se
www.canon-europe.com/sustainability/approach/.
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I Pouze Evropska unie a EHP (Norsko, Island a Lichtenstejnsko)

B

Tento symbol znamena, Ze podle smérnice OEEZ (2012/19/EU), nafizeni o bateriich (2023/1542) a/nebo
podle vnitrostatnich pravnich provadécich predpist k této smérnici a nafizeni nema byt tento vyrobek
likvidovan s odpadem z domacnosti.

Je li v souladu s poZadavky nafizeni o bateriich vytisténa pod vySe uvedenym symbolem chemicka
znacka, udava, ze tato baterie obsahuje tézké kovy (Pb = olovo) v koncentraci vys$si, nez je pfislusna
hodnota pfedepsana nafizenim.

Tento vyrobek ma byt vracen do uréeného sbérného mista, napf. v ramci autorizovaného systému odbéru
jednoho vyrobku za jeden nové prodany podobny vyrobek, nebo do autorizovaného sbérného mista pro
recyklaci odpadnich elektrickych a elektronickych zafizeni (OEEZ), baterii. Nevhodné nakladani s timto
druhem odpadu by mohlo mit negativni dopad na Zivotni prostiedi a lidské zdravi, protoZe elektricka

a elektronicka zarizeni zpravidla obsahuji potencialné nebezpecné latky. Vase spoluprace na spravné
likvidaci tohoto vyrobku napomuze efektivnimu vyuzivani pfirodnich zdroju.

Chcete li ziskat podrobné informace tykajici se recyklace tohoto vyrobku, obratte se prosim na mistni
Urad, organ pro nakladani s odpady, schvaleny systém nakladani s odpady &i spole€nost zajistujici
likvidaci domovniho odpadu, nebo navstivte webové stranky
www.canon-europe.com/sustainability/approach/

Csak az Eurépai Unio és az EGT (Norvégia, Izland és Liechtenstein)
orszagaiban

B

Ezek a szimbolumok azt jelzik, hogy a termék hulladékkezelése a haztartasi hulladéktél kildnvalasztva,
az elektromos és elektronikus berendezések hulladékairdl (WEEE) sz6l6 (2012/19/EU) iranyelvnek és az
elemekrdl,valamint a hulladék elemekrél sz6l6 ((EU) 2023/1542) rendeletnek megfeleléen és/vagy ezen
iranyelveknek megfelel6 helyi eléirasok szerint torténik.

Amennyiben a fent feltintetett szimbolum alatt egy vegyijel is szerepel, az elemekrél sz6l6 rendeletben
foglaltak értelmében ez azt jelzi, hogy az elem a rendeletben meghatarozott hatarértéknél nagyobb
mennyiségben tartalmaz nehézfémet (Pb = 6lom).

E terméket az arra kijeldlt gydjtéhelyre kell juttatni — pl. hasonlé termék vasarlasakor a régi becserélésére
vonatkozo hivatalos program keretében, vagy az elektromos és elektronikus berendezések (EEE)
hulladékainak gyljtésére, valamint a hulladék elemek gyjtésére kijeldlt hivatalos gy(ijtéhelyre. Az ilyen
jellegl hulladékok nem eldirasszeri kezelése az elektromos és elektronikus berendezésekhez (EEE)
altalanosan kapcsolhatod potencialisan veszélyes anyagok révén hatassal lehet a kdrnyezetre és az
egészségre.

E termék megfeleld leselejtezésével On is hozzajarul a természeti forrasok hatékony hasznalatahoz.

A termék Ujrahasznositasat illetéen informalédjon a helyi polgdrmesteri hivatalnal, a helyi kdzterilet-
fenntartd vallalatnal, a hivatalos hulladékleraké telephelyen vagy a haztartasi hulladék begylijtését végzé
szolgaltatonal, illetve l1dtogasson el a

www.canon-europe.com/sustainability/approach/ internetes oldalra.
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Tylko dla krajow Unii Europejskiej oraz EOG (Norwegia, Islandia i
Liechtenstein)

B

Te symbole oznaczajg, ze produktu nie nalezy wyrzucac razem z odpadami gospodarstwa domowego,
zgodnie z Dyrektywg WEEE w sprawie zuzytego sprzetu elektrycznego i elektronicznego (2012/19/

UE), Rozporzadzeniem Parlamentu Europejskiego i Rady 2023/1542 w sprawie baterii i/lub przepisami
krajowymi wdrazajgcymi te dyrektywe i rozporzadzenie.

Jesli pod powyzszym symbolem znajduje sie symbol chemiczny, zgodnie z Rozporzadzeniem w sprawie
baterii oznacza to, ze bateria zawiera metal ciezki (Pb = otéw) w stezeniu przekraczajgcym odpowiedni
poziom okreslony w Rozporzadzeniu.

Uzytkownicy baterii majg obowigzek korzysta¢ z dostepnego programu zwrotu, recyklingu, odzysku i
bezpiecznego unieszkodliwienia baterii, np. na zasadzie oddania ,jeden za jeden” przy zakupie nowego,
podobnego produktu.

Niewfasciwe postepowanie z tego typu odpadami moze mie¢ wptyw na srodowisko i zdrowie ludzi ze
wzgledu na substancje potencjalnie niebezpieczne, ktére sg zazwyczaj zwigzane ze zuzytym sprzetem
elektrycznym i elektronicznym.

Panstwa wspétpraca w zakresie wtasciwego zagospodarowania tego produktu przyczyni sie do
efektywnego wykorzystania zasobéw naturalnych.

W celu uzyskania informacji o sposobie recyklingu tego produktu prosimy o kontakt z wkasciwym urzedem
miejskim lub zaktadem gospodarki komunalnej bgdz zapraszamy na strone
www.canon-europe.com/sustainability/approach/ .

Plati len pre Staty Eurépskej unie a EHP (N6rsko, Island a
Lichtenstajnsko)

B

Tieto symboly oznaduju, Ze podla Smernice o odpade z elektrickych a elektronickych zariadeni (OEEZ)
2012/19/EU, Nariadenia Eurépskeho parlamentu a Rady (EU) 2023/1542 o batériach a odpadovych
batériach, a podla platnej legislativy Slovenskej republiky implementujucej tito smernicu a nariadenie sa
tento vyrobok nesmie likvidovat spolu s komunalnym odpadom.

Ak je v sulade s poziadavkami nariadenia chemicka znacka vytlaCena pod vySSie uvedenym symbolom,
znamena to, Ze tato batéria obsahuje tazké kovy (Pb = olovo) v koncentracii vyssej, ako je prislusna
povolena hodnota stanovena v nariadeni.

Vyrobok je potrebné odovzdat do uréeného zberného miesta, napr. prostrednictvom vymeny za kupu
nového podobného vyrobku, alebo na autorizované zberné miesto, ktoré recykluje odpad z elektrickych
a elektronickych zariadeni (EEZ) a batérii. Nespravna manipulacia s takymto typom odpadu méze mat
negativny vplyv na Zivotné prostredie a ludské zdravie, pretoZe elektrické a elektronické zariadenia
obsahuju potencialne nebezpecéné latky.

Spolupracou na spravne;j likvidacii tohto vyrobku prispejete k uinnému vyuzivaniu prirodnych zdrojov.
Dalsie informacie o recyklacii tohto vyrobku ziskate od miestneho/obecného tradu, okresného tradu
odboru Zivotného prostredia, zo schvaleného systému nakladania s odpadmi alebo od spolo¢nosti, ktora
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zabezpecuje zber a likvidaciu komunalneho odpadu. Viac informacii najdete aj na webovej stranke:
www.canon-europe.com/sustainability/approach/ .

I Ainult Euroopa Liidu ja EMP (Norra, Island ja Liechtenstein) puhul.

2R

Need sumbolid naitavad, et vastavalt elektroonikaromude direktiivile (2012/19/EL), patareide maarusele
((EL) 2023/1542) ja/vdi siseriiklikele digusaktidele, millega neid direktiive ja maarusi rakendatakse, ei tohi
seda toodet kdrvaldada koos olmejaatmetega.

Kui Glaltoodud stiimboli alla on trikitud see keemiline siimbol, thendab see vastavalt patareieeskirjale,
et selles patareis Uletab raskemetalli (Pb = plii) kontsentratsioon patareieeskirjas satestatud kohaldatavat
piirmaara.

See toode tuleb anda selleks ettendhtud kogumispunkti, nt tks Uhele pdhimdbttel uue sarnase toote
ostmisel vdi elektri- ja elektroonikaseadmete ning patareide ringlussevoétuks volitatud kogumispunkti.
Seda tllpi jaadtmete ebadige kaitlemine voib potentsiaalselt ohtlike ainete tdttu, mis on Uldiselt seotud
elektri- ja elektroonikaseadmetega,mojutada keskkonda ja inimeste tervist . Teie koostdd selle toote digel
korvaldamisel aitab kaasa loodusvarade tdhusale kasutamisele.

Lisateavet selle toote ringlussevotu kohta saate oma kohalikult omavalitsuselt, jaatmekaitlusasutuselt,
heakskiidetud susteemilt vdi oma kodumajapidamisele jaatmekaitlusteenuse osutajalt voi kulastades
veebilehte

www.canon-europe.com/sustainability/approach/.

Attiecas tikai uz Eiropas Savienibu un EEZ (Norvégija, Islande un
Lihtensteina)

B

Sie simboli norada, ka saskana ar EEIA direktivu (2012/19/ES), Bateriju regulu ((ES) 2023/1542) un/vai
valsts tiestbu aktiem, ar kuriem Tsteno So direktivu un regulu, So izstradajumu nedrikst izmest kopa ar
sadzives atkritumiem.

Ja zem iepriek$ noradita simbola ir uzdrukats kimiskais simbols saskana ar Bateriju regulu, tas norada,
ka 8aja baterija ir smags metals (Pb = svins), kura koncentracija parsniedz piemérojamo robezveértibu, kas
noteikta Bateriju regula.

Sis izstradajums ir janodod noteikta savaksanas vieta, pieméram, saskana ar apstiprinatu principu "viens
par vienu", kad iegadajaties jaunu Itdzigu izstradajumu, vai autorizéta elektrisko un elektronisko iekartu
(EEI) un bateriju atkritumu savak8anas vieta. Nepareiza riciba ar $ada veida atkritumiem var ietekmét
vidi un cilvéku veselibu, jo EEI parasti ir saistitas ar potenciali bistamam vielam. Jlsu sadarbiba, pareizi
utilizéjot So produktu, veicinas efektivu dabas resursu izmantoSanu.

Lai iegQtu vairak informacijas par 8T izstradajuma parstradi, sazinieties ar vietéjo pilsétas parvaldi,
atkritumu apsaimnieko3anas iestadi, apstiprinatu shému vai sadzives atkritumu apglabasanas dienestu,
vai apmekléjiet timekla vietni:

www.canon-europe.com/sustainability/approach/.
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I Tik Europos Sajungoje ir EEE (Norvegijoje, Islandijoje ir Lichtensteine)

B

Sie simboliai rodo, kad $io gaminio negalima i$mesti kartu su buitinémis atliekomis pagal EE] atlieky
direktyvag (2012/19/ES), baterijy reglamentg ((ES) 2023/1542) ir (arba) nacionalinius teisés aktus, kuriais
jgyvendinama Si direktyva ir reglamentas.

Jei po pirmiau nurodytu simboliu iSspausdintas cheminis simbolis pagal baterijy reglamentag, tai reiskia,
kad Sioje baterijoje yra sunkiyjy metaly (Pb = Svino), kuriy koncentracija virSija taikomg ribine verte,
nurodytg baterijy reglamente.

8j gaminj reikia atiduoti j paskirtg surinkimo punkta, pvz., vadovaujantis principu ,vienas uz vieng®, kai
perkate naujg panasy gaminj, arba j jgaliotg elektros ir elektroninés jrangos (EE]) ir baterijy atlieky
surinkimo vietg. Netinkamas Sios ruSies atlieky tvarkymas gali turéti jtakos aplinkai ir Zmoniy sveikatai dél
potencialiai pavojingy medziagy, kurios paprastai biina susijusios su EE]. Bendradarbiaudami ir teisingai
utilizuodami §j gaminj prisidésite prie efektyvaus gamtos iStekliy naudojimo.

Norédami gauti daugiau informacijos apie Sio gaminio perdirbimag, kreipkités | vieting miesto jstaiga,
atlieky tvarkymo institucija, patvirtintg programag ar buitiniy atlieky $alinimo tarnybg arba apsilankykite
adresu

Www.canon-europe.com/sustainability/approach/.

I Samo za Evropsko unijo in EGP (Norveska, Islandija in Lihtenstajn)

2K

Ti simboli pomenijo, da tega izdelka skladno z Direktivo OEEO (2012/19/EU), uredbo (EU) 2023/1542
in/ali nacionalno zakonodajo, ki uvaja Direktivo in Uredbo, ne smete odlagati z nesortiranimi
gospodinjskimi odpadki.

Ce je pod zgoraj prikazanim simbolom natisnjen kemijski simbol, to v skladu z Uredbo pomeni, da je v tej
bateriji prisotna tezka kovina (Pb = svinec), in sicer v koncentraciji, ki je nad relevantno mejno vrednostjo,
doloceno v Uredbi.

Ta izdelek je potrebno odnesti na izbrano zbirno mesto, t. j. pooblas€eno trgovino, kjer ob nakupu novega
(podobnega) izdelka vrnete starega, ali na pooblas&eno zbirno mesto za ponovno uporabo odpadne
elektri¢ne in elektronske opreme (EEQO) ter baterij. Neustrezno ravnanje s to vrsto odpadkov lahko
negativno vpliva na okolje in CloveSko zdravje zaradi potencialno nevarnih snovi, ki so pogosto povezane
z EEO.

VaSe sodelovanje pri pravilnem odlaganju tega izdelka predstavlja pomemben prispevek k smotrni izrabi
naravnih virov.

Za ve¢ informacij o ponovni uporabi tega izdelka se obrnite na lokalen mestni urad, pristojno sluzbo za
odpadke, predstavnika pooblas€enega programa za obdelavo odpadkov ali na lokalno komunalo. Lahko
pa tudi obiS¢ete naso spletno stran

www.canon-europe.com/sustainability/approach/ .
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Camo 3a EBponeinckus cbro3 n EUM (Hopserus, Ucnangua v
JlnxteHwanH)

2 X

Tesn cumBOnM NokasearT, Ye TO3M NPOAYKT He TpsibBa Aa ce M3XBbpNs 3aegHo ¢ OUTOBUTE OTNaabLM
cbrnacHo Aupektusata 3a MYEEO (2012/19/EC), PernameHT 3a 6atepuute ((EC) 2023/1542) n/vnu
BaweTto HaumoHanHo 3akoHo4aTencTBo, Npunarawlo Tean JMpekTusm.

AKO Nof, NokasaHus rope CUMBOS € oTrnevaTaH CMMBOJ 33 XMMUYECKM eIEMEHT, CbIMacHO pasnopenouTe
Ha PernameHT 3a 6aTtepun, To3n BTOPM CMMBOJS O3Ha4yaBa Hann4yneTo Ha Texxbk metan (Pb = onoso) B
OaTepusaTa B KOHLEHTpaUWs Haf ykasaHaTa rpaHuLa 3a CbOTBETHUS eneMeHT B PernameHT.

Tosun npogykT TpsabBa ga 6bae npedageH B NpedHa3HayeH 3a LenTta nyHKT 3a cbbupaHe, Hanpymep

Ha 6a3a pa3msHa, koraTo KynyBaTe HOB Noo6eH NpoayKT, unv B ogobpeH cbbrparteneH nyHKT 3a
peuuKnupaHe Ha U3nsas3no ot ynotpeba enekTpuiecko u enekTpoHHo obopyaeaHe (MYEEOQO), 6atepumn.
HenpaBunHoTo TpeTupaHe Ha TO3M TUMN OTNaAbLUN MOXE [a JOBeAEe OO EBEHTYanHN oTpuuaTenHu
nocneacTBus 3a OKONHaTa cpeja v YOBELLKOTO 3apaBe nopagu NoTeHUManHo onacHUTE BeLecTBa, KoMTo
0bukHoBeHO ca cBbp3aHu ¢ EEO.

B cbwoTo Bpeme BaweTo cbaencTeme 3a NpaBUITHOTO U3XBBbPIISHE Ha TO3M NPOAYKT e AonpuHece 3a
eeKTUBHOTO M3MNOM3BaHe Ha NPUPOLHUTE PECYPCHU.

3a noBeye MHpopmMauust OTHOCHO TOBa Kbe MOXeTe Aa npeJadeTe 3a peuuknmpaHe To3n NpoaykT,
MOIsi CBbPXETe Ce C MECTHUTE BracTu, C opraHa, OTroBOpPEH 3a oTnagbuuMTe, ¢ ogobpeHaTa cuctema 3a
MYEEO, c Bawara mecTHa cnyx0a 3a 6uToBM OTnagbLu Unmn noceTteTe.
www.canon-europe.com/sustainability/approach/

Doar pentru Uniunea Europeana si EEA (Norvegia, Islanda si
Liechtenstein)

B

Aceste simboluri indica faptul ca acest produs nu trebuie aruncat impreuna cu deseurile menajere, in
conformitate cu Directiva DEEE (2012/19/UE), Regulamentul ((UE) 2023/1542) si/sau legile dvs. nationale
ce implementeaza aceasta Directiva si Regulament.

Daca un simbol chimic este imprimat sub simbolul de mai sus, in conformitate cu Regulamentul referitor
la baterii, acest simbol indica prezenta in baterie a unui metal greu (Pb = Plumb) intr-o concentratie mai
mare decat pragul admis specificat in Regulamentul referitor la baterii.

Acest produs trebuie Tnméanat punctului de colectare adecvat, ex: printr-un schimb autorizat unu la unu
atunci cand cumparati un produs nou similar sau la un loc de colectare autorizat pentru reciclarea
reziduurilor de echipament electric si electronic (EEE) si baterii. Administrarea neadecvata a acestui tip
de deseuri, ar putea avea un impact asupra mediului si asupra sanatatii umane datorita substantelor cu
potential de risc care sunt In general asociate cu EEE.

Cooperarea dvs. in directia reciclarii corecte a acestui produs va contribui la o utilizare eficienta a
resurselor naturale.

Pentru mai multe informatji despre reciclarea acestui produs, va rugam sa contactati biroul dvs. local,
autoritatile responsabile cu deseurile, schema aprobata sau serviciul dvs. responsabil cu deseurile
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menajere sau vizitati-ne la.
www.canon-europe.com/sustainability/approach/.

I Samo za Europsku uniju i EEA (Norveska, Island i Lihtenstajn)

B

Oznaka pokazuje da se ovaj proizvod ne smije odlagati s komunalnim i ostalim vrstama otpada, u

skladu s direktivom WEEE (2012/19/EC), Uredbom o baterijama ((EU) 2023/1542) i/ili nacionalnim
zakonodavstvom koje provodi te Direktive i Uredbe.

Ako je ispod prethodno prikazane oznake otisnut kemijski simbol, u skladu s Uredbom o baterijama, to
znaci da se u ovoj bateriji nalazi teSki metal (Pb = olovo) i da je njegova koncentracija iznad razine
propisane u Uredbi o baterijama.

Ovaj bi proizvod trebalo predati ovlaStenom skupljaéu EE otpada ili prodavatelju koji je duZan preuzeti
otpadni proizvod po sistemu jedan za jedan, ako isti odgovara vrsti te je obavljao primarne funkcije

kao i isporu¢ena EE oprema. Otpadne baterije predaju se ovlastenom skupljacu otpadnih baterija ili
prodavatelju bez naknade i obveze kupnje za krajnjeg korisnika. Neodgovarajuc¢e rukovanje ovom vrstom
otpada moZe utjecati na okoli$ i ljudsko zdravlje zbog potencijalno opasnih supstanci koje se najéesée
nalaze na takvim mjestima.

Va8a suradnja u pravilnom zbrinjavanju ovog proizvoda pridonijet ¢e djelotvornom iskoriStavanju prirodnih
resursa. Dodatne informacije o recikliranju ovog proizvoda zatrazite od svog lokalnog gradskog ureda,
sluzbe za zbrinjavanje otpada, odobrenog programa ili komunalne sluZzbe za uklanjanje otpada ili pak na
stranicama

www.canon-europe.com/sustainability/approach/
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I Handling Precautions

» When Repairing, Lending, or Disposing of the Printer
» Legal Restrictions on Printing

» Ink Tips
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I When Repairing, Lending, or Disposing of the Printer

If you have entered personal data, passwords and/or other security settings on the printer, such information
may be stored in the printer.

To keep your personal information safe, please be sure to reset all printer settings when sending the printer
for repair, lending or transferring the printer to another person, or disposing of the printer.

= Reset settings
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I Legal Restrictions on Printing

Printing or modifying printed copies of the following may be punishable under law.

This list is non-exhaustive. When in doubt, check with a local legal representative.

* Paper money

* Money orders

* Certificates of deposit

» Postage stamps (canceled or uncanceled)

+ Identification badges or insignia

+ Selective service or draft papers

» Checks or drafts issued by governmental agencies
» Motor vehicle licenses and certificates of title

» Traveler's checks

* Food stamps

» Passports

* Immigration papers

* Internal revenue stamps (canceled or uncanceled)
* Bonds or other certificates of indebtedness

+ Stock certificates

» Copyrighted works or works of art, without the owner's consent
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| ink Tips

I How is ink used for various purposes other than printing?

Ink may be used for purposes other than printing.

During initial setup, some of the ink from the bundled ink bottles is used to fill the print head's nozzles to
ensure the printer is print-ready.

Therefore, the page yield of the initial bundled set of ink bottles is lower than that of the subsequent sets
of bottles.

To keep printer's performance, Canon printer performs cleaning automatically according to its condition.
When the printer performs cleaning, a small amount of ink is consumed. In this case, all colors of ink may
be consumed.

[Cleaning function]

The cleaning function helps the printer to suck air bubbles or ink itself from the nozzle and thus prevents
print quality degradation or nozzle clogging.

32 Important

» The used ink is ejected into the maintenance cartridge. When the maintenance cartridge becomes
full, replacement is necessary. If the displayed message indicates that the maintenance cartridge is
nearly full, promptly obtain a new one.

= Replacing the Maintenance Cartridge

I Does black-and-white printing use color ink?

Black-and-white printing may use ink other than black ink depending on the type of printing paper or the
settings of the printer driver. So, color ink is consumed even when printing in black-and-white.

Similarly, color inks are also consumed along with black ink during print head cleaning when Black is
specified for cleaning.
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I Specifications

» Specifications

» Print Area
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Specifications

L 3R 2R 2B B 2R B

Printer specifications
Printing performance

Memory
Interface

Network Specifications
Operating Conditions
Paper

22 Important

 The following values may vary depending on the operating environment.

I Printer specifications

Power supply

100-240 V AC (50/60 Hz)

Power consumption

When printing (wired LAN connection): Approx. 28 W
Standby (wired LAN connection): Approx. 1.7 W
Standby (all ports connected): Approx. 2.3 W

When power is off: Approx. 0.07 W *1

*1 The printer uses a trace amount of power even when turned off. To stop all
power consumption, turn off the printer and unplug the power cord.

Operating environment

Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 10 to 80 % RH (with no condensation)

* For the temperature and humidity conditions of papers such as photo paper
or medicine envelopes, refer to the paper's packaging or the supplied instruc-
tions.

Dimensions (W x D x H)

Printer only *:

Approx. 38.2 x 21.0 x 9.7 in. (968 x 533 x 245 mm)

Printer and Desktop Basket BU-06 (when the basket is opened) *:
Approx. 38.2 x 32.5 x 38.0 in. (968 x 825 x 965 mm)

Printer and Stand SD-24 (when the basket is opened) *:

Approx. 38.2 x 34.2 x 34.5in. (968 x 868 x 874 mm)

* With the covers and the trays closed.

Weight

Printer only *:

Approx. 70 Ib (32 kg)

Printer and Desktop Basket BU-06 *:
Approx. 72 Ib (33 kg)

Printer and Stand SD-24 *:

Approx. 94 Ib (43 kg)
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* With the Print Head installed.

Space for installation (W x D x
H)

Printer only:

Approx. 46.0 x 44.3 x 29.4 in. (1168 x 1125 x 745 mm)

Printer and Desktop Basket BU-06 (when the basket is opened):
Approx. 46.0 x 56.2 x 57.7 in. (1168 x 1425 x 1465 mm)

Printer and Stand SD-24 (when the basket is opened):

Approx. 46.0 x 55.2 x 54.1 in. (1168 x 1400 x 1374 mm)

I Printing performance

Print method

Bubblejet

Maximum resolution

2400 dpi (horizontally) * x 1200 dpi (vertically)

* Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Print head

PF-08

Number of nozzles

4352 nozzles (BK: 1280 nozzles, C/M/Y: 1024 nozzles)

I Memory

Memory

Physical memory 1GB

I Interface

USB and the network can be used at the same time.

You cannot use Wi-Fi and wired LAN at the same time.

UsB

Hi-Speed USB *

* To use Hi-Speed USB, your computer must support Hi-Speed USB. Addition-
ally, the Hi-Speed USB interface is completely backward compatible with USB
1.1, so the printer can be connected even if the computer interface is USB 1.1.

LAN

Wired LAN: IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T)

Wi-Fi: IEEE802.11n / IEEE802.11g / IEEE802.11b / IEEE802.11a /
IEEE802.11ac

I Network Specifications

Communication protocol

SNMP, HTTP, TCP / IP (IPv4 / IPv6)

Wired LAN specifications

Supported Standards: IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T)
Transmission speed: 10 Mbps / 100 Mbps (automatically selected)

Security: IEEE802.1X (EAP-TLS / EAP-TTLS / PEAP)
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Wi-Fi specifications

Supported Standards: IEEE802.11n / IEEE802.11g / IEEE802.11b /
IEEE802.11a / IEEE802.11ac

Frequency bandwidth: 2.4 GHz / 5 GHz *1
Channels:

2.4 GHz: 1-11 or 1-13 *1

5 GHz: W52, W53, W56, W58 *1

*1 Frequency bandwidth and available channels differ depending on country or
region.

Effective range: Indoors 164 feet/50 m *2

*2 Varies according to environmental conditions.
Security:

WPA-PSK (AES)

WPA2-PSK (AES)

WPA3-SAE (AES)

WPA-EAP (AES) *3

WPA2-EAP (AES) *3

WPA3-EAP (AES) *3

*3 Supports IEEE802.1X (EAP-TLS / EAP-TTLS / PEAP)
Setup:

WPS (push button method/PIN code method)

Easy wireless connect

I Operating Conditions

If operating conditions of the operating system are high, follow those.

Windows

printer driver)

Compatible Operating System (Standard supplied | Windows 11

Windows 10

Windows 8.1

Windows 7

Windows Server 2025
Windows Server 2022
Windows Server 2019
Windows Server 2016
Windows Server 2012 R2
Windows Server 2012
Windows Server 2008 R2

Use the latest Service Pack available.
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Free hard disk space 20 GB or more

macOS

Compatible Operating System (Standard macOS Big Sur 11.7.10 - macOS Sequoia 15
supplied printer driver)

Free hard disk space 20 GB or more

Other Supported OS

i0S, iPadOS, Android, Chrome OS

Some functions may not be available with the supported OS.

* An Internet connection is required to use the Online Manual.

» To install the software while using Windows, you must have a CD-ROM drive or a network
connection.

» To install the software while using macOS, you must have a network connection.

I Paper
For details on the compatible media types, see Paper Information List.

For details on the paper widths supported by the printer, see Paper Sizes.

For details about Print Area, see Print Area.
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I Print Area

A margin required by the printer is added with respect to the size of paper loaded in the printer. The actual
printing area corresponds to the paper size minus the space for this margin.

»» Note

» This product supports the minimal margin printing. Depending on the application you use to print, this
may be displayed as borderless printing.

* Printable Area: The area that can be printed.

* When performing the minimal margin printing on roll paper, the top and bottom margins will be 0 mm
(0.00 in.), with a slight margin remaining on the left and right.

= Printing with Minimal Margins on the Scenarios (Windows)
= Printing with Minimal Margins on the Scenarios (macOS)

* Recommended Print Area: We recommend printing within this area.

* To match the document size with the actual printing area, print on oversize paper with the required
margin added.

= Printing to Oversized Paper Sizes (Windows)
= Printing to Oversized Paper Sizes (macOS)

I Sheets, Postcards

Printable Area

Size Printable area

Hagaki / Hagaki 2 :0.12in. (3.0 mm)
:0.16in. (4.0 mm)
:0.13in. (3.4 mm)

:0.13in. (3.4 mm)

oo w>»

Paper size other than the above A:0.20 in. (5.0 mm)
B: 0.20 in. (5.0 mm)
C:0.20in. (5.0 mm)
D: 0.20in. (5.0 mm)
h
A
r
[ >t [
r
B
k.
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A: Top Edge

B: Bottom Edge
C: Left Edge

D: Right Edge

| Rolis

Printable Area

The required margins are 0.20 in. (5 mm)*1/ 1.18 in. (30 mm)*1 on the top and bottom, and 0.20 in. (5
mm) on the left and right. When performing the minimal margin printing, the top and bottom margins are
0.00 in. (0 mm), and the left and right margins are 0.02 in. (0.5 mm)*2. For information on paper that can
be printed with minimal margins, see "Paper Information List".

*1 The margins on the roll paper vary depending on the print settings.
*2 Margins may vary about between 0.1 mm and 0.8 mm depending on settings and your environment.

A

k )

A: Top Edge

B: Bottom Edge
C: Left Edge

D: Right Edge
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I Envelopes

B _.°I! ! B | :
il Ll e g
c D ¢ D
1 Printable area
Size Printable Area

Nagagata 3 / Nagagata 4

oo w>»

:0.20 in. (5.0 mm)
:0.31in. (8.0 mm)
:0.22in. (5.6 mm)
:0.22in. (5.6 mm)

Yougata 4 / Yougata 6

o0 w >

:0.50in. (12.7 mm)
:0.31in. (8.0 mm)
:0.22in. (5.6 mm)
:0.22in. (5.6 mm)

Envelope Com 10 / Envelope DL / Envelope C5 / Envelope Monarch

o0 w >

:0.50 in. (12.7 mm)
:0.50in. (12.7 mm)
:0.22in. (5.6 mm)
:0.22in. (5.6 mm)
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I Appendix

» Online Manual
» Symbols Used in This Document
» Trademarks

» Licenses
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I Online Manual

Models used in illustrations and videos in this manual, may differ from your model.

I Screenshots in This Manual

For Windows:

The screenshots used in this manual are taken with Windows 10.

For macOS:

The screenshots used in this manual are taken with macOS Ventura 13.
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